R&S®SMM-K60/-K117/-K178

Bluetooth® Signal Generation
User Manual

1111111111
Version 07

ROHDE&SCHWARZ
Make ideas real




This document describes the following software options:

® R&S®SMM-K60 Bluetooth EDR (1441.1918.xx)

® R&S®SMM-K117 Bluetooth 5.x (1441.1799.xx)

® R&S®SMM-K178 Bluetooth 5.4 + Channel Sounding (1441.0886.xx)

This manual describes firmware version FW 5.30.175.xx and later of the R&S®SMM100A.

© 2024 Rohde & Schwarz

Muehldorfstr. 15, 81671 Muenchen, Germany

Phone: +49 894129 -0

Email: info@rohde-schwarz.com

Internet: www.rohde-schwarz.com

Subject to change — data without tolerance limits is not binding.

R&S? is a registered trademark of Rohde & Schwarz GmbH & Co. KG.

The Bluetooth® word mark and logos are registered trademarks owned by Bluetooth SIG, Inc. and any use of such marks by Rohde
& Schwarz is under license.

All other trademarks are the properties of their respective owners.

1179.2054.02 | Version 07 | R&S®SMM-K60/-K117/-K178

Throughout this document, R&S® is indicated as R&S.


mailto:info@rohde-schwarz.com
http://www.rohde-schwarz.com

R&S®SMM-K60/-K117/-K178 Contents

Contents

1 Welcome to the Bluetooth options........ccceeeeeecciiiiiiieees 7

I T (o VA (=Y L= PR 7
1.2 Accessing the Bluetooth dialog........ccccccrimiiiiiiiicciscsseeriere s 9
R T4 3T 1= 3 - 9
1.4 Documentation OVEIVIEW.......ccccuiiiieimiinininsrs i s 9
1.4.1  Getting started ManuUal...............ouiiiiiiiiie e —————— 10
1.4.2 Usermanuals and NelpP..........uuueiiiiiiiiiiiiiiicie e e e eaaeae s 10
1.4.3  SEIVICE MANUAL......ciiiiiiiiiii ittt nnee e 10
1.4.4 Instrument SECUNitY PrOCEAUIES........ciiiiieii i ittt e e e e e e e e eee s 10
1.4.5 Printed safety iNStrUCHONS..........ooiiiiieiee e e e e e e e 11
1.4.6 Specifications and product broChUres...............oooiiiiiiiiiiiiie e 11
1.4.7 Calibration CertifiCate..........cuiiiiiiiii 11
1.4.8 Release notes and open source acknowledgment.............ccoccciiiiiiiiiiee e 11
1.4.9 Application notes, application cards, white papers, etC.............cccceeveciiiiiiiiieee i, 11
L L YA To [=T o L O TP PP PP OPPPPUPRPRPRRN 11
I T T o - PO 12
1.6 Notes on Screenshots........ccccciiiiiniini e —————— 12
2 About the Bluetooth options..........ccccoiimmmmmmrrrrnn e, 13
2.1 Required OPtioNS........cccceiiiiiiimiriiire i ———————— 13
2.2 About Bluetooth LE...........ccooiiiiiieiiiiii s s s s anes 13
221 Packet formats for LE..........oooii i 14
2.2.2 Packet types fOr LE.... .o 16
2.2.3 Advertising channel packet StruCtUre.............ooiiiiiiiiiii e 18
2.2.4 Data channel packet StruCtUIe...........oooi i 20
2.2.5 Modulation SChHEME........oiiiiiiei e 20
2.2.6  DiIreCtion fINAING.......eeeeeeii e 21
2.3 About Bluetooth LE Channel Sounding........ccccccmiirimmmmmnnnsmensss e 25
2.4 About Bluetooth BR/EDR..........ccoiciimmiiini s sssnss s 26
2.4.1 Bluetooth packet types for BRIEDR..........cooiiiiiiieeeeee e 27
2.4.2 Bluetooth transport MOAES. ..........ueiiiiiiiiee e e e e e e e eeas 30
2.4.3 Packet structure and fields.... ... 30

User Manual 1179.2054.02 — 07 3



R&S®SMM-K60/-K117/-K178 Contents

244

5.1

5.2
5.2.1
5.2.2
5.2.3

5.3
5.3.1
5.3.2
5.3.3
5.3.4
5.3.5
5.3.6
5.3.7
5.3.8
5.3.9

5.4
5.4.1
5.4.2
5.4.3
5.4.4
545
5.4.6

5.5
5.5.1
5.5.2
5.5.3
5.5.4
5.5.5

Bluetooth modulation SChemes. ... 33
Bluetooth general settings...........cccccmmmmmmmmimiii s 35
Dirty transmitter test settings......cccccccce i 39
Bluetooth LE configuration and settings............ccccmrmirrreeeeccccccenn, 44
Channel settings.........ccviiriiii i ————————— 44
Advertising event and frame configuration............cccccciiriiiinnn 51
Advertising event and frame SettingsS...........ocuivi i 51
CoNNECHION SEHINGS. ...oi it 54
Channel table SEtHNGS........oii i 56
Advertising and data packet configuration...........ccccccoviiiiiiinni 58
Packet configuration SEtNGS. ........ooiuiiiiiiiiii 58
HeEader SEHINGS. .....coiiiii et 60
CTEINTO SEENGS. ...eeeeee ittt 62
Legacy advertising PDU payload Settings...........eoviiiiiiiiiiiiiec e 63
Extended advertising PDU payload Settings..........c.ooueeiiiiiiiiiiiiiiiiee e 66
Scanning PDU payload SettingsS........c..eviiiiiiiiiiiiiec e 74
Initiating PDU payload Settings..........cooiiiiiiiii e 76
Data channel PDU payload Settings. ..o 79
FeatureSet configuration Settings...........ooooiiiiii i 89
CS subevent configuration..........cccccciimiiiiiiii i ———— 91
SUDEVENT SEHINGS. ....ceiiiitieiie et 91
Channel tabIe.........ooii e 95
CS SECUNMLY SEEINGS. .. eeeiiiiiitie it e e e e 96
Channel selection SEttiNGS. .......oueiiiii i 98
CS step CONFIGUIATION. ... 99
LRSI (=T o TN 1) o SO 108
CS control data payload settings...........cceerrriiiiiiiiiir 112
CS security payload SettingsS.........ueeiiiiiiii e 113
CS capabilities payload SEttNGS........ccoiiiiiiiiiii e 113
CS configuration payload Settings..........ccouiiiiiiiiiii 119
CS payload SEHINGS. .....coiiiiiie i 122
CS IND payload SettiNgS. ......cuueeiiiiiiiiiiie et 126

User Manual 1179.2054.02 — 07 4



R&S®SMM-K60/-K117/-K178 Contents

5.5.6
5.5.7
5.5.8

5.6

6.1
6.2

7.1
711
7.1.2
7.1.3
7.1.4

7.2

7.3

7.4

7.5

7.6

8.1
8.2
8.3
8.4
8.5
8.5.1
8.5.2
8.5.3
8.5.4
8.5.5
8.5.6
8.5.7
8.6

CS terminate payload SEtNGS. ......ccooiiiiiiiiiii e 128
CS FAE payload SettiNgS.........oeiiiiiiiiieiiiiiee e 128
CS channel map payload SettingsS..........cooiiiiiiiiii e 129
Test packet configuration.........cccceviiiiccinc e ——————— 129
Bluetooth BR/EDR configuration and settings............ccceviiiiiiinnee 133
L0d 3B 1T 1= BT =1 T Vo = RS, 133
Packet configuration...........ccccorireeiiiinns e e 135
Signal control and signal characteristics..........cccccciniiiieenniiiiiiinns 143
Filter/clipping Settings.........ccooiiiiiii e 143
Common fiIlter SEHINGS. .....oi e 144
DPSK filter SEHINGS. ..coe i 145
MOAUIAtION SELHINGS....oeiiiiiiiii e 146
(O3 [To] o gL JE=T=T 11 g o L3RR UPUPRRN 148
Power ramping settings.........cccvvimmmiimreer 149
Trigger SettiNgsS.....cccvceeiirre i ——————————— 151
Marker settings.........ooi i ————— 156
CloCk SettiNgS......ceiiiiiiiii i 158
Local and global connectors settings..........ccccoviiiiiimmemninn s 159
Remote control commands...........ccccciniiiinemnnnsere e, 160
General CoOMMANAS.......ccccriiiiiire e 161
Dirty transmitter configuration...........ccocciiiiiiiiicc e —— 166
Channel configuration commands - LE..........ccccccoiniiimiiniimnnene e 173
Event and frame configuration commands - LE...........ccccociiiriiniiimninciiennnininnns 179
Channel sounding commands = LE..........cccoocimiminiiimn e 189
CS general COMMEANGS. ......cooiiiiiiiie et 190
CS SUDEVENT COMMANGS......uiiiiiiiiiiie et 191
CS step configuration COMMANGAS...........ccoiiiiiiiiiiii e 195
CS step infO COMMEANAS. .......eeeeee e e e e e 201
CS channel table COMMEANGS.........ccoiiiiiiiii e 204
CS SECUNtY COMMEANGS. .....eiiiiiiiiiie et 206
CS channel selection COMMANGAS...........uuiiiiiiiiiiie e 208
Packet configuration commands = LE...........ccocciiiiiimniinene e 210

User Manual 1179.2054.02 — 07 5



R&S®SMM-K60/-K117/-K178 Contents

8.6.1
8.6.2
8.6.3
8.6.4
8.7
8.8
8.9
8.10
8.11
8.12
8.13
8.14

General CONfIGUIATION..........uiiiii i 216
Header configuIration............ooo i 217
Payload CoNfIgUration............cuueiiiiiii e 220
Cs payload coNfiQUuratioN.............eeiiiiiiiiiiii e 250
Test packet configuration commands - LE...........ccccocviiiiiiciiiniciienn s 267
Channel configuration commands - BR/IEDR............cccoviimmminnnimmnenn e 271
Packet configuration commands - BR/IEDR...........ccccconniiimininnssie e 272
Filter/clipping commands.............oo e s 281
Power ramping COMMAaNAS.........ccimrriiiiimmrriinrs s nns e 288
Trigger COMMANAS........cccueiiiiimrriiier e 290
Marker COMMAaNAS.........coiiiiiiiiirr s 295
Clock COMMANAS........oiiiiiiirii i 299
Glossary: Specifications..........ccccccmmmmmmmmini i ——— 301
List of commands..........ccccceiiiiiiiiimn s 302
INA@X. it ———————————— 310

User Manual 1179.2054.02 — 07 (]



R&SPSMM-K60/-K117/-K178 Welcome to the Bluetooth options

Key features

1 Welcome to the Bluetooth options

The Bluetooth options R&S SMM-K60/-K117/-K178 are firmware applications that add
functionality to generate signals in accordance with the Bluetooth standard.

This user manual contains a description of the functionality that the application pro-
vides, including remote control operation.

All functions not discussed in this manual are the same as in the base unit and are
described in the R&S SMM100A user manual. The latest version is available at:

www.rohde-schwarz.com/manual/SMM100A

Installation

You can find detailed installation instructions in the delivery of the option or in the
R&S SMM100A service manual.

1.1 Key features

R&S SMM-K60 key features

Option R&S SMM-K60 provides Bluetooth signals for basic rate (BR) and enhanced
data rate (EDR) signals. These signals are in line with Bluetooth Core Specification
v4.2. Also, the option provides low energy (LE) signals for the LE 1 Msymbol/s physical
layer.

R&S SMM-K60 supports the following BR and EDR features:

® Support for three transport modes ACL+EDR, SCO and eSCO+EDR

® Support of all packet types for both the basic rate and the enhanced data rate
modes.

® Generation of signals with up to 5238 frames sequence length

® Configuration of the packet contents with a convenient packet editor or all data
packets, both with optional data whitening

® Generation of signals in line with the "Dirty Transmitter Test" specification. The test
enables you to change the start phase, the frequency drift rate and the frequency
drift deviation.

® Power ramp control with possibilities to choose ramp time, rise and fall offset
® Configuration of the clipping, filter and modulation settings

R&S SMM-K60 supports the following LE features:

® Support for two channel types, the "Advertising" and "Data" channel types

® Support of all Bluetooth packet types for LE 1 Msymbol/s physical layer (LE 1M
PHY).

® Convenient packet editor for all supported packet types including optional data
whitening

User Manual 1179.2054.02 — 07 7
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Key features

e Dirty transmitter test, compliant to the RF test specification with options to change
start phase, frequency drift rate and frequency drift deviation

® Support of CRC corruption for every 2nd packet
® Power ramp control with configurable ramp time, rise and fall offsets
® Clipping, filter and modulation settings supported

R&S SMM-K117 key features

Option R&S SMM-K117 is an extension to option R&S SMM-KG60. It provides Bluetooth
LE signals in line with Bluetooth Core Specification v5.4.

Option R&S SMM-K117 supports the following LE features:

® Support for two channel types "Advertising" and "Data"

® Support of all Bluetooth packet types for uncoded LE 2 Msymbol/s physical layer
(LE 2M PHY)

® Support of all Bluetooth packet types for LE coded 1 Msymbol/s physical layer (LE
coded PHY)

® Support of CRC corruption for every 2nd packet

® Convenient packet editor for all supported packet types including optional data
whitening.

e Dirty transmitter test, compliant to the RF test specification with options to change
start phase, frequency drift rate, frequency drift deviation, and modulation index
mode.

® Support of Bluetooth Direction Finding using Constant Tone Extension methods
Angle of Arrival or Angle of Departure

R&S SMM-K178 key features

Option R&S SMM-K178 is an extension to option R&S SMM-K117. It provides Channel
Sounding of Bluetooth LE signals in line with the Bluetooth Channel Sounding specifi-
cation [2].

Option R&S SMM-K178 supports the following LE Channel Sounding features:

® Support of channel type "Channel Sounding"

® Support of Channel Sounding packet types CS SEQUENCE, Test Packet and CS
LL CONTROL PDUs

® Support of LE uncoded PHY "LE 2M 2BT" with PHY 2 Msymbol/s modulation and
bandwidth time product BT = 2

® Support CS subevent configuration

® Support CS step configuration including Mode-0, Mode-1, Mode-2 and Mode-3
configurations

® (CS steps with user-defined random sequence or sounding sequence

For more information, refer to the Bluetooth Core Specification [1].
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Documentation overview

1.2 Accessing the Bluetooth dialog

To open the dialog with Bluetooth settings
» In the block diagram of the R&S SMM100A, select "Baseband > Bluetooth".

A dialog box opens that displays the provided general settings.

The signal generation is not started immediately. To start signal generation with the
default settings, select "State > On".

1.3 What's new

This manual describes firmware version FW 5.30.175.xx and later of the
R&S®SMM100A.
Compared to the previous version, it provides the new features listed below:

® Option Bluetooth 5.4 + Channel Sounding (R&S SMM-K178) related to the Blue-
tooth release providing Channel Sounding (CS) for Bluetooth LE devices, see
Chapter 2.3, "About Bluetooth LE Channel Sounding", on page 25.

® (S settings of option R&S SMM-K178:

— Chapter 5.1, "Channel settings", on page 44 including settings to configure
the channel type, packet type, packet PHY, CS event and CS role.

— Chapter 5.4, "CS subevent configuration", on page 91 including settings to
configure the CS subevent, channel table, CS security and channel selection.

— Chapter 5.4.5, "CS step configuration”, on page 99 including CS step settings
to configure the main mode and the submode for subevent 0.

— Chapter 5.4.6, "CS step info", on page 108 including CS step information for
individual CS steps per subevent

— Chapter 5.5, "CS control data payload settings", on page 112 including settings
to configure the payload of CS_CONTROL_DATA PDUs.

® User-defined Sync Word in the test packet header for LE uncoded PHYs, see
"Sync Word" on page 131 and "User Pattern(hex)" on page 131.

® Payload type "Data List" added for a test packet, see "Payload Type" on page 131.

® Command for querying common filter type and EDR-specific filter type, see [ :
SOURce<hw>] :BB:BTOoth:FILTer: FILTers? on page 282.

e Editorial changes

1.4 Documentation overview

This section provides an overview of the R&S SMM100A user documentation. Unless
specified otherwise, you find the documents at:
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1.4.1

1.4.2

1.4.3

1.4.4

Documentation overview

www.rohde-schwarz.com/manual/smm100a

Getting started manual

Introduces the R&S SMM100A and describes how to set up and start working with the
product. Includes basic operations, typical measurement examples, and general infor-
mation, e.g. safety instructions, etc. A printed version is delivered with the instrument.

User manuals and help

Separate manuals for the base unit and the software options are provided for down-
load:

® Base unit manual
Contains the description of all instrument modes and functions. It also provides an
introduction to remote control, a complete description of the remote control com-
mands with programming examples, and information on maintenance, instrument
interfaces and error messages. Includes the contents of the getting started manual.

® Software option manual
Contains the description of the specific functions of an option. Basic information on
operating the R&S SMM100A is not included.

The contents of the user manuals are available as help in the R&S SMM100A. The
help offers quick, context-sensitive access to the complete information for the base unit
and the software options.

All user manuals are also available for download or for immediate display on the inter-
net.

Service manual
Describes the performance test for checking compliance with rated specifications, firm-
ware update, troubleshooting, adjustments, installing options and maintenance.

The service manual is available for registered users on the global Rohde & Schwarz
information system (GLORIS):

https://gloris.rohde-schwarz.com

Instrument security procedures

Deals with security issues when working with the R&S SMM100A in secure areas. It is
available for download on the internet.
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1.4.5

1.4.6

1.4.7

1.4.8

1.4.9

1.4.10

Documentation overview

Printed safety instructions

Provides safety information in many languages. The printed document is delivered with
the product.

Specifications and product brochures

The specifications document, also known as the data sheet, contains the technical
specifications of the R&S SMM100A. It also lists the firmware applications and their
order numbers, and optional accessories.

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.

See www.rohde-schwarz.com/brochure-datasheet/smm100a

Calibration certificate

The document is available on https://gloris.rohde-schwarz.com/calcert. You need the
device ID of your instrument, which you can find on a label on the rear panel.

Release notes and open source acknowledgment
The release notes list new features, improvements and known issues of the current
software version, and describe the software installation.

The software uses several valuable open source software packages. An open source
acknowledgment document provides verbatim license texts of the used open source
software.

www.rohde-schwarz.com/firmware/smm100a

Application notes, application cards, white papers, etc.

These documents deal with special applications or background information on particu-
lar topics.
For some application sheets, see also:

www.rohde-schwarz.com/application/smm100a

Videos

Find various videos on Rohde & Schwarz products and test and measurement topics
on YouTube: https://www.youtube.com/@RohdeundSchwarz
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Notes on screenshots

O On the menu bar, search for your product to find related videos.

HOME VIDEOS SHORTS PLAYLISTS COMMUNITY CHANNELS ABOUT ':::'\ <product>

Figure 1-1: Product search on YouTube

1.5 Scope

Tasks (in manual or remote operation) that are also performed in the base unit in the
same way are not described here.

In particular, it includes:

® Managing settings and data lists, like saving and loading settings, creating and
accessing data lists, or accessing files in a particular directory.

® |nformation on regular trigger, marker and clock signals and filter settings, if appro-
priate.

® General instrument configuration, such as checking the system configuration, con-
figuring networks and remote operation

® Using the common status registers

For a description of such tasks, see the R&S SMM100A user manual.

1.6 Notes on screenshots

When describing the functions of the product, we use sample screenshots. These
screenshots are meant to illustrate as many as possible of the provided functions and
possible interdependencies between parameters. The shown values may not represent
realistic usage scenarios.

The screenshots usually show a fully equipped product, that is: with all options instal-
led. Thus, some functions shown in the screenshots may not be available in your par-
ticular product configuration.
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About Bluetooth LE

2 About the Bluetooth options

The R&S SMM100A provides you with the ability to generate signals in accordance
with the core specification 5.4 for Bluetooth wireless technology.

This section lists required options and provides background information on basic terms
and principles used in Bluetooth technology.

2.1 Required options

The basic equipment layout for generating Bluetooth signals includes the:

® Baseband Generator(R&S SMM-B9)

® Frequency option (e.g. R&S SMM-B1006)

® Baseband real-time extension (R&S SMM-K520)

® Option Bluetooth EDR (R&S SMM-K60)

® Option Bluetooth 5.x (R&S SMM-K117), requires R&S SMM-K60

® Option Bluetooth 5.4 + Channel Sounding (R&S SMM-K178), requires R&S SMM-
K117

You can generate signals via playback of waveform files at the signal generator. To cre-
ate the waveform file with R&S WinlQSIM2, you do not need a specific option.

To play back the waveform file at the signal generator, you have two options:

® |nstall the R&S WinIQSIM2 option of the digital standard, for example, R&S SMM-
K255 for playing LTE waveforms.

® |f supported, install the real-time option of the digital standard, for example,
R&S SMM-K55 for playing LTE waveforms.

For more information, refer to the specifications document.

2.2 About Bluetooth LE

The R&S SMM100A provides you with the ability to generate signals in accordance
with the Low Energy (LE) specification for Bluetooth wireless technology.

Bluetooth LE provides data transfer from low-power devices running on the smallest of
batteries to a larger device, for example, a PC or a mobile phone. Bluetooth LE estab-
lishes a connection, for example, to a wristwatch, a heart rate sensor, or a data transfer
from a digital camera. The generated packets do not support audio content.

A time division duplex (TDD) scheme for duplex transmission is defined. The frequency
band defined for Bluetooth devices is the unlicensed 2.4 GHz "Industrial, Scientific and
Medical" (ISM) frequency band.
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About Bluetooth LE

Table 2-1: Operating band

Frequency range RF channels k and center frequencies f

2400.0 MHz to 2483.5 MHz k=0to 39, f=k*2MHz + 2402 MHz

Table 2-2: Channel index

RF channel RF center frequency Data channel index Advertising channel index

0 2402 MHz - 37

1 to 11 2404 MHz to 2424 MHz 0to 10 -

12 2426 MHz - 38

1310 38 2428 MHz to 2478 MHz 11 to 36 -

39 2480 MHz - 39

e

2402 f [MHz] 2480

Figure 2-1: RF channels

red = primary advertising channels
blue = data channels and secondary advertising channels

The minimum output power is -20 dBm. The maximum output power for LE is 20 dBm.
For more information on the limits of the output power level, see [1].

The following sections provide a detailed overview on LE signal characteristics:

o Packet formats fOr LE.......cccuuiiiiiiiiiee ettt 14
®  Packet types fOr LE........uuiiiiiiiiieie et e e 16
e Advertising channel packet Structure............ccccceceiiiiin e 18
e Data channel packet StrUCIUrE.......ccccoo e i 20
o  Modulation SCREME........eeiiie e e 20
L J 1 =Tox 1 o] o T 1 T LT Vo USRS 21

2.2.1 Packet formats for LE

Packet formats for LE uncoded PHY

The following packet format defines the LE uncoded physical layers (PHYs) LE 1M and
LE 2M. Advertising channel packets and data channel packets use this format.

Preamble | Access Address | PDU | CRC

Figure 2-2: LE uncoded PHY packet format
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Each packet consists of four mandatory fields: Preamble, Access Address, Protocol
Data Unit (PDU) and Cyclic Redundancy Check (CRC). For Bluetooth direction finding,
the optional field Constant Tone Extension (CTE) is at the end of the packet. See also
Chapter 2.2.6, "Direction finding", on page 21.

Table 2-3: LE uncoded PHYs and field lengths

PHY Preamble | Access address PDU CRC CTE
LE 1M 1 octet 4 octets 2 octets to 257 octets 3 octets | 16 ys to 160 us
LE 2M 2 octets 4 octets 2 octets to 257 octets 3 octets | 16 ys to 160 us

When transmitting a packet, a Bluetooth receiver receives the preamble first and CTE
last. For packet transmission, the symbol rate stays the same but is different for differ-
ent PHYs. The table below provides an overview including the required option.

PHY Symbol rate Required options
LE 1M 1 Msymbol/s R&S SMM-K60
LE 2M 2 Msymbol/s R&S SMM-K117

The transmit time for an LE uncoded PHY packet is between 44 us and 2120 ys. The
period extends by an additional period of 16 ys to 160 ys, if CTE is active.

Packet formats for LE coded PHY

The following packet format defines the PHY LE Coded. Advertising channel packets
and data channel packets use this format.

+«—S =8 coding————»<+-S =2 or S = 8 coding—

Preamble | Access Address | CI TERM1 PDU | CRC | TERM2

«— FEC block 1 >

A

FEC block 2—

Figure 2-3: LE coded PHY packet format

Each packet consists of the Preamble, a Forward Error Correction (FEC) block 1, and
FEC block 2. The preamble is not coded. The FEC block 1 consists of three fields:
Access Address, Coding Indicator (Cl), and TERM1. These fields use the S=8 coding
scheme. The Cl field determines the coding scheme for the FEC block 2. The FEC
block 2 consists of three fields: PDU, CRC, and TERM2. These fields use either the
S=2 or S=8 coding scheme, depending on the value of the Cl field.

The entire packet is transmitted with 1 Msymbol/s modulation. The following table cap-
tures the size and duration of the data packet fields.
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About Bluetooth LE

Table 2-4: Packet format for LE coded PHY

Pream- | Access |CI TERM1 | PDU CRC | TERM2
ble address
Number of uncoded bits 80 32 2 3 16 - 2056 24 3
Duration in ps for S=8 coding | 80 256 16 24 128 - 16448 192 24
Duration in ps for S=2 coding | 80 256 16 |24 32-4112 48 6

Packets take between 462 ps and 17040 us to transmit.

2.2.2 Packet types for LE

Test packet types

The test packet PDU consists of a PDU header and the payload field. The PDU header
indicates the payload content type and the payload length expresses in octets. RFU
field means reserved for future use.

PDU
LSB MSB
Header Payload
2 octets 0-255 octets

PDU type | RFU | Length
4 bits 4 bits | 8 bits

LE test packets are described in the "Air Interface Packets" section of the core specifi-
cation for Bluetooth wireless technology, volume 6, part B.

Advertising channel packet types

The advertising channel PDU has a 16-bit header and a variable-size payload. The
header fields of the advertising channel PDU are as shown in "Header" on page 18.

Table 2-5: Advertising packets for R&S SMM-K60

ADV_IND SCAN_REQ
ADV_DIRECT_IND SCAN_RSP
ADV_NONCONN_IND CONNECT_IND

ADV_SCAN_IND

Table 2-6: Advertising packets for R&S SMM-K117

ADV_EXT_IND AUX_SCAN_REQ

AUX_ADV_IND AUX_SCAN_RSP
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AUX_CHAIN_IND AUX_CONNECT_REQ

AUX_SYNC_IND AUX_CONNECT_RSP

Data channel packet types

The data channel PDU has a 16-bit header, a variable size payload, and can include a
message integrity check (MIC) field as shown in "Header" on page 20.

The MIC field is not included in an unencrypted link layer (LL) connection, or in an
encrypted LL connection with a data channel PDU with a zero length payload. The MIC
field is included in an encrypted LL connection, with a data channel PDU with a non-
zero length payload. The MIC calculation is specified in the section 1 of the core speci-
fication for Bluetooth wireless technology, volume 6, part E.

Besides the data packet type, the instrument supports the following CONTROL_DATA

packet types.

Table 2-7: Control data packets for R&S SMM-K60

Opcode CONTROL_DATA Opcode CONTROL_DATA
0x00 LL_CONNECTION_UPDATE_IND 0x07 LL_UNKNOWN_RSP
0x01 LL_CHANNEL_MAP_IND 0x08 LL_FEATURE_REQ
0x02 LL_TERMINATE_IND 0x09 LL_FEATURE_RSP
0x03 LL_ENC_REQ 0x0A LL_PAUSE_ENC_REQ
0x04 LL_ENC_RSP 0x0B LL_PAUSE_ENC_RSP
0x05 LL_START_ENC_REQ 0x0C LL_VERSION_IND
0x06 LL_START_ENC_RSP 0x0D LL_REJECT_IND

Table 2-8: Control data packets for R&S SMM-K117

Opcode | CONTROL_DATA Opcode | CONTROL_DATA

OXOE LL_PERIPHERAL_FEAT REQ 0x14 LL_LENGTH_REQ

OXOF LL_CONNECTION_PARAM_REQ 0x15 LL_LENGTH__ RSP

0x10 LL_CONNECTION_PARAM_RSP 0x16 LL_PHY_REQ

ox11 LL_REJECT_EXT_IND 0x17 LL_PHY_ RSP

0x12 LL_PING_REQ 0x18 LL_PHY UPDATE_IND

0x13 LL_PING_RSP 0x19 LL_MIN_USED_CHANNELS_IND
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2.2.3 Advertising channel packet structure

About Bluetooth LE

Header
PDU
LSB MSB
Header Payload
2 octets 1-255 octets
PDU type | RFU | ChSel | TxAdd | RxAdd | Length
4 bits 1 bit| 1bit 1 bit 1 bit 8 bits

® The possible PDU types, indicated in the header of advertising channel PDU, are
listed in the previous tables, see Table 2-5.

Table 2-9: PDU types and PHYs

PDU type | PDU name Physical channel LE 1M LE 2M LE Coded
0000, ADV_IND Primary advertising Yes No No
0001, ADV_DIRECT_IND Primary advertising Yes No No
0010, ADV_NONCONN_IND Primary advertising Yes No No
0011, SCAN_REQ Primary advertising Yes No No
0011, AUX_SCAN_REQ Secondary advertising Yes Yes Yes
0100, SCAN_RSP Primary advertising Yes No No
0101, CONNECT_IND Primary advertising Yes No No
0101, AUX_CONNECT_REQ | Secondary advertising Yes Yes Yes
0110, ADV_SCAN_IND Primary advertising Yes No No
0111, ADV_EXT_IND Primary advertising Yes No Yes
0111, AUX_ADV_IND Secondary advertising Yes Yes Yes
0111, AUX_SCAN_RSP Secondary advertising Yes Yes Yes
0111, AUX_SYNC_IND Secondary advertising Yes Yes Yes
0111, AUX_CHAIN_IND Secondary advertising Yes Yes Yes
1000, AUX_CONNECT_RSP Secondary advertising Yes Yes Yes
Others Reserved for future use

® The ChSel, TxAdd and RxAdd fields contain information specific to the PDU type.
If the ChSel, TxAdd or RxAdd fields are not defined as used in a given PDU then
they are reserved for future use.

® The Length field indicates the payload field length in octets.
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The advertising channel PDU types consist of three groups.

Table 2-10: Advertising channel PDU types

PDU type

PDU name

Option

Advertising PDU (legacy)

ADV_IND, ADV_DIRECT_IND, ADV_NONCONN_IND,
ADV_SCAN_IND

R&S SMM-K60

Advertising PDU (extended)

ADV_EXT_IND, AUX_ADV_IND, AUX_SYNC_IND,
AUX_CHAIN_IND

R&S SMM-K117

Scanning PDU

SCAN_REQ, SCAN_RSP

R&S SMM-K60

Scanning PDU

AUX_SCAN_REQ, AUX_SCAN_RSP

R&S SMM-K117

Initiating PDUs

CONNECT_IND

R&S SMM-K60

Initiating PDUs

AUX_CONNECT_REQ, AUX_CONNECT_RSP

R&S SMM-K117

Table 2-11: Advertising channel PDU fields and subfields

PDU name Field and parameter Option
ADV_IND, ADV_NON- AdvA, AdvData R&S SMM-K60
CONN_IND,

ADV_SCAN_IND

ADV_DIRECT_IND AdVA, TargetA (formerly InitA) R&S SMM-K60

ADV_EXT_IND,
AUX_ADV_IND,

AUX_SYNC_IND,
AUX_CHAN_IND

Extended Header Length, AdvMode, Extended Header,
AdvData

Extended Header subfields: AdvA, TargetA, ADI,
AuxPtr, Syncinfo, Tx Power, ACAD, AdvData

R&S SMM-K117

SCAN_REQ

ScanA, AdvA

R&S SMM-K60

SCAN_RSP

AdvA, ScanRspData

R&S SMM-K60

AUX_SCAN_REQ

ScanA, AdvA

Extended Header Length, AdvMode, Extended Header,
AdvData

Extended Header subfields: see above

R&S SMM-K117

CONNECT_IND

InitA, AdvA, LLData

LLData subfields: AA, CRCinit, WinSize, WinOffset,
Interval, Latency, Timeout, ChM, Hop, and SCA fields

R&S SMM-K60

AUX_CONNECT_REQ

InitA, AdvA, LLData

LLData subfields: see above

R&S SMM-K117

AUX_CONNECT_RSP

Extended Header Length, AdvMode, Extended Header,
AdvData

Extended Header subfields: see above

R&S SMM-K117

For more information, refer to the section Advertising channel PDU in [1].
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2.2.4 Data channel packet structure

Header

PDU
LSB MSB

Header Payload MIC |
2 octets | 0-251 octets |4 octets |

LLID | NESN | SN | MD | RFU |Length
2bits| 1bit | 1bit]| 1bit]|3 bits| 8 bits

The 16-bit header field consists of five fields:

® The LLID field of the header specifies the payload format, see "Payload"
on page 20.

® The NESN bit indicates a nextExpectedSeqNum used by the peer to acknowledge
the last PDU sent, or to request resending.

® The SN bit indicates a transmitSeqNum to identify packets sent by the link layer.

® The MD bit indicates, whether the device has more data to send.

® The Length field indicates the length of the payload and MIC if included.

Payload

® AnLL data PDU is used to send L2CAP data. The LLID field is set to either 01b or
10b.
— Forthe LLID field set to 01b, the LL data PDU is a continuation fragment of an
L2CAP message, or an empty PDU.
The LL of the Central sends an empty PDU to the Peripheral to allow the
Peripheral to respond with any data channel PDU, including an empty PDU.
— Forthe LLID field set to 10b, the LL data PDU is a start of an L2ZCAP message
or a complete L2ZCAP message with no fragmentation.
® An LL control PDU is used to control the LL connection. The payload consists of
Opcode and CtrData fields. All LL control PDUs have a fixed length, depending on
the Opcode. The Opcode field identifies different types of LL Opcode PDU, see
Table 2-7.

For more information, refer to section Data channel PDU in [1].

2.2.5 Modulation scheme

The modulation is Gaussian frequency shift keying (GFSK) with a bandwidth bit period
product BT = 0.5. The modulation index is between 0.45 and 0.55. The mandatory
modulation scheme is 1 Msymbol/s modulation. It uses a shaped, binary FM to mini-
mize transceiver complexity.

User Manual 1179.2054.02 — 07 20



R&SPSMM-K60/-K117/-K178 About the Bluetooth options

2.2.6

About Bluetooth LE

Option R&S SMM-K60 supports LE uncoded 1 Msymbol/s (LE 1M) physical layer
(PHY).

Option R&S SMM-K117 supports LE Coded 1 Msymbol/s PHY and an optional modu-
lation scheme LE uncoded 2 Msymbol/s (LE 2M) PHY.

Direction finding

Since Bluetooth version 5.1, a Bluetooth LE device can transmit its direction informa-
tion to a Bluetooth receiver. The information is transmitted in the direction finding
enabled packets in the LE uncoded PHY. In combination with location information sent
on profile-level, the Bluetooth LE receiver can calculate its position.

Angle of Arrival (AoA) method

A Bluetooth LE transmitter sends direction finding enabled packets using a single
antenna. A receiving Bluetooth LE peer device consists of an antenna array linked to
an RF switch which forwards the combined antennae signal to a Bluetooth LE receiver.

The peer device switches its antennae while receiving parts of the packets and captur-
ing 1/Q samples. The I/Q samples are used to calculate the phase difference of the
radio signal received by different antennae of the array.

For an array of two antennae with distance d, frequency f of the radio signal and speed
of light c, the phase difference y calculates as follows:

U = 2ndcos(©) - !

&
The angle of arrival © is calculated as follows:
arccos(V - ¢)

© = 2nd - f
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LE Peer Device
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Figure 2-4: Angle of Arrival method

Angle of Departure (AoD) method

A Bluetooth LE transmitter sends direction finding enabled packets using an antenna
array. A receiving Bluetooth LE device, consisting of a single antenna, captures 1/Q
samples and the geometry of the antenna array from profile-level information.

For an array with two antennae with distance d, frequency f of the radio signal and
speed of light ¢, the phase difference y calculates as follows:

U = 27ndcos(O) - /
c

The angle of arrival © is calculated as follows:

arccos(V - ¢)

© = 2rd - f
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Figure 2-5: Angle of Departure method

The geometry of the antenna array is information that is shared between Bluetooth LE
transmitter and receiver on a profile-level. The antenna switching pattern and the
method of angle estimation is specified by Constant Tone Extension.

For more information, refer to the section Direction Finding Using Bluetooth Low
Energy in [1].

Constant tone extension

To transmit direction finding information in packets in the Bluetooth LE Uncoded PHYSs,
the link layer packet format is extended by an optional field Constant Tone Extension
(CTE) as illustrated in Figure 2-2. The field has a length between 16 us and 160 ys
and consists of a constantly modulated series of unwhitened 1s. This modulation
results in a CW tone shifted by 250 kHz (LE 1M) or 500 kHz (LE 2M) from the LE chan-
nel center frequency.

The presence, type and length of CTE is specified in the CTEInfo field available for
ADV_SYNC_IND and ADV_CHAIN_IND PDUs.

CTElInfo (8 bit)
CTETime RFU CTEType

Figure 2-6: CTEInfo field

The parts of the CTEInfo field are described in the table below. CTEType specifies if
the AoA or AoD method is used for direction finding.
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CTEInfo field Length Value Description
CTETime 5 bit 21020 CTE length = 8 ps * Value
Other values are reserved for future use.
RFU 1 bit 1to2 Reserved for future use
CTEType 2 bit 0 AoA Constant tone extension
1 AoD Constant tone extension with 1 ps slots
2 AoD Constant tone extension with 2 ps slots
3 Reserved for future use

If Bluetooth LE devices support AoA/AoD CTE, the antennae within the array follow a
switching pattern specified by the Host. After a guard and reference period, timeslots of
1 us or 2 us provide periods for antenna switching and 1/Q sampling.

The following figure illustrates the CTE structure for the AoA method. On the transmit-
ting side, there is no antenna switching. On the receiving side, antenna switching and
I/Q sampling alternate in the timeslots after the guard and reference period.

Constant Tone Extension: Total length = 160 ps, length units =8 ps
1 2 3 20

Aol transmit: No antenna switching

Continuous Transmissian

Aok receive: 1 ps switching and 1/Q sampling slots

Swiich Swich Swich  Switch Svitch  Swirch

¥

4 * + +

Guard P eriod
4 s

Reference Period
g us

*
Sanple Sanple Sample  Sanple

Sample  Sample
2 3 4 73 74

Aol receive: 2 ps switching and 1/Q sampling slots

Switch

Switch Switch

+ + 3
Guard P eriod Reference Period
4us Bus fa
¥ 7 f
Sanple Sanmple Sanple
1 2 7

Figure 2-7: CTE structure for AoA method

The following figure illustrates the CTE structure for the AoD method. On the transmit-
ting side, antenna switching and I/Q sampling alternate in the timeslots after the guard
and reference period. On the receiving side, I/Q sampling is only in every second time-
slot after the guard and reference period.
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Constant Tone Extension: Total length =160 ps, length units = 8 ps
1 p 3 20

AoD trans mit: 1 ps switching and 1/Q sampling slots

Swiich  Switch Swich  Svitch Switch  Switch
+ ¥ ¥ + +
Guard Period Reference Period
4 s & yus
f
Sample Sample Sanple Sanple Sample Sanple
§ 2 3 4 73 74

AoD receive: 1 ps 1/Q sampling slots

Guard Period Reference Period
4us Bus .
¥ F F 7 7
Sample Sample Sanple Sanpls Sample Sanple
i 2 3 4 73 74

AoD trans mit: 2 ps switching and sampling slots

Switch Switch Switch

¥ ¥ ¥
Guard Period Reference Period
4 s & yus
f ¥ f
Sanple Sanple Sanple
i 2 &7

AoD receive: 2 ps 1/Q sampling slots

Guard Period Reference Period
4us Bus .

Sanple Sanple Sanple
i 2 &7

Figure 2-8: CTE structure for AoD method

For more information, refer to section 2.5 Constant Tone Extension and IQ Sampling of
core specification for Bluetooth wireless technology, volume 6, part B.

About Bluetooth LE Channel Sounding

This section provides basic information on Bluetooth LE Channel Sounding technology.
For the detailed information, refer to the Bluetooth specifications [2] and [1].

Channel Sounding architecture

Devices can use the LE Channel Sounding (CS) physical link to exchange information
for distance estimation calculations. A CS procedure, including the first CS event within
that procedure, is started offset from the timing of ACL connection event anchor points.
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A CS procedure exists only for a limited duration, and consists of CS events, CS sube-
vents, and CS steps.

CS events may contain one or more subevents. CS subevents contain two or more CS
steps. CS steps contain bilateral exchanges between the two CS peers known as the
initiator and reflector. The CS initiator transmits first in each step, followed by one or
more transmissions from the CS reflector. These transmissions may be a packet-based
GFSK-modulated exchange or a tone-based, amplitude shift keying modulated
exchange, or both.

Channel Sounding RF channels

Table 2-12: Operating frequency band

Frequency range RF channels k and center frequencies f

2400.0 MHz to 2483.5 MHz k=0to 78, f=k* 1 MHz + 2402 MHz

Some channels are not allowed for CS communication. The table Table 2-13 provides
an overview on allowed channels and not allowed channels including the channel
index and the center frequency of the channel.

Table 2-13: CS channel index and allowed channels

Channel index RF center frequency Channel allowed
0and 1 2402 MHz and 2403 MHz No
2t0 22 2404 MHz to 2424 MHz Yes
23to 25 2425 MHz to 2427 MHz No
26 to 76 2428 MHz to 2478 MHz Yes
77 and 78 2479 MHz and 2480 MHz No

Fractional frequency offset actuation error (FAE)

The FAE feature allows a device to adapt its frequency hopping pattern to avoid inter-
ference from other wireless devices operating in the same frequency band.

The feature uses a list of channels in the FAE table, which is periodically updated
based on the results of Channel Sounding procedures. When a device detects interfer-
ence on a particular channel, it can switch to a different channel from the FAE table to
avoid the interference.

2.4 About Bluetooth BR/IEDR

The frequency band defined for Bluetooth devices is the unlicensed 2.4 GHz Industrial,
Scientific and Medical (ISM) frequency band.

Table 2-14: Operating band

Regulatory range RF channels k and center frequencies f

2400.0 MHz to 2483.5 MHz k=0to 78, f=k*1MHz + 2402 MHz
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Two modulation formats are used for Bluetooth: the mandatory basic rate (BR) and the
optional enhanced data rate (EDR). The BR mode uses binary FM modulation and pro-
vides a data rate of 1 Mbit/s. The EDR mode uses two types of PSK modulation, the
/4-DQPSK or 8DPSK, and achieves data rates of 2 Mbit/s and 3 Mbit/s, respectively.
All modulation schemes have the symbol rate equal to 1 Msymbol/s.

A time division duplex (TDD) scheme for duplex transmission is defined for both
modes.

The following sections describe signal characteristics in detail:

e Bluetooth packet types for BR/IEDR.........uoiiiiiiiiiiieeeeeeeeeee e 27
e Bluetooth transSport MOUES. ... .cccoe e e e 30
o Packet structure and fieldS..........uuvuviiiiiiiiiiieiee e 30
o Bluetooth modulation SChEMES.........ccuuiiiiiiiiic e 33

2.4.1 Bluetooth packet types for BR/IEDR

2411 ACL packets

The ACL packets are used for asymmetric links and they contain user data or control
data. The table and the figures below give an overview of the ACL packets and their
structure.

Table 2-15: ACL packet - basic rate

Type Payload User Payload | FEC CRC Slot number
Header (bytes) | (bytes)

DM1 1 0-17 2/3

DH1 0-27 no 1

DM3 0-121 2/3

DH3 2 0-183 no Yes, 16-bit 3

DM5 0-224 2/3

DH5 0-339 no 5

AUX1 1 0-29 no

Anrcess Header| Payload
Code

Figure 2-9: Packet structure of ACL packets - basic rate
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Table 2-16: ACL packets - enhanced rate

About Bluetooth BR/EDR

Figure 2-10: Packet structure of ACL packets - enhanced data rate

2.41.2

SCO and eSCO packets

Type Payload User Payload | FEC CRC Slot number
Header (bytes) | (bytes)

2-DH1 0-54 1

2-DH3 0-367 3

2-DH5 2 0-679 no Yes, 16-bit 5

3-DHA1 0-83 1

3-DH3 0-552 3

2-DH5 0-1021 5

frocess Header]Guard| Svmc |F asdoad |Traier

Code

The SCO and eSCO packets are used for symmetric links. The SCO packets are used
for 64 kb/s speech transmission and for transparent synchronous data. The eSCO

packets are also used for 64kb/s speech transmission and transparent data at 64 kb/s
but also at other rates.

The tables and the figures below give an overview of the SCO and eSCO packets and
their structure.

Table 2-17: SCO packets

Figure 2-11: Packet structure SCO packets

Apncess
Cade

Header

Vioce
Field

Figure 2-12: Packet structure SCO packets (data only)
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Type Payload User Payload | FEC CRC Slot number
Header (bytes) | (bytes)
HV1 10 1/3
HV2 n.a. 20 no
HV3 30 2/3 n.a.
DV 1 (data only) 10+(0-9) 2/3 (data only) | Yes, 16-bit
(data only)
Access
Header| Fayload
Code

28
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Table 2-18: eSCO packets - basic rate

Type Payload User Payload | FEC CRC Slot number
Header (bytes) | (bytes)

EV3 1-30 no 1

EV4 n.a. 1-120 2/3 Yes, 16-bit 3

EV5 1-180 no (Data only) 3

Apncess Header| Payload
Cade

Figure 2-13: Packet structure eSCO packets - basic rate

Table 2-19: eSCO packets - basic rate

Type Payload User Payload | FEC CRC Slot number
Header (bytes) | (bytes)

2-EV3 1-60 1

2-EV5 n.a. 1-360 no Yes, 3

3-EV3 1-90 16-bit 1

3-EV5 1-540 3

Access :

Code Header]Guard| Symc P asd oad |Trailer

Figure 2-14: Packet structure eSCO packets - enhanced data rate

2.41.3 Link control packets for ACL, SCO, eSCO transport modes

There are some common kinds of packet types. An overview of these packet types is
given in the table below.

Table 2-20: Common link control packets

Transport modes | Type Payload | FEC CRC Application
Header
(bytes)
SCO, eSCO, ACL |ID Paging, inquiry, response
SCO, eSCO, ACL | NULL n.a. n.a. n.a. Carries Link information to the source,

e.g. about successfully received signal
(ARQN) or the state of the receiving
buffer (FLOW)

SCO, eSCO, ACL | POLL Similar to NULL packet, used by the
Central to poll the Peripheral devices,
must be confirmed

SCO, ACL FHS 18 2/3 Yes Page Central response, inquiry
response, in roll switch
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Table 2-21: Common link control packets: packet structure

Packet Type ID Packet Types NULL and PULL Packet Types FHS
Arecesz Code Access Arccess
Payload
(DAK orAC) Code [ Code [cader] Farl

Bluetooth transport modes

There are three different transport modes defined in the Bluetooth core specification,
each of them with special applications:

® Synchronous connection-oriented (SCO)
The SCO transport mode is used for a symmetric point-to-point link establishment
between a Central and a specific Peripheral in the piconet.

® Extended synchronous connection-oriented (eSCO)
The eSCO transport mode is used for a symmetric or asymmetric, point-to-point
link establishment between the Central and a specific Peripheral.

® Asynchronous connection less (ACL)
The ACL transport mode is used for a point-to-multipoint link establishment
between the Central and all Peripheral participating on the piconet.

There are some common transmitted packets used by all transport modes and some
specific packets defined for each transport mode.

Packet structure and fields

Almost all Bluetooth transmitted packets have standard format and consist of the
access code, the header and the payload with useful information. The exceptions are
the ID packet which consists of the access code only and NULL and POLL packets
which carry only the access code and the header.

Access code

The access code is used for synchronization, DC offset compensation and identifica-
tion. The fields of the access code are shown in the figure below and their meaning is
explained in the table below.

L3E 4 64 4 MIZE
Preamble payhc weotd| Trailes
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Table 2-22: The access code fields

Field Description Packets

Preamble | A fixed zero-one pattern of 4 symbols, used to facili- | All packets
tate DC compensation

Sync word | A 64-bit code word derived from a 24-bit address, All packets
improves timing acquisition

Trailer A fixed zero-one pattern of four symbols, extended | All packets, except ID
DC compensation

2.4.3.2 Header

The header contains link control information. The fields of the header are shown in the
figure and their meaning is explained in the table below.

L3E 3 4 1 1 2 MER
LT _ADDE | TYPE ARQN|SECQH | HEC

Table 2-23: The header fields

Field Description Packets

LT _ADDR | Logical transport address, indicates the destination Peripheral for a packet in a
Central-to-Peripheral transmission slot and the source Peripheral for a Periph-
eral-to-Central transmission slot

TYPE Type code, specifies which packet type is used

FLOW Flow control, used for flow control of packets over the ACL logical transport. All packets,
When the RX buffer in the recipient is full, a STOP indication must be returned. | except ID
When the RX buffer can accept data, a "Go" indication must be returned.

ARQN Automatic repeat request number, acknowledgement indication, used to inform
the source of a successful transfer of payload data with CRC can be positive
acknowledged ACK or negative acknowledged NAK,

SEQN Sequential numbering scheme to order the data packet stream

HEC Header-error-check to check the header integrity

2.43.3 Payload format

The payload structure depends on the type of the data field and the data rate. Two
fields are defined in the payload: the synchronous data field and the asynchronous
data field. The ACL packets only have the asynchronous data field and the SCO and
eSCO packets only have the synchronous data field. The exception is DV of SCO
transport mode which has both data fields, synchronous and asynchronous.
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Synchronous data fields

Fosie vl vackels Enhaticed rate packets

S0 R Pleln

Asynchronous data fields

Ilulti-slot ACL packets Single-slot ACL packets

LLID Flu:rw. Feserved |Payload Data |[CRC LLID| Flowr -Paylnad Cata |CEC

Synchronous and asynchronous data fields

W oice Field (Data Field

S T

LL ID|Fla Payload Data [CEC

The meaning of some payload fields is given in the table below.

Table 2-24: The payload fields

Field Description

CRC The cyclic redundancy error check

Guard, sync | The guard time and synchronization sequence, used for physical layer change of modula-

tion scheme
LLID The logical link identifier, specifies the logical link
Flow Field which controls the flow on the logical channels

The payload format and content of the FHS packet are different from other packets.
The fields of the FHS packet are shown in the figure below and their meaning is
explained in the table below.

Parityh up |BIR |Undefined| SR |Reserved [UAP| 1740 |[©1258 F |LT_ADDR |og grg7.9 | FageSean oo
hits Dence Ivlode
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Table 2-25: The payload fields for the FHS packet

Field Description

Parity bits Form the first part of the sync word of the access code of the device that sends the FHS
packet

LAP Contains the lower address part of the device that sends the FHS packet

EIR An extended inquiry response, provides miscellaneous information during the inquiry

response procedure

Undefined Reserved for future use and must be set to zero

SR The scan repetition field, indicates the interval between two consecutive page scan win-
dows

Reserved Must be set to 10

UAP Contains the upper address part of the device that sends the FHS packet

NAP Contains the non-significant address part of the device that sends the FHS packet

Class of Contains the class of device of the device that sends the FHS packet. This field is defined

device in Bluetooth assigned numbers.

LT _ADDR Contains the logical transport address

CLK27-2 Contains the value of the native clock of the device that sends the FHS packet, sampled at
the beginning of the transmission of the access code of this FHS packet

Page scan Indicates which scan mode is used by default by the sender of the FHS packet

mode

2.4.4 Bluetooth modulation schemes

The modulation used for the basic data rate packets is GFSK (Gaussian Frequency
Shift Keying) with a bandwidth bit period product BT = 0.5. The modulation index is
between 0.28 and 0.35.

The modulation scheme used for enhanced data rate packets changes within the
packet. The access code and packet header have a GFSK modulation scheme and are
transmitted with the basic rate 1 Mbps. The subsequent synchronization sequence,
payload and trailer sequence have a PSK type of modulation and are transmitted with
a data rate of 2 Mbps or optionally 3 Mbps.

The PSK modulation, namely 11/4 rotated differential encoded quaternary phase shift
keying (11/4—DQPSK) is defined for the 2 Mbps transmission.

The PSK modulation, namely differential encoded 8-ary phase shift keying (8DPSK), is
defined for the 3 Mbps transmission.

The modulation types and corresponding packet types are given in the table below.
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Table 2-26: The modulation types and corresponding packet types

Modulation type Packet types

GFSK ID, NULL, POLL, FHS, DM1, DH1, DM3, DH3, DM5, DH5, AUX1, HV1, HV2, HVS,
DV, EV3, EV4, EV5

GFSK + m/4-DQPSK | 2-DH1, 2-DH3, 2-DH5, 2-EV3, 2-EV5

GFSK + 8DPSK 3-DH1, 3-DH3, 3-DH5, 3-EV3, 3-EV5
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3 Bluetooth general settings

Access:

» Select "Baseband" > "Bluetooth".

Bluetooth —_ X

Trigger In Clock
n Seneral Sremne

Set To i Generate
j c Default @Recall Save 9 Waveform ...

[

5.3

Bluetooth Version

Bluetooth Mode
Bluetooth Low Energy

Dirty Transmitter Test ...

@Filter/clipping
Gauss(FSK) / Clip Off

epower Ramping ...

The tab provides general settings to call default settings and the "Save"/"Recall"
settings. Also, it provides Bluetooth version information, Bluetooth mode settings
and access to further settings.

Settings:

) = (= PSSR 35
ST A Lo T B LY =TV SO 35
SAVE/RECAIL......eeeeeeteeeee e e e e e e e e et e e ———— 36
(1 LT =) (SR AT L= V=) (o] o o RN 36
2] (UL (oY o] V£ 1 (o] o R 37
(2] [UT= (oo ] {1/ (o Lo [ 37
TranNSPOIT IMOGE. ... .ttt e e e e e e s e e s e e e e e e e e e e e e e aannenee 37
Dirty TransSmitter TESt... .. i e e e e e e e e e e e e e e e e e e e eeeeerane 37
1LY (@4 7o) o 1T R 37
POWETr RAMPING.....cci oo rr e e e e e e e e e e e e e e e e e e e eeee et a b seseeeeeeeaaaaaaaaseenenns 38
State

Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:STATe on page 165

Set To Default

Calls the default settings. The values of the main parameters are listed in the following
table.
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Parameter

Value

State

Not affected by "Set To default"

Bluetooth version

R&S SMM-K60: 4.2
R&S SMM-K117: 5.4
R&S SMM-K178: 5.4 + Channel Sounding

Bluetooth mode

Basic Rate + EDR

Transport mode

ACL(Asynchronous)+EDR

Packet type

DH1

Sequence length

1 Frame

Slot timing Tx Test Mode
Data whitening Off

Dirty transmitter test Off

Filter Gauss(FSK)
Clipping state Off

Power ramping function Cosine
Trigger mode Auto

Marker mode Restart
Clock source Internal

Remote command:
[ :SOURce<hw>] :BB:BTOoth:PRESet on page 163

Save/Recall

Accesses the "Save/Recall" dialog, that is the standard instrument function for saving
and recalling the complete dialog-related settings in a file. The provided navigation
possibilities in the dialog are self-explanatory.

The settings are saved in a file with predefined extension. You can define the filename
and the directory, in that you want to save the file.

See also, chapter "File and Data Management" in the R&S SMM100A user manual.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:SETTing:CATalog on page 164
[ :SOURce<hw>] :BB:BTOoth:SETTing:LOAD on page 164

[ :SOURce<hw>] :BB:BTOoth:SETTing:STORe on page 164

[ :SOURce<hw>] :BB:BTOoth:SETTing:DELete on page 164

Generate Waveform

With enabled signal generation, triggers the instrument to save the current settings of
an arbitrary waveform signal in a waveform file with predefined extension * . wv. You
can define the filename and the directory, in that you want to save the file.

Using the ARB modulation source, you can play back waveform files and/or process
the file to generate multi-carrier or multi-segment signals.
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Remote command:
[ :SOURce<hw>] :BB:BTOoth:WAVeform: CREate on page 166

Bluetooth Version
Displays the version of the standard that the firmware supports.

The displayed version for Bluetooth wireless technology depends on installed options.
For example, "Bluetooth Version" > "5.4" requires R&S SMM-K117.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:VERSion? on page 165

Bluetooth Mode
Selects the Bluetooth mode.

"Basic Rate + EDR"
Selects basic rate (BR) or enhanced data rate (EDR) Bluetooth
mode. For related settings, see Chapter 6, "Bluetooth BR/EDR con-
figuration and settings", on page 133.

"Bluetooth Low Energy"
Selects low energy (LE) Bluetooth mode. For related settings, see
Chapter 5, "Bluetooth LE configuration and settings", on page 44.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:BMODe on page 163

Transport Mode
Requires "Bluetooth Mode" > "Basic Rate + EDR".

Selects the transport mode.

"ACL(Asynchronous)+EDR"
The transport mode selected is used for a point-to-multipoint link
establishment between the Central and all the Peripheral devices par-
ticipating on the piconet.

"SCO(Synchronous)"
The transport mode selected is used for a point-to-point link estab-
lishment between a Central and a single Peripheral in the piconet.

"eSCO(Extended SCO)+EDR"
The transport mode selected is used for a symmetric or asymmetric
point-to-point link establishment between a Central and a specific
Peripheral.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:TMODe on page 165

Dirty Transmitter Test
Opens a dialog to configure dirty transmitter tests.

See Chapter 4, "Dirty transmitter test settings", on page 39.

Filter/Clipping
Opens a dialog to configure the baseband filtering, the modulation settings and clip-

ping.
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The button also displays configured filters and the clipping state.
See Chapter 7.1, "Filter/clipping settings”, on page 143.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:FILTer:FILTers? on page 282
[ :SOURce<hw>] :BB:BTOoth:CLIPping:STATe on page 282

Power Ramping
Opens a dialog to configure the power ramping.

See Chapter 7.2, "Power ramping settings", on page 149.
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4 Dirty transmitter test settings

Access:
1. Select "Bluetooth" > "General".

2. Select "Dirty Transmitter Test".

Bluetooth: Dirty Transmitter Test —_ X
oSet To Default
Dirty Transmitter Test Frequency Drift Rate
1.600 kHz
Start Phase Frequency Drift Deviation(+/-)
0 degrees 25 kHz

Dirty Transmitter Setting

The dialog provides settings to configure dirty transmitter test settings. These set-
tings contain parameters that you can change for the central device signal. It is
used to test the connection under 'dirty transmitter' conditions, and to define the
influence on the receiver quality (bit error rate tests).

The following tables list dirty transmitter parameters according to the Bluetooth test
specification. .. is the frequency offset, Aty is the symbol timing error and h is the
modulation index.

Table 4-1: Dirty transmitter test parameters for BR

Set fottset Aterror/ppm h

1 75 -20 0.28
2 14 -20 0.30
3 -2 20 0.29
4 1 20 0.32
5 39 20 0.33
6 0 -20 0.34
7 -42 -20 0.29
8 74 -20 0.31
9 -19 -20 0.28
10 -75 20 0.35
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Table 4-2: Dirty transmitter test parameters for EDR

Dirty transmitter test settings

Set foffset Ate rrorl ppm
1 0 0
2 65 20
3 -65 -20
Table 4-3: Dirty transmitter test parameters for LE
Set foffset Aterrorl ppm hstandard hstable *)
1 100 -50 0.45 0.495
2 19 -50 0.48 0.498
3 -3 50 0.46 0.496
4 1 50 0.52 0.502
5 52 50 0.53 0.503
6 0 -50 0.54 0.504
7 -56 -50 0.47 0.497
8 97 -50 0.50 0.500
9 25 -50 0.45 0.495
10 -100 50 0.55 0.505
*) Ngtaple requires R&S SMM-K117.
Settings:
S T= A o T DY £ T | S 40
Dirty TransSmitter TESt... .. i e e e e e e e e e e e e e e e e eeeeeeeraee 41
] c= T O e 0 F= 1T PPN 41
Modulation INAEX MOAE............ooiiiieeeee et e 41
Frequency Drift Rate...... .o 41
Frequency Drift Deviation(4/-).....oiiiieiiiiieee et 41
Number Of Packets Per Set/Number Of Steps Per Set.......cccceveiiiiiicccciiiiieeeeiee e 42
Dirty Transmitter SEtiNg........uuviiiiiiiiie e 42
L STttt 42
L Carrier Frequency OffSet (KHZ)........c.oueoeeeeeeeeeeeeeeeee e eesee e 42
L Symbol Timing Error (DPM)......cveeeereceeeeueeeeeeeeeeeseeeeesesesssassesesesesesesesesenenenanas 43
L MOQUIGLION INAEX.......eececvrereceeveeeeeceeeeeseeaee e seeseeae s s enas st enasaesenans 43

Set To Default

Calls the default settings for the dirty transmitter test. Default settings are according to
the specification for Bluetooth wireless technology. The setting corresponds to the
selected Bluetooth mode.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:DTTest:STDefault on page 169
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Dirty Transmitter Test
Enables the dirty transmitter test.

The setting is available for the following packet types:

e BR: DH1, DH3, DH5
For basic rate packets, each enabled set of parameters in the "Dirty Transmitter
Setting" is used for a duration of 20 ms. After 20 ms, the following enabled set is
used, continuing with the first enabled set after the sequence is completed.

e EDR: 2-DH1, 2-DH3, 2-DH5, 3-DH1, 3-DH3, 3-DH5, 2-EV3, 2-EV5, 3-EV3, 3-EV5
For EDR packets, the parameter sets apply for 20 packets each.

® LE: See the tables Table 5-1 and Table 5-2.
For LE packets, each enabled set of parameters in the "Dirty Transmitter Setting" is
used. After transmitting a configured number of packets or steps, the enabled set is
used. After the sequence is completed, the transmission continues with the first
enabled set.
You can set up to 50 packets or steps, see "Number Of Packets Per Set/Number
Of Steps Per Set" on page 42.

For more information, refer to the Bluetooth Core Specification [1].

Remote command:
[ :SOURce<hw>] :BB:BTOoth:DTTest:DTTState on page 167

Start Phase
Enters a start phase.

The start phase of the sine wave used to drift the modulated Bluetooth signal around
center frequency + carrier frequency offset is set here.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:DTTest : SPHase on page 169

Modulation Index Mode
Requires option R&S SMM-K117 and "Bluetooth Mode" > "Bluetooth Low Energy".

Specifies the mode of the modulation index h that is standard or stable.
"Standard" Standard modulation index hg,ngarg With @ range from 0.450 to 0.550.
"Stable" Stable modulation index hg,p,e With a range from 0.495 to 0.505.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:DTTest :MIMode on page 168

Frequency Drift Rate
Sets the frequency drift rate.

A sine wave is used to drift the modulated Bluetooth signal around center frequency +
carrier frequency offset with the set frequency drift rate.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:DTTest :FDRate on page 168

Frequency Drift Deviation(+/-)
Sets the frequency drift deviation.

User Manual 1179.2054.02 — 07 41



R&S®SMM-K60/-K117/-K178 Dirty transmitter test settings

A sine wave is used to drift the modulated Bluetooth signal around center frequency +
carrier frequency offset. The maximum deviation reached during the drift equals the set
frequency drift deviation.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:DTTest:FDDeviation on page 167

Number Of Packets Per Set/Number Of Steps Per Set
Setting the parameter requires "Bluetooth Mode" > "Bluetooth Low Energy" and one of
the following:

"Number Of Packets Per Set"
Requires "Channel Type" > "Advertising" or "Data".
Sets the number of transmitted packets per enabled dirty transmitter
set.

"Number Of Steps Per Set"
Requires "Channel Type" > "Advertising" or "Data".

Remote command:
[ :SOURce<hw>] :BB:BTOoth:DTTest :NPPSet on page 168

Dirty Transmitter Setting
Indicates the dirty transmitter parameters according to the Bluetooth test specification.

State — Dirty Transmitter Setting
Enables the corresponding parameter set.

If deactivated, the parameters are skipped in the sequence, and the next active set is
used.

Remote commands . .. :LONG:SET<ch>: ... are used for BR and LE packets. The
instrument provides a configuration of up to 10 sets (SET1 to SET10).

Remote commands . .. :SHORt:SET<ch>: ... are used for EDR packets. The
instrument provides a configuration of up to 3 sets (SET1 to SET3).

For basic rate packets, each enabled set applies to 20ms of signal. For EDR packets,
each enabled set applies to 20 packets.

For LE, each enabled set applies to 50 test packets.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:DTTest:TABLe: LONG: SET<ch>:STATe
on page 171

[ :SOURce<hw>] :BB:BTOoth:DTTest : TABLe : SHORt : SET<ch>:STATe
on page 172

Carrier Frequency Offset (kHz) — Dirty Transmitter Setting

Determines a carrier frequency offset.

The center frequency of the modulated RF carrier is offset by the specified value.
Remote command:

[ :SOURce<hw>] :BB:BTOoth:DTTest:TABLe:LONG: SET<ch>:CFOFfset
on page 170

[ :SOURce<hw>] :BB:BTOoth:DTTest : TABLe : SHORt : SET<ch>:CFOFfset
on page 172
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Symbol Timing Error (ppm) — Dirty Transmitter Setting
Sets the symbol timing error in ppm.

The symbol timing error modifies the symbol clock frequency by the specified value.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:DTTest : TABLe : LONG: SET<ch>:STERror
on page 171

[ :SOURce<hw>] :BB:BTOoth:DTTest:TABLe: SHORt : SET<ch>:STERror
on page 173

Modulation Index < Dirty Transmitter Setting
Sets the modulation index.

The modulation index h specifies the frequency deviation, defined as:
2y

fs}méﬂi

b=

7= is the symbol rate and # is the frequency deviation.
The modulation index can vary between 0.28 and 0.35.
For more information, refer to the Bluetooth Core Specification [1].

Remote command:
[ :SOURce<hw>] :BB:BTOoth:DTTest :TABLe : LONG: SET<ch>:MINDex
on page 170

Dirty transmitter test settings
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Channel settings

5 Bluetooth LE configuration and settings

Access:
1. Select "Baseband" > "Bluetooth".

2. Select "Bluetooth Mode" > "Bluetooth Low Energy".

The remote commands required to define these settings are described in Chapter 8,
"Remote control commands", on page 160.

Settings:

®  Channel SEHINGS. .. ..ot aa e e e 44
e Advertising event and frame configuration.............cccccveiie i, 51
e Advertising and data packet configuration.........ccccoooeeeiiiiiiiin 58
o CS subevent configuration............oooi i 91
e CS control data payload SettingS......cccuueiiiiiiiiiee e 112
o Test packet CONfIGUrAtioN..........ueiiiiiiiiiiei e 129

5.1 Channel settings

Access:
1. Select "Bluetooth" > "General".
2. Select "Bluetooth Mode" > "Bluetooth Low Energy".

3. Select "Channel".

Bluetooth — | X
Auto Internal
Channel Type Sequence Length
Advertising 1 Events
Packet Type Duty Cycle
ADV_DIRECT_IND High
Packet Format
~ Corrupted CRC Every 2nd Packet D
LE 1M
Bluetooth Controller Role
Advertiser
Event Configuration ...
Whitening On
ADV ADV ADV ADV
DIRECT DIRECT DIRECT DIRECT
IND IND IND IND
<=3.75ms
Adv_idx=37 Adv_idx=38 Adv_idx=39 Adv_idx=37
TEvent TEvent TEvent T
started closed started
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Channel settings

The tab provides settings to configure channel settings and general packet set-
tings.

To display Bluetooth LE event or frame sequences

Depending on the channel type packet type and packet format, the "Channel" tab dis-
plays a chart at the bottom that illustrates sequences of the corresponding events or
frames. The following steps provide examples to illustrate default sequences for differ-
ent channel types.

1. To display the sequence for an advertising channel, select the following:

a) Select "Channel Type" > "Advertising".
b) Select, for example, "Packet Type" > "ADV_DIRECT_IND".

The chart displays one sequence of ADV_DIRECT_IND packets including markers
for event start and event stop.

ADV ADV ADV ADV
DIRECT DIRECT DIRECT DIRECT
IND IND IND IND
<=3.75ms
Adv_idx=37 Adv_idx=38 Adv_idx=39 Adv_idx=37
TEvem TEvem TEvent T
started closed started

2. To display the sequence for a data channel, select the following:

a) Select "Channel Type" > "Data".
b) Select, for example, "Packet Type" > "DATA".

The chart displays one sequence of data PDUs including markers for event start
and event stop.

M->8 S=>M

T_IFS

T Connection Event T
Event Event

started closed

3. To display the sequence for a Channel Sounding channel, select the following:

a) Select "Channel Type" > "Channel Sounding".
b) Select, for example, "Packet Type" > "CS SEQUENCE".

The chart displays one sequence of CS events including event offset, CS sube-
vents and subevent lengths.

Subevent Length
©(iz50ps)

Event Offset
s —

CS SubEvent 0

< CS Event >
Connection Anchor Point
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Channel settings

Settings:

(07 g = 1oL T I Y/ o1 T SRR 46
e Tt = A Y] 1= TSR 46
Packet FOMMAL...... ..o e 48
D10V O Yo = T 48
SEQUENCE LENGIN . ettt e e e e ————— 48
Bluetooth Controller ROIE....... ..o 48
Bluetooth Controller State.........cuuvii i 49
Corrupted CRC Every 2nd PacKet..........couiiiiiiiiiiiei e 49
)Y (o = o I Y] o = TSR 49
[N =1 (o] o FO PP PPPRPPTTT 49
Modulation FOrMAL........ooiii e e 49
Event Configuration/Frame Configuration............cc.eeeeiiiiiiiiniiie e 50
CS Subevent Configuration..........ccuu i 50
Test Packet Configuration...........ooecoi i 50
Event IntervalS/Event INterval............oceeiiiiiiiii it 50
(070 ] o a =T i o] T 101 (=1 V= | SRR 50
EVENT OFffSEL... et e e 50
o ][ TS URPTUT PSP 50

Channel Type
Determines the channel type.

"Advertising" Selects channel type advertising.

"Data" Selects the data channel type.
Devices in a connected state transmit the data channel packets in
connection events with a start point and an interval.

"Channel Sounding"
Requires R&S SMM-K178.
Selects channel type Channel Sounding.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CTYPe On page 175

Packet Type
Selects the packet type that is the PDU type.

Available packet types depend on the channel type and installed options, see the fol-
lowing tables:

® For non-control data PDUs, see Table 5-1.

® For LE CONTROL_DATA PDUs, see Table 5-2.

® For LE Channel Sounding CS_CONTROL_DATA PDUs, see Table 5-3.

Table 5-1: Channel types and packet/PDU types

Channel type Packet/PDU type Option

Advertising ADV_IND, ADV_DIRECT_IND, ADV_NONCONN_IND, R&S SMM-K60
ADV_SCAN_IND, SCAN_REQ, SCAN_RSP, CON-
NECT_IND

Advertising ADV_EXT_IND *), AUX_ADV_IND, AUX_CHAIN_IND, R&S SMM-K117
AUX_SYNC_IND, AUX_SCAN_REQ, AUX_SCAN_RSP,
AUX_CONNECT_REQ, AUX_CONNECT_RSP
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Channel type Packet/PDU type Option
Advertising TEST PACKET R&S SMM-K60
Advertising CONTINUOUS R&S SMM-K60
Data DATA R&S SMM-K60
Data CONTROL_DATA, see Table 5-2. See Table 5-2.
Data TEST PACKET R&S SMM-K60
Data CONTINUOUS R&S SMM-K60
Channel Sounding TEST PACKET R&S SMM-K178
Channel Sounding CS SEQUENCE R&S SMM-K178
Channel Sounding CS_CONTROL_DATA, see Table 5-3. R&S SMM-K178

*) PDU type ADV_EXT_IND is available for LE 1M PHY and LE coded PHY.

CONTROL_DATA packets/PDUs depend on the controller role and installed options.
Table 5-2: CONTROL_DATA PDU and controller role

CONTROL_DATA PDU Controller role Option

LL_CONNECTION_UPDATE_IND, LL_CHAN- Central R&S SMM-K60
NEL_MAP_IND, LL_ENC_REQ, LL_FEATURE_REQ,
LL_PAUSE_ENC_REQ

LL_ENC_RSP, LL_UNKNOWN_RSP, LL_FEATURE_RSP, | Peripheral R&S SMM-K60
LL_PAUSE_ENC_RSP

LL_TERMINATE_IND, LL_START_ENC_REQ, Central or Peripheral | R&S SMM-K60
LL_START_ENC_RSP, LL_VERSION_IND,
LL_REJECT_IND

LL_PHY UPDATE_IND Central R&S SMM-K117
LL_PERIPHERAL_FEAT_REQ, LL_CONNEC- Peripheral R&S SMM-K117
TION_PARAM_RSP, LL_PHY_RSP, LL_MIN_USED_CHAN-

NELS_IND

LL_CONNECTION_PARAM_REQ, LL_REJECT_EXT_IND, | Central or Peripheral | R&S SMM-K117
LL_PING_REQ, LL_PING_RSP, LL_LENGTH_REQ,
LL_LENGTH__RSP, LL_PHY_REQ, LL_CTE_REQ,
LL_CTE_RSP, LL_PERIODIC_SYNC_IND,
LL_CLOCK_ACCURACY_REQ, LL_CLOCK_ACCU-
RACY_RSP

CS_CONTROL_DATA packets/PDUs are available for initiator and reflector Channel
Sounding devices.

Table 5-3: CS_CONTROL_DATA PDU

CS_CONTROL_DATA PDU Option

LL_CS_SEC_REQ, LL_CS_SEC_RSP, LL_CS_CAPABILITIES_REQ, R&S SMM-K178
LL_CS_CAPABILITIES_RSP, LL_CS_CONFIG_REQ, LL_CS_CONFIG_RSP,
LL_CS_REQ, LL_CS RSP, LL_CS_IND, LL_CS_TERMINATE_IND,
LL_CS_FAE_REQ, LL_CS_FAE_RSP, LL_CS_CHANNEL_MAP_IND
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How to: "To display Bluetooth LE event or frame sequences" on page 45
For more information, refer to the specifications document.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:UPTYpe on page 176

Packet Format
Selects the packet format that is the format according to the physical layer (PHY) that
supports the packet type or PDU type.

"LE 1M" LE uncoded PHY with 1 Msymbol/s modulation.
"LE 2M" Requires R&S SMM-K117.

LE uncoded PHY with 2 Msymbol/s modulation and bandwidth time
product BT = 0.5.

"LE Coded" Requires R&S SMM-K117.
LE coded PHY with 1 Msymbol/s modulation.

"LE 2M 2BT" Requires R&S SMM-K178.
LE uncoded PHY with 2 Msymbol/s modulation and bandwidth time
product BT = 2. The BT value in the GFSK filter settings is fixed to a
value "B*T" = "2.00".
See also "B*T" on page 144.

See also Table 2-9.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:PFORmat on page 175

Duty Cycle
Requires R&S SMM-K117 and "Packet Type" > "ADV_DIRECT_IND".

Specifies the duty cycle for directed advertising.

"High" Transmits the "ADV_DIRECT _IND" packet expecting an advertising
event interval.

"Low" Transmits the "ADV_DIRECT _IND" packet expecting an advertising
event interval and advertising event delay.

See also "Advertising Event Interval” on page 52.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:DCYCle on page 175

Sequence Length
Selects the number of frames or events depending on the packet type. The signal
repeats after this number.

The packet types SCAN_REQ, CONNECT _IND, AUX _SCAN_REQ and AUX_CON-
NECT_REQ define the sequence length in frames. All other packets use events.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:USLength on page 178

Bluetooth Controller Role
Requires "Channel Type" > "Advertising"/"Data".

Sets or displays the Bluetooth LE controller role depending on the channel type.

User Manual 1179.2054.02 — 07 48



R&S®SMM-K60/-K117/-K178 Bluetooth LE configuration and settings

Channel settings

Bluetooth controller Channel type PDU type
role

Advertiser (read-only) Advertising ADV_IND, ADV_DIRECT_IND, ADV_NON-
CONN_IND, ADV_SCAN_IND, SCAN_RSP,
ADV_EXT_IND, AUX_ADV_IND, AUX_CHAIN_IND,
AUX_SYNC_IND, AUX_SCAN_RSP, AUX_CON-
NECT_RSP, TEST PACKET

Scanner (read-only) Advertising SCAN_REQ, AUX_SCAN_REQ
Initiator (read-only) Advertising CONNECT_IND, AUX_CONNECT_IND
Central Data DATA, CONTROL_DATA

Peripheral Data DATA, CONTOL_DATA

See also "Payload" on page 19 and Table 5-2.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:BCRole on page 174

Bluetooth Controller State
Requires "Packet Type" > "Data"/"CONTROL_DATA".

Displays the state of the Bluetooth controller.
"Connected" The controller is connected and uses a data channel.
"Disconnected" The controller is disconnected.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:BCText? on page 162

Corrupted CRC Every 2nd Packet

If enabled, sets the ratio of packets with CRC faults to 50%. 50% of packets are gener-
ated with correct CRC. This setting is appropriate for packet error rate (PER) report
integrity tests.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CCRC:STATe on page 174

Payload Type
Requires "Packet Type" > "CONTINUOUS".

Sets the pattern for continuous packets. The transmitted packets do not contain packet
header information.

For supported payload types, refer to "Payload Type" on page 131.

Duration
Requires "Packet Type" > "CONTINUOUS".

Sets the duration of the continuous packet transmission.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:DURation on page 179

Modulation Format
Requires "Packet Type" > "CONTINUOUS".
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Channel settings

Specifies the physical layer.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:MFORmat on page 178

Event Configuration/Frame Configuration

Opens the "Event Configuration” dialog, if the sequence length of the packet type is
expressed in events or opens the "Frame Configuration" dialog, if it is expressed in
frames, see Chapter 5.2, "Advertising event and frame configuration”, on page 51.

Also, the button displays the data whitening state, see "Data Whitening" on page 59.

CS Subevent Configuration
Requires "Channel Type" > "Channel Sounding".

Opens the "CS Subevent Configuration" dialog, see Chapter 5.4, "CS subevent config-
uration", on page 91.

Test Packet Configuration
Requires "Packet Type" > "TEST PACKET".

Opens the "Test Packet Configuration" dialog, see Chapter 5.6, "Test packet configura-
tion", on page 129.

For Channel Sounding test packet settings, see "User Payload Pattern” on page 104
and "Select Data List" on page 104 for mode-1 subevents or mode-3 subevents. All
other settings are the same as for a CS subevent, see Chapter 5.4, "CS subevent con-
figuration", on page 91.

Event Intervals/Event_Interval
Requires R&S SMM-K178 and "Channel Type" > "Channel Sounding".

Sets the number of LE connection event intervals.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:EINTerval on page 190

Connection Interval
Requires R&S SMM-K178 and "Channel Type" > "Channel Sounding".

Sets the time of the LE connection interval. The anchor points of two consecutive CS
events define the length of this interval.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CINTerval on page 190

Event Offset
Requires R&S SMM-K178 and "Channel Type" > "Channel Sounding".

Sets the time between the anchor point of the LE connection event and the beginning
of the CS event.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:EOFFset on page 191

Role
Requires R&S SMM-K178 and "Channel Type" > "Channel Sounding".
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5.2

5.2.1

Advertising event and frame configuration

Sets the role of the Channel Sounding device.
"Initiator" Channel Sounding device initiates a CS procedure.
"Reflector” Channel Sounding device responds to a CS procedure.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:ROLE on page 191

Advertising event and frame configuration

Access:
1. Select "Bluetooth" > "General".
2. Select "Bluetooth Mode" > "Bluetooth Low Energy".

3. Inthe "Channel" tab, select "Event Configuration" for event-type packets or "Frame
Configuration" for frame-type packets.

The "Event Configuration" or "Frame Configuration" dialog provides settings to con-
figure advertising channel events or frames or data channel events. Also it pro-
vides access to the packet configuration.

At the bottom of the dialog, the graphics show the distribution of the packets, the
physical channel mapping and the channel indices. The channel table gives an
overview of the used channels and their assignments.

Settings:

o Advertising event and frame SettingS.........oouuiiiiiiiiiiii e 51
®  CoNNECtioN SEHINGS.....cii i ——————— 54
o Channel table SettiNgS......ccooo i i ———— 56

Advertising event and frame settings

Access:

1. Select "Channel" > "Channel Type" > "Advertising".
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Advertising event and frame configuration

2. Select "Event Configuration" for event-type packets or "Frame Configuration" for
frame-type packets.

Bluetooth: Event Configuration —_— X

AdvertiSing Smmgs channel Table

Advertising Event Interval Advertising Event Delay
20.0 ms 0.0 ms

Packet Configuration ...

Center frequency(MHz)
2402 2404 2424 2426 2428 2478 2480
AoV / pate v ADv v et \ ADV
37 0 10 38 11 36 39

Channel Index

Figure 5-1: Event configuration for an advertising channel (advertiser)

Bluetooth: Frame Configuration

Adverhsmg Smmgs Shemnetshie _
Scan Window Scan Interval
10.000 ms 10.000 ms
Packet Configuration ...
Center frequency(MHz)

2402 2404 2424 2426 2428 2478 2480
SADV /SAWV a0 VSAW\ SADV
37 0 10 38 11 36 39
Channel Index

Figure 5-2: Frame configuration for an advertising channel (scanner)

The "Advertising Settings" tab provides general settings to configure advertising
channel events or frames or data channel frames. Also it provides access to the
packet configuration.

Settings:

Advertising Event INterval..............oeeiiiiiiii e 52
Advertising EVENt Delay..........oooo i 53
Periodic Advertising INterval...........ooooi i 53
I Tez= 0 IRV [ 1 USRI 53
R Toz= 10 I ] (== SR 53
Advertising Packet INterval..........oouuoiiiiii e 53
Transmit WINAOW OffSEL......cciiiiceiiiiiieic et e e e e 54
TranSMIt WINAOW SiZE......oiuiiiiiiiiieee ettt 54
Packet Configuration...........cci oo e e e e e e s e e e e e 54

Advertising Event Interval
Requires a legacy or an extended advertising PDU, see Table 2-10.
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Advertising event and frame configuration

Sets the time interval between two consecutive advertising events, regarding the start-
ing points.

Remote command:

For packet type ADV_DIRECT_IND and duty cycle high:

[ : SOURce<hw>] :BB:BTOoth:ECONfiguration:ADINterval on page 182

For all others:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:AEINterval on page 182

Advertising Event Delay
Requires a legacy or an extended advertising PDU, see Table 2-10.

Sets a time delay between the start times of two consecutive advertising events. The
advertising event interval extends by this value.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:ECONfiguration:AEDelay on page 181

Periodic Advertising Interval
Requires option R&S SMM-K117 and packet type AUX_SYNC_IND.

Sets the time interval between the start of two PDUs from the same advertising set.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:PAINterval
on page 186

Scan Window
Requires a scanning PDU with packet type SCAN_REQ or AUX_SCAN_REQ. The
PDU AUX_SCAN_REQ also requires option R&S SMM-K117.

Sets the length of the window during which the scanner is operating in the advertising
channel.

Note that the scan window is less or equal to the value of the scan interval.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:SWINdow on page 188

Scan Interval
Requires a scanning PDU with packet type SCAN_REQ or AUX_SCAN_REQ. The
PDU AUX_SCAN_REQ also requires option R&S SMM-K117.

Sets the time interval between the starting points of two consecutive windows during
which the scanner is operating in an advertising channel.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:ECONfiguration:SINTerval on page 187

Advertising Packet Interval
Requires a scanning PDU with packet type SCAN_RSP or AUX_SCAN_RSP. The
PDU AUX_SCAN_REQ also requires option R&S SMM-K117.

Sets the time interval between packets starting points of two consecutive packets in
the advertising channel.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:APINterval on page 183
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5.2.2

Advertising event and frame configuration

Transmit Window Offset
Requires packet type CONNECT_IND, AUX_CONNECT_REQ or AUX_CON-
NECT_RSP.

Displays the start point of the transmit window. For related settings, see "Transmit Win-
dow Offset" on page 77.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:WOFFset

on page 246

Transmit Window Size
Requires packet type CONNECT_IND, AUX_CONNECT_REQ or AUX_CON-
NECT_RSP.

Displays the start point of the transmit window for configuring advertising frames. For
related settings, see "Transmit Window Size" on page 77.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:ECONfiguration:WSINfo? on page 189

Packet Configuration
Opens the dialog to configure packets. See Chapter 5.3, "Advertising and data packet
configuration”, on page 58.

Connection settings

Access:
1. Select "Channel" > "Channel Type" > "Data".

2. Select "Event Configuration".

Bluetooth: Event Configuration —_— X
Connection SEﬂings Shaniel fanie _
No. Of Tx Packets/Event Connection Event Interval
1 7.500 ms
LL Connection Mode Long Term Key(hex) 9
Un-encrypted 0000 0000...

2

Packet Configuration . | Selected Data Channel Index

0

Center frequency(MHz)
2402 2404 2424 2426 2428 2478 2480
_____________ Data V AoV V T
37 0 10 38 1 36 39

Channel Index

The "Connection Settings" tab provides general settings to configure data channel
events. Also it provides access to the packet configuration.
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Advertising event and frame configuration

Settings:

NO. Of TX PACKEIS/EVENT......ciiieeeeee et e e e e e e e s eeeanas 55
Connection EVEN INTEIVAL.....ccccooiiiiiiieeeeeeeeeeeee et e e e e ee e 55
LL CONNECHON MOAE......ceeveiiiiiiiicciieie it e e ee ettt eeeee et aese s e e e e e eeaeaaaeesesereeesenes 55
(o] Vo R =Y 0 g I SV (1 T 56
Selected Data Channel INAEX.........ue it e e e e 56

No. Of Tx Packets/Event
Sets the number of TX packets per event.

Each connection contains at least one data channel packet. The maximum number of
packets per event is determined by the duration of the connection event interval.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PNUMber on page 187

Connection Event Interval
Requires packet type CONNECT _IND, AUX_CONNECT_REQ or DATA.

Set the time interval between the start points of two consecutive connection events.
Subsequent transmissions within an event are separated by this parameter to separate
connecting event starting points in time.

See also "Connection Event Interval" on page 78.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:CINTerval
on page 229

LL Connection Mode
Select the link layer connection mode.

To provide safe transmission of payload data, you can encrypt the data in the packet. If
encrypted, the payload data follows a 32-bit message integrity check (MIC field).

The following table shows data packets with limited encrypting or unencrypting. All
other data packets allow encrypting and unencrypting the data packet.

Table 5-4: Limited data packet encryption (R&S SMM-K60)

Packet type Encrypted Unencrypted
LL_ENC_REQ No Yes
LL_ENC_RSP No Yes
LL_START_ENC_REQ No Yes
LL_START_ENC_RSP Yes No
LL_PAUSE_ENC_REQ No Yes
LL_PAUSE_ENC_RSP Yes No
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Advertising event and frame configuration

"Un-encrypted" Payload data is transmitted without encoding. Example of packet type

data:
Header Payload —_—n
LLID |[NESN | SN | MD CP | RFU | Length |CTElnfo Data
2 bits | 1bit | 1bit | 1bit [ 1bit | 2 bits| 8 bits 8 bits 0-251 bytes
‘ pRESAQi/tISLE ‘ Am;;Abs:ress PDU ‘ 23'1?:5 Constant Tone Extension
"Encrypted" The link layer connection runs in encrypted mode. Example of packet
type data:
Header Payload B
LLID | NESN | SN | MD CP | RFU | Length |CTElnfo Data MIC
2 bits | 1 bit 1bit | 1bit | 2 bits| 8 bits 8 bits 0-251 bytes 32 bits

1 bit

PREAMBLE | Access Address CRC
8 bits 32 bits 24 bits

PDU

Constant Tone Extension

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:LCMode on page 183

Long Term Key(hex)
For "LL Connection Mode" > "Un-encrypted", indicates the long-term key.

For "LL Connection Mode" > "Encrypted", sets the long-term key.

This key is the time that the controller needs to receive the long-term key from the
host. After this time, the controller is ready to enter into the last phase of encryption
mode setup.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:LTKey on page 184

Selected Data Channel Index
Displays the number of the first active data channel.

The data channel is selected for each connection event. The Central device and
Peripheral device determine the used data channel by selecting from the list of used
channels, see "Channel Table" on page 57.

Displays the data channel index currently selected.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:SDCI? on page 187

5.2.3 Channel table settings

Access:

1. Follow the directions in Chapter 5.2, "Advertising event and frame configuration”,
on page 51.

User Manual 1179.2054.02 — 07 56



R&S®SMM-K60/-K117/-K178 Bluetooth LE configuration and settings

Advertising event and frame configuration

2. Select "Channel Table"

Bluetooth: Event Configuration

PG LERWNEE Channel Table

Advertising
2426 38 Advertising Unused
2 480 39 Advertising Unused

The channel table displays all possible channels and their characteristics. Also you
can select the channel that you want to use for the generated packets.

Settings:

Channel Table
The channel table displays channel characteristics including the channel state.

Each row lists the configuration for a channel as per the data channel index. LSB rep-
resents data channel index 0 and the bit in position 36 represents data channel
index 36.

If you use the channel ("Used"), the channel bit is 1. If you do not use the channel
("Unused"), the channel bit is 0. The bits in positions 37, 38 and 39 are zero during
transmission and a receiver ignores them.

For a graphical representation

"Center Frequency"
Displays the center frequency of a channel.

"Channel Index"
Displays the channel index.

"Channel Type"
Displays the channel type.

"Channel State"
Sets if you use the channel ("Used") or not ("Unused"). You can only
use one channel.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:ACTable:
CHANnel<ch0>:STATe on page 181

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:DCTable:
CHANnel<chO0>:STATe on page 181

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:
PCONfiguration:DCMTable:CHANnel<chO0>:STATe

on page 181
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Advertising and data packet configuration

5.3 Advertising and data packet configuration

Access:
1. Select "Bluetooth" > "General".
2. "Bluetooth Mode" > "Bluetooth LE".

3. Inthe "Channel" tab, select the channel type, for example, "Channel Type" >
"Advertising".

4. Select "Event Configuration" event-type packets or "Frame Configuration" for
frame-type packets.

The "Event Configuration" or "Frame Configuration" dialog opens.
5. Select "Packet Configuration”

The dialog provides settings to configure the parameters of the selected packet

type.
Settings:
o Packet configuration Settings........c.uviiiiiiiiiie 58
®  Header SEHINGS...cci it e e e aaa s 60
L I O I = 101 (o T Y=Y ] o SRR 62
e Legacy advertising PDU payload settingsS...........ccceeeiiiiiiiiiiiiieececeeeeeeeeeeveevee 63
e Extended advertising PDU payload Settings............uuuiicciieiiiieiiiieeeeeeeeeeeeeeeeeeeeeennns 66
e Scanning PDU payload SettingsS........oooiiiieieeee e 74
e Initiating PDU payload Settings........coiiiiiiimimieaieae e 76
e Data channel PDU payload Settings........ccuuieiieiiiiiiiiiiiiiiceieeee e 79
e FeatureSet configuration SEttiNGS.........uuuiiiiieiiiiiii i 89

5.3.1 Packet configuration settings

Access:
» Select "Packet Configuration".

The "Packet Configuration” tab provides settings to configure the general packet
parameters. Also, it displays the main fields and field lengths of the selected packet

type.
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Advertising and data packet configuration

Bluetooth: Packet Configuration —_ X
Data Whitening I
Access Address(hex) CRC Initial Value(hex)
ACDE 48AC 00 0000
MinCTELenReq RFU CTETypeReq
5 bits 1 bit 2 bits
LLID [ NESN | SN | MD | CP | RFU Length Opcode —
2 bits | 1bit | 1bit | 1bit | 1bit | 2 bits 8 bits 8 bits roata
i _HeaEI_er Payload T
PREAMBLE e — — " Cre
16 bits 32 bits 24 bits
Settings:
Data WHItENMING....ceeii ittt et e et e e e e abbee e e e s eabeeeeeeanee 59
ACCESS AQAIESS. ..t i ittt e et e e e e e e ea e e e e e e ta e e e e e eetaaeeeeeeannaaaaanes 59
CRC INitial ValUB(NEX).c.ceiueeeeieeiiieieie ettt e e e 60
Data Whitening

Enables data whitening.

Evenly distributed white noise is ideal for the transmission and real data can be forced
to look similar to white noise with different methods called "Data Whitening". Applied to
the PDU and CRC fields of all packet types, whitening is used to avoid long equal
sequences in the data bitstream.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:DWHitening
on page 216

Access Address
Sets the access address of the link layer connection.

Bluetooth LE transmissions are based on an interface packet format that consists of a
preamble (8 bits) the access address (32 bits), the PDU and CRC (24 bits).

Access address is used to identify communications on a physical channel, and to
exclude or ignore packets on different physical channels. The channels are using the
same PHY channels in physical proximity.

The structure of the access address depends on the packet type:

® Data channel packets
The access address is a pseudo-random LL connection address, generated by the
initiator of the LL connection. The address has to follow some specific rules, which
are described in the Bluetooth LE technology.

® Advertising channel packets
The address is fixed to 01101011011111011001000101110001 with the leftmost bit
sent first and being the LSB.

This parameter is relevant for packet types in event or frame configurations of a data
channel or an advertising channel. See also Table 5-1.
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5.3.2

Advertising and data packet configuration

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:AADDress
on page 217

CRC Initial Value(hex)
Requires data channel PDU or an advertising channel PDU. For an advertising chan-
nel, also requires packet type CONNECT _IND or AUX_CONNECT_REQ.

Sets the initialization value for the 24-bit cyclic redundancy check (CRC) calculation. A
receiver receives a packet correctly after it passes the CRC.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:CIValue
on page 217

Header settings

Access:
1. Select "Packet Configuration".

2. Select "Header".

NESN Start Value SN Start Value
0 0

CTEInfo Present [ ]| CTEInfo Configuration ... OI

The tab provides settings to configure the packet header settings.

Settings:

NESN Start ValUeE.......cooeeeeeeeccieee ettt e e e e e e e e e e e e e e e eeeeaeaees 60
S N IR e= T A 2= 1 (U= YU 61
Channel SEIECHON. ... .uueeeceee e e e e e e e e e e e e e e e e e e e aaaas 61
L =) o T TS =Y o S 61
(621 =3 (01 {o J @7 o] a1 1o U] =111 ] o P PR 61
Tx Address TYPe/RX AdAress TYPE....ccoi it e e e e e e e e e e e e 61

NESN Start Value
Requires a data channel packet that is not a test packet.

Sets the next expected sequence number (NESN). This number is the start value of
the next expected packet from the same device in the LL connection. You can set this
parameter for the first event. From the second event and later events, the field is
empty.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:NSValue
on page 218
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Advertising and data packet configuration

SN Start Value
Requires a data channel packet that is not a test packet.

Sets the sequence number of the packet. You can set this parameter for the first event.
From the second event and later events, the field is empty.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:SSValue
on page 218

Channel Selection
Requires option R&S SMM-K117.

Sets the algorithm of channel selection for advertising channel packets, see
Table 2-10.

"Algorithm #1"  Channel selection only for connection events.

"Algorithm #2"  Channel selection for connection events and periodic advertising
packets.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:CSELection

CTEInfo Present
Requires a data channel packet or a test packet.

Enables the CTEInfo field in the header of Bluetooth LE data packets in the LE unco-
ded PHY.

See also "Constant tone extension" on page 23.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:CPResent
on page 218

CTEInfo Configuration
Requires "CTEInfo Present" > "On".

Opens the "CTEInfo Configuration" dialog to configure CTE length and the CTE
method. See Chapter 5.3.3, "CTEInfo settings”, on page 62.

Tx Address Type/Rx Address Type
Requires an advertising channel packet, see Table 2-10.

Selects the address type of a Bluetooth LE device. Depending on the Bluetooth con-
troller role, either the Tx or Rx or both address types are assigned.

The format of the device address differs depending on the selected address type. The

address type and corresponding packet types are as follows:

e "Tx" for the packet types ADV_IND, ADV_DIRECT_IND, ADV_NONCONN _IND,
ADV_SCAN_IND, SCAN_REQ, SCAN_RSP and CONNECT _IND
Within R&S SMM-K117 also with the packet types ADV_EXT _IND,
AUX_ADV_IND, AUX_CHAIN_IND, AUX_SYNC_IND, AUX_SCAN_REQ,
AUX_SCAN_RSP and AUX_CONNECT_REQ

e "Rx" for the packet types ADV_DIRECT IND, SCAN_REQ and CONNECT_IND
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5.3.3

Advertising and data packet configuration

"Public" Allocates a unique 48-bit address to each Bluetooth LE device. Public
addresses use an organizational unique identifier (OUI) obtained from
the IEEE registration authority.

"Random" Allocates a 48-bit random static device address to each Bluetooth LE
device. A random address is optional. It can be directly generated by
the beacon.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:TATYpe
on page 241

CTEInfo settings

Access:

1. Select "Packet Configuration".

2. Select "Header".

3. Select "CTEInfo Present" > "On".
4. Select "CTEInfo Configuration".

CTETime CTEType v
0.016 ms AOD(1us)
Antenna Number
4
Antenna0 Gain @ Antennal Gain
0.00dB 0.00dB
Antenna2 Gain Antenna3 Gain
0.00 dB 0.00dB

¢——— CTEInfo —»

CTETime RFU CTEType
5 bits 1 bit 2 bits

The dialog provides constant tone extension (CTE) settings for direction finding
including the CTE length and the CTE method. The settings are relevant for data
event configuration and all data channel packet types including test packets.
See also "Constant tone extension" on page 23.

Settings:
(O I = 111 01T TSRO TR TR TR 62
L2 I Y/ o1 S PR PR 63
F N a1 (=T a1 T TN [ T0 0] 0T 63
F N gL (=T a1 aT=) G CF= [ o TR 63
CTETime

Sets the CTETime that is the length of the constant tone extension field.
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5.3.4

Advertising and data packet configuration

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:CTIMe
on page 219

CTEType
Sets the type of constant tone extension. The type specifies the CTE AoA/AoD method
and for AoD the length of the switching and I/Q sampling slots.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:CTYPe
on page 219

Antenna Number
Requires "CTEType" > "AoD(1us)"/"AoD(2us)".

Sets the number of antennas for the angle of departure (AoD) direction finding method.
You can select up to four antennas for direction finding.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfig: PCONfig:ANTNumber on page 220

AntennaX Gain
Requires "CTEType" > "AoD(1us)"/"AoD(2us)".

Sets the gain of the antenna "AntennaX", where X is 0 to 3 depending on the number
of antennas. You can set the antenna gain information of up for four individual anten-
nas for direction finding.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfig:PCONfig:ANTGain<ch0> on page 220

Legacy advertising PDU payload settings

Access:

1. Select a legacy advertising PDU:

a) Inthe "Channel" tab, select "Channel Type" > "Advertising".
b) Select a legacy advertising PDU, for example "Packet Type" > "ADV_IND".

2. Select "Event Configuration"/"Frame Configuration" > "Packet Configuration".
3. Select "Payload".

Advertiser's Device Addr

00 0080
AC DE48
NAP(16), UAP(8) LAP(24)
Data Source
PN 9
Data Length
31 bytes

The tab provides settings to configure the payload of the legacy advertising PDUs.
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Advertising and data packet configuration

For an overview of supported legacy advertising PDUs, see Table 2-10.

Settings:

AAVErISEr'S DEVICE AQAI ... e e e e aaaas 64
Target's DEVICE AQAr ... ... i e e e e e e e e e e e e e e e e e e e e e ae e ———— 65
D= 1 e= S Lo YU ot PP UPU PPNt 65
Data LeNGtN..... e e e e e e 65

Advertiser's Device Addr
Sets the 48-bit device address of the advertiser.

This device address identifies the Bluetooth device. Devices use a public device
address or a random device address, see "Tx Address Type/Rx Address Type"
on page 61. For more information, see [1].

With Bluetooth wireless technology up to the version 4.2, the following address formats

are defined:
® "Public Address Type" is the unique 48-bit identity address of each Bluetooth LE
device.

The registration authority IEEE provides the address that consists of the following:
— LSB: 24 bits = company_assigned
— MSB: 24 bits = company_id
® "Random Address Type" is an optional 48-bit random static device address.
® "Private Address Type" is a resolvable 48-bit optional address.
A private address consists of the:
— LSB: 24 bits = hash
— MSB: 24 bits = random

Since version 5.0, the device address format is in accordance with BD_ADDR for

BR/EDR with the exception that LAP values does not apply. Unless the public device

address is also used for a BR/EDR controller.

® NAP: Selects the non-significant address part. The length of NAP is 16 bits or 4
hexadecimal figures.

® UAP: Selects the upper address part. The length of UAP is 8 bits or two hexadeci-

mal figures.
® |LAP: Selects the lower address part. The length of LAP is 24 bits or 6 hexadecimal
figures.
The NAP+UAP can take any values except the 64 reserved LAP values: #H9E8B00 —
#HOE8B3F.
For the address formats of Bluetooth version 5.0 and later, install option R&S SMM-
K117.

For advertising channel PDU types, see "Payload" on page 19.

Remote command:

Company_Assigned and Company_Id in the device address of an advertiser:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:ACID

on page 224

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:ACASsigned
on page 224

NAP+UAP and LAP in the device address of an advertiser:
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[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:ANUap
on page 226

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:ALAP
on page 225

Target's Device Addr

TargetA field of the device address that is a scanner's device address or an initiator's
device address.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:TNUap

on page 226

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:TLAP

on page 225

Data Source
Selects the data source for data in the corresponding data subfield of the Payload field.

The following standard data sources are available:

e "AlLQ"/"AIl 1"

An internally generated sequence containing O data or 1 data.
® "PNxx"

An internally generated pseudo-random noise sequence.
® "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern” box to set the bit pattern.
® "Data List"/"Select Data List"
Binary data from a list file, internally or externally generated.
Select "Select Data List" to open the standard "Select List" dialog. The dialog lists
file with file extension *.dm_1iqd if existing.
— Navigate to the list file and tap "Select" to select the file.
— Use the "New" and "Edit" functions to create a data list internally or to edit an
existing one.
— Use the standard "File Manager" function to transfer external data lists to the
instrument.
See also:
® Section "About data signals" in the R&S SMM100A user manual.
® Section "File and data management" in the R&S SMM100A user manual.
® Section "Data list editor" in the R&S SMM100A user manual.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:DATA

on page 229

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:DATA:
DPATtern on page 230

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:DATA:
DSELection on page 230

Data Length
Selects the length of the corresponding data subfield of the Payload field.
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5.3.5

5.3.5.1
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Advertising and data packet configuration

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:DLENgth

on page 231

Extended advertising PDU payload settings
Option: R&S SMM-K117

Access:

1. Select an extended advertising PDU:

a) Inthe "Channel" tab, select "Channel Type" > "Advertising".
b) Select an extended advertising PDU, for example "Packet Type" >
"ADV_EXT_IND".

2. Select "Event Configuration"/"Frame Configuration" > "Packet Configuration".
3. Select "Payload".
The tab provides settings to configure the payload of the extended advertising
PDUs.
For an overview of supported extended advertising PDUs, see Table 2-10.

GeNEral SEHNGS. ....ciiiiiiiiie e
Extended header SEetliNgS. ......ouui i
AdvDatalnfo configuration SEtHNGS.....ceuiieiiiiiiiicce e
AuxPtr configuration Settings.........ccuuueiiiiiii i
SynclInfo configuration SEttiNgS..........uueeiiiiiiiiiii i

General settings

Access:

» Select "Payload".

Packet Configuration Payload

Advertising Mode

4

Non-conn&Non-scan

Extended Header

Extended Header

Data Source
All1

Data Length G‘

66



R&S®SMM-K60/-K117/-K178 Bluetooth LE configuration and settings

5.3.5.2

Advertising and data packet configuration

The tab provides general settings to configure the payload of the extended adver-
tising PDUs.
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Advertising Mode
Selects the mode of the advertisement in the AdvMode field.

"Non-conn&Non-scan"
Non-connectable and non-scannable

"Conn&Non-scan"
Connectable and non-scannable

"Non-conn&Scan"
Non-connectable and scannable

"Chained data" Fixed value for an AUX_CHAIN_IND PDU.

"Scan response"
Fixed value for an AUX_SCAN_RSP PDU.

"Connection response"
Fixed value for an AUX_CONNECT_RSP PDU.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:AMODe
on page 226

Extended Header
Enables the extended header of an extended advertising PDU.

If enabled, displays a table with extended header settings, see Chapter 5.3.5.2, "Exten-
ded header settings", on page 67.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:EHEader:
STATe on page 232

Data Source
See "Data Source" on page 65.

Data Length
See "Data Length" on page 65.

Extended header settings

Access:

» Select "Payload" > "Extended Header" > "On".
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If enabled, the R&S SMM100A signals the extended header for extended advertis-
ing PDUs.

Extended Header

The "Extended Header" table provides general settings to configure the extended
header. It also provides access to further settings of fields within the extended

header.

Settings:

N0 OSSR 68
L1 [ VPP PP PP OTIPRR 68
LG I8 = [ 1o F TR 68
e LV - = 1) (o TSR 69
T | PSPPI 69
SyncInfo/SyncInfo Configuration...............eeciiiiii e 69
TXPOW(ABIM).cceii ittt et ettt e et e e s e b e et e e e s annne e e e e ennneeeas 69
ACAD LENGEN.... ettt ea s 70
7 5 SR 70
L] O = Y1 (= 4 o PP 70
AdvA

Enables the flag of the advertiser's device address (AdvA) subfield. If enabled, this
subfield is present in the Extened Header field.

For related settings, see "Advertiser's Device Addr" on page 64.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
AADDress:STATe on page 232

TargetA
Requires an advertising channel PDU that contains the TargetA field, see Table 2-11.

Enables the flag of the target's device address (TargetA) subfield. If enabled, this sub-
field is present in the Extened Header field.

For related settings, see "Advertiser's Device Addr" on page 64.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
TADDress:STATe on page 234

CTEInfo
Requires a data channel packet including a test packet. See also "Constant tone
extension" on page 23.

Enables the flag of the CTEInfo subfield. If enabled, this subfield is present in the Ext-
ened Header field.
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Selecting "Conf" opens the CTEInfo configuration dialog to define the CTE length and
the CTE method for direction finding. See Chapter 5.3.3, "CTEInfo settings",

on page 62.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
CINFo:STATe on page 233

AdvDatalnfo
Enables the flag of the advertising data information (AdvDatalnfo) subfield. If enabled,
this subfield is present in the Extened Header field.

Select "Conf" to open further AdvDatalnfo settings, see Chapter 5.3.5.3, "AdvDatalnfo
configuration settings", on page 71.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
ADINfo:STATe on page 233

AuxPtr
Enables the flag of the AuxPtr subfield. If enabled, this subfield is present in the Ext-
ened Header field.

The presence of the AuxPtr subfield indicates that some or all advertisement data is in
a following auxiliary packet. The contents of the AuxPtr subfield describe this auxiliary
packet.

Select "Conf" to open further AuxPtr settings, see Chapter 5.3.5.4, "AuxPtr configura-
tion settings", on page 71.

Remote command:

[ : SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
APTR:STATe on page 233

Syncinfo/Syncinfo Configuration
Requires packet type AUX_ADV_IND or LL_PERIODIC_SYNC_IND.

Enables the flag of the Syncinfo subfield. If enabled, this subfield is present in the Ext-
ened Header field. The presence of theSynclinfo field indicates the presence of a peri-
odic advertisement.

Select "Conf" to open further Syncinfo settings, see Chapter 5.3.5.5, "Synclinfo configu-
ration settings", on page 73.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
SINFo:STATe on page 234

TxPow(dBm)
Enables signaling and sets the required transmit power.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
TPOWer : STATe on page 234

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:TPOWer
on page 245
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ACAD Length
Specifies the length of an additional controller advertising data (ACAD) field.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:ALENgth
on page 225

ACAD
Sets the pattern for additional controller advertising data (ACAD).

The following standard data sources are available:

e Al O"/"All 1"

An internally generated sequence containing 0 data or 1 data.
® "PNxx"

An internally generated pseudo-random noise sequence.
® "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to set the bit pattern.
® "Data List"/"Select Data List"
Binary data from a list file, internally or externally generated.
Select "Select Data List" to open the standard "Select List" dialog. The dialog lists
file with file extension * .dm iqd if existing.
— Navigate to the list file and tap "Select" to select the file.
— Use the "New" and "Edit" functions to create a data list internally or to edit an
existing one.
— Use the standard "File Manager" function to transfer external data lists to the
instrument.
See also:
® Section "About data signals" in the R&S SMM100A user manual.
® Section "File and data management" in the R&S SMM100A user manual.
® Section "Data list editor” in the R&S SMM100A user manual.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:ACAD
on page 222

AList / Pattern
Sets one of the following:

® For "ACAD" > "Data List", selects the data list source file and directory.
® For"ACAD" > "Pattern”, sets the pattern.

See also "ACAD" on page 70.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:ACAD:
APATtern on page 223

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:ACAD:
ASELection on page 223
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5.3.5.3

5.3.54

Advertising and data packet configuration

AdvDatalnfo configuration settings

Access:

1. Select "Payload" > "Extended Header".
2. Select "AdvDatalnfo" > "On".

3. Select "AdvDatalnfo" > "Conf".

The "AdvDatalnfo Configuration" section opens.

AdvDatalnfo Configuration

Advertising Data ID(hex) Advertising Set ID(hex)
000 0

g——— AdvDatalnfo —_—

Advertising Data ID Advertising Set ID
12 bits 4 bits

The section provides AdvDatalnfo field settings and displays the structure of the
field graphically.

Settings:

Advertising Data ID(hex)
Sets the "Advertising Data ID" in the AdvDatalnfo field.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:ADID
on page 224

Advertising Set ID(hex)
Sets the "Advertising Set ID" in the AdvDatalnfo field.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:ASID
on page 228

AuxPtr configuration settings

Access:

1. Select "Payload" > "Extended Header".
2. Select "AuxPtr" > "On".

3. Select "AuxPtr" > "Conf".
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The "AuxPtr Configuration" dialog opens.

AuxPtr Configuration BN EWR-G I RS ENNE Table

Clock Accuracy Offset Units
51 ppm to 500 ppm 30 us
AUX Offset AUX PHY
24570 ms LE 1M
AuxPtr
Channel Index CA Offset Units AUX Offset AUX PHY
6 bits 1 bit 1 bit 13 bits 3 bits

The "AuxPtr Configuration" tab provides AuxPtr field settings and displays the
structure of the field graphically.

The "Secondary Advertising Channel Table" tab lists the configuration of all 37 LE
channels and allows you to enable the channel that you want to use for secondary
advertising. For related settings, see Chapter 5.2.3, "Channel table settings",

on page 56.
Settings:
(04 (oTe3 QT o1 ¥ | =3V 2 PR 72
L0157 A 1 SRR 72
G 5 1= SR 72
F N8 ) G d o b PP 72

Clock Accuracy
Sets the clock accuracy of the advertiser used between the packet containing this data
and the auxiliary packet.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:CACCuracy
on page 228

Offset Units

Sets the units used by the AUX offset, see "AUX Offset" on page 72.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:AOUNits
on page 227

AUX Offset
Sets the time from the start of the packet containing the AuxPtr field to the approximate
start of the auxiliary packet.

The parameter "Offset Units" affects the length of the AUX offset. Set the value at least
to the length of the packet plus 300 ps.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:AOFFset
on page 227

AUX PHY
Specifies the physical layer used to transmit the auxiliary packet.
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5.3.5.5

Advertising and data packet configuration

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:APHY
on page 227

Syncinfo configuration settings

Access:

1. Select "Payload" > "Extended Header".
2. Select "SyncInfo" > "On".

3. Select "Syncinfo" > "Conf".

The "Synclnfo Configuration" dialog opens.

Syncinfo Configuration B GERN N EH L ENEERLERTED] Table

Sync Packet Offset Offset Units
24570 ms 30us |
Offset Adjust D Periodic Adv Interval
20.00 ms
Sleep Clock Accuracy Access Address(hex)
251 ppm - 500 ppm | ACDE 48AC
CRC Initial Value(hex) Event Counter
00 0000 0 Events
Synclinfo

Sync Packet Offset Offset Units | Offset Adjust | RFU | Interval | ChM | SCA AA CRCInit | Event Counter
13 bits 1 bit 1 bit 1bit | 16 bits | 37 bits| 3 bits | 32 bits| 24 bits 16 bits

The "Synclinfo Configuration” tab provides Syncinfo field settings and displays the
structure of the field graphically.

The "Secondary Advertising Channel Table" tab lists the configuration of all 37 LE
channels and allows you to enable the channel that you want to use for secondary
advertising. For related settings, see Chapter 5.2.3, "Channel table settings",

on page 56.

SYNC PacKet OffSet.....c et 73
(0] (1Y A0 o] € TR UUPPPPRP 74
OFfSEE AQJUST. ettt et e e e s e e e e anneea s 74
PeriodiC AV INEEIVAL.......ccoiei e e e e e e e ea e e e 74
SIEEP ClOCK ACCUIACY ... uiiiieieeeiieiiecciittte ittt e e e e e e s e e seeat bt reeeeeaaaeeesesssanssstasaeeeeaaaeessaaaansnnes 74
ACCESS AQAIESS...ceeeieiiieiiiiiiiiie i et e e e e e e e e e e et et e e e e ettt ae e e s aeseseeeeaaaaaaeeeseeeeeeeresnnrnres 74
CRC INitial ValUB(NEX).....cccee et s e e e e e e e e e e e e e e e e e e e e e e as 74
EVENE COUNTEE ...ttt e s e s e e e e e e e aaaaaaaaeeeeeeeees 74

Sync Packet Offset
Specifies the time from the start of the AUX_ADV_IND packet containing the Syncinfo
field to the start of the AUX_SYNC_IND packet.

The sync packet offset consists of multiples of the offset units, see "Offset Units"
on page 74.
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5.3.6

Advertising and data packet configuration

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:SPOFfset
on page 244

Offset Units
Sets the offset units of the sync packet offset, see "Sync Packet Offset" on page 73.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:SOUNits
on page 244

Offset Adjust
Adjusts the "Sync Packet Offset" automatically to the next value, which is a multiple of
the "Offset Units".

If "Offset Adjust" > "On", the "Sync Packet Offset" is 2.4567 s and "Offset Units" >
"300 us".

If "Offset Units" > "30 us", disables the offset adjust.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:0ADJust
on page 240

Periodic Adv Interval
See "Periodic Advertising Interval" on page 53.

Sleep Clock Accuracy
See "Sleep Clock Accuracy" on page 79.

Access Address
See "Access Address" on page 59.

CRC Initial Value(hex)
See "CRC Initial Value(hex)" on page 60.

Event Counter
Counts the AUX_SYNC_IND packets that the Synclnfo field describes.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:ECOunter
on page 231

Scanning PDU payload settings

Access:

1. Select a scanning PDU:

a) Inthe "Channel" tab, select "Channel Type" > "Advertising".
b) Select a scanning PDU, for example "Packet Type" > "ADV_SCAN_REQ".
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Advertising and data packet configuration

2. Select "Event Configuration"/"Frame Configuration" > "Packet Configuration".

3. Select "Payload".

Facket Conﬂguraﬁon Paymad _

Scanner's Device Addr

00 0080
AC DE48
NAP(16), UAP(8) LAP(24)
Advertiser's Device Addr 00 0080
AC DE48
NAP(16), UAP(8) LAP(24)
The tab provides settings to configure the payload of the scanning PDUs.
For an overview of supported scanning PDUs, see Table 2-10.
Settings:
SCANNEI'S DEVICE AQAI.....ciiie it e e et e e e e e e e e e e e e e eesa e eaeeees 75
AdVErtiser's DEVICE A .......uuuuiciiiiiie e e e e e e e e e e e e e e eeaeaaes 75
Dat@ SOUICE... ..ottt et e e e e e e ettt et e et eseseeeeeaaaaaaaaseeeeeeeenes 75
Data LeNGth.. .. e e e e e e 75
(L= gTe (= To [ o o= o =T SR 76

Scanner's Device Addr
Requires a SCAN_REQ PDU or an AUX_SCAN_REQ PDU.

Sets the 48-bit device address of the scanner.
For more information, see "Advertiser's Device Addr" on page 64.

Remote command:

Company_Assigned and Company_Id in the device address of a scanner:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:SCASsigned
on page 224

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:SCID
on page 224

NAP+UAP and LAP in the device address of a scanner:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:SNUap
on page 226

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:SLAP
on page 225

Advertiser's Device Addr
See "Advertiser's Device Addr" on page 64.

Data Source
Requires a SCAN_RSP PDU or an AUX_SCAN_RSP PDU.

For related settings, see "Data Source" on page 65.

Data Length
Requires a SCAN_RSP PDU or an AUX_SCAN_RSP PDU.

For related settings, see "Data Length" on page 65.
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5.3.7

Advertising and data packet configuration

Extended Header
Requires an AUX_SCAN_RSP PDU.

For related settings, see "Extended Header" on page 67 and Chapter 5.3.5.2, "Exten-
ded header settings", on page 67.

Initiating PDU payload settings

Access:

1. Select a scanning PDU:

a) Inthe "Channel" tab, select "Channel Type" > "Advertising".
b) Select a scanning PDU, for example "Packet Type" > "CONNECT _IND".

2. Select "Event Configuration"/"Frame Configuration" > "Packet Configuration".
3. Select "Payload".

Initiator's Device Addr

AC DE48 000080
NAP(16), UAP(8) LAP(24)
Advertiser's Device Addr i 00 0080
NAP(16), UAP(8) LAP(24)
Access Address(hex) CRC Initial Value(hex)
ACDE 48AC 0000 0000
Transmit Window Size Transmit Window Offset
1.25ms 0.00 ms
Connection Event Interval Slave Latency
7.500 ms 0 Events
LL Connection Timeout Show Data Channel Map Table »
100 ms
Hop Length Sleep Clock Accuracy i
5 251 ppm - 500 ppm
The tab provides settings to configure the payload of the initiating PDUs.
For an overview of supported initiating PDUs, see Table 2-10.
Settings:
INItIAtOr'S DEVICE AQAN ... .. et e e e et e e e e e eeb s 77
AAVErISEr'S DEVICE AQAI.....cci e e e e e 77
TransmMit WINAOW SIZE.......oooiiiieiiiiiccecee ettt e e e e aaaaaaeas 77
Transmit WIindow OffSel........ccooiiiiiiiee e 77
Connection EVENt INtErvVal...........oooiiiiiiiiiieeeee e 78
Peripheral LatenCy.........ooo i 78
LL ConNection TIMEOUL...........ceeeiiiiiiieieeeeeitteeee et e et e e e e e e e e e e e e e e e e e eeeeee e bbb es 78
Show Data Channel Map Table/Hide Data Channel Map Table...........ccccccocvccceenennnn. 79
[ [ o 3N =Y oV | o PPN 79
S1EEP CIOCK ACCUIACY ... utieeeiiiiiieee ettt ettt e ettt e e e e e e e e e abbe e e e e enreeas 79
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(D F=) o= TS o U (o7 YT 79
Data LeNGth. ... e e e e e 79
[ (= [0 =10 [ [ST= o L= 79

Initiator's Device Addr
Sets the 48-bit device address of the initiator.

For more information, see "Advertiser's Device Addr" on page 64.

Remote command:

Company_Assigned and Company_Id in the device address of an initiator:

[ : SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:ICASsigned
on page 224

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:ICID
on page 224

NAP+UAP and LAP in the device address of an initiator:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:INUap
on page 226

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:ILAP
on page 225

Advertiser's Device Addr
See "Advertiser's Device Addr" on page 64.

Transmit Window Size

Requires packet type CONNECT _IND, AUX_CONNECT_REQ, LL_CONNEC-
TION_UPDATE_IND, LL_CONNECTION_PARAM_REQ or LL_CONNEC-
TION_PARAM_RSP. The PDUs AUX_CONNECT_REQ, LL_CONNEC-
TION_PARAM_REQ and LL_CONNECTION_PARAM_RSP also require option
R&S SMM-K117.

Sets the size of the transmit window for configuring advertising frames. The "Frame
Configuration" dialog also displays this setting.

The scan window size is less or equal to the value of the connection interval, see "Con-
nection Event Interval" on page 78.

Remote command:

For advertising channels:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:WSIZe
on page 246

For data channels:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:NWSize
on page 240

Transmit Window Offset

Requires packet type CONNECT _IND, AUX_CONNECT_REQ, LL_CONNEC-
TION_UPDATE_IND, LL_CONNECTION_PARAM_REQ or LL_CONNEC-
TION_PARAM_RSP. The PDUs AUX_CONNECT_REQ, LL_CONNEC-
TION_PARAM_REQ and LL_CONNECTION_PARAM_RSP also require option
R&S SMM-K117.

Sets the start point of the transmit window for configuring advertising frames. The
"Frame Configuration" dialog also displays this setting.
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Remote command:

For advertising channels:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:WOFFset
on page 246

For data channels:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:NWOFfset
on page 240

Connection Event Interval

Requires packet type CONNECT _IND, AUX_CONNECT_REQ, LL_CONNEC-
TION_UPDATE_IND, LL_CONNECTION_PARAM_REQ or LL_CONNEC-
TION_PARAM_REQ. The PDUs AUX_CONNECT_REQ, LL_CONNEC-
TION_PARAM_REQ and LL_CONNECTION_PARAM_REQ also require option
R&S SMM-K117.

Set the time interval between the start points of two consecutive connection events.
Also, this setting separates subsequent transmissions within an event to separate con-
necting event starting points in time.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:NCINterval
on page 239

Peripheral Latency

Requires packet type CONNECT _IND, AUX_CONNECT_REQ, LL_CONNEC-
TION_UPDATE_IND, LL_CONNECTION_PARAM_REQ or LL_CONNEC-
TION_PARAM_REQ. The PDUs AUX_CONNECT_REQ, LL_CONNEC-
TION_PARAM_REQ and LL_CONNECTION_PARAM_REQ also require option
R&S SMM-K117.

Sets the number of consecutive connection events that the Peripheral can ignore for
asymmetric link layer connections.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:SLATency
on page 243

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:NSLatency
on page 239

LL Connection Timeout

Requires packet type CONNECT _IND, AUX_CONNECT_REQ, LL_CONNEC-
TION_UPDATE_IND, LL_CONNECTION_PARAM_REQ or LL_CONNEC-
TION_PARAM_REQ. The PDUs AUX_CONNECT_REQ, LL_CONNEC-
TION_PARAM_REQ and LL_CONNECTION_PARAM_REQ also require option
R&S SMM-K117.

Defines the maximum time between two correctly received Bluetooth LE packets in the
LL connection before the connection is considered lost.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:LCTimeout
on page 236

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:NLCTimeout
on page 239
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Show Data Channel Map Table/Hide Data Channel Map Table
Requires packet type CONNECT _IND or LL_ CHANNEL_MAP_IND.

Shows or hides the data channel map table. For related settings, see Chapter 5.2.3,
"Channel table settings", on page 56.

Remote command:
n.a.

Hop Length
Requires packet type CONNECT _IND.

Sets the difference from the current channel to the next channel.

The Central and the Peripherals determine the data channel in use for every connec-
tion event from the channel map. Hop_length is set for the LL connection and commu-
nicated in the CONNECT _IND packets.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:HLENgth
on page 235

Sleep Clock Accuracy
Requires packet type CONNECT _IND or LL_PERIODIC_SYNC_IND.

Sets the clock accuracy of the Central device with a specified encoding. The Peripheral
device uses this parameter to determine the required listening windows in the LL con-
nection. It is a controller design parameter known by the controller.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:SCACcuracy
on page 243

Data Source
Requires an AUX_CONNECT_RSP PDU.

For related settings, see "Data Source" on page 65.

Data Length
Requires an AUX_CONNECT_RSP PDU.

For related settings, see "Data Length" on page 65.

Extended Header
Requires an AUX_CONNECT_RSP PDU.

For related settings, see "Extended Header" on page 67 and Chapter 5.3.5.2, "Exten-
ded header settings", on page 67.

5.3.8 Data channel PDU payload settings

Access:

1. Select "Channel Type" > "Data".
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2. Select "Event Configuration" for event-type packets or "Frame Configuration" for
frame-type packets.

The "Event Configuration" or "Frame Configuration" dialog opens.

3. Select "Packet Configuration"

Advertiser's Device Addr

AC DE48 000080
NAP(16), UAP(8) LAP(24)
Data Source 4
PN 9
Data Length
31 bytes
The dialog provides settings to configure the payload of advertising PDUs.
For an overview of supported advertising PDUs, see Table 2-10.
Settings:
TransSmMit WINAOW SIZE......uuiiiiiiiiiiiie ettt e e e e e e e s nenreeee e e e e e e e e e e nnanns 81
Transmit WINAOW OffSEL.......ciiiieiieiiiiee et e e e ee e 81
Connection Event INTErval..........coiiiiiiiiii e 81
Peripheral LatEnCy.......uuuuieiiiecicieie ettt e e e e e e e e e e e e e e eeeeeeaees 81
LL ConNection TIMEOUL....ccieii ittt ettt e e e e e e e e e e enene e 81
(070] a1 aT=Tex 1o T [ 1< 7= o | 0N PRSP 82
Show Data Channel Map Table/Hide Data Channel Map Table........cccccoeviiiiiiiecnnnnn. 82
o g OFoTo [T T g T PP 82
(=T aTe (o] g BV /=Ted (o] (T T SRR 82
Encrypted DIVErSIfier(NEX).......uuuuieiiieeiie it e e e e e e aeeeeee s 82
SESSION KEY ID(NEX).ceeiiiieeiiiiieee e e e e e e e e e reeeeeaeas 83
Initialization VeCLOr(NEX).....couu i 83
UNKNOWN TYPE(NEX)... ettt eaneeee e 83
FeatureSet LENGN.... .o 83
FeatureSet Configuration............cueiii e 83
VErsion NUMDEI(NEX)....uuuuuiiiiiiiieiee e e e e ettt r e e e e e e s e s s e e e e e e e e e e s e e ssnnnreneeereaaeeeeaanan 83
SubVersion NUMDBEI(NEX)......ciiiiiiiii e e e e e e e e aaes 84
CoMPANY TANEX)...uteiieiiieeeee et e e e e e e e e e e e e e e e e e e e s e enabsraeeeeeeas 84
T T [T (Y Y= | SO 84
DG [0 (T Y- | S 84
Preferred PeriodiCity..... ... it 84
Ref. Connection EVENt COUNL.......cciiii it e e e e e e e e 85
Show Offset Setting Table/Hide Offset Setting Table..........cccvveeeiieiiccciiiiieeeeee e, 85
Offset SEttNG TADIE......uueeiiiiie e e e e e e e e e e s e enanrenes 85
[N =To1 @] oTo7o o [ YA 85
MaxRXOCtetsS/MaXTXOCLELS. ..ot e e e e e e e 85
MaxXRXTIME/MaXTXTIME...eee et e e e e e e e e e e e e e s e enneeeeeeas 86
TX PHYSIRX PHYS .ttt ettt ettt e e e et te e e e e e arre e e e e nnreas 86
M_TO_S PHY/S TO M PHY ...ttt 86
o o TSP 87
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Min Used Channels....... oottt e e e e e e e e e 87
10T = SRR 87
SyncInfo ConfigUuIratioN..........coei i 87
ConNection EVENT COUNT..........ooiiiiiieecceee et 87
Last Pa EVENT COUNLET.........uuiiiiiiiecc ettt rree e e e e e e e e s s s b e e e e e e aaaee s 88
T T T TSR 88
AQArESS TYPB. . i r et e e e e e e e e e e e e et e e et e e e eeeete st et — e aeeeseeeaaaaaaaaeeeeeeenes 88
S1EEP CIOCK ACCUIACY.......utieeeieiiieee ettt ettt et e e e e b e e e e abbe e e e e enreeas 88
o o SR 88
AAVErtiSEr's DeVICE A ... e 89
Sync Connection EVENt COUNTET......coiiiiii i 89
MINCTELENREG. .. tiiiiiiieei ettt e e e e e e e e e st a e e e e e eeaaeeeessaennnrsanneeeeess 89
(O I Y/ o 1= =T o U 89

Transmit Window Size

Requires packet type LL_ CONNECTION_UPDATE_IND, LL__CONNEC-
TION_PARAM_REQ or LL_CONNECTION_PARAM_RSP. The PDUs LL_CONNEC-
TION_PARAM_REQ and LL_CONNECTION_PARAM_RSP also require option

R&S SMM-K117.

For related settings, see "Transmit Window Size" on page 77.

Transmit Window Offset

Requires packet type LL_ CONNECTION_UPDATE_IND, LL_ CONNEC-
TION_PARAM_REQ or LL_CONNECTION_PARAM_RSP. The PDUs LL_CONNEC-
TION_PARAM_REQ and LL_CONNECTION_PARAM_RSP also require option

R&S SMM-K117.

For related settings, see "Transmit Window Offset" on page 77.

Connection Event Interval

Requires packet type LL_ CONNECTION_UPDATE_IND, LL_ CONNEC-
TION_PARAM_REQ or LL_CONNECTION_PARAM_RSP. The PDUs LL_CONNEC-
TION_PARAM_REQ and LL_CONNECTION_PARAM_RSP also require option

R&S SMM-K117.

For related settings, see "Connection Event Interval" on page 78.

Peripheral Latency

Requires packet type LL_CONNECTION_UPDATE_IND, LL_CONNEC-
TION_PARAM_REQ or LL_CONNECTION_PARAM_RSP. The PDUs LL_CONNEC-
TION_PARAM_REQ and LL_CONNECTION_PARAM_RSP also require option

R&S SMM-K117.

For related settings, see "Peripheral Latency" on page 78.

LL Connection Timeout

Requires packet type LL_CONNECTION_UPDATE_IND, LL_CONNEC-
TION_PARAM_REQ or LL_CONNECTION_PARAM_RSP. The PDUs LL_CONNEC-
TION_PARAM_REQ and LL_CONNECTION_PARAM_RSP also require option

R&S SMM-K117.

For related settings, see "LL Connection Timeout" on page 78.
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Connection Instant

Requires packet type LL_CONNECTION_UPDATE_IND, LL__ CHANNEL_MAP_IND or
LL_PHY_UPDATE_IND. The PDU LL_PHY_UPDATE_IND also requires option

R&S SMM-K117.

Sets a connection instant for indicating the connection event at which the new connec-
tion parameters are taken in use.

Both the Central and the Peripheral have a 32-bit connection event counter per LL con-
nection. For the first event of the LL connection, the instant is zero and increments by
one on every elapsed connection event interval of the LL connection.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:CINStant
on page 229

Show Data Channel Map Table/Hide Data Channel Map Table
Requires packet type LL_ CHANNEL _MAP_IND.

Shows or hides the data channel map table. For related settings, see Chapter 5.2.3,
"Channel table settings", on page 56.

Remote command:
n.a.

Error Code(hex)
Requires packet type LL_ TERMINATE_IND, LL_REJECT_IND or
LL_REJECT_EXT_IND.

Sets an 8-bit error code. For an LL_ TERMINATE_IND packet, informs the remote
device about the termination of the connection. For an LL_REJECT_IND packet, indi-
cates a rejected request.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:ECODe
on page 231

Random Vector(hex)
Requires the packet type LL_ ENC_REQ and a Central Bluetooth controller.

Sets the random vector of the Central device for device identification.

The parameter is an initialization vector provided by the host in the
HCI_ULP_Start_Encryption command.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:RVECtor
on page 242

Encrypted DIVersifier(hex)
Requires the packet type LL_ ENC_REQ and a Central Bluetooth controller.

Sets the encrypted diversifier of the Central device for device identification. The param-
eter is an initialization vector provided by the host in the HCI_ULP_Start_Encryption
command.
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Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:
EDIVersifier on page 232

Session Key iD(hex)
Requires the packet type LL_ENC_REQ and a Central Bluetooth controller or
LL_ENC_RSP and a Peripheral Bluetooth controller.

Sets the portion of the Central or the portion of the Peripheral of the session key diver-
sifier (SKDmM/SKDs).

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:MSKD
on page 237

Initialization Vector(hex)
Requires the packet type LL_ENC_REQ and a Central Bluetooth controller or
LL_ENC_RSP and a Peripheral Bluetooth controller.

Sets the portion of the Central or the portion of the Peripheral of the initialization vector
(IVm/IVs).

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:MIVector
on page 236

Unknown Type(hex)
Requires the packet type LL__UNKNOWN_RSP and a Peripheral Bluetooth controller.

Enables indication of an invalid control packet. The "CtrType" field indicates the value
of the LL control packet that caused the transmission of this packet.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:UTYPe
on page 245

FeatureSet Length
Requires the packet type LL_FEATURE_REQ, LL_FEATURE_RSP or LL_PERIPH-
ERAL_FEATURE_REQ.

Displays the length of the feature set.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:FSLength
on page 235

FeatureSet Configuration
Requires the packet type LL_FEATURE_REQ, LL_FEATURE_RSP or LL_PERIPH-
ERAL_FEATURE_REQ.

Opens a dialog to enable or disable features within the link layer control PDU. See
"FeatureSet configuration table" on page 90.

Version Number(hex)
Requires packet type LL_VERSION_IND.
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Sets the version of the Bluetooth controller. It is an 8-bit value in hexadecimal repre-
sentation.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:VNUMber
on page 246

SubVersion Number(hex)
Requires packet type LL_VERSION_IND.

Sets a unique 16-bit value for each implementation or revision of an implementation of
the Bluetooth controller.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration: SVNumber
on page 244

Company Id(hex)
Requires packet type LL_VERSION_IND.

Sets the 16-bit company identifier of the manufacturer of the Bluetooth controller.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:CID
on page 228

Min. Interval
Requires option R&S SMM-K117 and packet types LL_ CONNECTION_PARAM_REQ
or LL_CONNECTION_PARAM_RSP.

Displays the minimum allowed connection interval.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:MNINterval
on page 184

Max. Interval
Requires option R&S SMM-K117 and packet types LL_ CONNECTION_PARAM_REQ
or LL_CONNECTION_PARAM_RSP.

Sets the maximum allowed connection interval.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:MXINterval
on page 184

Preferred Periodicity
Requires option R&S SMM-K117 and packet types LL_ CONNECTION_PARAM_REQ
or LL_CONNECTION_PARAM_RSP.

Sets the preferred periodicity. This value is typically a multiple of the value of the con-
nection interval.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:
PPERiodicity on page 186
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Ref. Connection Event Count
Requires option R&S SMM-K117 and packet types LL_ CONNECTION_PARAM_REQ
or LL_CONNECTION_PARAM_RSP.

Sets connection event counter relative to the calculation of all valid offset fields OffsetO
to Offsetb.

See also "Offset Setting Table" on page 85.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:RCECount
on page 186

Show Offset Setting Table/Hide Offset Setting Table
Requires option R&S SMM-K117 and packet types LL_ CONNECTION_PARAM_REQ
or LL_CONNECTION_PARAM_RSP.

Shows or hides the offset setting table, see "Offset Setting Table" on page 85.

Remote command:
n.a.

Offset Setting Table
Requires option R&S SMM-K117 and packet types LL_CONNECTION_PARAM_REQ
or LL_ CONNECTION_PARAM_RSP.

Sets the possible positions of the offset points of the LE connection. At these points,
you can update connection parameters relative to the reference connection event
count, see "Ref. Connection Event Count" on page 85.
"State" Enables the offset point state.
Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:
PCONfiguration:0FFSet<ch0>:STATe on page 185

"Offset(ms)" Sets the offset value.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:
PCONfiguration:0FFSet<ch0>:VALue on page 185

Reject Opcode
Requires option R&S SMM-K117 and packet type LL_REJECT_EXT _IND.

Sets the Opcode of a rejected control data PDU. For Opcode settings, see Table 2-7.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:ROPCode
on page 242

MaxRxOctets/MaxTxOctets
Requires option R&S SMM-K117 and packet types LL_LENGTH_REQ or
LL LENGTH_RSP.

Sets the maximum allowed payload length of a received packet (RX) or a transmitted
packet (TX).
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Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:MROCtets

on page 236

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:MTOCtets
on page 236

MaxRxTime/MaxTxTime

Requires option R&S SMM-K117 and packet types LL_LENGTH_REQ or
LL LENGTH_RSP.

Sets the maximum allowed time to receive (RX) a packet or to transmit (TX) a packet.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:MRTime

on page 237

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:MTTime
on page 237

TX PHYS/RX PHYS

Requires option R&S SMM-K117 and packet types LL_PHY_REQ or LL_PHY_RSP.

Sets preferred physical layers in receive direction (Rx) and transmit direction (Tx). For
permitted PHYs, see Table 2-9.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:L1M:
STATe on page 242

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:L2M:
STATe on page 242

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:
LCOD:STATe on page 242

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:L1M:
STATe on page 242

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:L2M:
STATe on page 242

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:
LCOD:STATe on page 242

M_TO_S_PHY/S_TO_M_PHY
Requires option R&S SMM-K117 and packet type LL_PHY_ UPDATE_IND.

Sets the physical layers of the Central-to-Peripheral (C_TO_P) direction and Periph-
eral-to-Central (P_TO_C) direction.

For available PHYs, see Table 2-9.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:
L1M:STATe on page 238

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:
L2M:STATe on page 238

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:
LCOD:STATe on page 238
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[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:
L1M:STATe on page 238

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:
L2M:STATe on page 238

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:
LCOD:STATe on page 238

PHYs
Requires option R&S SMM-K117 and packet type LL_MIN_USED_CHANNELS_IND.

Sets the physical layers for which the Peripheral device has a minimum used channels
requirement. See also "Min Used Channels" on page 87.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L1M:
STATe on page 241

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L2M:
STATe on page 241

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:LCOD:
STATe on page 241

Min Used Channels
Requires option R&S SMM-K117 and packet type LL_MIN_USED_CHANNELS_IND.

Sets the minimum number of channels to be used on the specified "PHYs" on page 87.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:MUCHannels
on page 238

ID(hex)
Requires option R&S SMM-K117 and packet type LL_PERIODIC_SYNC_IND.

Sets the ID of the identifier specified by the Host in the CtrData field. The value is in
hexadecimal representation.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:ID
on page 247

Syncinfo Configuration
Requires option R&S SMM-K117 and packet type LL_PERIODIC_SYNC_IND.

For related settings, see "Syncinfo/Syncinfo Configuration" on page 69 and Chap-
ter 5.3.5.5, "Synclinfo configuration settings", on page 73.

Connection Event Count
Requires option R&S SMM-K117 and packet type LL_PERIODIC_SYNC_IND.

Specifies the connEventCount field in the CtrData field.
The count value is specified within the following range:
currEvent - 2214 < connEventCount < currEvent+ 214

CurrEvent is the counter value for the connection event during transmission or retrans-
mission of the PDU.
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Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:CECount
on page 247

Last Pa Event Counter
Requires option R&S SMM-K117 and packet type LL_PERIODIC_SYNC_IND.

Sets the lastPaEventCounter field in the CtrData field.

The lastPaEventCounter value is typically equal to the PaEventCounter value in the
AUX_SYNC_IND PDU.

The values for lastPaEventCounter and EventCounter are as follows:

® [Equal values

® \Values with a difference of 1 (modulo 65536)

® Values representing LL_PERIODIC_SYNC_IND and AUX_SYNC_IND timing of
less than 5 seconds

Remote command:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:LPECounter

on page 248

SID(hex)
Requires option R&S SMM-K117 and packet type LL_PERIODIC_SYNC_IND.

Sets the SID field in the CtrData field. The value is in hexadecimal representation.

The SID is typically equal to the Advertising SID subfield of the advertising set pointing
to periodic advertising.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:SID
on page 249

Address Type
Requires option R&S SMM-K117 and packet type LL_PERIODIC_SYNC_IND.

Sets the address type in the CtrData field.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:ATYPe
on page 247

Sleep Clock Accuracy
Requires option R&S SMM-K117 and packet type LL_PERIODIC_SYNC _IND.

For related settings, see "Sleep Clock Accuracy" on page 79.

PHY
Requires option R&S SMM-K117 and packet type LL_PERIODIC_SYNC_IND.

Sets the PHY field in the CtrData field. The value is set in a hexadecimal representa-
tion.

The PHY information indicates the PHY type during periodic advertising. The selection
is exclusive; enabling one PHY disables the other enabled PHY.
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Remote command:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L1M:
STATe on page 248

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:PHY :L2M:
STATe on page 248

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:PHY:LCOD:
STATe on page 249

Advertiser's Device Addr
Requires option R&S SMM-K117 and packet type LL_PERIODIC_SYNC_IND.

For related settings, see "Advertiser's Device Addr" on page 64.

Sync Connection Event Counter
Requires option R&S SMM-K117 and packet type LL_PERIODIC_SYNC_IND.

Sets the event counter for the sync connection.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:SCECounter
on page 249

MinCTELenReq
Requires option R&S SMM-K117 and packet type LL_CTE_REQ.

Sets the minimum CTE length in the CtrData field.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:MCLReq
on page 248

CTETypeReq
Requires option R&S SMM-K117 and packet type LL_CTE_REQ.

Sets the 2-bit constant tone extension type in the CtrData field.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:CTReq
on page 219

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:MCLReq
on page 248

FeatureSet configuration settings

Option: R&S SMM-K117

Access:
1. In the "Channel" tab, select "Channel Type" > "Data".

2. Select a link layer control PDU that contains feature set information. These PDUs
are available for central or peripheral controllers.

3. For a central controller, proceed as follows:
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a) Select "Bluetooth Controller Role" > "Central".
b) Select "Packet Type" > "LL_FEATURE_REQ" or "LL_PERIPHERAL_FEA-
TURE_REQ".

For a peripheral controller, proceed as follows:

a) Select "Bluetooth Controller Role" > "Peripheral”.
b) Select "Packet Type" > "LL_FEATURE_RSP" or "LL_PERIPHERAL_FEA-
TURE_REQ".

Select "Event Configuration" > "Packet Configuration".

Select "Payload" > "FeatureSet Configuration”.

Bluetooth: FeatureSet Configuration

Opens a dialog to enable or disable features within the link layer control PDU. A
table lists all features that are available within the feature set of the PDU.

Settings:

FeatureSet configuration table
Displays available features within the link layer control PDU.

For configurable features, see the table Table 5-5. To enable the feature, select "Valid"
> "On" to the right of the feature.

Table 5-5: Link layer features: Bit number and feature

Bit | Link layer feature Bit | Link layer feature

0 LE encryption 14 | Channel selection algorithm #2

1 Connection parameter request procedure | 15 | LE power class 1

2 Extended reject indication 16 | Minimum Number of Used Channels procedure
3 Peripheral-initiated feature exchange 17 | Connection CTE request

4 LE ping 18 | Connectionless CTE response

5 LE data packet length extension 19 | Connectionless CTE transmitter

6 LL privacy 20 | Connectionless CTE receiver

7 Extended scanner filter policies 21 | Antenna switching during CTE transmission (AoD)
8 LE 2M PHY 22 | Antenna switching during CTE reception (AoD)
9 Stable modulation index - transmitter 23 | Receiving constant tone extensions

10 | Stable modulation index - receiver 24 | Periodic advertising Sync transfer - sender

1" LE coded PHY 25 | Periodic advertising Sync transfer - recipient
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Bit | Link layer feature Bit | Link layer feature
12 | LE extended advertising 26 | Sleep clock accuracy updates
13 | LE periodic advertising 27 | Remote public key validation

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:
FSBit<ch0>:STATe on page 234

5.4 CS subevent configuration

Option: R&S SMM-K178

Access:

1.

2
3
4.
5

For more information, refer to the Bluetooth Channel Sounding specification [2].

Select "Bluetooth" > "General".

Select "Bluetooth Mode" > "Bluetooth Low Energy".
Select "Channel".

Select "Channel Type" > "Channel Sounding".
Select "Cs Subevent Configuration".

The dialog provides settings to configure Channel Sounding subevents.

Settings:

SUDEVENT SEHINGS....eiiiiiiiiii s
L0 T T ol 0 1= I £= 1 o) SRR
CS seCUrity SEHINGS. ...t e

Channel selection settings
CS step configuration
CS step info

5.4.1 Subevent settings

Access:

1.

Select "Cs Subevent Configuration".
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2. Select "Subevent Settings".

Bluetooth: (S Subevent Configuration

Subevent ECE Channel Table | CS Security | Channel Selecﬂon

Subevent Length Subevent Interval
1250 ps pj
Step Scheduling Number of Subevents
Auto 1

150 ps 1 CS Step Config... | CS Step Info...

The tab provides settings to configure subevent settings.

Settings:

SUDEVENT LENGIN....eeiiiiiiie e e e e e e 92
SUDEVENT INTEIVAL ...t e e e e e 92
StEP SCHEAUING. ...eeeeieeiie et e st e e s enneeee s 93
NUMDBEr Of SUDEVENTS......eeeeiiieiiee et e e e e e 93
S T0] o1y =T ) =1 o] = PSS 93
RS T0] o1y 7=T o | P 94
N[0 0] o= ] (=T o 1SR 94
SUDEVENT SPACE (S).urtrrreeiiiieeeiii ittt et et e e e e e e se et ee e e e e e eeeeesessanbabrareeeeaaaeeessasannnrenes 94
B I L O T (1= TSRS 94
oo SR O S =T o1 SRS 94
CS StEP CONTIG.utttiiieiiitiee ettt e e e e e ab e e e 94
L2 TS (=T o TN [ 1 T USSR 94

Subevent Length
Sets the subevent length that is the duration of a CS subevent.

You can set values in multiples of 625 us. Settable subevent lengths depend on the
number of event intervals, the connection interval, the event offset and the subevent
interval.

For more information, refer to the Bluetooth Channel Sounding specification [2].

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:SLENgth on page 192

Subevent Interval

Sets the subevent interval. This interval is the time in multiples of 625 ps between the
beginning of a CS subevent and the beginning of the next CS subevent within the
same CS event.

For "Number of Subevents" = "1", the subevent interval is Ous. For "Number of Sube-
vents" higher than "1", settable subevent intervals depend on the number of event
intervals, the connection interval, the event offset and the subevent length.

For more information, refer to the Bluetooth Channel Sounding specification [2].

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:SINTerval on page 192
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Step Scheduling
Sets the CS step scheduling mode.

"Auto" Automatic CS step scheduling. The subevent length, the subevent
interval and the number of subevents are configurable.
The number of CS steps is 2.

"Manual" Manual CS step scheduling. The table Table 5-6 lists fixed CS param-
eters.

Table 5-6: CS parameters for manual step scheduling

Parameter Value
"Subevent Length" 1250 ps
"Subevent Interval" Opus
"Number of Subevents" 1
"Event Intervals" 2
"Connection Interval" 7.5ms
"Event Offset" 500 us

The number of CS steps is configurable.
For more information, refer to the Bluetooth Channel Sounding specification [2].

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS:SSCHeduling on page 193

Number of Subevents
Sets number of subevents. Settable values depend on the subevent interval.

For more information, refer to the Bluetooth Channel Sounding specification [2].

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:SNUMber on page 193

Subevent table
Lists properties and settings of all configured subevents in a table. The number of rows
equals the number of subevents.

CS Step Info...

1

CS Step Info...

CS Step Info...

The table allows you to check or configure the following parameters for each subevent
individually:

® "Subevent" on page 94

"Number of Steps" on page 94

"Subevent Space (us)" on page 94

"T_FCS (us)" on page 94

"Mode-0 Steps" on page 94

"CS Step Config" on page 94

"CS Step Info" on page 94
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Subevent

Displays the subevent number "Subevent x" within a subevent interval. "x" ranges from
0 to 31 depending on the number of subevents, see "Number of Subevents"

on page 93.

Remote command:
Via suffix SUBevent<ch>

Number of Steps

Sets or display the number of CS steps. Setting requires "Step Scheduling" > "Man-
ual". Settable minimum values are 1 or equal to the number of non-zero Mode-0 steps,
see "Mode-0 Steps" on page 94.

For more information, refer to the Bluetooth Channel Sounding specification [2].

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :NOSTep on page 193

Subevent Space (us)
Displays the subevent space in microseconds.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :SSPace? on page 194

T_FCS (us)
Sets the frequency change period (T_FCS) between consecutive CS steps. The period
ranges from 15 ys to 150 ps.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>]:TFCS on page 194

Mode-0 Steps
Sets the number of Mode-0 CS steps.

For "Step Scheduling”" > "Auto", the range is 1 to 3. For "Step Scheduling" > "Manual",
the range is 0 to 3. For non-zero Mode-0 CS steps ("Mode-0 Steps" # "0"), the mini-
mum number of CS steps equals the configured Mode-0 CS steps.

For more information, refer to the Bluetooth Channel Sounding specification [2].

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :MZSTeps on page 194

CS Step Config
Opens a dialog to configure CS steps, see Chapter 5.4.5, "CS step configuration”,
on page 99.

CS Step Info

Opens a dialog that provides information on configured CS steps per subevent in a
table, see Chapter 5.4.6, "CS step info", on page 108.
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5.4.2 Channel table

Access:
1. Select "CS Subevent Configuration".
2. Select "Channel Table".

Bluetooth: CS Subevent Conllgurutlon

Subevent Settings channeITabIe CS Security | Channel Selectlon

The tab lists general settings for all 78 Bluetooth LE channels in a table.

Settings:

(01 =T o =] ISP PPPPPRPPPPPN 95
Center FrequenCy (MHZ).....oooo it 95
(07 0= 1T T I [ aTo = G ST 96
L0 T T ol 0= I Y o TSR 96
Channel AlIOWE.........uuuiiiieiiiee et e e e e e e e e e e s e s beaeeeeeaaaeeesenaannnnnes 96
Channel

Displays the channel number that consists of "Channel" and the channel index.

For example, for "Channel 0" the channel index is 0 and the center frequency is
2402 MHz. See also Table 2-13.

Remote command:
Via suffix CHNNL<ch>

Center Frequency (MHz)
Displays the center frequency of the channel.

See also Table 2-13.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CTABle [ :CHANnel<chO0>] :CFRequency?
on page 204
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Channel Index
Displays the channel index of the channel.

See also Table 2-13.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CTABle [ : CHANnel<ch0>] :CINDex?
on page 205

Channel Type
Displays the channel type that is Channel Sounding for all channels.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CTABle [ :CHANnel<ch(0>] :CTYPe?
on page 205

Channel Allowed
Enables transmission of the subevent via the selected channel.

See also Table 2-13.
"Yes" Enables transmission of the subevent for the selected channel.
"No" Disables transmission of the subevent for the selected channel.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CTABle[:CHANnel<chO0>] :CALLowed
on page 205

5.4.3 CS security settings

Access:
1. Select "CS Subevent Configuration”.
2. Select "CS Security".

Bluetooth: (S Subevent Configuration

Subevent Settings [ Channel Table CSSecurlly Channel Selecﬂon

CS_IV_C (hex) CS cswP(hey ]
3E7F 5186 EOCA 0B3B E10B C28A OBFD DFE9
CS_IN
CS_IN_C (hex) CS_IN_P (hex)
8673 840D 9FF4 77C1
CS_PV
CS_PV_C (hex) CS_PV_P (hex)
64A6 7496 7868 F143 C980 DEDF 9882 ED44

The tab provides settings to configure CS security settings.

User Manual 1179.2054.02 — 07 96



R&S®SMM-K60/-K117/-K178 Bluetooth LE configuration and settings

CS subevent configuration

Settings:

(ORI LY O] (1Y TSP 97
LA T AV (1= T USSR 97
LGRS T | T O (1 T SEEUUR 97
OIS |V = (2 TS T PR 97
ORI e O (315 TSRS R PR 97
LRSI Y (1= PSR 97

CS_IV_C(hex)
Requires packet type CS SEQUENCE or LL_CS_SEC_REQ.

Sets the CS_IV_C parameter. The parameter is 64-bit in hexadecimal representation.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CIVC on page 206

CS_IV_P(hex)
Requires packet type CS SEQUENCE or LL_CS_SEC_RSP.

Sets the CS_|IV_P parameter. The parameter is 64-bit in hexadecimal representation.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CIVP on page 206

CS_IN_C(hex)
Requires packet type CS SEQUENCE or LL_CS_SEC_REQ.

Sets the CS_IN_C parameter. The parameter is a 32-bit in hexadecimal representa-
tion.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CINC on page 207

CS_IN_P(hex)
Requires packet type CS SEQUENCE or LL_CS_SEC_RSP.

Sets the CS_IN_P parameter. The parameter is a 32-bit in hexadecimal representation.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS:CINP on page 207

CS_PV_C(hex)
Requires packet type CS SEQUENCE or LL_CS_SEC_REQ.

Sets the CS_PV_C parameter. The parameter is 64-bit in hexadecimal representation.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CSPVc on page 208

CS_PV_P(hex)
Requires packet type CS SEQUENCE or LL_CS_SEC_RSP.

Sets the CS_PV_P parameter. The parameter is 64-bit in hexadecimal representation.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CPVP on page 208
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5.4.4 Channel selection settings

Access:
1. Select "CS Subevent Configuration”.

2. Select "Channel Selection".

Bluetooth: CS Subevent Configuration

Subevent Settings [ Channel Table | CS Security e ElT[=! Selecllon_

CSFilteredChM (hex) ChM_Repetition
0000 0000 0000 0000 0001

ChSel

Algorithm #Sbv

The tab provides settings to configure channel selection.

Settings:

CSFIEredCNM(NEX). ...ttt e e e e e e rre e e e e e e e e s e e s b e s beaaeeeeaaaeeas 98
(0 11/ I 2 =1 o 1= 111 o] o P PPN 98
L3 017 SRR 98
L0 1 10 Y =1 o 1R 99
L0 0 1 T 11 o T o P 99
CSFilteredChM(hex)

Displays the value of the field CSFilteredChM.

This value determines the bit map for the Channel Sounding channel map update pro-
cedure. The parameter is 64-bit in hexadecimal representation.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CFCHm? on page 208

ChM_Repetition
Sets the 3-bit ChM_Repetition field.

The value equals the number of cycles of the ChM field for non-Mode-0 CS steps
within a CS procedure.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CMRepetition on page 209

ChSel
Sets the algorithm to select the channels.

"Algorithm #3b"
Sets for Algorithm #3b channel selection algorithm.
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"Algorithm #3c"
Sets for Algorithm #3c channel selection algorithm.

Table 5-7: Algorithm #3c parameters

CSChannelJump seq1StartCh seq2StartCh maxRepsAllowed | saltRate
2 1 76 1 2
3 77 0 1 2
4 78 0 2 2
5 78 0 2 2
6 76 1 3 2
7 74 1 3 2
8 76 0 3 2

5.4.5

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CSEL on page 209

Ch3cShape
Requires "ChSel" > "Algorithm #3c".

Sets the bits of the Ch3cShape field. The field has a length of 4 bits and sets the shap-
ing method of the rising and falling ramps of the channels.

The resulting shapes are incorporated into a shuffled channel map so that they appear
random, preserving equal channel distribution qualities.

"Hat Shape" Channel with a rising ramp and a falling ramp.
"X Shape" Channel with interleaved rising and falling ramps.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CTCShape on page 210

Ch3cJump
Requires "ChSel" > "Algorithm #3c".

Determines the number of skipped channels when rendering the channel shapes. The
Ch3cJump field has a length of 1 octet and relates to the channel index values. See
also Table 5-7.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CTCJump on page 209

CS step configuration

Access:
1. Select "CS Subevent Configuration”.

2. Select "Subevent Settings" > "Subevent 0" > "CS Step Config...".
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CS subevent configuration

The "CS Step Config" tab of the "Structure for Subevent x" dialog opens.

The tab provides CS step settings for the first subevent "Subevent 0". If configured,
all following subevents share CS step configuration as subevent 0.

Settings:

®  General SEHINGS. ..o e 100
o  Mode-0 CoNfig SEINGS. .. uuueiiiiiieiee e e e 102
o  Mode-1 CoNfig SEHNGS.....uuiiiiiiiiiii e 102
o  Mode-2 CoNfig SELHNGS.....uueiiiiiiiiii e 104
o  Mode-3 CONfig SELINGS....uuuiiiiiiieee i a e e 106

General settings

Access:

» Select "CS Step Config" > "General".

Bluetooth: Structure for Subevent 0

CS Step Config

Main_Mode Sub_Mode General
Mode-1 None
Main_Mode_Max_Steps Main_Mode_Min_Steps Mode-0
Config
2 2
Main_Mode_Steps Main_Mode_Repetition
Config
1 0
Sub_Mode_Steps j -
0

The tab provides CS step general settings for each subevent.

Settings:

MaIN_MOAE......coiieeeee e e e e e e e e e e e e e e 100
RST8] o T 1/ o To [ SRR 101
Main_MOdE IMAX_ SEEPS...uiiiiiiieeiiiiciciiieiee et e e e e s e e e e e e e e e e e s s ebe b e e e e e eeaaeeeeseannns 101
Main_Mode Min_ SEEPS...coiiiiieiieier e aaaaa e 101
MaiN_MOAE  SEEPS. .. eeeiiieiiiie ettt e e e e e e e e e 101
Main_Mode Repetition...........o i 101
S0 o Y oo Y] (=T o LSRR 101
Main_Mode

Sets the main mode of the CS step.

"Mode-1" Mode-1 mode with no submode available.

"Mode-2" Mode-2 mode with submodes "Mode-1" and "Mode-3" available.
"Mode-3" Mode-3 mode with submode "Mode-2" available.

The table Table 5-8 provides an overview on available submodes per main mode.
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Table 5-8: CS step main modes and submodes

"Main_Mode" "Sub_Mode"

"Mode-1" "None"

"Mode-2" "None", "Mode-1", "Mode-3"
"Mode-3" "None", "Mode-2"

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :MMODe on page 195

Sub_Mode
Sets the submode of the main mode.

The table Table 5-8 provides an overview on available submodes per main mode.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] : SMODe on page 196

Main_Mode_Max_Steps
Sets the maximum number of main mode steps.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :MMASteps on page 196

Main_Mode_Min_Steps
Sets the minimum number of main mode steps.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :MMISteps on page 196

Main_Mode_Steps
Displays the number of main mode CS steps.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :MMSTeps? on page 197

Main_Mode_Repetition
Sets the main mode repetition.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :MMRepetition on page 197

Sub_Mode_Steps
Sets the number of submode CS steps.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>]:SMSTep? on page 197
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5.4.5.2 Mode-0 config settings

Access:

> Select "CS Step Config" > "Mode-0 Config".

Bluetooth: Structure for Subevent 0

CS Step Config

TJP] 7
145 ps

PREAMBLE CS Access Address Trailer ::::;-n

(1 octet) (4 octets) (4bits) g

e Mode-1

Config

T_SY T_SY T_FM »l
CS_SYNC_O_R CS Tone
T_RD+T_IP1 T_GD T_RD
Mode-0 Time = 2T_SY + 2T_RD(5 ps) + T_IP1(145ps) + T_GD(10 ps) + T_FM(80 ps) |

The tab provides Mode-0 CS step settings.
Settings:

T_IP1
Sets the time "T_IP1" for Mode-0 CS steps.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :MZERo: TIPO on page 197

5.4.5.3 Mode-1 config settings

Access:
1. Select "CS Step Config" > "General".

2. Select Mode-1 in the CS step main mode or submode:
e Select "Main_Mode" > "Mode-1".
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e Select "Main_Mode" > "Mode-2" and "Sub_Mode" > "Mode-1".

Bluetooth: Structure for Subevent 0

CS Step Config
T_IP1 Sequence Type
145 ps Sounding Sequence
Sequence Length
32 bits Config
Mode-1
PREAMBLE CS Access Address Trailer Sounding Sequence Config
(1 octet) (4 octets) (4 bits) ‘ (32bits)
CS_SYNC_1
T_RD + T_IP1 T_RD
Mode-1 Time = 2T_SY + 2T_RD(5 ps) + T_IP1(145ps) J
The tab provides Mode-1 CS step settings.
Settings:
T P ettt ettt ee et e reee et s e et seesereneed 103
SeQUENCE LENGIN...cciiiiii e e 103
Y= Yo (U= Lot Y o LT PPUPPRRRPIINt 103
User Payload Pattern............oooiiiiiiecccie it 104
SeleCt Data List.....cooeiiiiiiieeee e 104
T_IP1

Sets the time "T_IP1" for Mode-1.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :MONE: TIPO on page 197

Sequence Length
Sets the sequence length. The length is discrete and depends on the sequence type.

Sequence type Sequence length
Sounding sequence 32 bits, 96 bits
Random sequence 32 bits, 64 bits, 96 bits and 128 bits

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] : SEQLength on page 199

Sequence Type
Sets the sequence type.

"Sounding Sequence"
Sounding sequence

"Random Sequence"
Random sequence

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :STYPe on page 199
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User Payload Pattern

Displaying the parameter "User Payload Pattern" requires the following:

® "Packet Type" > "TEST PACKET".

® "Main_Mode" > "Mode-1" or "Mode-3".
"Sub_Mode" > "Mode-1" or "Mode-3".

® |n the "Mode-1 Config" or "Mode-3 Config", select "Sequence Type" > "Random
Sequence".

Sets a predefined pattern or user-defined data list as the data source for the user pay-
load.

"PRBS 9 sequence"/"PRBS 15 sequence”
Pseudo random bit sequences of the length 9 or 15 - transmission of
identical packet series.

Predefined pattern
"Repeated 11110000 sequence", "Repeated 10101010 sequence”,
"Repeated 11111111 sequence", "Repeated 00000000 sequence”,
"Repeated 00001111 sequence" or "Repeated 01010101 sequence”

"Use CS_SYNC_User_Payload"
Selects binary data from a user-defined data list file, see "Select Data
List" on page 104.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :UPPattern on page 200

Select Data List
Requires "User Payload Pattern" > "Use CS_SYNC_User_Payload".

See "Data Source" on page 65.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :UPAYload on page 199

Mode-2 config settings

Access:
1. Select "CS Step Config" > "General".

2. Select Mode-2 in the CS step main mode or submode:
e Select "Main_Mode" > "Mode-2".
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e Select "Main_Mode" > "Mode-3" and "Sub_Mode" > "Mode-2".

Bluetooth: Structure for Subevent 0 —_ X

0 ps 1
T_PM TIP2 Mﬂdfefﬂ
40 us 145 ps | Il

Mode-2
Config
(T_SW +T_PM)*(N_AP +1) e—— (T_SW +T_PM)*(N_AP +1)
CS Tone
T_RD + T_IP2 T_RD
Mode-2 Time = 2[T_SW(0 ps) + T_PM(40 ps)]*[N_AP(1) + 1] + 2T_RD(5 ps) + T_IP2(145ps) J
The tab provides Mode-2 CS step settings.
Settings:
IS 1A SRR 105
I SO PP PO P PP PPPPPPPN 105
B USSP PPPPPPP 105
N L PP PP 105
T_SW

Sets the time "T_SW" for Mode-2.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :MTWO:TSW? on page 198

N_AP
Sets the number of antenna path in the N_AP field.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :MTWO:NAP? on page 198

T_PM
Sets the time "T_PM" for Mode-2.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :MTWO: TPM on page 198

T_IP2
Sets the time "T_IP2" for Mode-2 CS steps.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :MTWO:TIPT on page 199
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5.4.5.5 Mode-3 config settings

Access:
1. Select "CS Step Config" > "General".

2. Select Mode-3 in the CS step main mode or submode:
e Select "Main_Mode" > "Mode-3".
e Select "Main_Mode" > "Mode-2" and "Sub_Mode" > "Mode-3".

e Step Conﬁg _

TsW N_AP
0 ps 1
T_PM T_IP2 Mﬂde*D
40 us 145 ps | Il

Bluetooth: Structure for Subevent 0 X

Sequence Type Sequence Length :;"o":;'!l
Sounding Sequence 32 bits 9
PREAMBLE CS Access Address Trailer Sounding Sequence
(1 octet) (4 octets) (4 bits) (32bits) :
[{T_SW +T_PM)*(N_AP +1),| e T_SY
CSTone CS_SYNC_3_R
_RD+T_IP T_GD

Mode-3 Time = 2(T_SY + T_GD(10 ps)) + 2[T_SW(0 ps) + T_PM(40 ps)]*[N_AP(1) + 1]+ 2T_RD(5 ps)+ T_IP2(145us)

The tab provides Mode-3 CS step settings.

Settings:

LS A PSPPSR PPPRPTPN 106
N I TP U UPPUUPRTRPPR 106
L USSR 107
L 2SS 107
SeqUENCE LENGN....ooii e 107
S TeTo (0= et Y/ o1 TSP UPR PRSP 107
User Payload Pattern............oooeiiiiiiiiicrre i e e 107
S T= =T QI = = N R S SRR 108
T_SW

Sets the time "T_SW" for Mode-3.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :MTHRee: TSW? on page 198

N_AP
Sets the "N_AP".

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :MTHRee :NAP? on page 198

User Manual 1179.2054.02 — 07 106



R&S®SMM-K60/-K117/-K178 Bluetooth LE configuration and settings

CS subevent configuration

T_PM
Sets the time "T_PM" for Mode-3.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :MTHRee: TPM on page 198

T_IP2
Sets the time "T_IP2" for Mode-3.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :MTHRee: TIPT on page 199

Sequence Length
Sets the sequence length. The length is discrete and depends on the sequence type.

Sequence type Sequence length
Sounding sequence 32 bits, 96 bits
Random sequence 32 bits, 64 bits, 96 bits and 128 bits

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] : SEQLength on page 199

Sequence Type
Sets the sequence type.

"Sounding Sequence"
Sounding sequence

"Random Sequence"
Random sequence

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] : STYPe on page 199

User Payload Pattern

Displaying the parameter "User Payload Pattern" requires the following:

® "Packet Type" > "TEST PACKET".

® "Main_Mode" > "Mode-1" or "Mode-3".
"Sub_Mode" > "Mode-1" or "Mode-3".

® |n the "Mode-1 Config" or "Mode-3 Config", select "Sequence Type" > "Random
Sequence".

Sets a predefined pattern or user-defined data list as the data source for the user pay-
load.

"PRBS 9 sequence"/"PRBS 15 sequence"
Pseudo random bit sequences of the length 9 or 15 - transmission of
identical packet series.

Predefined pattern
"Repeated 11110000 sequence", "Repeated 10101010 sequence”,
"Repeated 11111111 sequence", "Repeated 00000000 sequence”,
"Repeated 00001111 sequence" or "Repeated 01010101 sequence”
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5.4.6

5.4.6.1

CS subevent configuration

"Use CS_SYNC_User_Payload"
Selects binary data from a user-defined data list file, see "Select Data
List" on page 104.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :UPPattern on page 200

Select Data List
Requires "User Payload Pattern" > "Use CS_SYNC_User_Payload".

See "Data Source" on page 65.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :UPAYload on page 199

CS step info

Access:
1. Select "CS Subevent Configuration”.

2. Select "Subevent settings" > "CS Step Config".
The "CS Step Config" dialog opens.

The dialog provides CS step settings for each subevent.

Settings:

Step table

Access:

» Select "CS Step Info" > "Step Table".

Bluetooth:Subevent 0 Step Info

1D56 EC36

The tab provides the step table that lists the properties and settings for individual
CS steps per subevent. The number of rows equals the number of CS steps per
subevent. The table allows you to check or configure the following settings for each
CS step.
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Settings:

R =T o PP UPP PP 109
/0o [T 1Y/ o T T SSEPRR 109
(07 0= 1o 1o =Y I [0 To 1= PRSP 110
CS ACCESS AQAIMESS. ... uveiiieiitiiiie ettt e e see e e s s eee e e s st e e e s sat e e e e sasseeeesaanseaeeeeanseeeeean 110
Sounding Sequence Content/Random Sequence Content............coooiiiiiiiiiiiieeeneennn. 110
ComPANIoN SIGNAL........coiiiiiiiei e a e 110
L3S TN o T =T o PSR 112
Step

Displays the number of the CS step "Step x". "x" depends on the number of main mode
steps, see "Main_Mode_Steps" on page 101.

Remote command:
Via suffix STEP<st0>

Mode Type
Displays the mode type for individual CS steps.

The displayed mode type depends on the number of Mode-0 CS steps and the config-
ured main mode in the CS step configuration. See "Mode-0 Steps" on page 94 and
"Main_Mode" on page 100.

Example:

This example assumes manual step scheduling for one subevent with three CS steps
and one mode-0 step. The CS step main mode is mode-3. Set as follows:

"Step Scheduling”" > "Manual", "Number of Subevents" = "1", "Number of Steps" = "3",
"Mode-0 Steps" = "1" and "Main_Mode" > "Mode-3".

Step Scheduling Number of Subevents
Manual 1

50 ps 1 CS Step Config... | CS Step Info...

Select "CS Step Info..." to open the CS step table. The table displays the information
for three CS steps. The first step "Step 0" has the "Mode Type" > "Mode-0". The sec-
ond step "Step 1" and the third step "Step 2" have the "Mode Type" > "Mode-3"

Bluetooth:Subevent 0 Step Info

1D56 EC36

1D56 EC36

0000 D000

0 1D56 EC36 0000 D000 None off

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch(0>] [ :STEP<st(0>] :MTYPe?
on page 201

User Manual 1179.2054.02 — 07 109



R&S®SMM-K60/-K117/-K178 Bluetooth LE configuration and settings

CS subevent configuration

Channel Index
Sets or displays the channel index for individual CS steps.

Setting the index requires "Step Scheduling" > "Manual"
See also Table 2-13.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] [:STEP<st(0>] :CINDex
on page 202

CS Access Address
Sets or displays the 32-bit CS access address for individual CS steps.

Setting the address requires "Step Scheduling" > "Manual”

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] [ : STEP<st0>] : CAADdress
on page 202

Sounding Sequence Content/Random Sequence Content
Displays the 128-bit content of a sounding sequence or a random sequence. The con-
tent depends on the subevent mode.

For CS test packets, you can set the content for a sounding sequence and random
sequence, see "Sequence Type" on page 103.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch(0>] [:STEP<st(0>] : SCONtent
on page 202

Companion Signal
Sets the companion signal and the data source.
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"Companion Signal"

User Manual 1179.2054.02 — 07

Enables or disables the companion signal. This signal consists of one
or two signals that deviate symmetrically from the carrier frequency of
the wanted signal.

The carrier frequency is the center frequency of the channel that
relates to the channel index, see "Channel Index" on page 110.

You can select between the following values:

® "None"
Disables the companion signal.

e "2""2"["-2 and 2"
Requires "Packet Format" > "LE 1M".
Enables the companion signal with a deviation of -2 MHz or
2 MHz from the carrier frequency of the wanted signal. "-2 and 2"
enables two companion signals that deviate symmetrically from
the carrier by 2 MHz.

o "4"["4"["-4 and 4":
Requires "Packet Format" > "LE 2M" or "LE 2M 2BT".
Enables the companion signal with a deviation of -4 MHz or
4 MHz from the carrier frequency of the wanted signal. "-4 and 4"
enables two companion signals that deviate symmetrically from
the carrier by 4 MHz.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] [:
STEP<st0>] :CSIGnal on page 203
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"Data Source" Requires "Companion Signal" # "None".
Selects the data source.

The following standard data sources are available:

e Al O"/"All 1"

An internally generated sequence containing 0 data or 1 data.
® "PNxx"

An internally generated pseudo-random noise sequence.
® "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern” box to set the bit pattern.
e "Data List"/"Select Data List"

Binary data from a list file, internally or externally generated.

Select "Select Data List" to open the standard "Select List" dialog.

The dialog lists file with file extension *.dm iqgd if existing.

— Navigate to the list file and tap "Select" to select the file.

— Use the "New" and "Edit" functions to create a data list inter-
nally or to edit an existing one.

— Use the standard "File Manager" function to transfer external
data lists to the instrument.

See also:

® Section "About data signals" in the R&S SMM100A user manual.

® Section "File and data management” in the R&S SMM100A user
manual.

® Section "Data list editor" in the R&S SMM100A user manual.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] : DATA

on page 203

[ :SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :PATTern
on page 204

[ :SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :DLISt
on page 203

CS Tone Ext.
Displaying the CS tone extension requires the following:
® "Step Scheduling" > "Manual".
® "Number of Steps" higher than "Mode-0 Steps"
For example, "Number of Steps" = "2", "Mode-0 Steps" ="1".
® "Main_Mode" > "Mode-2" or "Mode-3"

Enables CS tone extension for mode-2 and mode-3 CS steps.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] [ :STEP<st0>] :CTEXtension
on page 204

5.5 CS control data payload settings

Option: R&S SMM-K178
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Access:
1. Select "Packet Configuration".

2. Select "Payload".

Bluetooth: Packet Configuration

Mode_Types @l RTT_capability . CpbData 1
Mode-3 0
RTT_AA_Only | RTT_Sounding_N T CpbData 2
150ns Ons
RTT_Random_Sequence_N G‘ NADM_Sounding_Capability CpbData 3
Ons No-NADM |
NADM_Random_Sequence_Capability CS_SYNC_PHY_Capability j
No-NADM | LE 2M
Num_Ant Max_Ant_Path
1 1
Role . .
nitiator Companion_Signal []

The tab provides settings to configure the packet/PDU payload.

o CS security payload SEtiNgS........occuueiiiiiiiiiie e 113
e CS capabilities payload Settings.......cccuurriiiiiieie i 113
e CS configuration payload Settings..........cccciiiiiiiiiiii e 119
® CS payload SEtiNGS......cccoiiiieeeee e e e e e 122
® CS IND payload SEttNGS. .. cueeriaeaieiiieeee et a e 126
e CS terminate payload SEttNGS. .. . cuririiiiiiiii e 128
o CS FAE payload SettiNgS......oocuueiiiiiiiiiei et 128
e CS channel map payload SettingsS........ccuuiiiiiiiiiiiii e 129

5.5.1 CS security payload settings

For packet type LL_CS_SEC _REQ and LL_CS_SEC_RSP, the "Payload" tab provides
CS security settings. The table below lists available CS security settings per LL Control

PDU.

LL Control PDU CS security settings

LL_CS_SEC_REQ "CS_IV_C(hex)", "CS_IN_C(hex)", "CS_PV_C(hex)"
LL_CS_SEC_RSP "CS_IV_P(hex)", "CS_IN_P(hex)", "CS_PV_P(hex)"

For related settings, see Chapter 5.4.3, "CS security settings", on page 96.
5.5.2 CS capabilities payload settings

For packet type LL_CS CAPABILITIES REQ and LL_CS CAPABILITIES_RSP, the
"Payload" tab provides the following settings.
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5.5.2.1

CS control data payload settings

Settings:

®  CpbData 1 SELNGS.....eiiiiiiiiiiiie it 114
o CpbData 2 SetliNgS......coii e ——————— 116
o CpbData 3 SetliNgS.......cocc i 117

CpbData 1 settings

Y (oo [T Y/ o 1= T PO P P PP PP 114
I I O7= T o= 1 o1 1 78S 114
I Y N © ] o |2 SRR 114
IS To T g T 1 T T N PO USSP 115
RTT_Random_Sequence N.... ..ot a e e 115
NADM_Sounding_ Capability.......cccueueeeeieiiiiieeee e 115
NADM_Random_Sequence Capability.........cccceeeiiiiiicciiiiiiiiieeee e a e 115
CS_SYNC _PHY _Capability........uuueeeieeeiiiiiiiciiiiiiieeeeee e e s sessvenreeeee e e e e e e e s s sssnnssnseeeeees 115
[N T T g TN 0 ) S 115
MaX_ANE Path....coeeecece e e e e e e ————— 115
0 ][RP 116
(070 gaT oY= T1] o TS T [ - SR 116
Mode_Types

Displays the LL Control packet mode type that is Mode-3.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:MTYPe? on page 258

RTT_Capability

Sets the bits in the RTT_Capability field.

These bits determine the time values for the RTT_AA_Only_N field, the RTT_Sound-
ing_N field and the RTT_Random_Sequence_N field. See the table Table 5-9 for an
overview.

Table 5-9: RTT_Capability bit numbers and RTT fields

"RTT_Capability" "RTT_AA_Only" "RTT_Sounding_N" | "RTT_Random_Sequence_N"
0 150ns, 10ns, Ons Ons Ons

1 Ons 150ns, 10ns, Ons Ons

2 Ons Ons 150ns, 10ns, Ons

Remote command:

[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:RCAPability on page 262

RTT_AA_Only

Displays or sets the time values of the RTT_AA_Only N field.

Setting the value depends on the bits of the RTT_Capability field. See the table
Table 5-9 for an overview.

Remote command:

[ : SOURce<hw>] :BB:BTOoth:CS:CDATa:RAONLy on page 262
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RTT_Sounding_N
Displays or sets the time values of the RTT_Sounding_N field.

Setting the value depends on the bits of the RTT_Capability field. See the table
Table 5-9 for an overview.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:RSOunding on page 265

RTT_Random_Sequence_N
Displays or sets the time values of the RTT_Random_Sequence_N field.

Setting the value depends on the bits of the RTT_Capability field. See the table
Table 5-9 for an overview.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS:CDATa:RRSequence on page 265

NADM_Sounding_Capability
Sets the NADM sounding sequence capability.

"No-NADM" NADM disabled
"NADM" NADM enabled

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:NSCapability on page 260

NADM_Random_Sequence_Capability
Sets the NADM random sequence capability.

"No-NADM" NADM disabled
"NADM" NADM enabled

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:NRSCapability on page 260

CS_SYNC_PHY_Capability
Displays the value of the CS_SYNC_PHY_Capability field that is the LE 2M PHY.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS:CDATa:CSPCapability? on page 267

Num_Ant
Sets the bits of the Num_Ant field. This field indicates the number of antenna elements
of the Channel Sounding device.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:NANT on page 259

Max_Ant_Path
Sets the maximum Num_Ant paths.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:MAPath on page 256
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5.5.2.2

CS control data payload settings

Role
See "Role" on page 50.

Companion_Signal
Enables the companion signal.

See also "Companion Signal" on page 110.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:CSIGnal on page 256

CpbData 2 settings

N o T o = SRR 116
Channel Selection Algorithm #3C.......cooii i 116
7o 0] ale [1aTe T = O I =51 110 = (- TR 116
RS 117
NN 103 @ T 1 SR 117
Max_Procedures SUPPOMEd.........ooie it e e e e e e e e e 117
IS 1L PSR 117
No_FAE

Sets the No_FAE bit. This bit indicates if the transmitting LE device supports a frac-
tional frequency offset actuation error (FAE) or not.

"On" No_FAE bit is 1. The transmitting LE device only supports an FAE of
zero.
"Off" No_FAE bit is 0. The transmitting LE device supports FAE values as

listed in an FAE table.
See also "Channel FAE Table" on page 129.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS:CDATa:NFAE on page 259

Channel Selection Algorithm #3c
Enables the channel selection algorithm #3c.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS:CDATa:CSAThreec on page 255

Sounding_PCT_Estimate
Sets the Sounding_PCT_Estimate bit. This bit indicates if the device supports phase
correction term (PCT) estimates from a sounding sequence or not.

"On" The Sounding_PCT_Estimate bit is 1. The device supports PCT esti-
mates from a sounding sequence.
"Off" The Sounding_PCT_Estimate bit is 0. The device does not support

PCT estimates from a sounding sequence.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:SPEStimate on page 266
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5.5.2.3

CS control data payload settings

RFU
Sets the bits that are reserved for future use (RFU).

The number of RFU bits can vary depending on the CS_Control_Data PDU.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:RFU on page 263

Num_Configs
Sets the Num_Configs field that relates to the number of independent CS configura-
tions.

This number equals the CS configurations supported by the link layer transmitting this
PDU for this specific ACL connection.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS:CDATa:NCONfig on page 259

Max_Procedures_Supported
Sets the bits in the Max_Procedures_Supported field.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:MPSupported on page 258

T_SW
Sets the T_SW field values that relate to the duration of the antenna switch period.

The local controller uses this period when switching antennas during active transmis-
sions.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS:CDATa: TSW on page 264

CpbData 3 settings

Show T_IP1 Capability Table/Hide T_IP1 Capability Table...........ccovvveecciriiiinreneennn. 117
T_IP1_Capability TADIE.......ccueeee ettt e e e e e 117
Show T_IP2 Capability Table/Hide T_IP2 Capability Table...........ccceeveeciiviieeeeeneeennn. 118
LI A = o= o 11§V =T o) = TR 118
Show T_FCS Capability Table/Hide T_FCS Capability Table...........cccccvvviiiivicannnn. 118
T_FCS_Capability TaDIE........cccueeeieeiciieii et e e e e e snree e e e neeas 118
Show T_PM Capability Table/Hide T_PM Capability Table..........ccooviiieceiiiiienenennen. 118
LI VB 0= T = o1 1 Y =T o = PR 119

Show T_IP1 Capability Table/Hide T_IP1 Capability Table
Shows or hides the "T_IP1_Capability Table".

The table provides settings to enable T_IP1 capability for bit positions that relate to
eight T_IP1 times. See also "T_IP1" on page 102.

T_IP1_Capability Table
The table provides settings to enable the T_IP1 capability including the T_IP1 time per
bit position. You can enable T_IP1 capabilities for bit position 0 to bit position 7.

"Bit Position" Displays the bit position.
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"T_IP1" Displays the T_IP1 time of the bit position.
"T_IP1 Capability"
Enables the T_IP1 capability per bit position.
Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa[:BPOSition<ch0>]:TIPO:
CAPability on page 253

Show T_IP2 Capability Table/Hide T_IP2 Capability Table
Shows or hides the "T_IP2_Capability Table".

The table provides settings to enable T_IP2 capability for bit positions that relate to
eight T_IP2 times. See also "T_IP2" on page 105.

T_IP2_Capability Table
The table provides settings to enable the T_IP2 capability including the T_IP2 time per
bit position. You can enable T_IP2 capabilities for bit position 0 to bit position 7.
"Bit Position" Displays the bit position.
"T_IP2" Displays the T_IP2 time of the bit position.
"T_IP2 Capability"
Enables the T_IP2 capability per bit position.
Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa [ :BPOSition<ch0>]:TIPT:
CAPability on page 253

Show T_FCS Capability Table/Hide T_FCS Capability Table
Shows or hides the "T_FCS_Capability Table".

The table provides settings to enable T_FCS capability for bit positions that relate to 10
T _FCS times. See also "T_FCS (us)" on page 94.

T_FCS_Capability Table
The table provides settings to enable the T_FCS capability including the T_FCS time
per bit position. You can enable T_FCS capabilities for bit position 0 to bit position 9.

"Bit Position" Displays the bit position.
"T_FCS" Displays the T_FCS time of the bit position.

"T_FCS Capability"
Enables the T_FCS capability per bit position.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa [ :BPOSition<ch0>] :TFCapability
on page 253

Show T_PM Capability Table/Hide T_PM Capability Table
Shows or hides the "T_PM_Capability Table".

The table provides settings to enable T_PM capability for bit positions that relate to
three T_PM times. See also "T_PM" on page 105.
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T_PM_Capability Table
The table provides settings to enable the T_PM capability including the T_PM time per
bit position. You can enable T_PM capabilities for bit position 0 to bit position 2.

"Bit Position" Displays the bit position.
"T_PM" Displays the T_PM time of the bit position.

"T_PM Capability"
Enables the T_PM capability per bit position.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa [ :BPOSition<ch(0>] :TPCapability
on page 254

5.5.3 CS configuration payload settings

For packet type LL_CS_CONFIG_REQ and LL_CS_CONFIG_RSP, the "Payload" tab
provides the following settings.

Settings:

o CfgData 1 SEtiNGS....cccii i 119
o CfgData 2 SEtiNGS....ccceii i ———— 121
o CfgData 3 SetiNgS...uccceii i ————— 122

5.5.3.1 Cfg Data 1 settings

1070 11 {o [ |5 2SRRI 119
R 2= | L= TP 119
107 011V =T o T=Y 111 o TP 120
= 10 T Y/ T Yo [ TSR 120
RST8] o T 1/ T [ R 120
Main_Mode_Min_SEEPS........eiiiiiiiiiiee e e e 120
Main_MOdE IMAX_ SEEPS...uuiiiiiieeiiiiicictiiietiee et e e e e e e sserrrrr e e e e e e e e s e e e s snrnr e e ereeeaaaeeeseennnns 120
Main_Mode _RePetitioN......cccoooeiiiii e ———— 120
Y oTe LR OS] (=T o1 TP UPUPPPP PN 120
I SRR 120
I R 5/ =S 121
] = 121
Config_ID

Sets the 6-bit Config_ID field that is the CS configuration ID. Settable ID values are 2
bits in decimal representation. All other values are for future use.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:CID on page 255

State
Enables the CS configuration ID, see "Config_ID" on page 119.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS:CDATa:CCID: STATe on page 255
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ChM_Repetition
Sets the 3-bit ChM_Repetition field.

The value equals the number of cycles of the ChM field for non-Mode-0 CS steps
within a CS procedure.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CMRepetition on page 209

Main_Mode

Sets the main mode of the CS control PDU.

"Mode-1" Mode-1 mode with no submode available.

"Mode-2" Mode-2 mode with submodes "Mode-1" and "Mode-3" available.
"Mode-3" Mode-3 mode with submode "Mode-2" available.

For an overview on available submodes per main mode, see Table 5-8.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:MMODe on page 257

Sub_Mode
Sets the submode of the main mode.

For an overview on available submodes per main mode, see Table 5-8.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa: SMODe on page 267

Main_Mode_Min_Steps
Sets the minimum number of main mode steps.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS:CDATa:MMISteps on page 257

Main_Mode_Max_Steps
Sets the maximum number of main mode steps.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:MMASteps on page 257

Main_Mode_Repetition
Sets the main mode repetition.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:MMRepetition on page 257

Mode_0_Steps
Sets the number of Mode-0 steps.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:MZSTeps on page 258

PHY
Displays the PHY field value that is also the packet format.
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This value indicates the TX PHY of the remote device, to which the Pwr_Delta field in

this PDU applies.
See also "Packet Format" on page 48.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:PHY? on page 261

RTT_Type

Selects the RTT type determined by the 4-bit RTT_Type field. This field indicates the

round trip time (RTT) variant within the CS
an overview.

Table 5-10: RTT_Type and RTT variant

procedure. The table Table 5-10 provides

RTT_Type value RTT variant <RttType>
0x00 RTT CS Access Address only timing RAAOT

0x01 RTT with 32-bit sounding sequence R32SS

0x02 RTT with 96-bit sounding sequence R96SS

0x03 RTT with 32-bit random sequence R32RS
0x04 RTT with 64-bit random sequence R64RS

0x05 RTT with 96-bit random sequence RI6RS

0x06 RTT with 128-bit random sequence R128RS

All other Reserved for future use. RAAOT

Remote command:

[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:RTYPe on page 263

Role

Selects the CS role, see "Role" on page 50.

Cfg Data 2 settings

Companion_Signal
Enables the companion signal.

See also "Companion Signal" on page 110.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:CSIGnal on page 256
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5.5.3.3

5.5.4

CS control data payload settings

RFU
Sets the bits that are reserved for future use (RFU).

The number of RFU bits can vary depending on the CS_Control_Data PDU.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:RFU on page 263

ChSel
See "ChSel" on page 98.

T_IP1
See "T_IP1" on page 102.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa: TIONe on page 264

T_IP2
See "T_IP2" on page 105.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:TITWo on page 264

T_FCS
See "T_FCS (ps)" on page 94.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:TFCS on page 263

T_PM
See "T_PM" on page 105.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa: TPM on page 264

Cfg Data 3 settings

Show Channel Table/Hide Channel Table
Shows or hides the channel table. For related settings, see Chapter 5.2.3, "Channel
table settings", on page 56.

Remote command:
n.a.

CS payload settings

For packet type LL_CS REQ and LL_CS_RSP, the "Payload" tab provides the follow-
ing settings.
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Settings:

(070] 11 {To [ | 2P PPUPUPRN 123
SRR 123
oTo a1 a1 =AY =T o1 {07 o]0 ] o | S SRR 123
L0 1 £5T=Y A /1 123
L0111 A 1 = S 124
MaX _ProCedure LeN.........cooo oottt e e e e e e e e e e 124
EVENE INTEIVAL ... e e e e e e e e e e e e e e 124
SUDEVENT Per EVENL....oiiiiiiiii it e e e e e nnnenee 124
SUDEVENT INTEIVAL.....uiiiiiiiieeie e e e e e e e e e e e e e s e e eannenes 124
ST o TSAZ=T o =Y o 1 125
Procedure INTErval...... .ot e e e —————— 125
Procedure COUNL..........ooo i e e e e e e e e e e e e e s e e e eaaaaas 125
SRR 125
o o PR 125
Preferred _Peer ANt e e e s 125
T 10 = | = TR 126
Config_ID

Sets the 6-bit Config_ID field that is the CS configuration ID. Settable ID values are 2
bits in decimal representation. All other values are for future use.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:CID on page 255

RFU
Sets the bits that are reserved for future use (RFU).

The number of RFU bits can vary depending on the CS_Control_Data PDU.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:RFU on page 263

connEventCount
Sets the 16-bit connEventCount field bits in a hexadecimal representation.

The connEventCount field sets a connection event counter value that meets the follow-
ing requirement:
currEvent — 2'* < connEventCount < currEvent + 2% (mod 65536)

The currEvent parameter is the counter value for the connection event for PDUs that
transmit or retransmit this field. The currEventCount value is greater than the currEvent
value of the event that transmits the LL_CS_ REQ PDU first.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:CECount on page 255

Offset_Min
Sets the time value of the Offset_Min field. The value has a length of 3 octets or 9 bits.

The field corresponds to the proposed minimum time (us) from the ACL anchor point of
a certain connection event to the start of the first CS subevent. The connEventCount
field references this connection event.
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The Offset_Min time value is greater than or equal to 500 ys and less than 4 s.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:OMIN on page 260

Offset_Max
Sets the time value of the Offset_Max field. The value has a length of 3 octets or 9 bits.

The field corresponds to the proposed maximum time between the ACL anchor point
and the offset of the first CS step of the first CS subevent. The anchor point marks a
certain connection event.

The Offset_Max time value is in microseconds. The value is greater than or equal to
the Offset_Min value and is less than the LE connection interval.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS:CDATa: OMAX on page 260

Max_Procedure_Len
Sets the time value of the Max_Procedure_Len field. The value has a length of 2 octets
or 6 bits.

The Max_Procedure_Len field is the proposed maximum extent of the entire CS proce-
dure in units of 625 ps. This value is equivalent to the time extent from the beginning of
the transmission of the first CS step to the end of the transmission of the final CS step.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS:CDATa:MPLength on page 258

Event_Interval
Sets the 16-bit Event_Interval field, see "Event Intervals/Event_Interval" on page 50.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:EINTerval on page 190

Subevent_Per_Event
For packet type LL_CS_REQ, displays the number of subevents per event.

For packet type LL_CS_ RSP, sets the number of subevents per event.

The Subevents_Per_Event field indicates the number of CS subevents in each CS
event.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa: SNUMber on page 266

Subevent_Interval
Sets or displays the subevent interval. Setting requires "Subevent Per_Event" * "1".
For "Subevent_Per_Event" = "1", the subevent interval is 0 ps.

The subevent interval is the time gap, in units of 625 us, between the start of two con-
secutive CS subevents. These subevents start from the same LE anchor point.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:SINTerval on page 265
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Subevent_Len
Sets the subevent length in the Subevent_Len field. The value has a length of 3 octets
or 9 bits.

The Subevent_Len field implies the maximum duration of each CS subevent in micro-
seconds. It is greater than or equal to 1250 us and less than 4 s.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa: SLENgth on page 266

Procedure_Interval
Sets the procedure interval in the Procedure_Interval field. The value has a length of 2
octets or 6 bits.

The Procedure_Interval field implies the time in units of connection intervals between
the start of consecutive CS procedures.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS:CDATa: PINTerval on page 262

Procedure_Count
Sets the bits in the Procedure_Count field. The value has a length of 2 octets.

The Procedure_Count field implies the number of consecutive CS procedures to
invoke. A value of 0 indicates that CS procedures continue to be invoked until they ter-
minate.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa: PCOunt on page 261

ACI
Sets the antenna configuration index (ACI) field. The value has a length of 1 octet or 0
to 7 in decimal representation.

The ACI field indicates the preferred ACI to use in the CS procedure.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:ACI on page 254

PHY
See "PHY" on page 120.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa: PHY? on page 261

Preferred_Peer_Ant
Sets the bits in the Preferred_Peer_Ant field. The value has a length of 1 octet or 3
bits.

The Preferred_Peer_Ant field is a bit-mapped field and indicates the preferred peer-
ordered antenna elements. The peer uses these elements for the antenna configura-
tion as in the ACI field.

The table Table 5-11 lists all possible values and their meaning.
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Table 5-11: Preferred_Peer_Ant field values

Bit number Description <PrePeerAnt>
0 Use the first ordered antenna element ANTO

1 Use the second ordered antenna element ANT1

2 Use the third ordered antenna element ANT2

3 Use the fourth ordered antenna element ANT3

All other bits Reserved for future use -

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa: PPANtenna on page 262

Pwr_Delta
Sets the bits in the Pwr_Delta field. The value has a length of 1 octet or 3 bits.

The Pwr_Delta field indicates the difference between the transmit power level of the
remote device for the CS tones and RTT packets and the transmit power level for the
PHY is in the PHY field.

The value in the Pwr_Delta field is a signed integer in dB. A positive value indicates a
higher transmit power level for the CS tones and RTT packets. A negative value indi-
cates a lower transmit power level for the CS tones and RTT packets, compared to the
transmit power level for the PHY indicated by the PHY field. A Pwr_Delta value of 0x00
indicates that the two transmit power levels are the same.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa: PDELta on page 261

5.5.5 CS IND payload settings

For packet type LL_CS_IND, the "Payload" tab provides the following settings.

Settings:

(070711 {To [ | 2P UPP PPN 126
R U et et e e et e e e e e e e e e e et — e e e e e et reeeeeearreeeeeanraeeeeeannees 127
oTo a1 a1 =AY =T o1 {87 00 ] o | SRR 127
L1 57 PRSP 127
EVENT INTEIVAL ... e e e e e e e e e e e e aeaeas 127
SUDEVENTS Per EVENt....oeeee et e e eeeaeaaaa 127
SUDEVENT INTEIVAL......cco it as 127
ST 0] oY= o =Y o T 127
X SRR 127
e o I SRR 128
PWE DAL ...t aaaaaaaaaaaes 128
Config_ID

Sets the 6-bit Config_ID field that is the CS configuration ID. Settable ID values are 2
bits in decimal representation. All other values are for future use.
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Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:CID on page 255

RFU
Sets the bits that are reserved for future use (RFU).

The number of RFU bits can vary depending on the CS_Control_Data PDU.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:RFU on page 263

connEventCount
See "connEventCount" on page 123.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:CECount on page 255

Offset
Sets the time value of the Offset field. The value has a length of 3 octets or 9 bits.

The field corresponds to the proposed minimum time (us) from the ACL anchor point of
a certain connection event to the start of the first CS subevent. The connEventCount
field references this connection event.

The Offset time value is greater than or equal to 500 us and less than 4 s.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:EOFFset on page 256

Event_Interval
Sets the 16-bit Event_Interval field, see "Event Intervals/Event_Interval" on page 50.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:EINTerval on page 190

Subevents_Per_Event
See "Subevent_Per Event" on page 124.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa: SNUMber on page 266

Subevent_Interval
See "Subevent_Interval" on page 124.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:SINTerval on page 265

Subevent_Len
See "Subevent_Len" on page 125.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa: SLENgth on page 266

ACI
See "ACI" on page 125.
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Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:ACI on page 254

PHY
Displays the LE physical layer that is the LE uncoded PHY LE1M.

See also "Packet Format" on page 48.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:PFORmat on page 175

Pwr_Delta
See "Pwr_Delta" on page 126.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:PDELta on page 261

5.5.6 CS terminate payload settings

For packet type LL_CS_TERMINATE_IND, the "Payload" tab provides the following

settings.

Settings:

1077 1T |5 2 EEEPPRRNE 128
SRR 128
] o A @00 [T (1= TR 128
Config_ID

Sets the 6-bit Config_ID field that is the CS configuration ID. Settable ID values are 2
bits in decimal representation. All other values are for future use.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:CID on page 255

RFU
Sets the bits that are reserved for future use (RFU).

The number of RFU bits can vary depending on the CS_Control_Data PDU.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:RFU on page 263

Error Code(hex)

Sets an 8-bit error code. For an LL_CS_TERMINATE_IND packet, informs the remote
device about the termination of the connection.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CS:CDATa:ECODe on page 256

5.5.7 CS FAE payload settings

For packet type LL_CS_FAE_RSP, the "Payload" tab provides the following settings.
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5.5.8

5.6

Test packet configuration

Settings:
Show Channel FAE Table/Hide Channel FAE Table..........ooveiiiiieeieeeee e 129
(010 T= o] T I A i =1 o] L= YR 129

Show Channel FAE Table/Hide Channel FAE Table
Shows or hides the fractional frequency offset actuation error (FAE) channel table.

See "Channel FAE Table" on page 129.

Channel FAE Table
The FAE channel table provides settings to set the fractional frequency offset actuation
error (FAE) per channel.

"Channel Index"
See "Channel Index" on page 96.

"Channel FAE" Sets the FAE of the channel.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CS:CDATa [ :CHANnel<ch0>] : CFAE on page 254

CS channel map payload settings

For packet type LL_CS_CHANNEL_MAP_IND, the "Payload" tab provides the follow-
ing settings.

Settings:
Show Channel Mapping Table/Hide Channel Mapping Table..........ccccccciccccennnnn. 129
1076] ol g =Tex 1 o] T [ 1S3 =1 o | RPN 129

Show Channel Mapping Table/Hide Channel Mapping Table
Shows or hides the channel-mapping table to set channel characteristics.

See Chapter 5.4.2, "Channel table", on page 95.

Connection Instant
See "Connection Instant" on page 82.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:CINStant
on page 229

Test packet configuration

Access:
1. Select "Bluetooth" > "General".

2. "Bluetooth Mode" > "Bluetooth Low Energy".
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3. Select "Channel" > "Packet Type" > "TEST PACKET".

4. Select "Test Packet Configuration".

Bluetooth: Test Packet Configuration —_— X
Packet Configuration
Packet Interval Symbols per a Bit
1.875 ms 2
Payload
Payload Type Payload Length
PRBS9 37 bytes
Header Payload
Payload Type RFU Length PDU Payload
4 bits 4 bits 8 bits 0-255 bytes
PREAMBLE Access Address Cl TERM B3I CRC TERM2
8 bits 32 bits 2 bits | 3 bits 24 bits 3 bits

The dialog provides settings to configure test packets. The graphic below the set-
tings shows the test packet structure and fields.

Settings:

Packet ConfiguIration..........coui i 130
Packet INterval..... ... 130
SYMDOIS PEF @ Bil....eeiiiiiiie e 130
[ =TT [ PP 131
(O I = [0 (o I oy oYY o | TR 131
CTEINfo Configuration...........cooo it 131
YL o2 (o PSP 131
USEI PatterN(NEX)....eeeee ittt e e s 131
PayIOad. ... .. e s 131
(o) (o= To I Y] o T OO O PP PUPPPPPPR 131
)Y (o= o B =Y o Vo |1 o TR 132

Packet Configuration
The "Packet Configuration" section provides settings to configure the packet interval
and the number of symbols per bit "S".

Packet Interval

Sets the time interval between two consecutive test packets, regarding the starting
points.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:DTTest:TPConfiguration:TPINterval

on page 269

Symbols per a Bit
Requires option R&S SMM-K117 and "Packet Format" > "LE Coded".

Sets the number of symbols per bit "S" for forward error correction (FEC) coding for LE
coded packets. See also Table 2-4.
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Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:SPBit
on page 268

Header
The "Header" section provides settings to configure the header of the test packet.

CTEInfo Present
Requires a data channel packet or a test packet.

Enables the CTEInfo field in the header of Bluetooth LE data packets in the LE unco-
ded PHY.

See also "Constant tone extension" on page 23.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:CPResent
on page 218

CTEInfo Configuration
Requires "CTEInfo Present" > "On".

Opens the "CTEInfo Configuration" dialog to configure CTE length and the CTE
method. See Chapter 5.3.3, "CTEInfo settings", on page 62.

Sync Word
Requires an LE uncoded PHY, see "Packet Format" on page 48.

Sets the 32-bit Sync Word in the packet header field.
"0x94826E8E" Fixed value in hexadecimal representation.
"User Pattern"  Allows a user-defined value, see "User Pattern(hex)" on page 131.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:SYNCword
on page 268

User Pattern(hex)

Requires "Sync Word" > "User Pattern".

Sets a user-defined value of the 32-bit Sync Word. This value is an 8-digit hexadecimal
input.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:USERpatt
on page 269

Payload
The "Payload" section provides settings to configure the payload of the test packet.

Payload Type
Selects the data source used for the payload test packets.

"PRBS 9"/"PRBS 15"
Pseudo random bit sequences of the length 9 or 15 - transmission of
identical packet series.
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Predefined pattern
11110000, 10101010, 11111111, 00000000, 00001111 or 01010101

"Data List" See "Data Source" on page 65.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:DTTest:TPConfiguration:UPSource
on page 270

Payload Length
Sets the payload length of the test packet.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:DTTest:TPConfiguration:UPLength
on page 270
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Channel settings

6 Bluetooth BR/EDR configuration and set-
tings

Access:
1. Select "Baseband" > "Bluetooth".

2. Select "Bluetooth Mode" > "Basic Rate + EDR".

The remote commands required to define these settings are described in Chapter 8,
"Remote control commands", on page 160.

Settings:
@  Channel SEHNGS.....ocveeiieie e e e e e e e e e a e 133
o Packet configuration.............eeeiiiiiii e 135

6.1 Channel settings

Access:
1. Select "Bluetooth" > "General".
2. Select "Bluetooth Mode" > "Basic Rate + EDR".

3. Select "Bluetooth" > "Channel".

Bluetooth
ui‘ Internal

Packet Type Sequence Length
DH1 1 Frames

Slot Timing

Tx Test Mode
Packet Configuration ...

Whitening Off

Tx Slot Rx Slot
625 Symbols 625 Symbols
Frame

The tab provides settings to configure Bluetooth BR/EDR channel settings. These
settings include the packet type, the sequence length and the slot timing. The
graphic at the bottom of the tab shows the frame structure of the selected packet
type.

Also, the tab provides further access to the BR/EDR packet configuration, see
Chapter 6.2, "Packet configuration", on page 135.
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Channel settings

For Bluetooth LE channel settings, see Chapter 5.1, "Channel settings", on page 44.

Settings:

= Tod (=Y R 5] 1= TS 134
7= o[0T oLt =T g o | 1 o 1 134
1] o I 11 Vo PP URU PPt 134
Packet ConfiguIration..........cooo i 135
Packet Type

Selects the packet type.
The available packets depend on the selected Transport Mode.

All packet types as defined in the Bluetooth specification are supported. For an over-
view, see Chapter 2.4.1, "Bluetooth packet types for BR/EDR", on page 27.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:PTYPe on page 271

Sequence Length
Selects the sequence length in frames of the generated signal. The signal repeats after
the specified number of frames.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:SLENgth on page 271

Slot Timing
Selects the timing mode for the RX slot.

The graphic below shows the frame structure of the selected Packet Type and slot tim-

Ing.
Tx Slot Rx Slot Tx Slot i Rx Slot
3xB25 Symbols | 625 Symbols P 3x625 Symbols i 3x625 Symbols P
Frame ' Frame
TX test mode Loopback test mode

A transmitted packet has a duration of N x 625 us where "N" is an odd integer larger
than 0. N depends on the type of the transmitted packet. In "Tx Test" mode, N = 1 for
RX slots.

"Tx Test Mode"
The transmitted RX package takes 625 symbols, regardless of the
selected packet type.

"Loopback Test Mode"
Extends the RX slot time according to the selected packet type.
For example, the RX slot of Packet Type > DH3 takes 3 x 625 sym-
bols.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:STIMing on page 271
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6.2

Packet configuration

Packet Configuration
Access the "Packet Configuration" dialog, see Chapter 6.2, "Packet configuration”,
on page 135.

The current data source for the packet and the data whitening state are displayed next
to the button.

Remote command:
n.a.

Packet configuration

Access:
1. Select "Bluetooth" > "General".
2. Select "Bluetooth Mode" > "Basic Rate + EDR".

3. Select "Bluetooth" > "Channel" > "Packet Configuration".

Bluetooth: Packet Configuration

Data Source for Packet _
.~ Data Whitening
Packet Editor

Access Code

. . LAP for Sync Word
Synchronize LAP with BD_ADDR 00 0080
Bluetooth Device Address
NAP UAP LAP
ACDE 48 00 0080

PREAMBLE SYNC WORD TRAILER LT_ADDR TYPE FLOW ARQN SEQN HEC
4 bits 64 bits 4 bits 3 bits 4 bits 1 bits 1 bits 1 bits 8 bits
ACCESS CODE HEADER PAYLOAD
72 bits 54 bits 240 bits
Parity bits | LAP | EIR [ Undefined | SR | Res. | UAP | NAP | Class of dev | LT_ADDR | CLK27-2 | Page scan mode | CRC
34 bits | 24bits | 1 bit 1 bit 2 bits | 2 bits | 8 bits | 16 bits 24 bits 3 bits 26 bits 3 bits 16 bits

The dialog contains the parameters for configuring the packet type.
Available settings vary according to the selected Packet Type and data source.

Settings:

Packet ConfigUuIration...........coiiiiiiiiii e 136
L Data SOUCE fOr PACKEL..........cuceeeeeeeeeeeeeeeeeeeeee ettt 136
L Data WHItENING. ....cvcveveveveeeeeeeeeececectetete ettt ee s s esesasasas ettt seee s s e s s ennaneees 136
L Synchronize LAP with BD_ADDR............cccovevrrueeeeeeeeeeseeeeseeessseseneeseseeens 136
L LAP fOr SYNC WOT.....o.eviieeceeeeeeeeeeeeee ettt s st n s senas 136
L Bluetooth Device Address (BD_ADDR).........ccoeiioereeeereeeeseeeeesseeeseeees 137

[ (== T = OO UUPPPRRP 137
L Logical TransSport AdAress...........c.occeeureueueueuereeeeeeeseeesessssssesesesesesesesssenes 137
L FIOW CONEIOL ...ttt 137
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L ACKNOWIEAGMEN........oeeeeeeeecececectetete ettt en st seeenns 138
L SEQN Start ValUE..........cecveeeececeeeeecee e eseae e sens e enseae s eneeee 138
PayIOad. ... . e e as 138
L DA SOUICE. v ettt eee et ettt et e et e e et e et et e e eeene e eeere e eeereeeens 138
L DAt LENGLN. ...ttt st 139
L EIR PACKEt FOIOWS........eeeeee ettt n s 139
L FIOW CONTOL......evecectececte sttt s 139
L Scan Repetition MOGE. ..........c.cueuiieeeeeeeeeee e e ee e, 140
L ClaSS OF DBVICE. ...ttt ee et ee e et e e e e e e eeeeneen 140
DV PAYIOAQd........eeeeiiiiiiiiiiie ettt e e s 140
L Data Source (V0ICe FIEIA).........cucueeeeeeeeeeeeeeeeeeeeee et eeeee e en s e s eneneae 140
L DAt SOUICE. ...ttt ettt ettt e e es 141
L DAt LENGEN. ...ttt et en e en 142
L FIOW CONTOL.....eeveieecteeeeete sttt s 142
D= | - PP UPPPPPPRPPNE 142
L PaCKEt LENGHN......vvvveeeeeceeeeeeece ettt ee sttt en s ee s anaeeee 142

Packet Configuration
In this section, specify general Bluetooth BR/EDR packet properties.

Data Source for Packet — Packet Configuration

The data sent for each packet can be comfortably edited with the packet editor, or filled
with a predefined "ALL" data sequence.

"Packet Editor" Enables the editing mode to configure the packet fields individually.

"All Data" Fills the generated packets with the selected data source. This mode
is useful if you need to load predefined data contents from a data list
file or the data contents of the packet are not of interest.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:PCONfiguration:DSFPacket on page 276

Data Whitening — Packet Configuration
Activates the data whitening.

Evenly distributed white noise is ideal for the transmission, and real data can be forced
to look similar to white noise with different methods called "Data Whitening".

Remote command:
[ : SOURce<hw>] :BB:BTOoth:PCONfiguration:DWHitening on page 277

Synchronize LAP with BD_ADDR — Packet Configuration
Requires "Packet Type" > "FHS".

Activates synchronization of the LAP for Sync Word and the Bluetooth Device Address
> LAP.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:PCONfiguration:SLAP on page 279

LAP for Sync Word — Packet Configuration
Requires "Packet Type" > "FHS".
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Sets the 24-bit lower address part (LAP) in the 64-bit sync word separately, if "Syn-
chronize LAP with BD_ADDR > OFF".

The LAP is obtained automatically from the Bluetooth device address "BD_ADDR >
LAP", if "Synchronize LAP with BD_ADDR > ON".

Remote command:
[ : SOURce<hw>] :BB:BTOoth:PCONfiguration:LFSWord on page 278

Bluetooth Device Address (BD_ADDR) «— Packet Configuration
Enters the Bluetooth device address. Each Bluetooth device has allocated a unique
48-bit Bluetooth device address (BD_ADDR).

The BD_ADDR can take any values except the 64 reserved LAP values: 0xX9E8BO0O —

Ox9E8B3F.
"NAP" Selects non-significant address part.

The length of NAP is 16 bits or 4 hexadecimal figures.
"UAP" Selects the upper address part.

The length of UAP is 8 bits or two hexadecimal figures.
"LAP" Selects the lower address part.

The length of LAP is 24 bits or 6 hexadecimal figures.
Remote command:
[ : SOURce<hw>] :BB:BTOoth:PCONfiguration:BDANap on page 273
[ : SOURce<hw>] :BB:BTOoth:PCONfiguration:BDAUap on page 273
[ :SOURce<hw>] :BB:BTOoth:PCONfiguration:BDALap on page 273

Header
Access:

Select "Bluetooth > General > Bluetooth Mode > Basic Rate + EDR > Packet Configu-
ration > Header".

Fackel Conﬁguratiun Header Paymad _

LT Address Flow Control
0 GO |
Acknowledgment SEQN Start Value
ACK 1

Provides header settings.

Logical Transport Address — Header
Available for all packet types except ID packet.

Enters the logical transport address for the header.

Each Peripheral that is active in a piconet is assigned a primary logical transport
address (LT_ADDR). The all-zero LT _ADDR is reserved for broadcast messages.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:PCONfiguration:LTADdress on page 278

Flow Control < Header
Available for all packet types except ID packet.
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Sets the FLOW bit in the header. This bit indicates the start or stop of transmission of
packets over the ACL logical transport.

"Go" Allows the other devices to transmit new data.
"Stop" Stops the other devices from transmitting data temporarily.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:PCONfiguration:HFControl on page 277

Acknowledgment — Header
Available for all packet types except ID packet.

Sets the ARQN bit of the packet header.
"NAK" Request to retransmit the previous payload.
"ACK" Previous payload has been received successfully.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:PCONfiguration:ACKNowledgement on page 272

SEQN Start Value — Header
Available for all packet types except ID packet.

Sets the start value of the header SEQN bit.
The SEQN bit is present in the header to filter out retransmissions in the destination.

The signal generator is altering this bit automatically on consecutive frames, if a
sequence length of at least two frames is set.

"0" The SEQN bit starts with 0.
"1" The SEQN bit starts with 1.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:PCONfiguration:SNSValue on page 280

Payload
Access:

Select "Bluetooth > General > Bluetooth Mode > Basic Rate + EDR > Packet Configu-
ration > Payload".

Fackel Conﬁguration Pa}.load _

Data Source

-

PN 9
Data Length Flow Control
17 bytes GO

Provides payload settings.

Data Source < Payload
(Available for all packet types except ID, POLL, NULL and FHS packets)

Selects the data source used for the payload.

The following standard data sources are available:
o "AllO"/"AIl 1"
An internally generated sequence containing 0 data or 1 data.
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® "PNxx"
An internally generated pseudo-random noise sequence.
® "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern” box to set the bit pattern.
e "Data List"/"Select Data List"

Binary data from a list file, internally or externally generated.

Select "Select Data List" to open the standard "Select List" dialog. The dialog lists

file with file extension * .dm_1iqd if existing.

— Navigate to the list file and tap "Select" to select the file.

— Use the "New" and "Edit" functions to create a data list internally or to edit an
existing one.

— Use the standard "File Manager" function to transfer external data lists to the
instrument.

See also:

® Section "About data signals" in the R&S SMM100A user manual.

® Section "File and data management" in the R&S SMM100A user manual.
® Section "Data list editor" in the R&S SMM100A user manual.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:PCONfiguration:DATA on page 274

[ :SOURce<hw>] :BB:BTOoth:PCONfiguration:DATA:DPATtern Oh page 274

[ : SOURce<hw>] :BB:BTOoth:PCONfiguration:DATA:DSELection on page 275

Data Length «— Payload
(Available for all packet types except ID, POLL, NULL and FHS packets)

Enters the payload data length in bytes.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:PCONfiguration:DLENgth on page 276

EIR packet follows < Payload
Available for FHS packets.

Indicates that an extended inquiry response packet can follow.
"Yes" Indicates that an EIR packet follows.
"No" Indicates that EIR does not follow.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:PCONfiguration:EIRPacketfollows
on page 277

Flow Control — Payload
(Available for all packets types except ID, POLL, NULL, FHS, HV1, HV2, HV3, EV3,
EV4, EV5, 2-EV3, 2-EV5, 3-EV3, 3-EV5 packets.)

Sets the FLOW bit in the payload (flow control per logical link)

"Go" Indicates start of transmission of ACL packets after a new connection
has been established.

"Stop" Indicates stop of transmission of ACL packets before an additional
amount of payload data is sent.
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Remote command:
[ : SOURce<hw>] :BB:BTOoth:PCONfiguration:PFControl on page 279

Scan Repetition Mode — Payload
Available for FHS packets.

The 2-bit scan repetition field indicates the interval between two consecutive page
scan windows, determines the behavior of the paging device.

"RO" The scan interval is equal to the scan window T,,_page_scan (contin-
uous scan) and maximal 1.28s.

"R1" The scan interval is maximal 1.28s.

"R2" The scan interval is maximal 2.56s.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:PCONfiguration:SRMode on page 280

Class of Device «— Payload
Available for FHS packets.

A parameter received during the device discovery procedure, indicates the type of
device and which types of service that are supported.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:PCONfiguration:CODevice on page 274

DV Payload
Access:

Select "Bluetooth > Transport Mode = SCO > Channel > Packet Type = DV > Packet
Configuration > Data Source for Packet = Packet Editor > DV Payload".

Voice Field

Data Source
PN 9

Data Field

Data Source i @Select Data List ...
Data List BR_Data_Test
Data Length Flow Control
9 bytes GO |

Provides DV payload settings.

Data Source (Voice Field) — DV Payload
(Available for DV packets)

Selects the data source for the voice field.

The following standard data sources are available:

o "AIlLQ"/"AIl 1"

An internally generated sequence containing 0 data or 1 data.
® "PNxx"

An internally generated pseudo-random noise sequence.
® "Pattern"

An internally generated sequence according to a bit pattern.
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Use the "Pattern” box to set the bit pattern.
e "Data List"/"Select Data List"
Binary data from a list file, internally or externally generated.
Select "Select Data List" to open the standard "Select List" dialog. The dialog lists
file with file extension *.dm iqgd if existing.
— Navigate to the list file and tap "Select" to select the file.
— Use the "New" and "Edit" functions to create a data list internally or to edit an
existing one.
— Use the standard "File Manager" function to transfer external data lists to the
instrument.
See also:
® Section "About data signals" in the R&S SMM100A user manual.
® Section "File and data management" in the R&S SMM100A user manual.
® Section "Data list editor” in the R&S SMM100A user manual.

Remote command:

[ : SOURce<hw>] :BB:BTOoth:PCONfiguration:VDATa on page 281

[ : SOURce<hw>] :BB:BTOoth:PCONfiguration:DATA:VDPAttern on page 275
[ :SOURce<hw>] :BB:BTOoth:PCONfiguration:DATA:VDSElection

on page 276

Data Source — DV Payload
(Available for all packet types except ID, POLL, NULL and FHS packets)

Selects the data source used for the payload.
The following standard data sources are available:

e Al O"/"All 1"

An internally generated sequence containing 0 data or 1 data.
® "PNxx"

An internally generated pseudo-random noise sequence.
e "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern” box to set the bit pattern.
® "Data List"/"Select Data List"
Binary data from a list file, internally or externally generated.
Select "Select Data List" to open the standard "Select List" dialog. The dialog lists
file with file extension *.dm_1iqd if existing.
— Navigate to the list file and tap "Select" to select the file.
— Use the "New" and "Edit" functions to create a data list internally or to edit an
existing one.
— Use the standard "File Manager" function to transfer external data lists to the
instrument.
See also:
® Section "About data signals" in the R&S SMM100A user manual.
® Section "File and data management” in the R&S SMM100A user manual.
® Section "Data list editor" in the R&S SMM100A user manual.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:PCONfiguration:DATA on page 274

[ :SOURce<hw>] :BB:BTOoth:PCONfiguration:DATA:DPATtern on page 274

[ : SOURce<hw>] :BB:BTOoth:PCONfiguration:DATA:DSELection on page 275
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Data Length — DV Payload
(Available for all packet types except ID, POLL, NULL and FHS packets)

Enters the payload data length in bytes.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:PCONfiguration:DLENgth on page 276

Flow Control < DV Payload
(Available for all packets types except ID, POLL, NULL, FHS, HV1, HV2, HV3, EV3,
EV4, EV5, 2-EV3, 2-EV5, 3-EV3, 3-EV5 packets.)

Sets the FLOW bit in the payload (flow control per logical link)

"Go" Indicates start of transmission of ACL packets after a new connection
has been established.

"Stop" Indicates stop of transmission of ACL packets before an additional
amount of payload data is sent.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:PCONfiguration:PFControl on page 279

Data
Access:

Select "Packet Configuration > Data Source for Packet = All Data > Data".

Fackel Conﬁguration pata _

Data Source for Packet @Select Data List ..
Data List

BR_Data_Test

Packet Length @
366 Symbols

Provides data settings.

Packet Length — Data
(Available in "All Data" mode and for all packet types except ID packet.)

Enters the packet length in symbols.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:PCONfiguration:PLENgth on page 279
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7 Signal control and signal characteristics

This section lists settings provided for configuring the baseband filter and configuring
power ramping of bluetooth bursts. Also settings are listed for defining the signal gen-
eration start and for generating signals necessary for synchronization with other instru-
ments.

It covers the following topics:

o Filter/clipping SEtINGS........uuiiiiieiiiicce e s 143
o Power ramping SEHINGS....cocoiii i ———— 149
L I I 4T To [T Y= 1 ] o | UUURRTTRR 151
L I Y= T = Y= 1] o 156
O ClOCK SELHNGS. ... eieeiii ittt e e s e e e 158
e Local and global connectors Settings.........cceieiiiiiiiiiiiii e 159

7.1 Filter/clipping settings

Access:

1. Select "Baseband" > "Bluetooth".

2. Select "General" > "Filter"/"Clipping".

Bluetooth: Filter/Clipping Settings

Filter
GFSK.Root Cosine Modulation Settings |8l Clipping -

GFSK section
Filter
Gauss(FSK)
B*T
0.50
Impulse Length 4
is Auto 32
. 2
Oersamping 10
/4 DQPSK section
Filter

Root Cosinev
Roll Off Factor
0.40

The dialog provides settings to configure the baseband filter, the modulation set-
tings and to enable clipping.
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Settings:
711 Common fillEr SEHINGS. ....oii i 144
7.1.2 DPSK filter SEHINGS. .. eei ittt 145
7.1.3  ModUuIation SEHINGS. ....ceiiiiiiiiie et e e 146
714 Clipping SEHINGS. . coe ittt e e e e e e s e e e 148

7.1.1 Common filter settings

Access:
1. Select "General" > "Filter"/"Clipping".
2. Select "Filter" > "GFSK section".

GFSK section

Filter 9
Gauss(FSK)
B*T
0.50
o
Impulse Length
is Auto 32
o
Oversampling
is Auto 10

The section provides settings to configure the common baseband GFSK filter.

Settings:

(=) SRR 144
o SRR 144
IMPUISE LENGLN... . e e e e e e e e e e e e e e e eeeees 145
OVEISAMPIING. ettt e e st e e s e bt e e e s e abbe e e e e s e e e e e e aanreas 145
Filter

Displays the filter type that is GFSK. This type is common to the Bluetooth baseband
signal.

Remote command:

n.a.

B*T

Sets the rolloff factor or bandwidth time product ("B*T") for the filter type that supports
this parameter.

For supporting predefined filters, this parameter can have a different default value for
each of the predefined filters.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:FILTer:PARameter:APCO25 on page 285

[ : SOURce<hw>] :BB:BTOoth:FILTer:PARameter:COSine on page 285

[ : SOURce<hw>] :BB:BTOoth:FILTer:PARameter: FGAuss on page 286
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:SOURce<hw>] :BB:BTOoth:FILTer: PARameter: GAUSs on page 286
:SOURce<hw>] :BB:BTOoth:FILTer: PARameter: LPASs on page 286
:SOURce<hw>] :BB:BTOoth:FILTer: PARameter: PGAuss on page 287
:SOURce<hw>] :BB:BTOoth:FILTer: PARameter :RCOSine on page 287
:SOURce<hw>] :BB:BTOoth:FILTer: PARameter : SPHase on page 287

— o/ o/ o/

Impulse Length
Displays the number of filter tabs.

If enabled, the most sensible parameter values are selected. The value depends on
the coherence check.

Disable it to set the values manually.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:FILTer: ILENgth:AUTO[: STATe] on page 284

[ :SOURce<hw>] :BB:BTOoth:FILTer: ILENgth on page 283

Oversampling
Sets the upsampling factor.

If enabled, the most sensible parameter values are selected. The value depends on
the coherence check.

Disable it to change the value manually.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:FILTer:0SAMpling:AUTO[:STATe] on page 284

[ :SOURce<hw>] :BB:BTOoth:FILTer:0SAMpling on page 284

DPSK filter settings

Access:

1. Select a Bluetooth EDR packet that supports a /4 DQPSK filter or 8DPSK filter:
See Table 7-1.

2. Select "General" > "Filter"/"Clipping".
3. Select "Filter" > "r/4 DQPSK section" or "8DPSK section".

/4 DQPSK section

Filter
Root Raised Cosine (RRC)v
Roll Off Factor
0.40

The section provides settings to configure the /4 DQPSK filter or 8DPSK filter.
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Table 7-1: DPSK filter for Bluetooth EDR packets

Transport mode Packet type DPSK filter type
ACL+EDR 2-DH1, 2-DH3, 2-DH5 /4 DQPSK

3-DH1, 3-DH3, 3-DH5 8DPSK
eSCO+EDR 2-EV3, 2-EV5 /4 DQPSK

3-EV3, 3-EV5 8DPSK
Settings:
110 PP STP PP 146
ROI Off FACIOIB T ...ttt e e e bt e e e 146
Cut Off FreqUeNCY FaCION. ... 146
Filter

Selects the filter type for DQPSK sections or 8DPSK sections in EDR packets.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:FILTer: TYPE on page 283

Roll Off Factor/B*T
Sets the rolloff factor or bandwidth time product ("B*T") for the filter type that supports
this parameter.

For supporting predefined filters, this parameter can have a different default value for
each of the predefined filters.

Remote command:
SOURce<hw>] :BB:BTOoth:FILTer:PARameter : APCO25 on page 285

SOURce<hw>] :BB:BTOoth:FILTer: PARameter:COSine on page 285
SOURce<hw>] :BB:BTOoth:FILTer:PARameter : FGAuss on page 286
:BB:BTOoth:FILTer:PARameter:GAUSs on page 286

[:

[: ]

[: ]

[ : SOURce<hw>]

[ :SOURce<hw>] :BB:BTOoth:FILTer:PARameter:LPASs on page 286
[: ]

[: ]

[: ]

SOURce<hw>] :BB:BTOoth:FILTer:PARameter : PGAuss on page 287
SOURce<hw>] :BB:BTOoth:FILTer: PARameter :RCOSine on page 287
SOURce<hw>] :BB:BTOoth:FILTer: PARameter : SPHase on page 287

Cut Off Frequency Factor
Requires a lowpass filter.

Sets the value for the cutoff frequency factor. The cutoff frequency of the filter can be
adjusted to reach spectrum mask requirements.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:FILTer : PARameter: LPASs on page 286

7.1.3 Modulation settings

Access:

1. Select "General" > "Filter"/"Clipping".
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2. Select "Modulation Settings".

Bluetooth: Filter/Clipping Settings

Filter
e Modulation Settings | - 5Lt} -

Modulation Type

GFSK
Frequency Deviation
250.0 kHz
Modulation Index 9
0.5

Symbol Rate Variation

1.000 000 000 MHz

The tab provides settings to configure modulation settings.

Settings:

1Y oTe [UTE= 1 ToT o 1Y/ o1 Y 147
FrequencCy Deviation...... ... .. e e e e e e 147
1 oo [ =1 1 o] o T [ Vo [ PP UURRRT 147
Symbol Rate Variation..........ooeeei e 148

Modulation Type
Displays the modulation format used for the current packet selection.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:FILTer :MTYPe on page 285

Frequency Deviation
Enter the frequency deviation of the frequency modulated part.

The frequency deviation can be varied in a range from 100.0 kHz to 200.0 kHz accord-
ing to the Bluetooth specification.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:MSETtings:FDEViation on page 285

Modulation Index
Displays the modulation index resulting from the entered frequency deviation value.

Modulation index is calculated from the given frequency deviation and symbol rate val-
ues.

The modulation index h is defined as:
a2y

f smadol

b=

Where ‘== is the "symbol rate" and ¢/ is the "frequency deviation".

According to the Bluetooth specification, the modulation index is allowed to vary
between 0.28 and 0.35.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:FILTer :MINDex on page 284
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Symbol Rate Variation
Enter the symbol rate.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:SRATe:VARiation on page 288

7.1.4 Clipping settings

Access:
1. Select "General" > "Filter"/"Clipping".
2. Select "Clipping".

Bluetooth: Filter/Clipping Settings

Filter
e Modulation Settings || 1 [S[sJ 0] -

State

Clipping Level

100 %

Clipping Mode
Vector [i+jq|

The tab provides settings to configure clipping.

Settings:

] = | (- R 148
L0470 o] g TN 0= Y SRR 148
104170 o] 1 aTe T 1Y, o o = T EEUPPRR NS 149
State

Switches baseband clipping on and off.

Baseband clipping is a simple and effective way of reducing the crest factor of the sig-
nal. Since clipping is done before to filtering, the procedure does not influence the
spectrum. The EVM however increases.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CLIPping: STATe on page 282

Clipping Level
Sets the limit for clipping.

This value indicates at what point the signal is clipped. It is specified as a percentage,
relative to the highest level. 100% indicates that clipping does not take place.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CLIPping:LEVel on page 281
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Clipping Mode
Selects the clipping method. The dialog displays a graphical illustration on how this two
methods work.
® "Vector|i+jq|"
The limit is related to the amplitude | i + q |. The | and Q components are mapped
together, the angle is retained.
® "Scalar|il|,|q]"
The limit is related to the absolute maximum of all the | and Q values |i |+ | q .
The | and Q components are mapped separately, the angle changes.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:CLIPping:MODE on page 282

Power ramping settings

Access:

> Select "Bluetooth" > "General" > "Power Ramping".

Bluetooth: Power Ramp Control — X
Ramp Function
Cosine'

Ramp Time

2 Symbols
Rise Offset

-2 Symbols
Fall Offset

0 Symbols

The dialog provides settings to configure power ramping.

To monitor power ramping for LE Channel Sounding

1. Select "Bluetooth" > "General" > "Bluetooth Mode" > "Bluetooth Low Energy".
2. Select "Bluetooth” > "Channel" > "Channel Type" > "Channel Sounding".

3. Select "Bluetooth" > "General" > "Power Ramping".

LE Channel Sounding uses fixed power ramping parameter as in the table below.

Parameter Value
"Ramp Function" "Cosine"
"Ramp Time" "5 Symbols"
"Rise Offset" "0 Symbols"
"Fall Offset" "0 Symbols"
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Settings:

(= 0T o JN U ] o (o) o 1SS 150
= 0 0] T 1 = T PSR 150
(LTI @1 7= SO SRR 150
L1 7= SRS 150

Ramp Function
Selects the form of the transmitted power, i.e. the shape of the rising and falling edges
during power ramp control.

"Linear" The transmitted power rises and falls with linear fashion.

"Cosine" The transmitted power rises and falls with a cosine-shaped edge.
This setting causes a more favorable spectrum than the "Linear" set-
ting.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:PRAMping:RFUNction on page 289

Ramp Time

Sets the ramp time, which extends the burst by a corresponding number of 0 padding
symbols at the beginning and the end of a burst. During this period of time, power
ramping is based on the specified ramp function.

Do not switch the transmitted power abruptly at the end or the start of a burst, since the
switching operation generates excessively strong non-harmonics. The switching opera-
tion is therefore stretched over several symbol clocks.

Remote command:
[ : SOURce<hw>] :BB:BTOoth: PRAMping:RTIMe on page 289

Rise Offset

Sets the offset of the rising edge of a burst. The offset is specified by the selected num-
ber of symbols.

Negative values shift the rising edge to earlier positions, which results in a correspond-
ing number of added 0 padding symbols before the burst.

Positive values shift the rising edge to later positions, which results in a corresponding
number of skipped symbols at the beginning of the burst.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:PRAMping:ROFFset on page 289

Fall Offset
Sets the offset of the falling edge of a burst. The offset is specified by the selected
number of symbols.

Negative values shift the falling edge to earlier positions, which results in a correspond-
ing number of skipped symbols at the end of the burst.

Positive values shift the falling edge to later positions, which results in a corresponding
number of added 0 padding symbols following the burst.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:PRAMping: FOFFset on page 288
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7.3 Trigger settings

Access:

» Select "Baseband" > "Bluetooth" > "Trigger In".

Bluetooth

Mode

Auto] Stopped

This tab provides settings to select and configure the trigger, like trigger source,
trigger mode and trigger delays, and to arm or trigger an internal trigger manually.
The header of the tab displays the status of the trigger signal and trigger mode. As
in the tabs "Marker" and "Clock", this tab provides also access to the settings of the
related connectors.

Routing and activating a trigger signal

1. Define the effect of a trigger event and the trigger signal source.

a) Select "Trigger In" > "Mode".
b) Select "Trigger In" > "Source".

2. For external trigger signals, define the connector for signal input. See Chapter 7.6,
"Local and global connectors settings", on page 159.
You can map trigger signals to one or more User x or T/M connectors.

Local and global connectors settings allow you to configure the signal mapping, the
polarity, the trigger threshold and the input impedance of the input connectors.

3. Activate baseband signal generation. In the block diagram, set "Baseband" > "On".

The R&S SMM100A starts baseband signal generation after the configured trigger
event.

About baseband trigger signals

This section focuses on the available settings.

For detailed information on baseband trigger signals, see section About trigger signals"
in the R&S SMM100A user manual.

Settings:

1Yo o [T PPPPPUT PRI 152
Signal Duration UNit.........coooiii et 152
ST (o [ E= 1 B 1H =1 (o] o U UURRRUR SR 152
(U] T T e TS (o] o] o= SRR 153
TIME BASEA THGOET .. .eeeeiiiiitiee ettt ettt e e s bt e e e e s ebee e e e s saabeeeeeeaas 153
e e =T T L= T PP PP PP R ORPPPPRP 153
4 0 1 PO PSS ST PPPPPPP 153
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=y o101 (=R Ny T o 1= ST PP PP OPPRPT 153
S To 10 (o= TP PUPPPIPPRR 154
Sync. Output to Ext. Trigger/Sync. Output to THQGer......ccueveiiiiiiiii e 154
External Inhibit/Trigger INNIDIt.........c.eiiii e 155
External Delay/Trigger DElay.........ccccuiiiiiiiieiee ettt ssccvrrrne e e e e e e e e ennnes 155

Mode
Selects the trigger mode. The mode determines the effect of a trigger event on the sig-
nal generation.

For more information, see chapter "About trigger signals" in the R&S SMM100A user

manual.

o llAutoll
The signal is generated continuously.

® "Retrigger"
The signal is generated continuously. A trigger event (internal or external) causes a
restart.

® "Armed Auto"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated continuously.
An "Arm" stops the signal generation. A subsequent trigger event (internal or exter-
nal) causes a restart.

® "Armed Retrigger"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated continuously. Every subsequent trigger event causes a restart.
An "Arm" stops signal generation. A subsequent trigger event (internal or external)
causes a restart.

® "Single"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated once to the length specified at "Signal Duration".
Every subsequent trigger event (internal or external) causes a restart.

Remote command:
[ : SOURce<hw>] :BB:BTOoth[:TRIGger] : SEQuence on page 291

Signal Duration Unit
Defines the unit for describing the length of the signal sequence to be output in the
"Single" trigger mode.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:TRIGger: SLUNit on page 294

Signal Duration
Requires trigger "Mode" > "Single".

Enters the length of the trigger signal sequence.

Use this parameter, for example, for the following applications:
® To output the trigger signal partly.
® To output a predefined sequence of the trigger signal.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:TRIGger: SLENgth on page 293
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Running/Stopped
With enabled modulation, displays the status of signal generation for all trigger modes.

® "Running"
The signal is generated; a trigger was (internally or externally) initiated in triggered
mode.

e "Stopped"
The signal is not generated and the instrument waits for a trigger event.

Remote command:
[ :SOURce<hw>] :BB:BTOoth: TRIGger : RMODe on page 292

Time Based Trigger
Requires trigger "Mode" > "Armed Auto"/"Single".

Activates time-based triggering with a fixed time reference.

The R&S SMM100A triggers signal generation when its operating system time ("Cur-
rent Time") matches a specified time trigger ("Trigger Time"). As trigger source, you
can use an internal trigger or an external global trigger.

How to: Chapter "Time-based triggering" in the R&S SMM100A user manual.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:TRIGger:TIME [ :STATe] on page 293

Trigger Time
Requires trigger "Mode" > "Armed Auto"/"Single".

Sets date and time for a time-based trigger signal.

Set a trigger time that is later than the "Current Time". The current time is the operating
system time of the R&S SMM100A. If you set an earlier trigger time than the current
time, time-based triggering is not possible.

How to: Chapter "Time-based triggering" in the R&S SMM100A user manual.
"Date" Sets the date of the time-based trigger in format YYYY-MM-DD.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:TRIGger : TIME: DATE on page 292

"Time" Sets the time of the time-based trigger in format hh:mm:ss.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:TRIGger: TIME: TIME On page 292

Arm
Stops the signal generation until subsequent trigger event occurs.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:TRIGger:ARM:EXECute on page 294

Execute Trigger
For internal trigger source, executes trigger manually.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:TRIGger:EXECute on page 294
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Source
The following sources of the trigger signal are available:
® "Internal"
The trigger event is internal. Tap "Execute Trigger" to trigger signal generation
manually.

e "External Global Trigger"
The trigger event is the active edge of an external trigger signal provided and con-
figured at the User x connectors.

® "Baseband Sync In"
Requires "Multi Instrument Trigger" > "Secondary" for primary-secondary instru-
ment mode.
Triggers signal generation at the secondary instrument by the active edge of the
baseband synchronization signal of the primary instrument.

How to: "Routing and activating a trigger signal" on page 151

Remote command:
[ : SOURce<hw>] :BB:BTOoth:TRIGger : SOURce on page 291

Sync. Output to Ext. Trigger/Sync. Output to Trigger
Enables signal output synchronous to the trigger event.

e "On"

Corresponds to the default state of this parameter.
The signal calculation starts simultaneously with the trigger event. Because of the
processing time of the instrument, the first samples are cut off and no signal is out-
put. After elapsing of the internal processing time, the output signal is synchronous
to the trigger event.

| Ext

| Trigger Event

\

Calculated
signal

! \/
| Signal at
the output
| N
»—]<&-Processing time—
. lloffll
The signal output begins after elapsing of the processing time. Signal output starts
with sample 0. The complete signal is output.
This mode is recommended for triggering of short signal sequences. Short sequen-

ces are sequences with signal duration comparable with the processing time of the
instrument.
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Calculated
signal

1
| \_/
| Signal at
the output
»—]<&-Processing time—
Remote command:

[ :SOURce<hw>] :BB:BTOoth:TRIGger[:EXTernal] : SYNChronize:OUTPut
on page 294

External Inhibit/Trigger Inhibit
Applies for an external trigger signal.

Sets the duration with that any following trigger event is suppressed. In "Retrigger"
mode, for example, a new trigger event does not cause a restart of the signal genera-
tion until the specified inhibit duration does not expire.

For more information, see chapter "Basics on signals, modulation formats and filters" in
the user manual.

Remote command:
[ : SOURce<hw>] :BB:BTOoth:TRIGger [:EXTernal] : INHibit on page 295

External Delay/Trigger Delay
Delays the trigger event of the signal from:
® The external trigger source

Use this setting to:
® Synchronize the instrument with the device under test (DUT) or other external devi-
ces

For more information, see chapter "Basics on ..." in the R&S SMM100A user manual.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:TRIGger [ :EXTernal] : DELay on page 295
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7.4 Marker settings

Access:

» Select "Baseband" > "Bluetooth" > "Marker".

Bluetooth — | X
ﬂ Trigger ¢ Marker _
Auto Internal
Mode Marker 1
Restart festart

Delay

0.000 sym Restart

Marker 3
Restart

This tab provides settings to select and configure the marker output signal includ-
ing marker mode and marker delay.
Routing and activating a marker signal

1. To define the signal shape of an individual marker signal "x", select "Marker" >
"Marker x" > "Mode".

2. Optionally, define the connector for signal output. See Chapter 7.6, "Local and
global connectors settings", on page 159.
You can map marker signals to one or more User x or T/M connectors.

3. Enable baseband signal generation. In the block diagram, set "Baseband" > "On".

The R&S SMM100A adds the marker signal to the baseband signal. Also,
R&S SMM100A outputs this signal at the configured User x connector.

About marker output signals

This section focuses on the available settings.

For detailed information on baseband trigger signals, see section About trigger signals”
in the R&S SMM100A user manual.

Settings:

1[0 To [T TP PPPPPUT PRI 156
DEIAY .ttt e e e e e e e e e et ——————————————————_ 158
Mode

Sets the marker mode that defines the shape and periodicity of the marker signals.

You can configure marker modes for up to 3 markers. The marker configuration
changes with the selected marker mode.

How to: "Routing and activating a marker signal" on page 156
"Restart" A marker signal is generated at the start of each signal sequence.
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"Event/Frame Start"

A marker signal is generated at the start of each event/frame. The
term event corresponds to a Bluetooth LE event, the term frame cor-
responds to a Bluetooth BR/EDR frame.

"Event/Frame Active Part"/"Event/Frame Inactive Part"

"Pulse"

"Pattern”

User Manual 1179.2054.02 — 07

The marker masks the active/inactive part of the event/frame. At the
start of each burst, the marker signal changes to high/low. It changes
back to low/high after the end of each burst.

Shift the marker signal at the start/end of each burst with the parame-
ters "Rising/Falling Edge Shift".

Also, for Bluetooth LE data packets higher than one, configure the
"Packet Index". The index corresponds to the transmitted Tx event
during the connection interval.

Remote command:

[ :SOURce<hw>] :BB:BTOoth:TRIGger :OUTPut<ch>:FESHift
on page 296

[ :SOURce<hw>] :BB:BTOoth:TRIGger:0UTPut<ch>:RESHift
on page 299

[ : SOURce<hw>] :BB:BTOoth:TRIGger :OUTPut<ch>:PINDex
on page 298

A regular marker signal is generated. The pulse frequency is defined
by entering a divider. The frequency is derived by dividing the sample
rate by the divider. The input box for the divider opens when "Pulse"
is selected, and the resulting pulse frequency is displayed below it.

Remote command:

[ : SOURce<hw>] :BB:BTOoth:TRIGger :O0UTPut<ch>:PULSe:
DIVider on page 298

[ : SOURce<hw>] :BB:BTOoth:TRIGger :0UTPut<ch>:PULSe:
FREQuency? on page 299

A marker signal that is defined by a bit pattern is generated. The pat-
tern has a maximum length of 32 bits and is defined in an input field
which opens when pattern is selected.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:TRIGger:0UTPut<ch>:PATTern
on page 298
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"On/Off Ratio"
A regular marker signal that is defined by an On/Off ratio is gener-
ated. A period lasts one On and Off cycle.
If "Marker Mode > On/Off Ratio", specify the "On Time" and "Off
Time", which are expressed as number of samples.

‘Ontime Off time On time Off time

Remote command:

[ : SOURce<hw>] :BB:BTOoth:TRIGger :0UTPut<ch>:0ONTime
on page 298

[ : SOURce<hw>] :BB:BTOoth:TRIGger:OUTPut<ch>:0FFTime
on page 298

Remote command:
[ : SOURce<hw>] :BB:BTOoth:TRIGger : OUTPut<ch>:MODE on page 297

Delay
Delays the marker signal at the marker output relative to the signal generation start.

Variation of the parameter "Marker x" > "Delay" causes signal recalculation.

Remote command:
[ :SOURce<hw>] :BB:BTOoth:TRIGger: 0OUTPut<ch>:DELay on page 296

7.5 Clock settings

Access:

» Select "Baseband" > "Bluetooth" > "Clock".

Bluetooth

— | X
uto Internal

Clock Source

Internal

This tab provides settings to select and configure the clock signal, like the clock
source and clock mode.

Defining the clock

1. Select "Clock" > "Source" to define the source of the clock signal.

2. For external clock signals, define the connector for the signal input. See Chap-
ter 7.6, "Local and global connectors settings", on page 159.
You can map clock signals to one or more User x or T/M connectors.

Local and global connectors settings allow you to configure the signal mapping, the
polarity, the trigger threshold and the input impedance of the input connectors.
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7.6

Local and global connectors settings

3. Activate baseband signal generation. In the block diagram, set "Baseband" > "On".

The R&S SMM100A starts baseband signal generation with a symbol rate that
equals the clock rate.

About clock signals
This section focuses on the available settings.

For detailed information on baseband trigger signals, see section About trigger signals"
in the R&S SMM100A user manual.

Settings:
(0o To QS To 1 U1 {07 =Y 159

Clock Source
Selects the clock source.
® ‘"Internal"
The instrument uses its internal clock reference.

How to: "Defining the clock" on page 158

Remote command:
[ :SOURce<hw>] :BB:BTOoth:CLOCk: SOURce on page 300

Local and global connectors settings

Opens a dialog to configure local connectors or global connectors.

The button is available in the following dialogs or tabs:

® "Trigger / Marker / Clock" dialog that is accessible via the "TMC" block in the block
diagram.

® "Trigger In", "Marker" and "Clock" tabs of baseband signal configuration dialogs
that you can open via the "Baseband" block in the block diagram. These tabs are
available, for example, for "ARB" baseband signals.

eLocal Connectors ...

See also chapter "Local and global connectors settings" in the user manual.

28 Global Connectors ..
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Remote control commands

The following commands are required to perform signal generation with the Bluetooth
options in a remote environment. We assume that the R&S SMM100A has already
been set up for remote operation in a network as described in the R&S SMM100A doc-
umentation. A knowledge about the remote control operation and the SCPI command
syntax is assumed.

Conventions used in SCPl command descriptions

For a description of the conventions used in the remote command descriptions, see
section "Remote Control Commands" in the R&S SMM100A user manual.

Common suffixes

The following common suffixes are used in remote commands:

Suffix Value range Description
SOURce<hw> 1 Available baseband signals
OUTPut<ch> 1t03 Available marker signals

Programming examples

This section provides simple programming examples. The purpose of the examples is
to present all commands for a given task. In real applications, you typically use an
appropriate subset of these commands.

For verification and testing purposes, a software tool executed these programming
examples. To keep the example as simple as possible, the examples report clean SCPI
syntax elements. Non-executable command lines, for example comments, start with
two characters / /.

Before executing a SCPI sequence, most remote control programs reset or preset the
instrument to a definite state. The commands *RST and SYSTem: PRESet are equiva-
lent for this purpose. *CLS also resets the status registers and clears the output buffer.

The following chapters describe the commands specific to the Bluetooth options
R&S SMM-K60, R&S SMM-K117 and R&S SMM-K178.

®  General COMMEANGS. .. .ciiii ittt ee e et e e e e e e e e e s an e ereeeeaaeaeeeaeaaas 161
e Dirty transmitter configuration.............ooev oo 166
e Channel configuration commands - LE...........ccoiiiiiiiii e, 173
e Event and frame configuration commands - LE........ccccoocoeiiiiiiiiiiiniiiee e, 179
e Channel sounding commands - LE.........ccceeeiiiiiiii e, 189
e Packet configuration commands - LE............cco o, 210
e Test packet configuration commands - LE.........ccccceoeeiiiiiiiiiiiiiiiieeeeee, 267
e Channel configuration commands - BR/EDR...........coiiiiiiiiiiiiiieeeeeeeeeee 271
e Packet configuration commands - BR/EDR.........ccooiiiiiiiiiiiiiieeeeeeee e 272
o Filter/clipping COMMANGS........coe i e e e e e e e e e e nans 281
e Power ramping COMMANAS.........ccccuriiiiiiiieeee e s ce et rr e e e e e e e e e sssenrarrreeeeeeeeeseesnns 288
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8.1

e Trigger commands
e Marker commands
e Clock commands

General

Remote control commands

General commands

commands

Example: To configure time units for timing and delay commands

The default time unit of timing and delay commands is millisecond. You can set time
unit to millisecond or to second.

:SOURcel:BB:

// Response:

BTOoth:UNIT:TIME?
Mg

// Change time unit to seconds.

:SOURcel:BB:

BTOoth:UNIT:TIME S

Example: To save and recall settings

MMEM:CDIR "/var/user/"

:SOURcel:BB:
:SOURcel:BB:
:SOURcel:BB:
// Response:
:SOURcel:BB:
:SOURcel:BB:
:SOURcel:BB

// Response:

BTOoth:PRESet
BTOoth:SETTing:STORe "/var/user/Bluetooth EDR"
BTOoth:SETTing:CATalog?

Bluetooth EDR,Bluetooth SCO,BTO test
BTOoth:SETTing:DELete "BTO_ test"
BTOoth:SETTing:LOAD "BTO dl1"

:BTOoth:SETTing:CATalog?

"Bluetooth EDR,Bluetooth SCO"

Example: To configure general Bluetooth BR/EDR settings

// KKK KA A A AR A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR A AR AR KRN KA KKK

// Set time

unit to ms.

VAR EEEEEE SRR LA EEEE SRR EE AR Rt

:SOURcel:BB:

BTOoth:UNIT:TIME MS

// RR R R Rk h dE I h b Sk E h h h b b b b E E b b E b b E E E h b b b b b dh b E b b b h b b b b E b 3h b b b E b b b b b b b b b i

// Set frequency and level.

// Set BR/EDR PHY and transport modes.

// Query the version of the digital standard.

// Generate

and save a waveform file in the current directory.

// KKK KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR AR AR KKK

SOURcel :FREQuency:CW 2402000000
SOURcel : POWer:POWer -50

:SOURcel:BB:
:SOURcel:BB:
// :SOURcel
// :SOURcel

:SOURcel:BB:

BTOoth:BMODe BAS
BTOoth:TMODe ACL

:BB:BTOoth:TMODe SCO
:BB:BTOoth:TMODe ESCO

BTOoth:VERSion?

// Supported Bluetooth version, for example, "4.2".

:SOURcel:BB:
:SOURcel:BB:

BTOoth:STATe ON
BTOoth:WAVeform:CREate "Bluetooth EDR"
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Example: To configure general Bluetooth LE settings
// khkhkhkhkhkhkhkkhkhhhkhkhkhbhkhkhkhkhkhhhkhkhkhbhkhkhkhhhhhhkhkhrhhkhhkhkhhhkhkhkhrhrhkhkhkhkkhkhhhkhhrhhhkhkhk*k

// Set time unit to ms.

// ER R R E h h E b b b S I E I h b h b b E E b E E b b E E E b b b b b b dh b b b b b h 3h b b b E b 3E b b b b b h b b b b b b b 3

:SOURcel:BB:BTOoth:UNIT:TIME MS

// KKK KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR A A AR AR KRR XA KKK
// Set frequency and level.

// Set LE PHY and query the version of the digital standard.

// Generate and save a waveform file in the current directory.

// ER R R dE b b S E E I E I b Ih b b E b b E E b E E E h b b b b dh b b b b b E b b b b E b 3E b b E E b b b b b b b b b 3
SOURcel :FREQuency:CW 2402000000

SOURcel :POWer:POWer -10

:SOURcel :BB:BTOoth:BMODe BLEN

:SOURcel :BB:BTOoth:VERSion?

// Supported Bluetooth version, for example, "5.4".
:SOURcel:BB:BTOoth:STATe ON

:SOURcel:BB:BTOoth:WAVeform:CREate "Bluetooth LE"

[:SOURCe<hw>]:BB:BTOOth:BCTEXE?.c.eerreruerununueaaaaaeaeeeeeeeeeeeeeeeeeeeeeeeeeeenennnnnnaaaaaaeaeeeeas 162
[:SOURCce<hw>]:BB:BTOOtN:BMODE..........ceevvrerrrrurnrnnniiiaieeeeeeseeeeeeeeeeesereeeersersrsssnrnsnnan.. 163
[:SOURCe<hw>]:BB:BTOOth:PRESEL......ccvuuiieeeeiiiiiieieeieeiiiee e e e ettt e e e e eetae e e e e eeab e e e e eeeenns 163
[:SOURCce<hw>]:BB:BTOOth:SETTING:CATAIOF. ... ceeeeerrineeeeeeeriiieeeeeeeeteeeeeeeernteeeeeeeerannnnns 164
[:SOURce<hw>]:BB:BTOOth:SETTING:DELEte....c.eiiiiiiieeee e 164
[:SOURce<hw>]:BB:BTOOth:SETTING:LOAD......cuuiiiei ettt e e 164
[:SOURCce<hw>]:BB:BTOOth:SETTING:STORE.....ccceeietieieeieeiie e eeeeetr e e e ee e e e e e e e 164
[:SOURCE<hW>]:BB:BTOOtN:STATE...ceeeurrrurnrnrnnuaaaaaaeeeeeeeeaeaaeeeeeeeeereenensnsnnnnnnnnaaaaaeaeaees 165
[:SOURCe<hw>]:BB:BTOOtN: TMODE. .. .ceieieieieieeeeeeeieeeeeeeeeeeeeerebareeaeseeeeeeeeeaeaaeeeeereeeees 165
[:SOURCce<hw>]:BB:BTOOth:UNITTIME......uuceieeiiieiiiieeeeeeettieeeeeeeeteeeeeeeeeetaeeeeeeeennaeeeeeeees 165
[:SOURce<hw>]:BB:BTOOth:VERSION?... ..t et 165
[:SOURce<hw>]:BB:BTOOth:WAVEform:CREALE.........ccvueeeeeieiiiiieeeeeeeereeeee e e eeeanees 166

[:SOURce<hw>]:BB:BTOoth:BCText?
Queries the state and controller role.

Return values:
<BcText> string

Connected
(only data channel type)

Advertiser

(only advertising channel type)

ADV_IND, ADV_DIRECT_IND, ADV_NONCONN_IND,
ADV_SCAN_IND

Within R&S SMM-K117 also ADV_EXT _IND, AUX_ADV_IND,
AUX_SYNC_IND, AUX_CHAIN_IND
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Scanner

(only advertising channel type)

SCAN_REQ, SCAN_RSP

Within R&S SMM-K117 also AUX_SCAN_REQ,
AUX_SCAN_RSP

Initiator

(only advertising channel type)

CONNECT_IND

Within R&S SMM-K117 also AUX_CONNECT_REQ,
AUX_CONNECT_RSP

Example: See Example"To configure general Bluetooth BR/EDR settings"
on page 161.
Usage: Query only

Manual operation: See "Bluetooth Controller State" on page 49

[:SOURce<hw>]:BB:BTOoth:BMODe <BMode>
Sets the Bluetooth mode.

Parameters:
<BMode> BASic | BLENergy

BASic
Sets basic rate (BR) or enhanced data rate (EDR) Bluetooth
mode.

BLENergy
Sets low energy (LE) Bluetooth mode.

*RST: BASic

Example: See Example"To configure general Bluetooth BR/EDR settings"
on page 161.

Manual operation: See "Bluetooth Mode" on page 37

[:SOURce<hw>]:BB:BTOoth:PRESet

Sets the parameters of the digital standard to their default values (*RST values speci-
fied for the commands).

Not affected is the state set with the command SOURce<hw>:BB:BTOoth:STATe.
Example: See Example"To save and recall settings" on page 161.
Usage: Event

Manual operation: See "Set To Default" on page 35
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[:SOURce<hw>]:BB:BTOoth:SETTing:CATalog <Catalog>

Queries the files with settings in the default directory. Listed are files with the file exten-

sion * .bto.
Parameters:
<Catalog> string
Returns a string of file names separated by commas.
Example: See Example"To save and recall settings" on page 161.

Manual operation: See "Save/Recall" on page 36

[:SOURce<hw>]:BB:BTOoth:SETTing:DELete <Filename>

Deletes the selected file from the default or specified directory. Deleted are files with
the file extension * .bto.

Parameters:
<Filename> string

file name or complete file path; file extension can be omitted
Example: See Example"To save and recall settings" on page 161.

Manual operation: See "Save/Recall" on page 36

[:SOURce<hw>]:BB:BTOoth:SETTing:LOAD <Filename>

Loads the selected file from the default or the specified directory. Loaded are files with
extension * .bto.

Parameters:
<Filename> string

file name or complete file path; file extension can be omitted
Example: See Example"To save and recall settings" on page 161.

Manual operation: See "Save/Recall" on page 36

[:SOURce<hw>]:BB:BTOoth:SETTing:STORe <Filename>

Saves the current settings into the selected file; the file extension (* .bto) is assigned
automatically.

Setting parameters:
<Filename> string

file name or complete file path
Example: See Example"To save and recall settings" on page 161.
Usage: Setting only

Manual operation: See "Save/Recall" on page 36
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[:SOURce<hw>]:BB:BTOoth:STATe <State>

Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

Parameters:

<State> 1|ON |0 | OFF
*RST: 0

Example: See Example"To configure general Bluetooth BR/EDR settings"
on page 161.

Manual operation: See "State" on page 35

[:SOURce<hw>]:BB:BTOoth:TMODe <TMode>
Selects the transport mode.

Parameters:

<TMode> ACL | SCO | ESCO

ACL
Asynchronous connection-less (ACL) mode used for a point-to-
point multipoint link between a Central and all Peripherals.

SCO
Synchronous connection-oriented (SCO) mode used for a point-
to-point link between a Central and a specific Peripheral.

ESCO
Enhanced SCO mode used for a symmetric or asymmetric point-
to-point link between a Central and a specific Peripheral.

*RST: ACL

Example: See Example"To configure general Bluetooth BR/EDR settings"
on page 161.

Manual operation: See "Transport Mode" on page 37

[:SOURce<hw>]:BB:BTOoth:UNIT:TIME <Time>

Sets the time unit for remote control commands.

Parameters:
<Time> S| MS
*RST: MS
Example: See Example"To configure time units for timing and delay com-

mands" on page 161.

[:SOURce<hw>]:BB:BTOoth:VERSion?

Queries the version of the specification for Bluetooth wireless technology underlying
the definitions.
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Return values:

<Version> string

Example: See Example"To configure general Bluetooth BR/EDR settings"
on page 161.

Usage: Query only

Options: Version 5.x requires R&S SMM-K117.

Version 5.5 requires R&S SMM-K178.

Manual operation: See "Bluetooth Version" on page 37

[:SOURce<hw>]:BB:BTOoth:WAVeform:CREate <Filename>
Saves the current settings as an ARB signal in a waveform file (* . wv).

Setting parameters:

<Filename> string

Example: See Example"To configure general Bluetooth BR/EDR settings"
on page 161.

Usage: Setting only

Manual operation: See "Generate Waveform" on page 36

8.2 Dirty transmitter configuration

Example: To configure a dirty transmitter
// ER R R S B S B i I I I I I I I I I e e i b I i I i b I I e R b b b b b b I I I b b b b b b b

// Set modulation index mode to stable.

// ER R R R R R I I R R R R I I I R R R E R E E E E h h E E I E I I E I b b I b E I I I i

SOURcel:BB:BTOoth:DTTest:MIMode STAB

// RER R R R R R I R R I R R R I I I I I R R R E R E I R b E E I I E I h E I b I I I E I E I I I 3

// Reset dirty transmitter. Set frequency drift rate, start phase,

// frequency drift deviation and number of packets

// per dirty transmitter set (LE only). Enable dirty transmitter.

A
SOURcel:BB:BTOoth:DTTest:STDefault

SOURcel:BB:BTOoth:DTTest:FDRate 1.25

SOURcel:BB:BTOoth:DTTest:SPHase 0
SOURcel:BB:BTOoth:DTTest:FDDeviation 50
SOURcel:BB:BTOoth:DTTest :NPPSet NP50

// ER R R R R R I I R I I R I I I E R R R E E E I I b E E I R E b I E b b b I b E E I b 3

// Enable all long sets for LE or BR dirty transmitter.

// KKK KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR A AR AR AR AR KKK

SOURcel:BB:BTOoth:DTTest:TABLe:LONG:SET1:STATe 1
SOURcel :BB:BTOoth:DTTest:TABLe: LONG:SET2:STATe 1
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SOURcel:BB:BTOoth:DTTest :TABLe:LONG:SET3:STATe
SOURcel:BB:BTOoth:DTTest:TABLe:LONG:SET4:STATe
SOURcel:BB:BTOoth:DTTest:TABLe:LONG:SET5:STATe
SOURcel:BB:BTOoth:DTTest :TABLe:LONG:SET6:STATe
SOURcel:BB:BTOoth:DTTest:TABLe:LONG:SET7:STATe
SOURcel:BB:BTOoth:DTTest:TABLe:LONG:SET8:STATe

= R S T e

SOURcel:BB:BTOoth:DTTest:TABLe:LONG:SET9:STATe
SOURcel:BB:BTOoth:DTTest:TABLe:LONG:SET10:STATe 1
// Ak hkkhkhkhkhkhkhkhkhhkhkhhkhkhhkhkhkhhkhkhkhkhkdhhhkhhkhkhkdh kb hkhkhkhkhkhkhhkhkhkhkhkdhkhkhkhkhkhkhhhkhhkhxkx*x

// Enable dirty transmitter.

// KKK KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR AR AN KA KA KK

SOURcel:BB:BTOoth:DTTest:DTTState 1

[:SOURce<hw>]:BB:BTOOth:DTTest:DTTState......cceeeeeeeeeeeieeeieiiiiiiieee e e e e e e e e e e e eeeeeeeees 167
[:SOURce<hw>]:BB:BTOo0th:DTTest:FDDEVItioN............cceveveiieeeeeeerereiiriiene e e e e e e e e 167
[:SOURce<hw>]:BB:BTOOth:DTTest:FDRALE......uuucieeeeeiiiieieeeeeeiiie e e e eeene e e e eeree e e e e eeraans 168
[:SOURce<hw>]:BB:BTOOth:DTTeSt:MIMOUE. ......cevueieeeiiiiiieeeeeeeeiee e e e eeetiee e e e e eeveeeeeeeeees 168
[:SOURce<hw>]:BB:BTOOth:DTTest:NPPSEt.......coeieiieee e 168
[:SOURce<hw>]:BB:BTOOth:DTTeSt:SPHASE.....ccceieieiiieeeeeeiiice e e et e e e ee e e e e e e 169
[:SOURce<hw>]:BB:BTOoth:DTTest:STDEfaUlt........c.ceeeeeiuiieieeeeiecce e e e e e 169
[:SOURce<hw>]:BB:BTOOth:DTTEeSt: TABLE. ...cvtteteerueenaaaaeieieeeeeeeeeaeeeeeeeeeeeeeeneennnnnnaneans 169
[:SOURce<hw>]:BB:BTOoth:DTTest: TABLe:LONG:SET<ch>:CFOFfSet........uuvveeereeeeeeiiennns 170
[:SOURce<hw>]:BB:BTOoth:DTTest: TABLe:LONG:SET<ch>:MINDEX.........cevrrrrrrrrrnrmrnnnnnnn 170
[:SOURce<hw>]:BB:BTOoth:DTTest: TABLe:LONG:SET<Ch>:STATE....ccceevuriiniiiiiieieeeeaennns 171
[:SOURce<hw>]:BB:BTOoth:DTTest: TABLe:LONG:SET<ch>:STERror........ccoiiiuiiiiiieiiiaennns 171
[:SOURce<hw>]:BB:BTOoth:DTTest: TABLe:SHORt:SET<ch>:CFOFfset.........ccceevieeneiennnen. 172
[:SOURce<hw>]:BB:BTOoth:DTTest: TABLe:SHORt:SET<Ch>:STATE....c..oivrvrrieriieiereeeen. 172
[:SOURce<hw>]:BB:BTOoth:DTTest: TABLe:SHORt:SET<Ch>:STERIOI.......cctvtreeeeeriiiianine 173

[:SOURce<hw>]:BB:BTOoth:DTTest:DTTState <DttState>
Activates the "Dirty Transmitter Test".

For EDR packets, the parameter sets apply for 20 packets each.

Parameters:
<DttState> 1|/ ON |0 | OFF
*RST: 0
Example: See Example"To configure a dirty transmitter" on page 166.

Manual operation: See "Dirty Transmitter Test" on page 41

[:SOURce<hw>]:BB:BTOoth:DTTest:FDDeviation <FdDeviation>
Sets a frequency drift rate.

A sine wave is used to drift the modulated Bluetooth signal around center frequency +
carrier frequency offset. The maximum deviation reached during the drift equals the set
frequency drift deviation.
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Parameters:
<FdDeviation> integer
Range: -100 to 100
*RST: 25
Example: See Example"To configure a dirty transmitter” on page 166.

Manual operation: See "Frequency Drift Deviation(+/-)" on page 41

[:SOURce<hw>]:BB:BTOoth:DTTest:FDRate <FdRate>
Sets a frequency drift rate.

A sine wave is used to drift the modulated Bluetooth signal around center frequency +
carrier frequency offset with the set frequency drift rate.

Parameters:
<FdRate> 0.3KHz | 0.5KHz | 1.6 KHz | 10 KHz
Range: depends on packet type to depends on packet
type
Increment: 0.001
*RST: depends on packet type
Example: See Example"To configure a dirty transmitter" on page 166.

Manual operation: See "Frequency Drift Rate" on page 41

[:SOURce<hw>]:BB:BTOoth:DTTest:MIMode <MIMode>

Determines standard or stable mode for the modulation index of dirty transmitter
according to the Bluetooth core specification.

Parameters:
<MIMode> STANdard | STABle
*RST: STANdard
Example: See Example"To configure a dirty transmitter" on page 166.
Options: R&S SMM-K117

Manual operation: See "Modulation Index Mode" on page 41

[:SOURce<hw>]:BB:BTOoth:DTTest:NPPSet <NumPack>
Specifies the number of packets per dirty transmitter set.

Specifies the number of packets or CS steps per dirty transmitter set.

Bluetooth mode Channel type Number of packets

BR + EDR - 50, 2, 1 packets

LE Advertising, data 50, 2, 1 packets

LE Channel sounding | 50, 20, 18, 16, 14, 12, 10, 8, 6, 4, 2, 1 CS steps
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Parameters:

<NumPack> NP50 | NP2 | NP1 | NP4 | NP6 | NP8 | NP10 | NP12 | NP14 |
NP16 | NP18 | NP20
*RST: NP50

Example: See Example"To configure a dirty transmitter” on page 166.

Manual operation: See "Number Of Packets Per Set/Number Of Steps Per Set"
on page 42

[:SOURce<hw>]:BB:BTOoth:DTTest:SPHase <SPhase>
The command enters a start phase.

The start phase applies to the sine wave that is used to drift the modulated Bluetooth
signal. The drift is around the center frequency plus the carrier frequency offset.

Parameters:
<SPhase> integer
Range: 0 to 359
Increment: 1
*RST: 0
Default unit: degree
Example: SOURcel :BB:BTO:DTT:SPH 0
enters a start phase.
Example: See also Example"To configure a dirty transmitter" on page 166.

Manual operation: See "Start Phase" on page 41

[:SOURce<hw>]:BB:BTOoth:DTTest:STDefault

The command calls the default settings for the Dirty Transmitter Test.

Example: SOURcel :BB:BTO:DTT:STD

calls the default settings.
Example: See also Example"To configure a dirty transmitter" on page 166.
Usage: Event

Manual operation: See "Set To Default" on page 40

[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe <Table>

Opens the table settings.
Parameters:
<Table> NOTable | SHORt | LONG
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Example: SOURcel :BB:BTO:PTYP DHI1

calls the default settings.
SOURcel:BB:BTO:DTT: TABL LONG

See also Example"To configure a dirty transmitter" on page 166.

Example: calls the default settings.

[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:LONG:SET<ch>:CFOFfset <CfOffset>
Sets a carrier frequency offset.

The carrier frequency offset shows the deviation of the transmitted initial center fre-
quency from carrier frequency.

Parameters:
<CfOffset> integer
Range: -150 to 150
*RST: 1
Default unit: kHz
Example: SOURcel :BB:BTO:PTYP DHI1
sets the packet type.
SOURcel :BB:BTO:DTT:TABL LONG
sets the table type
SOURcel :BB:BTO:DTT:TABL:LONG:SET2:CFOF 14
sets a carrier frequency offset.
Example: See also Example"To configure a dirty transmitter" on page 166.

Manual operation: See "Carrier Frequency Offset (kHz)" on page 42

[:SOURce<hw>]:BB:BTOoth:DTTest: TABLe:LONG:SET<ch>:MINDex <MIndex>
Sets the modulation index, that specifies the frequency deviation.

The modulation index h is defined as:

ety

fs}mbﬂi

b=

with

7= "symbol rate" , set with the command [ : SOURce<hw>] : BB:BTOoth:SRATe:
VARiation

4= "frequency deviation", set with the command [ : SOURce<hw>] :BB:BTOoth:
MSETtings:FDEViation

According to the Bluetooth standard, the modulation index is allowed to vary between
0.28 and 0.35.
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Parameters:
<MIndex>

Example:

Example:

Manual operation:

Dirty transmitter configuration

float

Range: 0.28 to 0.55
Increment: 0.01
*RST: 0.28

SOURcel:BB:BTO:PTYP DHI1

sets the packet type.
SOURcel :BB:BTO:DTT:TABL LONG

enters the table type
SOURcel :BB:BTO:DTT:TABL:LONG: SET2:MIND 0.3

enters a modulation index.
See also Example"To configure a dirty transmitter" on page 166.

See "Modulation Index" on page 43

[:SOURce<hw>]:BB:BTOoth:DTTest: TABLe:LONG:SET<ch>:STATe <State>

Activates the corresponding parameter set for the long table.

For basic rate packets, each set applies to 20 ms of signal.

Parameters:
<State>

Example:

Example:

Manual operation:

1] ON |0 | OFF
*RST: 1
SOURcel:BB:BTO:PTYP DH1

sets the packet type.
SOURcel:BB:BTO:DTT:TABL LONG

sets the table type
SOURcel :BB:BTO:DTT: TABL:LONG:SET2:STAT ON

activates the set 2 in the long table.
See also Example"To configure a dirty transmitter" on page 166.

See "State" on page 42

[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:LONG:SET<ch>:STERror <StError>

Sets a symbol timing error in ppm.

This parameter modifies the symbol clock frequency by the set value.

Parameters:
<StError>
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Range: -150 to 150
*RST: 1

Default unit: ppm

171



R&S®SMM-K60/-K117/-K178

Remote control commands

Example:

Example:

Manual operation:

Dirty transmitter configuration

SOURcel:BB:BTO:PTYP DHI1

sets the packet type.
SOURcel :BB:BTO:DTT:TABL LONG

sets the table type
SOURcel :BB:BTO:DTT:TABL:LONG:SET2:STER -20

sets a symbol timing error.
See also Example"To configure a dirty fransmitter” on page 166.

See "Symbol Timing Error (ppm)" on page 43

[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:SHORt:SET<ch>:CFOFfset <CfOffset>

Sets a carrier frequency offset.

The carrier frequency offset shows the deviation of the transmitted initial center fre-
quency from carrier frequency.

Parameters:
<CfOffset>

Example:

Example:

Manual operation:

integer

Range: -150 to 150
*RST: 1

Default unit: kHz
SOURcel:BB:BTO:PTYP DHI1

sets the packet type.
SOURcel :BB:BTO:DTT:TABL SHOR

sets the table type
SOURcel :BB:BTO:DTT:TABL: SHOR: SET2:CFOF 65

sets a carrier frequency offset.
See also Example"To configure a dirty transmitter" on page 166.

See "Carrier Frequency Offset (kHz)" on page 42

[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:SHORt:SET<ch>:STATe <State>

Activates the corresponding parameter set in the short table. If a set deactivated, its
parameters are skipped in the sequence. Instead, the next active set is used.

For EDR packets, each set applies to 20 packets.

Parameters:
<State>

Example:

Example:
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1] ON |0 | OFF
*RST: 1

SOURcel:BB:BTO:PTYP DHI1

sets the packet type.
SOURcel :BB:BTO:DTT:TABL SHOR

sets the table type
SOURcel :BB:BTO:DTT:TABL:SHOR: SET2:STAT ON

activates the set 2 in the short table.

See also Example"To configure a dirty transmitter" on page 166.
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8.3

Channel configuration commands - LE

Manual operation: See "State" on page 42

[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:SHORt:SET<ch>:STERror <StError>
Sets a symbol timing error in ppm.

The symbol timing error modifies the symbol clock frequency by the set amount.

Parameters:
<StError> integer
Range: -150 to 150
Increment: 1
*RST: 1
Example: SOURcel :BB:BTO:PTYP DHI
sets the packet type.
SOURcel:BB:BTO:DTT:TABL SHOR
enters the table type
SOURcel :BB:BTO:DTT:TABL:SHOR: SET2:STER 20
enters a symbol timing error.
Example: See also Example"To configure a dirty transmitter" on page 166.

Manual operation: See "Symbol Timing Error (ppm)" on page 43

Channel configuration commands - LE

Example: To configure general channel settings for LE
// KAk hkkhkhkhkhkhkhkhkhkhhkhhkhkhhk bk hhkhhbhkhhkhhkh bk hbhhhkh bk hhk bk hkhhkhk b hkhkhk kb kb hkhkhkhkhkkhkx*k

// Set time unit to ms.

// ER R R kb dh b bk bk h h b b b b b h h b E E b b E E E b b b b b b b b b b b b b b b b b h b b b b b b b b b b b b b b b b

SOURcel :BB:BTOoth:UNIT:TIME MS

// ER R R kb dE b b b b b h h b I b h b b E b b E E b b E E E b b b b b b dh b b b b b b h b b b b b 3h b b b b b b b b b b b b b 3

// Select channel type, test packet, packet format, sequence length,
// controller role. Enable CRC corruption for every second packet.

// RR R Rk b dE b b b bk b b h b b b b b E E b b E b b E h E b b b b b b dh b b b b b b b b b b b b 3E b b b b b b b b b b b b b b
SOURcel:BB:BTOoth:CTYPe DATA

SOURcel:BB:BTOoth:UPTYpe TPAC

SOURcel:BB:BTOoth:PFORmat L2M

SOURcel:BB:BTOoth:USLength 2

SOURcel:BB:BTOoth:BCRole CENTral

SOURcel:BB:BTOoth:CCRC:STATe 1

// ER Rk b dh b b b b b E E E b E b b b b h b E E b b h h E b b b b b b b b b b b b b b b b b b b 3E b b b b b b b b b b b b b i

// Alternatively set duty cycle for ADV DIRECT IND

// KK A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A KA A AR A A AR AR KA A K

SOURcel:BB:BTOoth:CTYPe ADV
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SOURcel:BB:BTOoth:UPTYpe ADIN
SOURcel:BB:BTOoth:DCYCle LOW

[:SOURce<hw>]:BB:BTOOth:BCROIE........ceeiiiiirieinniniaaaaaaaae e e e e e eeeeeaeeeeeeeeeeeaeeeeenennnneenns 174
[:SOURCce<hw>]:BB:BTOOth:CCRC:STATE.......etverrrrererererrinniiaeieieseseeeeeeeaeseererereeeesssssranes 174
[:SOURCE<hW>]:BB:BTOOtN:CTY P cuuuiieieetiiieieeeeetiieieeeeettee e e e e eeebe s e e e eeessteeeeeeestnnaeaeens 175
[:SOURCe<hw>]:BB:BTOOth:DCY CIE....uuuiieeeiieiieeeeeeeetteee e eeeeetee e e e et e e e e e et e e e e eeeaaanns 175
[:SOURce<hw>]:BB:BTOOth:PFORMAL.......cuiiiiiiiiiiii e e 175
[:SOURGESNWS]:BB:BTOON: UPTYDE. c..eeeeeeeeseseeseseeseesesesseseeseseaseseesesenseseeseseesesseseseesenes 176
[:SOURCce<hw>]:BB:BTOOth:USLENGth......ccereiiiiieeieeiicee et 178
[:SOURce<hw>]:BB:BTOOth:MFORMAL......uuuuuuuaaaeieieeeeeeeeeeeeeeeeeeeeeeeeeeeeeeinnenne s e e e e e s 178
[:SOURCce<hw>]:BB:BTOOth:DURGON. ....c.ceeeeeeeeeeeeieieeeeeeeeeverrebireeeeeieseeeeeeeaeeeeeeeeeereeeees 179

[:SOURce<hw>]:BB:BTOoth:BCRole <BcRole>
Sets the Bluetooth controller role.

Depending on the selected channel type different roles are assigned to the controller.
For channel type "Data", you can assign Central or Peripheral.

If the channel type is "Advertising", the parameter is read only and displayed directly
above the graph.

Parameters:
<BcRole> CENTral | PERipheral | ADVertiser | SCANner | INITiator

CENTral
Selects Central as controller role.

PERipheral
Selects Peripheral as controller role.

ADVertiser|SCANner|INITiator
Assigned roles depending on the selected packet type of the
respective channel type.

*RST: CENTral

Example: See Example"To configure general channel settings for LE"
on page 173.

Manual operation: See "Bluetooth Controller Role" on page 48

[:SOURce<hw>]:BB:BTOoth:CCRC:STATe <State>

Enables/disables the corruption of CRC for every second generated packet. If enabled,
only 50% of packets are generated with correct CRC.

Parameters:

<State> 1]ON|0|OFF
*RST: 0

Example: See Example"To configure general channel settings for LE"
on page 173.

Manual operation: See "Corrupted CRC Every 2nd Packet" on page 49
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[:SOURce<hw>]:BB:BTOoth:CTYPe <CType>
Determines the channel type. Advertising and data are available.

Parameters:
<CType> ADVertising | DATA | | CS

ADVertising
Selects channel type advertising.

DATA

Selects channel type data. Devices in a connected state transmit
data channel packets in connection events with a start point and
an interval.

CS
Requires R&S SMM-K178.
Selects channel type channel sounding.

*RST: ADVertising

Example: See Example"To configure general channel settings for LE"
on page 173.

Manual operation: See "Channel Type" on page 46

[:SOURce<hw>]:BB:BTOoth:DCYCle <DCycle>
Specifies duty cycle for directed advertising (packet type ADV_DIRECT_IND).

Parameters:

<DCycle> LOW | HIGH
*RST: HIGH

Example: See Example"To configure general channel settings for LE"
on page 173.

Options: R&S SMM-K117

Manual operation: See "Duty Cycle" on page 48

[:SOURce<hw>]:BB:BTOoth:PFORmat <PFormat>

Selects the packet format that is the format according to the physical layer (PHY) that
supports the packet type or PDU type.

Parameters:

<PFormat> L1M | L2M | LCOD | L2M2B
L1M
LE uncoded PHY with 1 Msymbol/s modulation.
L2M

LE uncoded PHY with 2 Msymbol/s modulation and bandwidth
time product BT = 0.5.

LCOD
LE coded PHY with 1 Msymbol/s modulation.
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Example:

Options:

Manual operation:

L2M2B

Channel configuration commands - LE

LE uncoded PHY with 2 Msymbol/s modulation and bandwidth

time product BT = 2.

*RST: L1M

See Example"To configure general channel settings for LE"

on page 173.

L2M and LCOD require option R&S SMM-K117.
L2M2B requires option R&S SMM-K178.

See "Packet Format" on page 48

See "PHY" on page 128

[:SOURce<hw>]:BB:BTOoth:UPTYpe <UpType>

Selects the packet type.

The available packets depend on the selected channel type and installed options. The
tables below provide an overview.

Table 8-1: R&S SMM-K60 packet/PDU types

<UpType> Packet/PDU type <UpType> Packet/PDU type
AIND ADV_IND ERSP LL_ENC_RSP

ADINd ADV_DIRECT_IND SEReq LL_START_ENC_REQ
ANINd ADV_NONCONN_IND SERSp LL_START_ENC_RSP
SREQ SCAN_REQ URSP LL_UNKNONW_RSP
SRSP SCAN_RSP FREQ LL_FEATURE_REQ
CREQ CONNECT_IND FRSP LL_FEATURE_RSP
ADCind ADV_SCAN_IND TPACket TEST PACKET

DATA DATA PEReq LL_PAUSE_ENC REQ
CUReq LL_CONNECTION_UPDATE_IND | PERSp LL_PAUSE_ENC_RSP
CMReq LL_CHANNEL_MAP_IND VIND LL_VERSION_IND
TIND LL_TERMINATE_IND RIND LL_REJECT_IND
EREQ LL_ENC_REQ
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Table 8-2: R&S

SMM-K117 packet/PDU types

Channel configuration commands - LE

<UpType> Packet/PDU type <UpType> Packet/PDU type

PREQ LL_PHY_REQ ACINd AUX_CHAIN_IND

PRSP LL_PHY_RSP ASINd AUX_SYNC_IND

PUIN LL_PHY_UPDATE_IND ASReq AUX_SCAN_REQ

LREQ LL_LENGTH_REQ ASPSp AUX_SCAN_RSP

LRSP LL_LENGTH_RSP ACRSp AUX_CONNECT_RSP

SFR LL_PERIPHERAL_FEATURE_REQ | ACReq AUX_CONNECT_REQ

CPR LL_CONNECTION_PARAM_REQ MUCH LL_MIN_USED_CHANNELS_IND
CPRS LL_CONNECTION_PARAM_RSP CONT CONTINUOUS

REIN LL_REJECT_EXT_IND CTEQ LL_CTE_REQ

PIR LL_PING_REQ CTEP LL_CTE_RSP

PIRS LL_PING_RSP PSIND LL_PERIODIC_SYNC

AEINd ADV_EXT_IND CAReq LL_CLOCK_ACCURACY_REQ
AAINd AUX_ADV_IND CARSp LL_CLOCK_ACCURACY_RSP
Table 8-3: R&S SMM-K178 packet/PDU types

<UpType> Packet/PDU type <UpType> Packet/PDU type

CSSEq CS_SEQUENCE CSREQ LL_CS_REQ

CSRQ LL_CS_SEC_REQ CSRSP LL_CS_RSP

CSRP LL_CS_SEC_RSP CSIND LL_CS_IND

CCRQ LL_CS_CAPABILITIES_REQ CTI LL_CS_TERMINATE_IND
CCRP LL_CS_CAPABILITIES_RSP CFRQ LL_CS_FAE_REQ

COREQ LL_CS_CONFIG_REQ CFRP LL_CS_FAE_RSP

CORSP LL_CS_CONFIG_RSP CCMI LL_CS_CHANNEL_MAP_IND

For more information, refer to the specifications document.

Parameters:
<UpType>

Example:

Manual operation:

AIND | ADINd | ANINd | SREQ | SRSP | CREQ | ADCind |
DATA | CUReq | CMReq | TIND | EREQ | ERSP | SEReq |
SERSp | URSP | FREQ | FRSP | TPACket | PEReq | PERSp |
VIND | RIND | PREQ | PRSP | PUIN | LREQ | LRSP | SFR |
CPR | CPRS | REIN | PIR | PIRS | AEINd | AAINd | ACINd |
ASINd | ASReq | ASPSp | ACRSp | ACReq | MUCH | CONT |
CTEQ | CTEP | PSINd | CAReq | CARSp | CSSEQ | CSRQ |
CSRP | CCRQ | CCRP | COREQ | CORSP | CSREQ | CSRSP |
CSIND | CTI | CFRQ | CFRP | CCMI

*RST: AIND
IdPDbBtoCsCtrIRfu

See Example"To configure general channel settings for LE"

on page 173.
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[:SOURce<hw>]:BB:BTOoth:USLength <UsLength>

Selects the number of frames or events depending on the packet type. The signal
repeats after the specified number of frames/events.

For SCAN_REQ and CONNECT _IND packet, the sequence length is expressed in
"Frames".

For AUX_SCAN_REQ and AUX_CONNECT_REQ packet, the sequence length is
expressed in "Frames".

For LL_TERMINATE_IND packets, a default value according to the specification is
given:

Central: PeripheralLatency + 6
Peripheral: 6

For all other packet types the sequence length is expressed in "Events".

Parameters:
<UslLength> integer
Range: depends on the number of states in dirty transmitter
test to dynamic
*RST: 1
Example: See Example"To configure general channel settings for LE"
on page 173.

Manual operation: See "Sequence Length" on page 48

[:SOURce<hw>]:BB:BTOoth:MFORmat <ModFmt>

Sets the LE PHY for continuous payload transmission. This transmission requires a
CONTINUOUS packet:

:SOURcel :BB:BTOoth:UPTYpe CONT
Parameters:
<ModFmt> L1M | L2M | LCOD

L1M: LE 1M

L2M: LE 2M

LCOD: LE coded

See also [ : SOURce<hw>] :BB:BTOoth: PFORmat
on page 175.

*RST: L1M

Example: See Example"To configure general channel settings for LE"
on page 173.

Options: L2M and LCOD require R&S SMM-K117.

Manual operation: See "Modulation Format" on page 49
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Event and frame configuration commands - LE

[:SOURce<hw>]:BB:BTOoth:DURation <Duration>

Sets the transmission duration for continuous payload transmission. This transmission
requires a CONTINUOUS packet:

:SOURcel :BB:BTOoth:UPTYpe CONT
Command sets the values in ms. Query returns values in s.

The duration range, increment and default value depend on the modulation format,
symbols per a bit and payload type.

For more information, refer to the specifications document.

Parameters:
<Duration> float
Range: depends on settings
Increment: depends on settings
*RST: depends on settings
Default unit: ms
Example: See Example"To configure general channel settings for LE"

on page 173.

Manual operation: See "Duration" on page 49

Event and frame configuration commands - LE

Example: Configure event and frame configuration settings

// KKK KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR AR AR RN KA KKK
// For ADV_SCAN IND, select advertising event interval.

// o o
SOURcel:BB:BTOoth:CTYPe ADV

SOURcel:BB:BTOoth:UPTYpe ADC
SOURcel:BB:BTOoth:ECONfiguration:AEINterval 20

// ER R Rk b E b b b b b E I h b h b b b b b E E b b h E E b b b b b b b b b b b b b h b b b b b 3E b b b b b b b b b b b b b b

// Alternatively set advertising event interval for ADV DIRECT IND.
// ****************************************************:******:******
SOURcel:BB:BTOoth:CTYPe ADV

SOURcel:BB:BTOoth:UPTYpe ADIN
SOURcel:BB:BTOoth:ECONfiguration:ADINterval 3.75

// R R dE kb b b b h b Sk E h h b b b b b E b b E E b b E h E b b b b b b b b b b b b b b b b b h b 3h b b b E b b b b b b b b b 3

// Set advertising event delay, activate channel 37.

// KKK KA A A AR A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A KA A A A A A A AR AR AR AR AR XA KKK
SOURcel :BB:BTOoth:ECONfiguration:AEDelay 0
SOURcel:BB:BTOoth:ECONfiguration:ACTable:CHANnelO:STATe 1

// KKK A A A AR A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR A AR A AR KKK
// For packet type SCAN REQ, set length of the window,

// time interval.
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// KKK AR A AR A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A KA A A AR A AR A AR AR KN KKK

SOURcel
SOURcel
SOURcel
SOURcel

:BB:
:BB:
:BB:
:BB:

BTOoth
BTOoth

:CTYPe ADV
:UPTYpe SREQ

BTOoth:ECONfiguration:SWINdow 10
BTOoth:ECONfiguration:SINTerval 3500

// ER R R dE h b E b b b I E h h h I b b b b E E b b E b b E E E b b b b b b dh b b b b b E b b b h b b 3E b b b E b b b b b b b b b

//
//
//
//
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel

:BB:
:BB:
:BB:
:BB:
:BB:
:BB:

BTOoth:
BTOoth:
BTOoth:
BTOoth:

BTOoth

BTOoth:

CTYPe ADV
UPTYpe CREQ

:ECONfiguration:

ECONfiguration:
ECONfiguration:

ECONfiguration:

start point of the transmit window,

LL connection timeout and time interval.

PCONfiguration
PCONfiguration
PCONfiguration
PCONfiguration

For packet type CONNECT IND set transmit window,

B

:WSIZe 8.25
:WOFFset 800
:LCTimeout 7500
:CINTerval 6400

// B

//
//
//
!/
SOURcel:
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel

window,

BB:
:BB:
:BB:
:BB:
:BB:
:BB:

set transmit window,

Alternatively select packet type LL CONNECTION UPDATE IND,

start point of the transmit

LL connection timeout and time interval.

BTOoth
BTOoth

BTOoth:
BTOoth:
BTOoth:
BTOoth:

:CTYPe DATA
:UPTYpe CUR

ECONfiguration:
ECONfiguration:
ECONfiguration:
ECONfiguration:

PCONfiguration
PCONfiguration
PCONfiguration
PCONfiguration

KKK KA KRR A A A AR A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR AR KKK

:NWSize 8.25
:NWOFfset 800
:NLCTimeout 7500
:NCINterval 6400

// KKK AR A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR AR KRR KN KKK

// Set time interval for advertising channel and events.

// Set time delay for advertising events.

// KKK KA AR AR A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR AN KRR KA KKK

SOURcel:BB:BTOoth:ECONfiguration:APINterval 1.3
SOURcel:BB:BTOoth:ECONfiguration:AEINterval 15

SOURcel:BB:BTOoth:ECONfiguration:AEDelay 5

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:ACTable:CHANnel<ch0>:STATe.....................
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:DCTable:CHANnel<ch0>:STATe.....................

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DCMTable:

CHANnNel<ch0>:STATe
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:AEDelay

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:ADINterval

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:AEINterval
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:APINterval

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:LCMode....
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:LTKey.......

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MNINterval..............c.cceeeunnnne
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MXINterval................cceeeennnee.
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet<ch0>:STATe.............
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet<ch0>:VALue.............
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PAINterval................ccceereneues 186
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PPERiodicCity...............uuuueen.. 186
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RCECount.........ccccceeeeererrnnnn. 186
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PNUMDET.......ccccieieeeeeeeeeeeieieeeeeeeeeeeneniennnnnas 187
[:SOURce<hw>]:BB:BTOoth:ECONTFiguration:SDCI?.....c.cccievruuieeeeeiiiiieeeeeeeeriee e eeeeeriee e 187
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:SINTErVal..........ccuvueeeeeierriiieeeeeeeereeeeeeeeennnnnss 187
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:SWINAOW.........ccuriiiiiiiiiieiiieeee e, 188
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:WOINO?........cuuiiiiriii e 188
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:WSINfO?........ceereeiiiiiiiiee e eee e e e 189

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:ACTable:CHANnel<ch0>:STATe
<State>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:DCTable:CHANnel<ch0>:STATe
<State>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DCMTable:
CHANnRel<ch0>:STATe <State>

Indicates used and unused data channels.

Note: The previously used syntax . . : SET<ch>:STATe has been replaced
by ...:CHANnel<ch>:STATe. Compatibility to the previous commands is given.

This parameter is relevant for data event and advertising frame configuration with the
packet types LL_CHANNEL_MAP_IND, CONNECT_IND.

Within the option R&S SMM-K117, the following packet types are also relevant for the
setting: AUX_CONNECT_IND, AUX_EXT_IND, AUX_ADV_IND, AUX_CHAIN_IND,
AUX_SYNC_IND, AUX_SCAN_RSP.

Parameters:
<State> 1]ON| 0| OFF

*RST: 0
Example: SOURcel :BB:BTO:ECON:ACT:CHAN: STAT ON
State in Advertising Channel Table and Secondary Advertising

Channel Table

SOURcel :BB:BTO:ECON:DCT:CHAN: STAT ON

State in Data Channel Table and Secondary Advertising Chan-
nel Table

SOURcel:BB:BTO:ECON:PCON:DCMT:CHAN: STAT ON

State in Data Channel Map Table

Example: See also Example"Configure event and frame configuration set-
tings" on page 179.

Manual operation: See "Channel Table" on page 57

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:AEDelay <AeDelay>

Sets a time delay between the start times of two consecutive advertising events. The
value is added to the advertising event interval.

Command sets the values in ms. Query returns values in s.
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Parameters:
<AeDelay> float
Range: O0sto 10E-3 s
Increment: 0.1E-3
*RST: 0
Default unit: ms
Example: SOURcel :BB:BTO:ECON:AEDelay 5
Sets a delay of 5 ms.
Example: See also Example"Configure event and frame configuration set-

tings" on page 179.

Manual operation: See "Advertising Event Delay" on page 53

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:ADINterval <AdInterval>

Sets the time interval between two consecutive advertising events for packet type
"ADV_DIRECT_IND" and duty cycle high.

Command sets the values in ms. Query returns values in s.

Parameters:
<AdInterval> float
Range: 1.05E-3 s to 3.75E-3 s
Increment: 0.01E-3
*RST: 3.75E-3
Default unit: ms
Example: SOURcel:BB:BTO:ECON:ADIN 13
Sets a time interval of 13 ms.
Example: See also Example"Configure event and frame configuration set-

tings" on page 179.

Manual operation: See "Advertising Event Interval” on page 52

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:AEINterval <Aelnterval>

Sets the time interval between two consecutive advertising events, with regard to the
starting points.

Command sets the values in ms. Query returns values in s.

Parameters:
<Aelnterval> float
Range: 5E-3 s to depends on oversampling
Increment: 0.1E-3
*RST: 20E-3
Default unit: ms
Example: SOURcel :BB:BTO:ECON:AEIN 15

Sets a time interval of 15 ms.
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Example: See also Example"Configure event and frame configuration set-
tings" on page 179.

Manual operation: See "Advertising Event Interval” on page 52

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:APINterval <Aplinterval>

Sets the time interval between packets starting points of two consecutive packets in
the advertising channel.

Parameters:
<Aplnterval> float
Range: 1.3E-3 to 28E-3
Increment: 0.1E-3
*RST: 10E-3
Default unit: ms
Example: SOURcel :BB:BTO:ECON:APIN 1.3
Sets a time interval of 1.3 ms.
Example: See also Example"Configure event and frame configuration set-

tings" on page 179.

Manual operation: See "Advertising Packet Interval” on page 53

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:LCMode <LcMode>

Selects the link layer connection mode. In order to provide safe transmission of pay-
load data, the data in the packet can be encrypted. If activated, the payload data fol-
lows MIC (Message authentication Code).

Parameters:
<LcMode> UENC | ENC
UENC
Payload data is transmitted without encoding.
ENC
The link layer connection runs in encrypted mode.
*RST: UENC
Example: SOURcel :BB:BTO:ECON:LCM UENC
without encoding.
SOURcel:BB:BTO:ECON:LCM ENC
in encrypted mode.
Example: See also Example"Configure event and frame configuration set-

tings" on page 179.

Manual operation: See "LL Connection Mode" on page 55
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:LTKey <LtKey>, <BitCount>

Indicates the time the controller needs to receive the long-term key from the host. After
this time, the controller is ready to enter into the last phase of encryption mode setup.

Parameters:
<LtKey> numeric
*RST: #HO
<BitCount> integer
Range: 128 to 128
*RST: 128
Example: SOURcel :BB:BTO:ECON:LCM ENC
SOURcel:BB:BTO:ECON:LTK
#H00000000000000000000000000000000,128
In encrypted mode, the code can be edited.
Example: See also Example"Configure event and frame configuration set-

tings" on page 179.

Manual operation: See "Long Term Key(hex)" on page 56

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MNINterval
<MNInterval>

Specifies the minimum allowed connection interval.

Command sets the values in ms. Query returns values in s.

Parameters:
<MNiInterval> float
Range: 7.5E-3 s to depending on Max. Interval
Increment: 1.25E-3 s
*RST: 7.5E-3
Example: SOURcel :BB:BTO:ECON:PCON:MNIN 7.5
Sets a time interval of 7.5 ms.
Example: See also Example"Configure event and frame configuration set-
tings" on page 179.
Options: R&S SMM-K117

Manual operation: See "Min. Interval" on page 84

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MXINterval
<Minterval>

Specifies the maximum allowed connection interval.

Command sets the values in ms. Query returns values in s.
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Parameters:
<Minterval> float
Range: 7.5E-3 s to 4000E-3 s
Increment: 1.25E-3
*RST: 7.5E-3
Example: SOURcel:BB:BTO:ECON:PCON:MXIN 12.5
Sets a time interval of 12.5 ms.
Example: See also Example"Configure event and frame configuration set-
tings" on page 179.
Options: R&S SMM-K117

Manual operation: See "Max. Interval" on page 84

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet<ch0>:
STATe <State>

Enables / disables Offset0 to Offset5 of the offset setting table.

Parameters:

<State> 1|ON |0 | OFF
*RST: 0

Example: See Example"Configure event and frame configuration settings"
on page 179.

Options: R&S SMM-K117

Manual operation: See "Offset Setting Table" on page 85

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet<ch0>:
VALue <Offset>

Specifies Offset0 to Offset5 of the offset setting table.
Command sets the values in ms. Query returns values in s.

Parameters:
<Offset> float

Range: 0 s to depending on Max. Interval
Increment: 1.25

*RST: 0

Default unit; ms

Example: SOURcel:BB:BTO:ECON:PCON:OFFSet0:VALue 7
SOURcel:BB:BTO:ECON:PCON:OFFSet0:VALue?
// Response: "7.5"
Sets the Offset0 to 7.5 ms. The setting 7 ms is automatically
changed to the closest multiple of 1.25 ms, which is 7.5 ms.

Example: See also Example"Configure event and frame configuration set-
tings" on page 179.
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Options: R&S SMM-K117
Manual operation: See "Offset Setting Table" on page 85

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PAINterval
<Interval>

Sets the time interval between the start of two AUX_SYNC_IND PDUs from the same
advertising set.

Command sets the values in ms. Query returns values in s.

Parameters:
<Interval> float
Range: 7.5E-3 s to depending on oversampling
Increment: 0.01E-3
*RST: 20E-3
Default unit: ms
Example: SOURcel:BB:BTOoth:ECON:PCON:PAINterval 10
Sets a time interval of 10 ms.
Example: See also Example"Configure event and frame configuration set-

tings" on page 179.

Manual operation: See "Periodic Advertising Interval" on page 53

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PPERiodicity
<PPeriodicity>

Specifies a value the connection interval is preferred to be a multiple of.

Parameters:
<PPeriodicity> float
Range: 0 to depends on Max. Interval
Increment: 0.01E-3
*RST: 0
Example: See Example"Configure event and frame configuration settings"
on page 179.
Options: R&S SMM-K117

Manual operation: See "Preferred Periodicity" on page 84

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RCECount
<RCECount>

Specifies the ReferenceConnEventCount field of LL_ CONNECTION_PARAM_REQ.
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Parameters:

<RCECount> integer
Range: 0 to 65535
*RST: 0

Example: See Example"Configure event and frame configuration settings"
on page 179.

Options: R&S SMM-K117

Manual operation: See "Ref. Connection Event Count" on page 85

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PNUMber <PNumber>
Sets the number of Tx packets per event.

Each connection contains at least one data channel packet. The maximum number of
packets per event is determined by the duration of the connection event interval.

Parameters:
<PNumber> integer
Range: 1 to depends on connection event interval
*RST: 1
Example: SOURcel :BB:BTO:ECON:PNUM 2580
Sets the number of Tx packets per event.
Example: See also Example"Configure event and frame configuration set-

tings" on page 179.

Manual operation: See "No. Of Tx Packets/Event" on page 55

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:SDCI?
Queries the number of the first active data channel.

Return values:
<SelectedChannel> integer

Range: 0 to 36

*RST: 0
Example: SOURcel :BB:BTOoth:ECONfiguration:SDCI?
Example: See also Example"Configure event and frame configuration set-

tings" on page 179.
Usage: Query only

Manual operation: See "Selected Data Channel Index" on page 56

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:SINTerval <Sinterval>

Sets the time interval between the starting points of two consecutive windows during
which the scanner is operating in an advertising channel.
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Command sets the values in ms. Query returns values in s.

Parameters:
<Slinterval>

Example:

Example:

Manual operation:

float

Range: 10E-3 s to depends on oversampling and the num-
ber of advertsing channel table states

Increment: 0.625E-3

*RST: 10E-3

Default unit: ms

SOURcel :BB:BTO:ECON:SINT 3.5
Sets a time interval of 3.5 ms.

See also Example"Configure event and frame configuration set-
tings" on page 179.

See "Scan Interval" on page 53

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:SWINdow <SWindow>

Sets the length of the window during which the scanner is operating in the advertising

channel.

Note that the scan window is less or equal to the value of the scan interval.

Command sets the values in ms. Query returns values in s.

Parameters:
<SWindow>

Example:

Example:

Manual operation:

float

Range: 10E-3 s to 10240E-3 s
Increment: 0.625E-3

*RST: 10E-3

Default unit: ms

SOURcel:BB:BTO:ECON:SWIN 10
Sets the length of the window to 10 ms.

See also Example"Configure event and frame configuration set-
tings" on page 179.

See "Scan Window" on page 53

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:WOINfo?

Requires data event and advertising frame configuration with the packet type CON-

NECT_IND.

Queries the start point of the transmit window.

Return values:
<Wolnfo>
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Example: SOURcel :BB:BTO:UPTY CREQ

Sets packet type CONNECT_IND
SOURcel :BB:BTO:ECON: PCON:WOIN?
Queries the start point of the transmit window.

Example: See also Example"Configure event and frame configuration set-
tings" on page 179.

Usage: Query only

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:WSINfo?

Requires data event and advertising frame configuration with the packet type CON-
NECT_IND.

Queries the size of the transmit window, regarding to the start point.

Return values:
<Wslnfo> string

Example: SOURcel:BB:BTO:UPTY CREQ
Sets packet type CONNECT _IND
SOURcel :BB:BTO:ECON: PCON:WSIN?

Queries the size of the transmit window.

Example: See also Example"Configure event and frame configuration set-
tings" on page 179.

Usage: Query only

Manual operation: See "Transmit Window Size" on page 54

8.5 Channel sounding commands - LE

o S general COMMANGS.......ccooiiiiiiiieie e e e e e e e e e e e e e e e e e e e e e e e eeseeea b anaaas 190
o S subevent COMMANGS......ccoooiiiiiiiiiieeece e e e e e e e e e e e e e e e e e e eeeeeeeeeens 191
e CS step configuration COMMaNAS........coviiiiiiiiiiiiie e 195
o CS step infO COMMEANGAS.....cuiiiiiiii i e e e e 201
e CS channel table COMMANGS.........eeiiiieiiiiiiiccee e e e 204
® S SECUrity COMMANGS.......ccccuiiiiiiiiiee e e e e e e e e e e s e e e e e e e e e e e s e e sannnenes 206
e (S channel selection COMMANAS..........uuuuuiiiiiieieiei e 208

User Manual 1179.2054.02 — 07 189



R&S®SMM-K60/-K117/-K178 Remote control commands

8.5.1
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CS general commands

Example: To configure CS sequence settings

:SOURcel:BB:BTOoth:CINTerval 10

// The connection interval is 10 microseconds.
:SOURcel:BB:BTOoth:EINTerval 2

// The number of event intervals is two.
:SOURcel:BB:BTOoth:EOFFset?

// Response: "500"

// The event offset is 500 microseconds.
:SOURcel:BB:BTOoth:CS:ROLE?

// Response: "INITIATOR"

// The instrument initiates a channel sounding procedure.

Commands:

[:SOURce<hw>]:BB:BTOOth:CS:CINTEIVAL ...uueieieieieieeeeeeeeeieeieeeeeeeeeeererer e n e e e e e e 190
[:SOURCce<hw>]:BB:BTOOth:CS:EINTEIVAL .....uceieeiiiiieieeeeeeiiee e eee et e e e e e e e e e 190
[:SOURce<hw>]:BB:BTOOth:CS:EOFFSEL......iiiiiiieei e 191
[:SOURce<hw>]:BB:BTOOth:CS:ROLE......c.iiuiiiiiiieee e e e e e 191

[:SOURce<hw>]:BB:BTOoth:CS:CINTerval <Connectinterval>

Sets the time of the LE connection interval. The anchor points of two consecutive CS
events define the length of this interval.

Parameters:
<Connectinterval> float

Range: 7.5 to 4000
Increment: 0.1
*RST: 7.5

Example: See Example"To configure CS sequence settings" on page 190.

Manual operation: See "Connection Interval" on page 50

[:SOURce<hw>]:BB:BTOoth:CS:EINTerval <Eventinterval>

Sets the number of LE connection event intervals.

Parameters:
<Eventinterval> integer
Range: 1 to 65535
*RST: 1
Example: See Example"To configure CS sequence settings" on page 190.

Manual operation: See "Event Intervals/Event_Interval" on page 50
See "Event_Interval" on page 124
See "Event_Interval" on page 127
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[:SOURce<hw>]:BB:BTOoth:CS:EOFFset <EventOffset>

Sets the time between the anchor point of the LE connection event and the beginning
of the CS event.

Parameters:
<EventOffset> integer
Range: 500 to 4e6
*RST: 500
Example: See Example"To configure CS sequence settings" on page 190.

Manual operation: See "Event Offset" on page 50

[:SOURce<hw>]:BB:BTOoth:CS:ROLE <Role>
Sets the role of the channel sounding device that is the R&S SMM100A.

Parameters:
<Role> INITIATOR | REFLECTOR
INITIATOR
The instrument initiates a CS procedure.

REFLECTOR
The instrument responds to a CS procedure.

*RST: INITIATOR
Example: See Example"To configure CS sequence settings" on page 190.

Manual operation: See "Role" on page 50

CS subevent commands

Example: To configure CS subevent settings

// R gk dh gk Sk kb kb kb b b b b b b b b b b b b bk bk kb b b b b b b b b b b kb b b b bk b b b b b b b b b b b b bk b b bk kb b i
// Configure general settings of a CS subevent.

// R I s
// Configure general subevent settings.

:SOURcel:BB:BTOoth:CS:SLENgth 1250

// CS subevent sequence length is 1250 microseconds.

:SOURcel :BB:BTOoth:CS:INTerval 1875

// CS subevent interval is 1875 microseconds.

:SOURcel:BB:BTOoth:CS:SSCHeduling?

// Response: "AUTO"

// CS step scheduling is automatic.

:SOURcel :BB:BTOoth:CS:SNUMber?

// Response: "1"

// Number of subevents is 1 subevent.
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// KA K KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR A AR AN KA KA AR KK

// Configure channel selection settings of a CS subevent.

] Rk ko K K Kk ok ok K KKKk ok K K KKk ok K KKKk ok K K K kK ok ok K K Kk ok ok ok o K Kk ok ok ok o K Kk ok ok ok K K Kk ok ok o K K kK ok K
:SOURcel:BB:BTOoth:CS:CFCHm?

// Response: "#H00000000000000000001,80"

// CSFilteredChM value is 00000000000000000001 in hexadecimal reperesentation.
:SOURcel:BB:BTOoth:CS:CMRepetition 1

// Sets one cycle of the ChM field for non-Mode-0 steps within the CS procedure.
:SOURcel:BB:BTOoth:CS:CSEL?

// Response: "SEL 3B"

// The channel selection algorithm is Algorithm #3b.

// Optionally, enable and configure Algorithm #3c parameters.
:SOURcel:BB:BTOoth:CS:CSEL SEL 3C

:SOURcel:BB:BTOoth:CS:CTCShape HAT

// The channel has a rising ramp and a falling ramp.

:SOURcel:BB:BTOoth:CS:CTCJump JUMP_2

Commands:

[:SOURce<hw>]:BB:BTOOth:CS:SLENGth......cciiiiie e 192
[:SOURce<hw>]:BB:BTOOth:CS:SINTEIVAl....ccuiiiiiiiicec et e e e 192
[:SOURce<hw>]:BB:BTO0th:CS:SSCHeAUING. . ...ttt 193
[:SOURce<hw>]:BB:BTOOth:CS:SNUMDET.......cciiiieieeeeeeeaeeeeeeeeeeeee et e e e e e 193
[:SOURce<hw>]:BB:BTO0th:CS[:SEVent<chO>]:NOSTEP....cceueieeeeeeeeeeereieeeeeeeeeeeeeeenennnnnnnnns 193
[:SOURce<hw>]:BB:BTO0th:CS[:SEVent<ch0>]:SSPaCE?........ccieeerrrrriieieeeeeriieeeeeeeenn s 194
[:SOURce<hw>]:BB:BTO0th:CS[:SEVent<ChO>]:TFCS.....cceiiiiriiieeeeeieereeee et eeeaanns 194
[:SOURce<hw>]:BB:BTOOth:CS[:SEVENt<ChO>:MZSTEDS  ceeeeeeeerererereeeeeeeererreresesesesesenes 194

[:SOURce<hw>]:BB:BTOoth:CS:SLENgth <SubLength>
Sets the subevent length that is the duration of a CS subevent.

You can set values in multiples of 625 ps. Settable subevent lengths depend on the
number of event intervals, the connection interval, the event offset and the subevent

interval.
Parameters:
<SublLength> integer
Range: 1250 to 4e6
*RST: 1250
Example: See Example"To configure CS subevent settings" on page 191.

Manual operation: See "Subevent Length" on page 92

[:SOURce<hw>]:BB:BTOoth:CS:SINTerval <Sublnterval>

Sets the subevent interval. This interval is the time in multiples of 625 ps between the
beginning of a CS subevent and the beginning of the next CS subevent within the
same CS event.

For : SOURcel:BB:BTO:CS:SNUM 1, the subevent interval is Ops.
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For : SOURcel:BB:BTO:CS:SNUM 2 or higher, settable subevent intervals depend on
the number of event intervals, the connection interval, the event offset and the sube-
vent length.

See also [ : SOURce<hw>] :BB:BTOoth:CS:SNUMber on page 193.

Parameters:
<Sublnterval> integer
Range: 0 to 2.7e11
*RST: 0
Example: See Example"To configure CS subevent settings" on page 191.

Manual operation: See "Subevent Interval” on page 92

[:SOURce<hw>]:BB:BTOoth:CS:SSCHeduling <StepScheduling>
Sets the step scheduling mode.

Parameters:

<StepScheduling>  AUTO | MANUAL

AUTO

Automatic CS step scheduling. The subevent length, the sube-
vent interval and the number of subevents are configurable.
The number of CS steps is 2.

MANUAL

Manual CS step scheduling. The subevent length is 1250 ps, the
subevent interval is 0 ys and the number of subevents is 1.

The number of CS steps is configurable.

*RST: AUTO
Example: See Example"To configure CS subevent settings" on page 191.

Manual operation: See "Step Scheduling" on page 93

[:SOURce<hw>]:BB:BTOoth:CS:SNUMber <SubNumber>

Sets number of subevents. Settable values depend on the subevent interval.

Parameters:
<SubNumber> integer
Range: 1 to 32
*RST: 1
Example: See Example"To configure CS subevent settings" on page 191.

Manual operation: See "Number of Subevents" on page 93

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:NOSTep <NumOfSteps>
Sets or display the number of CS steps.
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Setting requires manual step scheduling. Settable minimum values are 1 or equal to
the number of non-zero Mode-0 steps. See also [ : SOURce<hw>] :BB:BTOoth:CS:
SSCHedul ing on page 193.

Parameters:

<NumOfSteps> integer
Range: 2 to 160
*RST: 2

Example: See Example"To configure CS steps for subevent 0"
on page 195.

Manual operation: See "Number of Steps" on page 94

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:SSPace?
Queries the subevent space in microseconds.

Return values:
<SubeventSpace> integer

Range: 150 to 65535

*RST: 150
Example: See Example"To configure CS subevent settings" on page 191.
Usage: Query only

Manual operation: See "Subevent Space (us)" on page 94

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:TFCS <TFcs>

Sets the frequency change period (T_FCS) between consecutive CS steps. The period
ranges from 15 us to 150 ps.

Parameters:

<TFcs> TFCS_15| TFCS_20 | TFCS_30 | TFCS_40| TFCS_50 |
TFCS_60| TFCS_80 | TFCS_100 | TFCS_120 | TFCS_150
TFCS_x, x represents values in microseconds.
*RST: TFCS_150

Example: See Example"To configure CS subevent settings" on page 191.

Manual operation: See "T_FCS (us)" on page 94

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MZSTeps <Mode0Steps>

Parameters:
<Mode0Steps> integer

Range: 1to3
*RST: 1

Manual operation: See "Mode-0 Steps" on page 94
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8.5.3 CS step configuration commands

Example: To configure CS steps for subevent 0

// R I I
// Configure general CS step settings of the first subevent "Subevent 0".

// R IR E E kI S b E I h b E h b h b dE b b h b h h b h b b b b E E h b b b E E h b b b b dh b I b b b b b b b b b b b b b b b b b b b b b b i
// Configure general subevent settings.

:SOURcel:BB:BTOoth:CS:SLENgth 1250

// CS subevent sequence length is 1250 microseconds.
:SOURcel:BB:BTOoth:CS:INTerval 1875

// CS subevent interval is 1875 microseconds.

:SOURcel :BB:BTOoth:CS:SSCHeduling?

// Response: "AUTO"

// CS step scheduling is automatic.

:SOURcel:BB:BTOoth:CS:SNUMber?

// Response: "1"

// Number of subevents is 1 subevent.

Commands:

[:SOURce<hw>]:BB:BTO0th:CS[:SEVent<ch0>]:MMODE.........c.cc.ceeeeeremrrieeeeereerieeeeeeeennnnnns 195
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<chO0>]:SMODE.......ccccoeuiiiiiiiiiieie e 196
[:SOURce<hw>]:BB:BTO0th:CS[:SEVent<ChO>:MMASIEDS. ......veeeeereeeeresereeseeeseeeseseseeeen. 196
[:SOURce<hw>]:BB:BTO0th:CS[:SEVENt<ChO>:MMISLEDS. ......veeeeeereeeeereereeeeesseseseseeneeenes 196
[:SOURce<hw>]:BB:BTOo0th:CS[:SEVent<chO>]:MMSTEPS?.....cceeeieiereeeeeeeaeeeeeeeeeeeeeeeennenens 197
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MMRepetition..............cceerreeerreererenrnrnnnnnnns 197
[:SOURce<hw>]:BB:BTO0th:CS[:SEVent<ch0>]:SMSTEP?.....cevvrreieeeeerriiieeeeeeerreieeeeeesnnanss 197
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MONE:TIPO........c.ccoceeieeieiiriiieeeeeeerieieeeeens 197
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<chO>]:MZERO:TIPO.....cccccoeiiiiiiiiieeicieeceeceeeeans 197
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTHRee:TSW?.....couiiiiiiiiiieeiieeeeeee e 198
[:SOURce<hw>]:BB:BTOo0th:CS[:SEVent<ch0>]:MTWO:TSW?......ucciaaaaaieeeeeeeeeeeeeeeeeeeeeeeeens 198
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<chO>]:MTHREE:NAP?........cccccrririeeeeeeee e e e e 198
[:SOURce<hw>]:BB:BTOo0th:CS[:SEVent<ch0>]:MTWO:NAP?.....cccceiee et eeeeeetee e eeeen, 198
[:SOURce<hw>]:BB:BTOo0th:CS[:SEVent<ch0>]:MTHREE:TPM.....c.cceerrrrreereeeieireeeeeeeevenenn. 198
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<chO>]:MTWO:TPM.....ccooiiiiiiiieeic e, 198
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<chO>]:MTHREE:TIPT.....cceiiiieieeieeiceeeeeecee e 199
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<chO>]:MTWO:TIPT.....c.coiiiiiiiieiieeeeee e 199
[:SOURce<hw>]:BB:BTO0th:CS[:SEVent<ch0>]:STYPE....cccceieeeeeeeeeeeeeeeeeeeeeeeeeee e 199
[:SOURce<hw>]:BB:BTOo0th:CS[:SEVent<ch0>]:SEQLENGIN......cceevrrererirriiiiiieeeieeeeeeeeeennn, 199
[:SOURce<hw>]:BB:BTOo0th:CS[:SEVent<ch0>]:UPAYI0ad........ccceeeereeriieeeeeeeiiieeeeeeeennannn. 199
[:SOURce<hw>]:BB:BTOo0th:CS[:SEVent<ch0>]:UPPattern...........cvceeeeeeeeirreeeeeieevieeeeeeeeens 200

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MMODe <mainMode>

Sets the main mode for the first subevent SEvent0. All following subevents use the
same main mode.
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For an overview on available submodes per main mode, see Table 5-8.

Parameters:
<mainMode>

Example:

Manual operation:

MODE1 | MODE2 | MODE3

MODE1
Mode-1 mode with no submode available.

MODE2
Mode-2 mode with submodes Mode-1 and Mode-3 available.

MODE3
Mode-3 mode with submodes Mode-1 and Mode-2 available.

*RST: MODE1
See Example"To configure CS subevent settings" on page 191.

See "Main_Mode" on page 100

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:SMODe <SubMode>

Sets the submode of the main mode.

Parameters:
<SubMode>

Example:

Manual operation:

MODE1 | MODE2 | MODES3 | NONE

See the table Table 5-8 for an overview on available submodes
per main mode.

*RST: NONE
See Example"To configure CS subevent settings" on page 191.

See "Sub_Mode" on page 101

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MMASteps <MMMaxSteps>

Sets the maximum number of main mode steps.

Parameters:
<MMMaxSteps>

Example:

Manual operation:

integer
Range: 2 to 255
*RST: 2

See Example"To configure CS subevent settings" on page 191.

See "Main_Mode Max_Steps" on page 101

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MMISteps <MMMinSteps>

Sets the minimum number of main mode steps.

Parameters:
<MMMinSteps>
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Example: See Example"To configure CS subevent settings" on page 191.

Manual operation: See "Main_Mode_Min_Steps" on page 101

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MMSTeps?
Queries the number of main mode CS steps.

Return values:

<MMSTeps> integer

Range: 2 to 160

*RST: 2
Example: See Example"To configure CS subevent settings" on page 191.
Usage: Query only

Manual operation: See "Main_Mode_Steps" on page 101

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MMRepetition <MMRepetition>

Sets the main mode repetition.

Parameters:
<MMRepetition> integer
Range: 0to3d
*RST: 0
Example: See Example"To configure CS subevent settings" on page 191.

Manual operation: See "Main_Mode Repetition" on page 101

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:SMSTep?
Sets the number of submode CS steps.

Return values:
<SubModeStep> integer

Range: 0 to 160

*RST: 0

Example: See Example"To configure CS steps for subevent 0"
on page 195.

Usage: Query only

Manual operation: See "Sub_Mode_Steps" on page 101

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MONE:TIPO <TIPO>
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MZERo:TIPO <TIPO>

Sets the time "T_IP1" for Mode-0 and Mode-1 CS steps.
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Parameters:

<TIPO> TIP1_10 | TIP1_20 | TIP1_30 | TIP1_40 | TIP1_50 | TIP1_60 |
TIP1_80| TIP1_145
TIP1_x, x represents values in microseconds.
*RST: TIP1_145

Example: See Example"To configure CS subevent settings" on page 191.

Manual operation: See "T_IP1" on page 102

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTHRee:TSW?
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTWO:TSW?

Sets the time "T_SW" for Mode-2 or Mode-3 CS steps.

Return values:

<Tsw> TSW_O | TSW_1|TSW_2 | TSW_4 | TSW_10

TSW_x, x represents values in microseconds.

*RST: TSW_0
Example: See Example"To configure CS subevent settings" on page 191.
Usage: Query only

Manual operation: See "T_SW" on page 105

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTHRee:NAP?
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTWO:NAP?

Sets the number of antenna path in the N_AP field for Mode-2 and Mode-3 CS steps.

Return values:

<Nap> NAP_1 | NAP_2 | NAP_3 | NAP_4

NAP_Xx, x represents the path number.

*RST: NAP_1
Example: See Example"To configure CS subevent settings" on page 191.
Usage: Query only

Manual operation: See "N_AP" on page 105

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTHRee:TPM <Tpm>
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTWO:TPM <Tmp>

Sets the time "T_PM" for Mode-2 or Mode-3 CS steps.

Parameters:
<Tmp> TPM_10 | TPM_20 | TPM_40 | TPM_652
TPM_x, x represents values in microseconds.
*RST: TPM_40
Example: See Example"To configure CS subevent settings” on page 191.
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Manual operation: See "T_PM" on page 105

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTHRee:TIPT <TIPT>
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTWO:TIPT <TIPT>

Sets the time "T_IP2" for Mode-2 or Mode-3 CS steps.

Parameters:

<TIPT> TIP2_10 | TIP2_20 | TIP2_30 | TIP2_40 | TIP2_50 | TIP2_60 |
TIP2_80 | TIP2_145
TIP2_x, x represents values in microseconds.
*RST: TIP2_145

Example: See Example"To configure CS subevent settings" on page 191.

Manual operation: See "T_IP2" on page 105

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:STYPe <SeqType>
Sets the sequence type.

Parameters:
<SeqType> SOUNDING | RANDOM

SOUNDING
Sounding sequence

RANDOM
Random sequence

*RST: SOUNDING
Example: See Example"To configure CS subevent settings” on page 191.

Manual operation: See "Sequence Type" on page 103

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:SEQLength <SeqlLen>

Sets the sequence length. The length is discrete and depends on the sequence type.

Parameters:

<SegLen> SL_32|SL_64|SL 96 |SL_128
*RST: SL_32

Example: See Example"To configure CS steps for subevent 0"
on page 195.

Manual operation: See "Sequence Length" on page 103

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:UPAYload <UserPayload>
Selects a data list file as the data source for a random CS sequence.

This sequence uses the CS_SYNC_User_Payload for CS step configuration modes
Mode-1 or Mode-3.
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Select the file from the default instrument directory or a specific directory.

Parameters:
<UserPayload> string
Example: See Example"To configure CS step settings for a subevent”

on page 201.

Manual operation: See "Select Data List" on page 104

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:UPPattern <Pattern>
Selects the user payload pattern for a random CS sequence.
This pattern is the payload type for CS step configuration modes Mode-1 or Mode-3.

Parameters:

<Pattern> PRBS09 | RE1S | RE2S | PRBS15 | RE3S | RE4S | RESS |
RE6S | UPLD
PRBS09|PRBS15
Pseudo random bit sequence with 9-bit length or 15-bit length in
accordance with the IUT-T.
RE1S|RE2S|RE3S|RE4S|RE5S|RE6S
Repeated 8-digit sequences of zeroes and ones.
UPLD
Uses the CS_SYNC_User_Payload. Set this payload via a data
list file and the following command:
:SOURcel:BB:BTOoth:CS:SEVent<ch0>:UPAYload
See also [ : SOURce<hw>] :BB:BTOoth:CS|[:
SEVent<ch0>] :UPAYload on page 199.

*RST: PRBS09

Example: See Example"To configure CS step settings for a subevent"
on page 201.

Manual operation: See "User Payload Pattern" on page 104
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8.5.4 CS step info commands

Example: To configure CS step settings for a subevent

// R I I
// Configure general settings of a CS subevent.

// R R dE I I S I E E h b E b b b b E E dE b h b h bk b b b b b dh h dh b b b h h h b b b b b h b b b b b b h b b b b E b b b b b b E b b b b i
// Configure general subevent settings.

:SOURcel:BB:BTOoth:CS:SLENgth 1250

// CS subevent sequence length is 1250 microseconds.
:SOURcel:BB:BTOoth:CS:INTerval 1875

// CS subevent interval is 1875 microseconds.

:SOURcel :BB:BTOoth:CS:SSCHeduling?

// Response: "AUTO"

// CS step scheduling is automatic.

:SOURcel:BB:BTOoth:CS:SNUMber?

// Response: "1"

// Number of subevents is 1 subevent.

Commands:

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<StOS:MTYPE?.....vreeeeeereeeerererenen. 201
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][: STEP<St0>]: CINDEX....evreeerrererrerereerene. 202
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][: STEP<st0>]: CAADAIESS. ...erveereerereerereenes 202
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:SCONtent............euvuuuuaaaannn. 202
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:CSIGnal.............cccrrrrrrrrrrrnes 203
[:SOURce<hw>]:BB:BTO0th:CS[:SEVent<ChO>]:DATA.......ctttieeieeeeeticeiee e e et eeeeeetee e e e 203
[:SOURce<hw>]:BB:BTO0th:CS[:SEVent<ChO>]:DLISt.....c.ccieeriuiieeeeeeeice e eeer e 203
[:SOURce<hw>]:BB:BTOo0th:CS[:SEVent<ChO>]:PATTEIN. ..ccuiiiuiiiaieii e ei et 204
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][: STEP<st0>]: CTEXENSION. .. ..v.veeereeeereens 204

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:MTYPe?
Queries the mode type for individual CS steps.

For the first CS step, the mode type is the Mode-0. For the other CS steps, the mode
type is the main mode in the CS step configuration.

Return values:

<ModeType> MODEO | MODE1 | MODE2 | MODE3
For a description, see [ : SOURce<hw>] :BB:BTOoth:CS[:
SEVent<ch0>] :MMODe on page 195.

*RST: MODEOQ

Example: See Example"To configure CS step settings for a subevent”
on page 201.

Usage: Query only

Manual operation: See "Mode Type" on page 109
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[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:CINDex
<Channlindex>

Queries the channel index for individual CS steps.

Parameters:

<Channlindex> integer
Range: 0 to 78
*RST: 0

Example: See Example"To configure CS step settings for a subevent”
on page 201.

Manual operation: See "Channel Index" on page 110

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:CAADdress
<AccessAddress>, <BitCount>

Sets or queries the 32-bit CS access address for individual CS steps.
Setting require manual step scheduling:
:SOURcel: :BB:BTOoth:CS:SSCHeduling MANUAL

See also [ : SOURce<hw>] :BB:BTOoth:CS:SSCHeduling on page 193.

Parameters:
<AccessAddress> numeric
*RST: #H00000000
<BitCount> integer
Range: 32 to 32
*RST: 32
Example: See Example"To configure CS step settings for a subevent"
on page 201.

Manual operation: See "CS Access Address" on page 110

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:SCONtent
<SeqContent>, <BitCount>

Queries the content and the length of a sounding sequence or random sequence. The
content depends on the subevent mode.

For CS test packets, you can set the content for a sounding sequence and random
sequence.

Parameters:
<SeqContent> numeric

*RST: #H00000000
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<BitCount> integer
Range: 32 to 128
*RST: 32

Example: See Example"To configure CS step settings for a subevent”
on page 201.

Manual operation: See "Sounding Sequence Content/Random Sequence Content"
on page 110

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:CSIGnal
<CompanionSignal>

Sets the companion signal.

Parameters:
<CompanionSignal> NONE | P2 | M2 | P4 | M4 | M2P2 | M4P4
NONE
Companion signal is disabled.
P2|P4
Positive companion signal with values 2 or 4.
M2|M4
Negative companion signal with values -2 or -4.
M2P2|M4P4
Positive and negative companion signal with values -2 and 2 or
-4 and 4.
*RST: NONE
Example: See Example"To configure CS step settings for a subevent"
on page 201.

Manual operation: See "Companion Signal" on page 110

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:DATA <DataSource>

Sets the data source for the companion signal.

Parameters:

<DataSource> ALLO | ALL1 | PATTern | PNO9 | PN11 | PN15 | PN16 | PN20 |
PN21 | PN23 | DLISt
*RST: PNO09

Example: See Example"To configure CS step settings for a subevent”
on page 201.

Manual operation: See "Companion Signal" on page 110

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:DLISt <DataList>

Selects a data list file as the data source for the companion signal.
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Select the file from the default instrument directory or a specific directory.

Parameters:
<DataList> string
Example: See Example"To configure CS step settings for a subevent”

on page 201.

Manual operation: See "Companion Signal" on page 110

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:PATTern <Pattern>, <BitCount>

Sets the data pattern for the companion signal.

Parameters:
<Pattern> numeric
*RST: #HO
<BitCount> integer
Range: 1 to 64
*RST: 1
Example: See Example"To configure CS step settings for a subevent”
on page 201.

Manual operation: See "Companion Signal" on page 110

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:CTEXtension
<CsToneExt>

Enables CS tone extension for mode-2 and mode-3 CS steps.

Parameters:

<CsToneExt> 1]ON| 0| OFF
*RST: 0

Example: See Example"To configure CS step settings for a subevent"
on page 201.

Manual operation: See "CS Tone Ext." on page 112

CS channel table commands

[:SOURce<hw>]:BB:BTOoth:CS:CTABIe[:CHANnel<ch0>]:CFRequency?........ccccccvvvvvvvvnnnn. 204
[:SOURce<hw>]:BB:BTOoth:CS:CTABIe[:CHANNEI<ChO>]:CINDEX?......ccuvrrrrrrriereaeeeeeieennns 205
[:SOURce<hw>]:BB:BTOo0th:CS:CTABIe[:CHANNEI<ChO>]:CTYPE?....uuvrrriciiiieieieeeeeeeeeenn, 205
[:SOURce<hw>]:BB:BTOoth:CS:CTABIle[:CHANnel<chO0>]:CALLowed.........ccceeeurerrrennreennnen 205

[:SOURce<hw>]:BB:BTOoth:CS:CTABle[:CHANnel<ch0>]:CFRequency?

Queries the center frequency of the channel.
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Return values:
<CenterFreg> float

For a description, see also table Table 2-13.

Range: 2402 to 2480
Increment: 2

*RST: 2402
Example: See Example"To configure CS subevent settings" on page 191.
Usage: Query only

Manual operation: See "Center Frequency (MHz)" on page 95

[:SOURce<hw>]:BB:BTOoth:CS:CTABIle[:CHANnNel<ch0>]:CINDex?
Queries the channel index of the channel.

Return values:
<CsChannellndex> integer
For a description, see also table Table 2-13.

Range: 0 to 78

*RST: 0
Example: See Example"To configure CS subevent settings" on page 191.
Usage: Query only

Manual operation: See "Channel Index" on page 96

[:SOURce<hw>]:BB:BTOoth:CS:CTABIle[:CHANnNel<ch0>]:CTYPe?
Queries the channel type that is Channel Sounding for all channels.

Return values:

<ChannelType> CS

CS

Channel type is Channel Sounding.

*RST: Cs
Example: See Example"To configure CS subevent settings" on page 191.
Usage: Query only

Manual operation: See "Channel Type" on page 96

[:SOURce<hw>]:BB:BTOoth:CS:CTABIle[:CHANnel<ch0>]:CALLowed
<ChannelAllowed>

Enables transmission of the subevent via the selected channel.

Parameters:
<ChannelAllowed> 1| ON |0 | OFF

For a description, see also table Table 2-13.

User Manual 1179.2054.02 — 07 205



R&S®SMM-K60/-K117/-K178 Remote control commands

8.5.6

Channel sounding commands - LE

1|ON
Enables transmission of the subevent for the selected channel.

0|OFF
Disables transmission of the subevent for the selected channel.

*RST: 0
Example: See Example"To configure CS subevent settings" on page 191.

Manual operation: See "Channel Allowed" on page 96

CS security commands

[:SOURCce<hw>]:BB:BTOOth:CS:CIVC ...t e e e e e 206
[:SOURCce<hw>]:BB:BTOOth:CS:CIVP.. ettt e e e e e 206
[:SOURCce<hw>]:BB:BTOOth:CS:CINC......ieieeiiiiieieeeeeeice e e e e eeet e e e e e e e e e e e eeanne e e e e e eneanns 207
[:SOURce<hw>]:BB:BTOOth:CS:CINP........ceeeiiiiiiiieiiieiiaaaaaae e e e e e e e eeeaeeeeereeeeeeeeeeenennnnnnnnnnns 207
[:SOURCe<hw>]:BB:BTOOth:CS:CSPVC....cuuuceieeiiiiiiieeeeeetttcee e e e eeetee e e e e e eebee e e e e eeeanaeeaeeeees 208
[:SOURCe<hw>]:BB:BTOOth:CS:CPVP.....ctuiiieeiieiiieeeeeeeeetee e e eeetee e e e e et e e e e e e eanae s e e e eeesaan 208

[:SOURce<hw>]:BB:BTOoth:CS:CIVC <CslvC>, <BitCount>
Requires packet type CS SEQUENCE or LL_CS_SEC_REQ.

Sets the CS_|V_C parameter. The parameter is 64-bit in hexadecimal representation.

Parameters:
<CslvC> numeric
CS_IV_C value in hexadecimal representation.
*RST: #HO
<BitCount> integer
Fixed bit count of 64 bits.
Range: 64 to 64
*RST: 64
Example: See Example"To configure CS subevent settings" on page 191.

Manual operation: See "CS_|V_C(hex)" on page 97

[:SOURce<hw>]:BB:BTOoth:CS:CIVP <CslvP>, <BitCount>
Requires packet type CS SEQUENCE or LL_CS_SEC_REQ.
Sets the CS_IV_P parameter. The parameter is 64-bit in hexadecimal representation.

Parameters:

<CslvP> numeric
CS_IV_P value in hexadecimal representation.
*RST: #HO
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<BitCount> integer
Fixed bit count of 64 bits.

Range: 64 to 64
*RST: 64

Example: See Example"To configure CS subevent settings" on page 191.

Manual operation: See "CS_IV_P(hex)" on page 97

[:SOURce<hw>]:BB:BTOoth:CS:CINC <CsInC>, <BitCount>
Requires packet type CS SEQUENCE or LL_CS_SEC_REQ.

Sets the CS_IN_C parameter. The parameter is 32-bit in hexadecimal representation.

Parameters:
<CsInC> numeric
CS_IN_C value in hexadecimal representation.
*RST: #HO
<BitCount> integer
Fixed bit count of 32 bits.
Range: 32 to 32
*RST: 32
Example: See Example"To configure CS subevent settings" on page 191.

Manual operation: See "CS_IN_C(hex)" on page 97

[:SOURce<hw>]:BB:BTOoth:CS:CINP <CsInP>, <BitCount>
Requires packet type CS SEQUENCE or LL_CS_SEC_REQ.

Sets the CS_IN_P parameter. The parameter is 32-bit in hexadecimal representation.

Parameters:
<CslInP> numeric
CS_IN_P value in hexadecimal representation.
*RST: #HO
<BitCount> integer
Fixed bit count of 32 bits.
Range: 32 to 32
*RST: 32
Example: See Example"To configure CS subevent settings" on page 191.

Manual operation: See "CS_IN_P(hex)" on page 97
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[:SOURce<hw>]:BB:BTOoth:CS:CSPVc <csPvC>

Parameters:
<csPvC> 64 bits

Manual operation: See "CS_PV_C(hex)" on page 97

[:SOURce<hw>]:BB:BTOoth:CS:CPVP <CsPvP>, <BitCount>
Requires packet type CS SEQUENCE or LL_CS_SEC_REQ.

Sets the CS_PV_P parameter. The parameter is 64-bit in hexadecimal representation.

Parameters:
<CsPvP> numeric
CS_PV_P value in hexadecimal representation.
*RST: #HO
<BitCount> integer
Fixed bit count of 64 bits.
Range: 64 to 64
*RST: 64
Example: See Example"To configure CS subevent settings" on page 191.

Manual operation: See "CS PV _P(hex)" on page 97

CS channel selection commands

[:SOURCce<hw>]:BB:BTOOth:CS:CFCHM?.....uvviiititiiiiiieieieeeeeeeeeeeeeeeeeeeeeeeeeesessssaranannanannns 208
[:SOURce<hw>]:BB:BTOOth:CS:CMREPELItION.....ccceeerriieeeeeiiiiieeeeeeetiieeeeeeeetee e e e e eeernaeeeeas 209
[:SOURCe<hw>]:BB:BTOOth:CS:CSEL.....cuuuiieieeiiiiiieieeeeeeiiieeeeeeeeee e e e e eeetee e e e e eeebaaeeeeeeenes 209
[:SOURCce<hw>]:BB:BTOOth:CS:CTCJUMP . ettt et e e e e e e e e 209
[:SOURce<hw>]:BB:BTOOth:CS:CTCShaPe. . i iiiei e eeee ettt e e e e e e e e eans 210

[:SOURce<hw>]:BB:BTOoth:CS:CFCHm? <BitCount>
Queries the value of the field CSFilteredChM.

This value determines the bit map for the Channel Sounding channel map update pro-
cedure. The parameter is 64-bit in hexadecimal representation.

Parameters:
<BitCount> integer
Fixed bit count of 80 bits.

Range: 80 to 80
*RST: 80

User Manual 1179.2054.02 — 07 208



R&S®SMM-K60/-K117/-K178 Remote control commands

Channel sounding commands - LE

Return values:
<CsFilteredChM> numeric

CSFilteredChM value in hexadecimal representation.

*RST: #HO
Example: See Example"To configure CS subevent settings" on page 191.
Usage: Query only

Manual operation: See "CSFilteredChM(hex)" on page 98

[:SOURce<hw>]:BB:BTOoth:CS:CMRepetition <ChMRepetition>
Sets the 3-bit ChM_Repetition field.

The value equals the number of cycles of the ChM field for non-Mode-0 steps within a
CS procedure.

Parameters:
<ChMRepetition> integer

Range: 1t 3
*RST: 1

Example: See Example"To configure CS subevent settings" on page 191.

Manual operation: See "ChM_Repetition" on page 98

[:SOURce<hw>]:BB:BTOoth:CS:CSEL <ChSel>
Sets the algorithm to select the channels.

Parameters:
<ChSel> SEL 3B | SEL_3C

SEL_3B
Sets for Algorithm #3b channel selection algorithm.

SEL_3C
Sets for Algorithm #3c channel selection algorithm.
For related parameters, see Table 5-7.

*RST: SEL_3B
Example: See Example"To configure CS subevent settings" on page 191.

Manual operation: See "ChSel" on page 98

[:SOURce<hw>]:BB:BTOoth:CS:CTCJump <ChThreeCJump>

Determines the number of skipped channels when rendering the channel shapes. The
Ch3cJump field has a length of 1 octet and relates to the channel index values.

Configure this field when using the channel selection algorithm Algorithm #3c:

:S0URcel:BB:BTOoth:CS:CSEL SEL_3C
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Parameters:

<ChThreeCJump>  JUMP_2 | JUMP_3 | JUMP_4 | JUMP_5 | JUMP_6 | JUMP_T7 |
JUMP_8
For Ch3cJump field parameters, see Table 5-7.
*RST: JUMP_2

Example: See Example"To configure CS subevent settings" on page 191.

Manual operation: See "Ch3cJump" on page 99
[:SOURce<hw>]:BB:BTOoth:CS:CTCShape <ChThreeCShape>

Sets the bits of the Ch3cShape field. The field has a length of 4 bits and sets the shap-
ing method of the rising and falling ramps of the channels.

Configure this field when using the channel selection algorithm Algorithm #3c:

:SOURcel:BB:BTOoth:CS:CSEL SEL_3C

Parameters:
<ChThreeCShape> HAT | X
HAT
Channel with a rising ramp and a falling ramp.
X
Channel with interleaved rising and falling ramps.
*RST: HAT
Example: See Example"To configure CS subevent settings" on page 191.

Manual operation: See "Ch3cShape" on page 99

Packet configuration commands - LE

Example: To configure advertising packets

// KA A Ak h A A Ak A Ak kA Ak kA A Ak kA Ak kA Ak hkhhhhkhhhkhkhk Ak hkhdhkhkhhkhkkhkhkhkkhhkkkhdxkk
// Configure packet for ADV SCAN IND: switch off whitening,

// set Tx device address type, AdvA, data source and length

// KKK A A A A AR A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR A AKX KA K

SOURcel:BB:BTOoth:CTYPe ADV

SOURcel:BB:BTOoth:UPTYpe ADC

SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel

:BB:
:BB:
:BB:
:BB:
:BB:
:BB:

BTOoth:
BTOoth:
BTOoth:
BTOoth:
BTOoth:
BTOoth:
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ECONfiguration:
ECONfiguration:
ECONfiguration:
ECONfiguration:
ECONfiguration:
ECONfiguration:

PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:

DWHitening 0
TATYpe PUBL
ANUap #H017412,24
ALAP #H9ESBO0O0, 24
DATA PNO9

DLENgth 31
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// ER R R E kb b b b b I E E E E b b b E E b E E b b SE E E h b b b b b b b dh b b b h b b b b h b 3E b b b b b b b b b b b b b 3

// Alternatively set periodic advertising interval for AUX SYNC IND
// *******************************************************:****:*****
SOURcel:BB:BTOoth:CTYPe ADV

SOURcel:BB:BTOoth:UPTYpe ASIN
SOURcel:BB:BTOoth:ECONfiguration:PCONfiguration:PAINterval

KKK KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR AR AR AR KA KK

!/
//
//
//
//
//
!/
//
//
SOURcel:BB:BTOoth:CTYPe ADV

:BB:BTOoth:UPTYpe AAIN

Select packet type AUX ADV_IND. (All parameters of

extended header are configurable with AUX ADV IND packet
type.) Set channel selection,
Tx device address type, advertising mode.

Enable extended header for advertising PDUs. Enable all

flags: AdvA, TargetA, AdvData Info, Aux Ptr, Sync Info,

TxPow. Set Tx power value and ACAD length and pattern.

B

SOURcel

SOURcel
SOURcel
SOURcel
SOURcel

:BB:
:BB:
:BB:
:BB:

BTOoth:
BTOoth:
BTOoth:
BTOoth:

ECONfiguration:
ECONfiguration:
ECONfiguration:
ECONfiguration:

PCONfiguration
PCONfiguration
PCONfiguration
PCONfiguration

:CSELection CS1
:TATYpe PUBL
:AMODe NCNS
:EHEader:STATe ON

PCON:
PCON:EHFLags:
PCON: :ADINfo:STATe ON
PCON:
PCON:
PCON

SOURcel:BB: :AADDress:STATe ON
:BB:

:BB:

BTOoth:
BTOoth:

ECONfiguration: EHFLags

SOURcel ECONfiguration: TADDress:STATe ON

SOURcel BTOoth:ECONfiguration:
BTOoth:
BTOoth:
BTOoth:
BTOoth:
BTOoth:

BTOoth:

EHFLags

SOURcel:BB: :APTR:STATe ON
:BB:

:BB:

ECONfiguration: EHFLags
EHFLags

:EHFLags:

SOURcel ECONfiguration: :SINFo:STATe ON

SOURcel ECONfiguration: TPOWer:STATe ON

SOURcel:BB:
:BB:

:BB:

ECONfiguration:PCONfiguration:TPOWer -100
PCONfiguration:ALENgth 16

PCONfiguration:ACAD PN16

SOURcel ECONfiguration:

SOURcel ECONfiguration:

// KKK KA A AR A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR AR AR KKK

// Alternatively set user-defined pattern.

// Kk hkkhkhkhkhkhkhkhkhkhhkhhkhkhhkhhkhhkhhhhhkhhkh bbb h b bk h bk hbh kb h kb hkhkhkhkhk bk hkhkhkhkhkhhkx*k
SOURcel:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD PATTern

SOURcel :BB:BTOoth:ECONfiguration:PCON:ACAD:APATtern #B011000011,9

VAR EEEEEE SRR LA AR EEEE SRR R AR R R Rt

// Alternatively set pattern from data list.

// ER R R E h b dE I I E E b b b b b b h h b E E h b SE h E b b b b b b dE b b b b b h b b b b h b 3E b b b E b h b b b b b h I i
SOURcel:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD DLISt
SOURcel:BB:BTOoth:ECON:PCON:ACAD:ASEL "p:/patternl.dm iqgd

ER R R h b E b h b E A E h b b b b E h b b E h b E E E b b b b b b dh b b b b h b b b b E b 3E b b b b b b b b b b b b 3

//
//
//
//
SOURcel:BB:BTOoth:ECONfiguration:PCON:EHFLags:ADINfo:STATe ON

Enable AdvData Info flag, set advertising data ID and

advertising data set ID.

ER R R bk E I h b I E E h h E E h b b E E b b E b b h h E h h b b b b dh b b b b b E b b b b b b 3E b b b b b h b b b E b b b
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SOURcel :BB:BTOoth:ECONfiguration:PCONfiguration:ADID #HO1FF,12
SOURcel:BB:BTOoth:ECONfiguration:PCONfiguration:ASID #HOF, 4

VAR EEEEEE SRR LA AR EEEE e AR EEE e E R Rt

!/
//
//
!/
SOURcel

channel

SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
//
//
!/
//
//
//
SOURcel:BB

packet:

value.

SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
// 99.9
SOURcel
SOURcel:BB

AUX offset,
KKK AR A AR A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR A AR AR A AN KA KKK
:BB:
:BB:
:BB:
:BB:
:BB:
:BB:

interval,

:BB:
:BB:
:BB:
:BB:
:BB:
:BB:
:BB:
:BB:

:BB:

: select AUX channel,

BTOoth

set sync packet offset,

Reset event counter.

:BTOoth

BTOoth

:BTOoth

BTOoth:
BTOoth:
BTOoth:

BTOoth:
BTOoth:
BTOoth:

BTOoth:

AUX PHY.

:ECONfiguration:
BTOoth:
BTOoth:

sleep clock accuracy,

ECONfiguration:
ECONfiguration:
ECONfiguration:

ECONfiguration:
ECONfiguration:

ER R R dE h b E I b E A h E b b b b E E b b E b b E h E h b b b b b b b dh b b b h dh b b h E b 3E b b b b b b b b b b b b b

set clock accuracy,

PCONfiguration
PCONfiguration
PCONfiguration
PCONfiguration

offset unit,

access address,

Enable and specify AuxPtr for the secondary advertising

offset unit,

PCON:EHFLags:APTR:STATe ON
DCTable:CHANnelO:STATe 1

:CACCuracy T500
:AOUNits U30
:AOFFset 100
:APHY L1M

Enable and specify SyncInfo field for the AUX SYNC IND

periodic adv

CRC initial

Configure channel map.

KKK KA A AR A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR A AR AR KRR RN KKK

:ECONfiguration:PCON:EHFLags:SINFo:STATe ON

:ECONfiguration:
BTOoth:
BTOoth:
BTOoth:
BTOoth:

:ECONfiguration

ECONfiguration:
ECONfiguration:
ECONfiguration:

ECONfiguration:
ECONfiguration:
ECONfiguration:
ECONfiguration:

ECONfiguration:

PCONfiguration

PCONfiguration

PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:

:PAINterval 20
SCACcuracy SCAOQ
AADDress #HACDE48AC, 32
CIV #H000000,24
SPOFfset 100

SOUNits U30

OADJust 1

SPOFfset?

:ECOunter 0

:PCON:DCMTable:CHANnelO:STATe 1

// KKK A A A AR A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A KA A A A A A AR AR AR AR KA KK

// Configure advertiser,

scanner and initiator device addresses.

// Company Assigned and Company Id in Advertiser’s Device Address
SOURcel :BB:BTOoth:ECONfiguration:PCONfiguration:ACAS #H000000,24
SOURcel:BB:BTOoth:ECONfiguration:PCONfiguration:ACID #H000000,24

// Company Assigned and Company Id in Scanners Device Address
SOURcel :BB:BTOoth:ECONfiguration:PCONfiguration:SCAS #H000000,24
SOURcel:BB:BTOoth:ECONfiguration:PCONfiguration:SCID #H000000,24

// Company Assigned and Company Id in Initiators Device Address
SOURcel :BB:BTOoth:ECONfiguration:PCONfiguration:ICAS #H000000,24
SOURcel:BB:BTOoth:ECONfiguration:PCONfiguration:ICID #H000000,24

YRR EEEEEE RS LA EEEE SRR EEEE AR R Rt
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Example: To configure data packets

// B R

// Configure signal for DATA: select channel type, packet type,

// packet format, sequence length, role, enable CRC corruption.

// B R R

SOURcel:
:BB:
:BB:

SOURcel
SOURcel
SOURcel
SOURcel
SOURcel

//
//
//
//

SOURcel:

SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel

BB

:BB:
:BB:
:BB:

NESN start,

BB

:BB:
:BB:
:BB:
:BTOoth:
:BB:
:BB:

:BB

:BB:

:BTOoth
BTOoth
BTOoth
BTOoth
BTOoth
BTOoth

Configure packet type DATA:

SN

:BTOoth

BTOoth

BTOoth:
BTOoth:
BTOoth:

:CTYPe DATA
:UPTYpe CUR
:PFORmat L1M
:USLength 12
:BCRole CENTral
:CCRC:STATe 1

start values,

:CTYPe DATA
UPTYpe DATA

:ECONfiguration:
BTOoth:
BTOoth:

data source,

ECONfiguration:
ECONfiguration:
ECONfiguration:

ECONfiguration:
ECONfiguration:

access address,

PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:

ER R R R b dE b b h b Ik E I E b I b E E b E E E b E E IE h b b b b b E E b b b b b h b b h E b 3E b b b I b h b b b h b b I 3
CRC initial,
data length

ER R R R h dE b h b Ik E I E b dh b b E I b E R E b E E E E b b b b dE b b b b b E h b b h E b 3E b b b b b b b b b b b b I i

AADDress #HDAB85479,32
CIValue #H000000,24
NSValue O

SSValue 0

DATA PNO9

DLENgth 251

// KKK A A A AR A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR A AR AR AR AR KA KK

//
//
//
//

SOURcel:

SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel

//
//
//
//
SOURcel
SOURcel
SOURcel
SOURcel

type,

ER R R R h dE b h b I E I dE b I b b E E b E E h b E E E E b b b b b dh b dE b b b E h b b h h b 3E b b b b b b b b E dh b b b i

latency,

BB

:BB:
:BB:
:BB:
:BB:
:BB:
:BB:
:BB:
:BB:
:BB:
:BB:
:BB:

window size and offset,

:BTOoth

BTOoth

BTOoth:
BTOoth:
BTOoth:
BTOoth:

BTOoth:
BTOoth:
BTOoth:
BTOoth:
BTOoth:
BTOoth:

LL connection timeout,

:CTYPe DATA
UPTYpe CUR

:ECONfiguration:

ECONfiguration:
ECONfiguration:
ECONfiguration:

ECONfiguration:
ECONfiguration:
ECONfiguration:
ECONfiguration:
ECONfiguration:
ECONfiguration:

connection event interval,

PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:

Configure payload of LL CONNECTION UPDATE IND: transmit

Peripheral

connection instant.

RR R R R b dE b b S E h h E b h b b h E b b R h b E E E E b b b b b dh b b b b b b b b b b E b 3h b b b I b b b b b b b b b 3

AADDress #HDAB85479,32
CIValue #H000000,24
NSValue O

SSValue 0

NWSize 1.25

NWOFfset 0

NCINterval 7.5
PSLatency 0

NLCTimeout 100
CINStant O

RR R R R b dE b Ik b E E b b b b E I b b E E b b E dE h b b h b b dh b b b b b E 3h b b h b b 3E b b b b b b b b b b b b b

Configure the payload of LL FEATURE REQ: set packet

feature set length and configure feature set.

:BB:
:BB:
:BB:
:BB:

BTOoth
BTOoth
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:CTYPe DATA
:UPTYpe FREQ

BTOoth:ECONfiguration:PCONfiguration:FSLength 8
BTOoth:ECONfiguration:PCONfiguration:FSBit0:STATe 1
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SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel

//
//
//
//
//
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel

//
//
//
//

SOURcel:

SOURcel
SOURcel
SOURcel
SOURcel
SOURcel

:BB:
:BB:
:BB:
:BB:
:BB:
:BB:
:BB:
:BB:
:BB:
:BTOoth:
:BB:
:BB:

:BB

:BB:
:BB:
:BB:
:BB:

interval,

periodicity,

:BB:
:BB:
:BB:
:BB:
:BB:
:BB:
:BB:
:BB:
:BB:
:BB:
:BTOoth:
:BB:
:BB:

:BB

:BB:
:BB:
:BB:
:BB:

BB

:BB:
:BB:
:BB:
:BB:
:BB:

BTOoth

BTOoth

BTOoth

BTOoth

BTOoth

BTOoth

BTOoth

BTOoth

payload octets,

:BTOoth

BTOoth
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BTOoth:

BTOoth:
BTOoth:
BTOoth:

BTOoth:
BTOoth:

BTOoth:
BTOoth:
BTOoth:

BTOoth:
BTOoth:

BTOoth:
BTOoth:

:ECONfiguration:

:ECONfiguration:
BTOoth:
BTOoth:
BTOoth:

:ECONfiguration:
BTOoth:
BTOoth:
BTOoth:
:ECONfiguration:
BTOoth:

Peripheral latency,

CTYPe DATA
UPTYpe CPR

:ECONfiguration:

:ECONfiguration:
BTOoth:
BTOoth:
BTOoth:

:ECONfiguration:
BTOoth:
BTOoth:
BTOoth:
:ECONfiguration:
BTOoth:

max.

:CTYPe DATA
UPTYpe LREQ

:ECONfiguration:

ECONfiguration:

ECONfiguration:
ECONfiguration:
ECONfiguration:

ECONfiguration:
ECONfiguration:
ECONfiguration:
ECONfiguration:

ECONfiguration:
ECONfiguration:
ECONfiguration:

ECONfiguration:

ECONfiguration:
ECONfiguration:
ECONfiguration:

ECONfiguration:
ECONfiguration:
ECONfiguration:
ECONfiguration:

ECONfiguration:
ECONfiguration:

ECONfiguration:

ECONfiguration:

ECONfiguration:

ECONfiguration:
ECONfiguration:

Packet configuration commands - LE

PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:

LL connection timeout,

reference connection even count

PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:

PCONfiguration
PCONfiguration
PCONfiguration
PCONfiguration

FSBitl:STATe
FSBit2:STATe
FSBit3:STATe
FSBit4:STATe
FSBit5:STATe
FSBit6:STATe
FSBit7:STATe
FSBit8:STATe

O B O B B B PP

FSBit9:STATe
FSBit10
FSBitll
FSBitl2
FSBitl3
FSBitl4
FSBitl5
FSBitl6:STATe

:STATe
:STATe
:STATe
:STATe
:STATe
:STATe

o O B O O O O

KKK AR AR A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR A AR AN AR KKK K

Configure the payload of LL CONNECTION PARAM REQ: max. and min.

preferred

ER R E kb E I b h b E E Ih h b b b b E I b b E E b E E E h b b b b b dh b b b b b b h b b h E b 3E b b b E b b b b b b b b i

MXINterval 10
MNINterval 7.5
PSLatency 1
NLCTimeout 100
PPERiodicity 1.25
RCECount 10
OFFSetO
OFFSetO
OFFSetl
OFFSetl
OFFSet2
OFFSet2
OFFSet3
OFFSet4
OFFSet5

:STATe ON
3.75
ON

:VALue 5

:VALue
:STATe
:STATe ON

6.25
OFF
OFF
OFF

:VALue
:STATe
:STATe
:STATe

KKK KA KRR A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR AR AKX KKK

Configure the payload of LL LENGTH REQ: max. Rx and TX

time to receive and transmit a packet.

KKK KA A AR A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR AR R AR KA KK

:MROCtets 27
:MTOCtets 27
:MRTime 0.328
:MTTime 0.328
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// KKK AR A AR A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A KA A A AR A AR A AR AR KN KKK

// Set the payload of LL PHY REQ: specify preferred Tx, Rx PHYs.

VAR EEEEEE SRR LA AR EEEE e AR EEE e E R Rt

SOURcel:BB
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel:BB
SOURcel

:BB:
:BB:
:BB:
:BB:
:BB:

:BB:

:BTOoth:CTYPe DATA
BTOoth:UPTYpe PREQ
BTOoth
BTOoth:
BTOoth:
BTOoth:
:BTOoth:
BTOoth

:ECONfiguration:
ECONfiguration:
ECONfiguration:
ECONfiguration:
ECONfiguration:
:ECONfiguration:

PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:

TPHYs
TPHYs
TPHYs
RPHYs
RPHYs
RPHYs

:LIM:STATe 1
:L2M:STATe 1
:LCOD:STATe O
:LIM:STATe 1
:L2M:STATe 1
:LCOD:STATe O

VAR EEEEEE SRR LA AR EEEE e AR EE AR R R Rt

// Set the payload of LL PHY UPDATE IND: specify PHYs for

// Central-to-Peripheral and Peripheral-to-Central direction and instant.

VAR EEEEEE SRR LA AR EEEE SRR EEEE AR R Rt

SOURcel:BB
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel

:BB:
:BB:
:BB:
:BB:
:BB:
:BB:
:BB:
:BB:

:BTOoth:CTYPe DATA
BTOoth:UPTYpe PUIN
BTOoth
BTOoth:
BTOoth:
BTOoth:
BTOoth:
BTOoth

BTOoth:ECONfiguration

:ECONfiguration:
ECONfiguration:
ECONfiguration:
ECONfiguration:
ECONfiguration:
:ECONfiguration:

PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
:PCONfiguration:

MTSPhy:L1M:STATe 1
MTSPhy:L2M:STATe 1
MTSPhy:LCOD:STATe 0
STMPhy:L1M:STATe 1
STMPhy:L2M:STATe 1
STMPhy:LCOD:STATe 0
CINStant 1

// KKK KA AR A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR AR AR KA KK

// Set the payload of LL REJECT EXT IND: set reject opcode

VAR EEEEEE SRR LA EEEE SRR EEEE AR Rt

SOURcel:BB
SOURcel :BB

:BTOoth:CTYPe DATA
:BTOoth:UPTYpe REIN

SOURcel :BB:BTOoth:ECONfiguration:PCONfiguration:ROPCode #H02,8

//
//
//
//

role to

Peripheral,

used channels requirement

set the packet type,

KKK KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR A AR AR KA KKK

Set the payload of LL_MIN USED_CHANNELS IND: set the controller

specify PHYs and minimum

// R R E h b E I I E A E h b h b b E b E E b E E E b h b b b dh b b b b b h 3h b b h E b 3E b b b b b b b b b b b b 3 i

SOURcel:BB
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel
SOURcel

:BB:
:BB:
:BB:
:BB:
:BB:
:BB:

:BTOoth:CTYPe DATA
BTOoth:
BTOoth:UPTYpe MUCH
BTOoth:
BTOoth:
BTOoth:
BTOoth

ECONfiguration:
ECONfiguration:
ECONfiguration:
:ECONfiguration:

BCRole PERipheral

PCONfiguration
PCONfiguration
PCONfiguration
PCONfiguration

:PHYS:L1IM:STATe 1
:PHYS:L2M:STATe 1
:PHYS:LCOD:STATe 0

:MUCHannels 2

// KKK KA A A AR A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR AR AR KRR KA KK

// Set header and payload of LL_PERIODIC_SYNC IND: enable CTE and
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// configure CTE method,

// and address type.

VAR EEEEEE SRR LA AR EEEE e AR EEE e E R Rt

:SOURcel
:SOURcel
:SOURcel
:SOURcel
:SOURcel
:SOURcel
:SOURcel
:SOURcel
:SOURcel

:BB:
:BB:
:BB:
:BB:
:BB:
:BB:
:BB:
:BB:
:BB:

// Enabling

:SOURcel
:SOURcel
:SOURcel
:SOURcel
:SOURcel
:SOURcel
:SOURcel

:BB:
:BB:
:BB:
:BB:
:BB:
:BB:
:BB:

// Enabling

:SOURcel
:SOURcel
:SOURcel
:SOURcel
:SOURcel
:SOURcel

8.6.1

:BB
:BB:
:BB:
:BB:
:BB:
:BB:

BTOoth:
BTOoth:
BTOoth:
BTOoth:
BTOoth:
BTOoth:
BTOoth:
:ECONfiguration:
BTOoth:

BTOoth

offset

BTOoth:
BTOoth:
BTOoth:
BTOoth:
BTOoth:
BTOoth:
BTOoth:

CTYPe DATA
UPTYpe PSIN

ECONfiguration:
ECONfiguration:
ECONfiguration:
ECONfiguration:
ECONfiguration:

ECONfiguration:

Packet configuration commands - LE

set event counter properties,

PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:

CPResent 1
CTIMe 0.016
CTYPe AOA

ID #HAAAA,16
SPOFfset 245.7
SOUNits U30
OADJust 1

adjust sets the Sync packet offset to 300 ups.

ECONfiguration:
ECONfiguration:
ECONfiguration:
ECONfiguration:
ECONfiguration:
ECONfiguration:
ECONfiguration:

PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:

SOUNits U300
CECount 65535
LPECounter 65535
SID #HI1,4

ATYPe PUBL
SCACcuracy SCAOQ
PHY:L1M:STATe 1

another PHY automatically disables the previous PHY.

:BTOoth:
BTOoth:
BTOoth:
BTOoth:
BTOoth:
BTOoth:

General configuration
Header configuration
Payload configuration
Cs payload configuration

ECONfiguration:
ECONfiguration:
ECONfiguration:
ECONfiguration:
ECONfiguration:
ECONfiguration:

General configuration

PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:
PCONfiguration:

PHY:L2M:STATe 1

PHY:LCOD:STATe 1
PHY:L1M:STATe? O
PHY:L2M:STATe? O

ACASsigned #H000080,24

SCECounter 65535

specify PHYs

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DWHitening................ccccceee. 216
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AADDIeSS.........ccceeeeeeeeeeernnn 217
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CIValue..............ccccuvrrreeennnn. 217
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DWHitening
<DWhitening>

Activates or deactivates the Data Whitening. Evenly distributed white noise is ideal for
the transmission and real data can be forced to look similar to white noise with different
methods called Data Whitening. Applied to the PDU and CRC fields of all packet types,
whitening is used to avoid long equal seqeunces in the data bit stream.

Parameters:

<DWhitening> 1]ON| 0| OFF

*RST: 0
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8.6.2

Packet configuration commands - LE

Example: See Example"To configure data packets" on page 213.

Manual operation: See "Data Whitening" on page 59

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AADDress
<AAddress>, <BitCount>

Sets the access address of the link layer connection (32-bit string).

Parameters:
<AAddress> numeric
*RST: #HACDE48AC
<BitCount> integer
Range: 32 to 32
*RST: 32
Example: See Example"To configure advertising packets" on page 210.

Manual operation: See "Access Address" on page 59

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ClValue <CiValue>,
<BitCount>

Sets the initialization value for the CRC (Cyclic Redundancy Check, 24 bits) calcula-
tion. A packet has been received correctly, when it has passed the CRC check.

Parameters:
<CiValue> numeric
*RST: #HO
<BitCount> integer
Range: 24 to 24
*RST: 24
Example: See Example"To configure advertising packets" on page 210.

Manual operation: See "CRC Initial Value(hex)" on page 60

Header configuration

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CSELection............ccccceeeeenn.. 218
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NSValue.............cceeeeeereeeeee. 218
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SSValue...........ccccevrvrrrrernnnn.. 218
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CPResent..........cceeeeeeeeeiiennns 218
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTIMe............cevrrrrrrrrrrrnnnnnnnn 219
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTREq.......cccevvrueeereerrrnrnnnnn.. 219
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTYPe..........cuuvruuieeieeeerennn. 219
[:SOURce<hw>]:BB:BTOoth:ECONfig:PCONfig:ANTGain<ChO>.......cccoeeuiiiiiiiiiiiiiieeeieee 220
[:SOURce<hw>]:BB:BTOoth:ECONfig:PCONfig:ANTNUMDET .......uueueiaaiaaeeeeeeeeeeeeeeeeeeeeeees 220
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CSELection
<CSelection>

Specifies the algorithm of channel selection.

Parameters:
<CSelection> CS1|CS2
Algorithm #1 or algorithm #2
*RST: CS1
Example: See Example"To configure advertising packets" on page 210.
Options: R&S SMM-K117

Manual operation: See "Channel Selection" on page 61

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NSValue <NsValue>

Sets the start value of the next expected packet from the same device in the LL con-
nection ("N"ext"E"xpected "S"equence"N"umber). This parameter can be set in the first
event. From the second event this field is not indicated.

Parameters:
<NsValue> integer
Range: 0 to 1
*RST: 1
Example: See Example"To configure data packets" on page 213.

Manual operation: See "NESN Start Value" on page 60

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SSValue <SsValue>

Sets the sequence number of the packet. This parameter can be set in the first event.
From the second event, this field is not indicated.

Parameters:
<SsValue> integer
Range: 0 to 1
*RST: 0
Example: See Example"To configure data packets" on page 213.

Manual operation: See "SN Start Value" on page 61

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CPResent <State>

Activates the CTEInfo field in the header of Bluetooth LE data packets in the LE unco-
ded PHY.

Parameters:
<State> 1|ON | 0| OFF

*RST: 0
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Packet configuration commands - LE

Example: See Example"To configure data packets" on page 213.

Manual operation: See "CTEInfo Present” on page 61

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTIMe <CTime>

Sets the CTETime comprising the length of constant tone extension field of the Blue-
tooth LE PDU.

Parameters:
<CTime> float
Range: 16E-6 to 160E-6
Increment: 8E-6
*RST: 16E-6
Example: See Example"To configure data packets" on page 213.

Manual operation: See "CTETime" on page 62

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTReq <CTReqg>

Sets the CTE type in the CTETypeReq field of the CtrData field of the LL_CTE_REQ
PDU.

Parameters:
<CTReg> AOD1 | AOA | AOD2

AOA
AoA Constant Tone Extension

AOD1
AoD Constant Tone Extension with 1 us time slots

AOD2
AoD Constant Tone Extension with 2 us time slots

*RST: AOA
Example: See Example"To configure data packets" on page 213.

Manual operation: See "CTETypeReq" on page 89

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTYPe <CType>

Sets the type of constant tone extension. The type specifies the CTE AoA/AoD method
and for AoD the length of the switching and I/Q sampling slots.

Parameters:

<CType> AOD1 | AOA | AOD2
AOA
AoA Constant Tone Extension
AOD1

AoD Constant Tone Extension with 1 us time slots
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AOD2
AoD Constant Tone Extension with 2 us time slots

*RST: AOA
Example: See Example"To configure data packets" on page 213.

Manual operation: See "CTEType" on page 63

[:SOURce<hw>]:BB:BTOoth:ECONfig:PCONfig:ANTGain<ch0> <AntennaGain>

Specifies the gain of the antenna. You can specify the antenna gain infomation of up
for four individual antennas for direction finding.

Parameters:
<AntennaGain> float
Range: -10 to 10
Increment: 0.01
*RST: 0
Example: See Example"To configure data packets" on page 213.

Manual operation: See "AntennaX Gain" on page 63

[:SOURce<hw>]:BB:BTOoth:ECONfig:PCONfig:ANTNumber <AntennaNum>

Specifies the number of antenas for angle of departure (AoD) direction finding method.
You select up to four antennas, that are used for direction finding.

Parameters:
<AntennaNum> integer
Range: 1to 4
*RST: 1
Example: See Example"To configure data packets" on page 213.

Manual operation: See "Antenna Number" on page 63

Payload configuration

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD..........ccceeereeereernneennnns 222
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD:APATtern.................... 223
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD:ASELection................. 223
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACID............cceevrrrrrrrnrnnnnnnnnn. 224
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACASsigned..............cuvvrnnn... 224
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCASSsIgned..............ccccurenns 224
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCID...........ccceerrrvrrrrnrmnnnnnnnn 224
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ICASsigned..........cc.cceeeeeeeee. 224
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ICID.............eeeeeeieieeeieeeeennn. 224
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ADID............cceeevrrrrrrnrnnnnnnnnn. 224
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ALAP............ccceeeeeeeereereeeenes 225
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ILAP...........ccceverrrrermrnnnnnannnn 225

User Manual 1179.2054.02 — 07 220



R&S®SMM-K60/-K117/-K178 Remote control commands

Packet configuration commands - LE

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SLAP...........ccoeeeiiiiiiiiiieneenens 225
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TLAP........cccevmiiiiiniiriiieeeenn. 225
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ALENgth.........c..ccceeniiiirnnnneen. 225
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AMODE........cccceeerererrreeaeannnn. 226
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ANU@P........c.cccevvrueeerereernnnnn. 226
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:INUap.......c..ccceeeeeeeeeeereerennns 226
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SNUaP............eueueeeeieeeeeennnn. 226
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration: TNUapP..........ccvvuciereerrennnnnnnn. 226
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AOFFset.........cccccoerviiirnnnens 227
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AOUNIts............cceerreeeerrennnnee 227
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:APHY ..........ccccccvrrirrirrenennnnn. 227
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ASID.........c.cccevvvrueereererrnnnnnn. 228
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CACCUracy..........cccceeeeerennn.. 228
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CID..............ceeeeeeerrerreeerennnnns 228
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CINStant...........ccccceeeeeeeeeenn. 229
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CINTerval..............ccccveeeeeeees 229
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA.........cceeeerreieeeeereeaaaaen 229
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA:DPATterN............ccc...... 230
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA:DSELection................. 230
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DLENGth........ccccceeeererererennn. 231
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ECODE.........cccceeeeeererienaaann. 231
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ECOuUNter.................uuuuuunnnn. 231
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EDIVersifier...........ccccceeeenn... 232
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHEader:STATe..............c..... 232

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:AADDress:STATe.... 232
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:ADINfo:STATe......... 233

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:APTR:STATe.......... 233
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:CINFo:STATe.......... 233
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:SINFo:STATe.......... 234

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags: TADDress:STATe.... 234
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags: TPOWer:STATe...... 234

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit<ch0>:STATe................ 234
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:FSLength............cccvvvrvrrrrnnnee. 235
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:HLENGth.........ccccceeerereeeren... 235
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:LCTimeout..........cceevereurnnnnnne. 236
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MIVector.............cccccceeeeeeennnn. 236
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SIVector...............ccceeveeerrnnes 236
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MROCtetS........cccceeerreerennnne 236
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTOCtetSs............ccvvvueeeeennnn. 236
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MSKD............c.ceevrrrrrrrrrrnnnn. 237
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SSKD............ccceeeaiiieaeieeeeannnn. 237
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MRTime.........c.ccccevireennnreen. 237
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTTime..........ceeeeririennerernnnn. 237
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MUCHannels...........ccccc........ 238
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:L1M:STATe.............. 238
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:L2M:STATe.............. 238
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:LCOD:STATe........... 238
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:L1M:STATe.............. 238
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:L2M:STATe.............. 238
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:LCOD:STATe........... 238
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NCINterval..............cceeeeernen. 239
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NLCTimeout...............cceeuunn. 239
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NSLatency...........c.eceeeeeeeennn. 239
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NWOFfset.........ccccceeererrrennn.. 240
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NWSize..........c..ecevvrrueeerennnnn. 240
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:OADJUSL...........ccevrerrrrrreennnnn. 240
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L1M:STATe................. 241
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L2M:STATe................. 241
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:LCOD:STATe............... 241
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration: TATYPE......cccaeereeeeeeeeeeaaaannn. 241
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RATYPE........evrrrererreeereriiinnnns 241
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ROPCode..........ccccoceeeeerennne. 242
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:L1M:STATe................ 242
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:L2M:STATe................ 242
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:LCOD:STATe............. 242
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration: TPHYs:L1M:STATe................ 242
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration: TPHYs:L2M:STATe................ 242
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:LCOD:STATe............. 242
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RVECHOr............ccevvvuueereeennn. 242
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCACcUracy...........ccccevvveeeens 243
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SLATENCY.........c.ceerrrerrerrennes 243
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SOUNIts..............ccoerrrrrrrnnnnns 244
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SPOFfset............uvueuuuaaaannnn. 244
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SVNumber.......c....c..cceevrunnnnn. 244
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration: TPOWeT.............ccceeeveerereeenns 245
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:UTYPe..........cuuveuuiiciieeeeennnn. 245
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:VNUMDber...............cccvvrrrreens 246
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:WOFFset........ccccceeeeererrnannne. 246
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:WSIZe............cceeeeeeeerereeeene. 246
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ATYPe........cccerrreermrmmnnnnaannn. 247
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CECouUNt........cccceeeeeererererennnn. 247
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ID........cc.cccoeeererruuceeeeeeenrnnnnnn. 247
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:LPECounter...............cc.evuen.. 248
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MCLREq...........uuuuueeieeeerennnn. 248
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L1M:STATe.......cccceeunneee. 248
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L2M:STATe.......cccceeunn.e.. 248
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:LCOD:STATe................. 249
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCECouNter..........ccceeeeeeennnn. 249
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SID..........ccccceeeeeerevrnnerereeennne. 249

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD <Data>

Specifies the pattern source used for additional controller advertising data (ACAD).

Parameters:

<Data> ALLO | ALL1 | PATTern | PNO9 | PN11 | PN15 | PN16 | PN20 |
PN21 | PN23 | DLISt
ALLO / ALL1

All 0 or all 1 pattern
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PATTern

User-defined pattern. The pattern can be specified via:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:
PCONfiguration:ACAD:APATtern On page 223

PNxx

Pseudo-random bit sequences (PRBS) of a length of xx bits.
The length in bit can be 9, 11, 15, 16, 20, 21, or 23.

DLISt

Internal ACAD data list is used. The data list can be specified
via:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:
PCONfiguration:ACAD:ASELection on page 223

*RST: PNO09
Example: See Example"To configure advertising packets" on page 210.
Options: R&S SMM-K117

Manual operation: See "ACAD" on page 70

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD:APATtern
<DPattern>, <BitCount>

Specifies user-defined pattern. The settings is relevant for

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:ACAD

PATTern
Parameters:
<DPattern> numeric
*RST: #HO
<BitCount> integer
Range: 1 to 64
*RST: 1
Example: See Example"To configure advertising packets" on page 210.
Options: R&S SMM-K117

Manual operation: See "AList / Pattern" on page 70

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD:ASELection
<DSelection>

Specifies data list file. The settings is relevant for
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:ACADDLISt

Parameters:
<DSelection> string

Path and file name.
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Example: See Example"To configure advertising packets" on page 210.
Options: R&S SMM-K117

Manual operation: See "AList / Pattern” on page 70

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACID <Acid>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACASsigned
<AcAssigned>, <BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCASsigned
<ScAssigned>, <BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCID <Scid>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ICASsigned
<lcAssigned>, <BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ICID <Icid>,
<BitCount>

Sets the advertiser’s device address. For advertising channel packets, the format of
the device address differs, depending on the selected address type.

® "Public Address Types"
The public address is given from the registration authority IEEE and is composed
of:

— LSB: 24 bits = company_assigned
— MSB: 24 bits = company_id
® "Random Address Type" is a 48-bits random static device address.

® "Private Address Type"
A private address is optional and composed of:

— LSB: 24 bits = hash
— MSB: 24 bits = random

Parameters:
<lcid> numeric
*RST: #HACDE48
<BitCount> integer
Range: 24 to 24
*RST: 24
Example: See Example"To configure advertising packets" on page 210.

Manual operation: See "Initiator's Device Addr" on page 77

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ADID <Adid>,
<BitCount>

Specifies "Advertising Data ID" in hexadecimal format to be signaled within an exten-
ded header.
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Parameters:
<Adid> numeric
*RST: #H000
<BitCount> integer
Range: 12 to 12
*RST: 12
Example: See Example"To configure advertising packets" on page 210.
Options: R&S SMM-K117

Manual operation: See "Advertising Data ID(hex)" on page 71

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ALAP <Lap>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ILAP <Lap>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SLAP <Lap>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TLAP <Lap>,
<BitCount>

Sets the lower address part (LAP) of Bluetooth device address. Commands for the
advertising . . : ALAP, initiating . . : ILAP, scanning . . : SLAP PDUs of advertising
channel type are provided. In addition, a command is provided for scanner’s or initia-

tor’s target device address to which the advertisement is directed . . : TLAP.
Parameters:
<Lap> numeric

*RST: #H000080
<BitCount> integer

Range: 24 to 24

*RST: 24
Example: See Example"To configure advertising packets" on page 210.
Options: R&S SMM-K117

Manual operation: See "Target's Device Addr" on page 65

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ALENgth <Length>
Specifies the length of ACAD data pattern.

Parameters:
<Length> integer
Range: 0 to 62
*RST: 27
Example: See Example"To configure advertising packets" on page 210.
Options: R&S SMM-K117

User Manual 1179.2054.02 — 07 225



R&S®SMM-K60/-K117/-K178 Remote control commands

Packet configuration commands - LE

Manual operation: See "ACAD Length" on page 70

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AMODe <AMode>

Indicates the mode of the advertisement.

Parameters:
<AMode> NCNS | CNS | NCS
NCNS: Non-connectable, non-scannable
CNS: Connectable, non-scannable
NCS: Non-connectable, non-scannable
*RST: NCNS
Example: See Example"To configure advertising packets" on page 210.
Options: R&S SMM-K117

Manual operation: See "Advertising Mode" on page 67

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ANUap <NapUap>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:INUap <NapUap>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SNUap <NapUap>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TNUap <NapUap>,
<BitCount>

Sets the non-significant address part (NAP) and upper address part (UAP) of Bluetooth
device address. Commands for the advertising . . : ANUap, initiating . . : INUap, and
scanning . . : SNUap PDUs of advertising channel type are provided. In addition, a
command is provided for scanner’s or initiator’s target device address to which the
advertisement is directed . . : TNUap.

Parameters:
<NapUap> numeric
*RST: #HACDEA48
<BitCount> integer
Range: 24 to 24
*RST: 24
Example: See Example"To configure advertising packets" on page 210.
Options: R&S SMM-K117

Manual operation: See "Target's Device Addr" on page 65
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AOFFset <AOffset>

Specifies the time from the start of the packet containing the AuxPtr field to the approx-
imate start of the auxiliary packet. The offset is determined by multiplying the value by
the unit, see

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:AQUNits

Parameters:
<AOffset> float

Range: 0 to 245.7 or 246 to 2457 depending on offset unit
Example: See Example"To configure advertising packets" on page 210.
Options: R&S SMM-K117

Manual operation: See "AUX Offset" on page 72

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AOUNits <Unit>
Indicates the units used by the "Aux Offset" parameter, see

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:AOFFset

Parameters:
<Unit> U30 | U300
U30: 30 us
U300: 300 us
*RST: u30
Example: See Example"To configure advertising packets" on page 210.
Options: R&S SMM-K117

Manual operation: See "Offset Units" on page 72

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:APHY <APhy>
Sets the physical layer (PHY) to transmit the auxiliary packet.

Parameters:
<APhy> L1M | L2M | LCOD | L2M2B
For a description, see [ : SOURce<hw>] :BB:BTOoth: PFORmat
on page 175.
*RST: L1M
Example: See Example"To configure advertising packets" on page 210.
Options: L2M and LCOD require option R&S SMM-K117.

L2M2B requires option R&S SMM-K178.
Manual operation: See "AUX PHY" on page 72
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ASID <Asid>,
<BitCount>

Specifies the "Advertising Set ID" in hexadecimal format to be signaled within an
extended header.

Parameters:
<Asid> numeric
*RST: #HO
<BitCount> integer
Range: 4 to 4
*RST: 4
Example: See Example"To configure advertising packets" on page 210.
Options: R&S SMM-K117

Manual operation: See "Advertising Set ID(hex)" on page 71

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CACCuracy
<CAccuracy>

Specifies the clock accuracy of the advertiser used between the packet containing this
data and the auxiliary packet.

Parameters:
<CAccuracy> T500 | T50
T500: 51 ppm to 500 ppm
T50: 0 ppm to 50 ppm
*RST: T500
Example: See Example"To configure advertising packets" on page 210.
Options: R&S SMM-K117

Manual operation: See "Clock Accuracy" on page 72

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CID <Cid>,
<BitCount>

Sets the company identifier of the manufacturer of the Bluetooth Controller. A 16 bit
value is set.

Note: This parameter is relevant for data frame configuration and for the packet type
LL_VERSION_IND.

Parameters:
<Cid> numeric

*RST: 0
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<BitCount> integer
Range: 16 to 16
*RST: 16
Example: See Example"To configure data packets" on page 213.

Manual operation: See "Company Id(hex)" on page 84

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CINStant
<Clnstant>

Sets a connection instant for indicating the connection event at which the new connec-
tion parameters are taken in use.

Parameters:
<Clnstant> integer
Range: 1 to depends on sequence length
*RST: 1
Example: See Example"To configure data packets" on page 213.

Manual operation: See "Connection Instant" on page 82
See "Connection Instant" on page 129

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CINTerval
<Clnterval>

Sets the time interval between the start points of two consecutive connection events for
the packet type DATA and all CONTROL_DATA packet types.

Command sets the values in ms. Query returns values in s.

Parameters:
<Clnterval> float
Range: 7.5E-3 s to depends on oversampling
Increment: 1.25E-3 s
*RST: 7.5E-3 s
Default unit: ms
Example: See Example"To configure data packets" on page 213.

Manual operation: See "Connection Event Interval" on page 55

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA <Data>

Selects the pattern source used for the payload.

Parameters:

<Data> ALLO | ALL1 | PATTern | PNO9 | PN11 | PN15 | PN16 | PN20 |
PN21 | PN23 | DLISt
ALLO/ALL1

All 0 or all 1 pattern
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PATTern

User-defined pattern. The pattern can be specified via:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:
PCONfiguration:DATA:DPATtern on page 230

PNxx

Pseudo-random bit sequences (PRBS) of a length of xx bits.
The length in bit can be 9, 11, 15, 16, 20, 21, or 23.

DLISt

Internal data list is used. The data list can be specified via:
[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:
PCONfiguration:DATA:DSELection on page 230

*RST: PNO09
Example: See Example"To configure advertising packets" on page 210.

Manual operation: See "Data Source" on page 65

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA:DPATtern
<DPattern>, <BitCount>

Specifies the user-defined pattern. The setting is relevant for

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:DATA

PATTern
Parameters:
<DPattern> numeric
*RST: #HO
<BitCount> integer
Range: 1 to 64
*RST: 1
Example: See Example"To configure data packets" on page 213.

Manual operation: See "Data Source" on page 65

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA:DSELection
<DSelection>

Selects a data list file from the default directory or from the specific directory.

Using data list (DL.ISt) data requires one of the following commands:

® BB:BTO:ECON:PCON:DATA DLISt
See [ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:
DATA on page 229.

® BB:BTO:DTT:TPC:UPS DLISt
See [:SOURce<hw>] :BB:BTOoth:DTTest:TPConfiguration:UPSource
on page 270.
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Parameters:
<DSelection> string
Example: See Example"To configure advertising packets" on page 210.

Manual operation: See "Data Source" on page 65

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DLENgth
<DLength>

Sets the payload data length in bytes.

Parameters:
<DLength> integer
Range: 0 to 255 (advertiser) or 251 (data)
*RST: 31
Example: See Example"To configure advertising packets" on page 210.

Manual operation: See "Data Length" on page 65

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ECODe <ECode>,
<BitCount>

Sets the error code value to inform the remote device why the connection is about to
be terminated in case of LL_ TERMINATE_IND packet. On the other hand, this param-
eter for LL_REJECT _IND packet is used for the reason a request was rejected. A 8 bit
value is set.

Note: This parameter is relevant for data frame configuration and the packet type:

e LL TERMINATE_IND
e LL REJECT_IND

Parameters:
<ECode> numeric
*RST: #HO00
<BitCount> integer
Range: 8 to 8
*RST: 8
Example: SOURcel :BB:BTO:ECON:PCON:ECOD #HO0O0, 8

Sets the error code.

Manual operation: See "Error Code(hex)" on page 82

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ECOunter
<ECounter>

Counts the AUX_SYNC_IND packets that the Synclnfo field describes.
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Parameters:
<ECounter> integer
Range: 0 to 65535
*RST: 0
Example: See Example"To configure advertising packets" on page 210.
Options: R&S SMM-K117

Manual operation: See "Event Counter" on page 74

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EDIVersifier
<EDiversifier>, <BitCount>

Sets the encrypted diversifier of the Central for device identification. The parameter is
an initialization vector provided by the host in the HCI_ULP_Start_Encryption com-

mand.
Parameters:
<EDiversifier> numeric
*RST: #H0000
<BitCount> integer
Range: 16 to 16
*RST: 16
Example: SOURcel :BB:BTO:ECON:PCON:EDIV #H0000,16

Sets the encrypted diversifier of the Central.

Manual operation: See "Encrypted DIVersifier(hex)" on page 82

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHEader:STATe
<State>

Enables / disables extended header for advertising packets with scanning PDUs.

Parameters:
<State> 1] ON |0 | OFF
*RST: 1
Example: See Example"To configure advertising packets" on page 210.
Options: R&S SMM-K117

Manual operation: See "Extended Header" on page 67

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
AADDress:STATe <State>

If enabled, the R&S SMM100A includes the signaling of non-significant advertising
address part (NAP) and upper address part (UAP).
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<State>

Example:
Options:

Manual operation:
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1| ON |0 | OFF
*RST: 0

See Example"To configure advertising packets" on page 210.
R&S SMM-K117
See "AdvA" on page 68

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:ADINfo:

STATe <State>

Enables / disables the signaling of advertising data information consisting of "Advertis-
ing Data ID" and "Advertising Set ID".

Parameters:
<State>

Example:
Options:

Manual operation:

1|/ON |0 | OFF
*RST: 0
See Example"To configure advertising packets" on page 210.

R&S SMM-K117
See "AdvDatalnfo" on page 69

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:APTR:

STATe <State>

Enables / disables secondary advertising channel.

Parameters:
<State>

Example:
Options:

Manual operation:

1]ON |0 | OFF
*RST: 0

See Example"To configure advertising packets" on page 210.
R&S SMM-K117
See "AuxPtr" on page 69

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:CINFo:

STATe <State>

Activates the CTEInfo field in the extended header of Bluetooth LE advertising packets
in the LE uncoded PHY.

Parameters:
<State>

Example:

Manual operation:
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1] ON |0 | OFF
*RST: 0

See Example"To configure advertising packets" on page 210.

See "CTEInfo" on page 68
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:SINFo:
STATe <State>

Enables / disables the signaling of Syncinfo field for periodic advertisement.

Parameters:
<State> 1] ON |0 | OFF
*RST: 0
Example: See Example"To configure advertising packets" on page 210.
Options: R&S SMM-K117

Manual operation: See "SyncInfo/Syncinfo Configuration" on page 69

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
TADDress:STATe <State>

Enables / disables the signaling of non-significant address part (NAP) and upper
address part (UAP) of a target address.

Parameters:
<State> 1]ON| 0| OFF
*RST: 0
Example: See Example"To configure advertising packets" on page 210.
Options: R&S SMM-K117

Manual operation: See "TargetA" on page 68

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:TPOWer:
STATe <State>

Enables the signaling of required transmit power.

Parameters:
<State> 1]ON|0|OFF
*RST: 0
Example: See Example"To configure advertising packets" on page 210.
Options: R&S SMM-K117

Manual operation: See "TxPow(dBm)" on page 69

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit<ch0>:STATe
<State>

Requires link layer control PDUs LL_ FEATURE_REQ, LL_FEATURE_RSP or
LL_PERIPHERAL_FEATURE_REQ, see [ :SOURce<hw>] :BB:BTOoth:UPTYpe
on page 176.
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Enables features of the feature set within the the link layer control PDU. See also

Table 5-5.
Suffix:
<ch0> 0to 27
Bit number that relates to a feature
Parameters:
<State> 1]ON| 0| OFF
*RST: 0
Example: See Example"To configure data packets" on page 213.
Options: R&S SMM-K117

Manual operation: See "FeatureSet configuration table" on page 90

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:FSLength
<FsLength>

Enables that the feature set length is indicated.

Parameters:
<FsLength> integer
Range: 1to 26
*RST: 8
Example: See Example"To configure data packets" on page 213.

Manual operation: See "FeatureSet Length" on page 83

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:HLENgth
<HLength>

Requires data event and advertising frame configuration with the packet type CON-
NECT_IND.

Sets the difference from the current channel to the next channel.

The Central and Peripherals determine the data channel in use for every connection
event from the channel map. Hop_length is set for the LL connection and communica-
ted in the CONNECT_IND and LL_CHANNEL_MAP_IND packets.

Parameters:
<HLength> integer
Range: 5 to 16
*RST: 5
Example: See Example"To configure data packets" on page 213.

Manual operation: See "Hop Length" on page 79
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:LCTimeout
<LcTimeout>

Defines the maximum time between two correctly received Bluetooth LE packets in the
LL connection before the connection is considered lost for the packet type CON-
NECT_IND.

Command sets the values in ms. Query returns values in s.

Parameters:
<LcTimeout> float
Range: 100E-3 s to 32000E-3 s
Increment: 10E-3 s
*RST: 100E-3 s
Default unit: ms
Example: See Example"To configure data packets" on page 213.

Manual operation: See "LL Connection Timeout" on page 78

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MIVector
<MiVector>, <BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SIVector
<SiVector>, <BitCount>

Sets the portion of Central or the portion of the Peripheral of the initialization vector

(IVm/IVs).

Parameters:

<SiVector> numeric
*RST: #HO

<BitCount> integer
Range: 32 to 32
*RST: 32

Example: SOURcel :BB:BTO:ECON:PCON:MIV
#H0000000000000000, 32
(Central).

SOURcel :BB:BTO:ECON:PCON:STIV
#H0000000000000000, 32
(Peripheral).

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MROCtets
<MROctets>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTOCtets
<MTOctets>

Specifies the maximum allowed payload length of a packet to be received
(..:MROCtets) or transmitted (. . : MTOCtets). Information is signaled via
LL_ LENGTH_REQ and LL_LENGTH_RSP.
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Parameters:
<MTOctets> integer
Range: 27 to 251
*RST: 27
Example: See Example"To configure data packets" on page 213.
Options: R&S SMM-K117

Manual operation: See "MaxRxOctets/MaxTxOctets" on page 85

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MSKD <Mskd>,

<BitCount>
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SSKD <Sskd>,
<BitCount>
Sets the portion of Central or the portion of the Peripheral of the session key diversifier
(SKDm/SKDs).
Parameters:
<Sskd> numeric
*RST: #HO
<BitCount> integer
Range: 64 to 64
*RST: 64
Example: SOURcel :BB:BTO: ECON: PCON: MSKD
#H0000000000000000, 64
(Central).

SOURcel:BB:BTO:ECON:PCON: SSKD
#H0000000000000000, 64
(Peripheral).

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MRTime <MRTime>
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTTime <MTTime>

Specifies the maximum allowed time to receive (. . :MRTime) or transmit (. . :MTTime)
a packet. Information is signaled via LL_LENGTH_REQ and LL_LENGTH_RSP.

Parameters:
<MTTime> float
Range: 0.328E-3 to 17.04E-3
Increment: 0.001E-3
*RST: 17.04E-3
Example: See Example"To configure data packets" on page 213.
Options: R&S SMM-K117

Manual operation: See "MaxRxTime/MaxTxTime" on page 86
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MUCHannels
<Muchannels>

Specifies the minimum number of channels to be used on the specified PHYs, see

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L1M:

STATe etc.
Parameters:
<Muchannels> integer
Range: 2 to 37
*RST: 2
Example: See Example"To configure data packets" on page 213.
Options: R&S SMM-K117

Manual operation: See "Min Used Channels" on page 87

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:L1M:
STATe <MTSP>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:L2M:
STATe <MTSP>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:LCOD:
STATe <MTSP>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:L1M:
STATe <STMP>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:L2M:
STATe <STMP>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:LCOD:
STATe <STMP>

Specifies the physical layers in Central-to-Peripheral (. . :MTSPhy: . .) or Peripheral-
to-Central (. . : STMPhy: . .) direction. Information is signaled via

LL PHY_UPDATE_IND.

You can enable one or more PHYs:

® 11M: for LE uncoded 1 Msymbol/s PHY.

® 1.2M: for LE uncoded 2 Msymbol/s PHY.

e 1.coD: for LE coded 1 Msymbol/s PHY.

Parameters:
<STMP> 1]ON| 0| OFF
*RST: 0
Example: See Example"To configure data packets" on page 213.
Options: R&S SMM-K117

Manual operation: See "M _TO S PHY/S TO M _PHY" on page 86
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NCINterval
<Nclnterval>

Sets the time interval new connection events for the packet types CONNECT_IND and
LL_CONNECTION_UPDATE_IND.

Command sets the values in ms. Query returns values in s.

Parameters:
<Nclnterval> float
Range: 7.5E-3 s to depends on oversampling
Increment: 1.25E-3 s
*RST: 7.5E-3 s
Default unit: ms
Example: See Example"To configure data packets" on page 213.

Manual operation: See "Connection Event Interval" on page 78

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NLCTimeout
<NlIcTimeout>

Defines the maximum time between two correctly received Bluetooth LE packets in the
LL connection before the connection is considered lost only for the packet type
LL_CONNECTION_UPDATE_IND.

Command sets the values in ms. Query returns values in s.

Parameters:
<NIcTimeout> float
Range: 100E-3 s to 32000E-3 s
Increment: 10E-3 s
*RST: 100E-3 s
Default unit: ms
Example: See Example"To configure data packets" on page 213.

Manual operation: See "LL Connection Timeout" on page 78

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NSLatency
<NsLatency>

Requires a data event and advertising frame configuration with the packet type
LL_CONNECTION_UPDATE_IND.

Sets the number of consecutive connection events the Peripheral can ignore for asym-
metric link layer connections.

Parameters:
<NsLatency> integer
Range: 0 to depends on LL connection timeout and con-
nection event interval
*RST: 0
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Example: SOURcel :BB:BTO:UPTY CUR

sets packet type LL_ CONNECTION_UPDATE_IND
SOURcel:BB:BTO:ECON:PCON:NSLatency 10
sets the number of consecutive connection events.

Manual operation: See "Peripheral Latency" on page 78

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NWOFfset
<NwOffset>

Sets the start point of the transmit window for data event and advertising frame config-
uration with the packet type LL_CONNECTION_UPDATE_IND.

Command sets the values in ms. Query returns values in s.

Parameters:
<NwOffset> float
Range: 0 s to depends on connection event interval
Increment: 1.25E-3 s
*RST: 0
Default unit; ms
Example: See Example"To configure data packets" on page 213.

Manual operation: See "Transmit Window Offset" on page 77

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NWSize <NwSize>

Sets the size of the transmit window, regarding to the start point for data event and
advertising frame configuration with the packet type LL__ CONNEC-
TION_UPDATE_IND.

Parameters:

<NwSize> float
Range: 1.25E-3 to depends on connection event interval
Increment: 1.25E-3
*RST: 1.25E-3

Example: See Example"To configure data packets" on page 213.

Manual operation: See "Transmit Window Size" on page 77

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:OADJust <State>

Adjusts the "Sync Packet Offset" automatically to the next value, which is a multiple of
the ""Offset Units".

Parameters:
<State> 1]ON| 0| OFF
*RST: 0
Example: See Example"To configure data packets" on page 213.
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Manual operation: See "Offset Adjust" on page 74

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L1M:STATe
<State>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L2M:STATe
<State>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:LCOD:STATe
<State>

Specifies the physical layers for which the Peripheral has a minimum number of used
channels requirement. Information is signaled via LL_MIN_USED CHANNELS_IND.

You can enable one or more PHYs:

® T11M: for LE uncoded 1 Msymbol/s PHY.
® 1.2M: for LE uncoded 2 Msymbol/s PHY.
® 1coD: for LE coded 1 Msymbol/s PHY.

Parameters:
<State> 1]ON| 0| OFF
*RST: 0
Example: See Example"To configure data packets" on page 213.
Options: R&S SMM-K117

Manual operation: See "PHYs" on page 87

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TATYpe <TaType>
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RATYpe <RaType>

Selects the address type of the controller device.

Depending on the Bluetooth controller role either Tx or Rx or both address types are
assigned. Subdivided into private and random, a Bluetooth LE device address consits
of 48 bits. The format of the device address differs depending on the selected address

type.

Parameters:
<RaType> PUBLic | RANDom

PUBIic
Allocates a unique 48 bit address to each Bluetooth LE device.
The public address is given from the registration authority IEEE.

RANDom
Allocates a 48-bit address to each Bluetooth LE device. A ran-
dom address is optional.

*RST: PUBLic

Example: SOURcel:BB:BTO:ECON:PCON:TATY PUBL
SOURcel :BB:BTO:ECON: PCON:RATY RAND

User Manual 1179.2054.02 — 07 241



R&S®SMM-K60/-K117/-K178 Remote control commands

Packet configuration commands - LE

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ROPCode
<ROpcode>, <BitCount>

Specifies the Opcode of rejected LL control PDU. information is signaled via
LL_REJECT_EXT_IND.

Parameters:
<ROpcode> numeric
*RST: #H00
<BitCount> integer
Range: 8 to 8
*RST: 8
Example: See Example"To configure data packets" on page 213.
Options: R&S SMM-K117

Manual operation: See "Reject Opcode" on page 85

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:L1M:STATe
<RPhys>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:L2M:STATe
<RPhys>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:LCOD:
STATe <RPhys>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:L1M:STATe
<TPhys>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:L2M:STATe
<TPhys>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:LCOD:
STATe <TPhys>

Specifies preferred physical layers in Rx (. . :RPHYs:..)or Tx(..:TPHYs:..)direc-
tion. Information is signaled via LL_PHY_ REQ and LL_PHY_RSP.

You can enable one or more PHYs: : .1M: for LE uncoded 1 Msymbol/s PHY, : 1.2M:
for LE uncoded 2 Msymbol/s PHY, and : LcoD: for LE coded 1 Msymbol/s PHY.

Parameters:
<TPhys> 1|ON |0 | OFF
*RST: 0
Example: See Example"To configure data packets" on page 213.
Options: R&S SMM-K117

Manual operation: See "TX PHYS/RX PHYS" on page 86

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RVECtor
<RVector>, <BitCount>

Sets the random vector of the Central for device identification.
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The parameter is an initialization vector provided by the Host in the
HCI_ULP_Start_Encryption command.

Parameters:
<RVector> numeric
*RST: #HO
<BitCount> integer
Range: 64 to 64
*RST: 64
Example: SOURcel :BB:BTO:ECON:PCON:RVEC

#H0000000000000000, 64
Sets the random vector of the Central.

Manual operation: See "Random Vector(hex)" on page 82

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCACcuracy
<ScAccuracy>

Defines the clock accuracy of the Central with specified encoding.

This parameter is used by the Peripheral to determine required listening windows in
the LL connection. It is a controller design parameter known by the bluetooth controller.

Parameters:

<ScAccuracy> SCAO | SCA1 | SCA2 | SCA3 | SCA4 | SCA5 | SCAG6 | SCAT7
*RST: SCAO0

Example: SOURcel:BB:BTO:ECON:PCON:SCAC SCAl

Sets the encoding value.

Manual operation: See "Sleep Clock Accuracy" on page 79

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SLATency
<SlLatency>

Requires data event and advertising frame configuration with the packet type CON-
NECT _IND.

Sets the number of consecutive connection events the Peripheral can ignore for asym-
metric link layer connections.

Parameters:
<SlLatency> integer
Range: 0 to depends on LL connection timeout and con-
nection event interval
*RST: depends on LL connection timeout and connection

event interval
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Example: SOURcel :BB:BTO:UPTY CREQ

Sets packet type CONNECT _IND.
SOURcel:BB:BTO:ECON:PCON:SLAT 10

Sets the number of consecutive connection events.

Manual operation: See "Peripheral Latency" on page 78

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SOUNits <Unit>
Indicates the units used by the "Sync Packet Offset" parameter, see

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:SPOFfset

Parameters:
<Unit> U30 | U300
u3o0
30 us
U300
300 ps
*RST: u30
Example: See Example"To configure advertising packets" on page 210.
Options: R&S SMM-K117

Manual operation: See "Offset Units" on page 74

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SPOFfset
<SPOffset>

Specifies the time from the start of the AUX_ADV_IND packet containing the Syncinfo
field to the start of the AUX_SYNC _IND packet. The offset is determined by multiplying
the value by the unit, see

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:PCONfiguration:SOUNits

Parameters:
<SPOffset> float

Range: 0 to 245.7 or 246 to 2457 depending on offset unit
Example: See Example"To configure advertising packets" on page 210.
Options: R&S SMM-K117

Manual operation: See "Sync Packet Offset" on page 73

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SVNumber
<SvNumber>, <BitCount>

Sets a unique value for each implementation or revision of an implementation of the
Bluetooth Controller. A 16-bit value is set.

Note: This parameter is relevant for data frame configuration and for the packet type:
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LL_VERSION_IND.

Parameters:
<SvNumber> numeric
*RST: 0
<BitCount> integer
Range: 16 to 16
*RST: 16
Example: SOURcel :BB:BTO:ECON:PCON:SVN #H0000,16

Sets the sub version number.

Manual operation: See "SubVersion Number(hex)" on page 84

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPOWer <TPower>

Sets the required transmit power to be signaled within an extended header.

Parameters:
<TPower> integer
Range: -127 to 126
*RST: 0
Example: See Example"To configure advertising packets" on page 210.
Options: R&S SMM-K117

Manual operation: See "TxPow(dBm)" on page 69

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:UTYPe <UType>,
<BitCount>

Enables that an invalid control packet is indicated.

The CtrType field indicates the value of the LL control packet that caused the transmis-
sion of this packet.

Parameters:
<UType> numeric
*RST: #HO
<BitCount> integer
Range: 8 to 8
*RST: 8
Example: SOURcel :BB:BTO:ECON:PCON:UTYP #HO00,8

Enables that an invalid control packet is indicated.

Manual operation: See "Unknown Type(hex)" on page 83
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:VNUMber
<VNumber>, <BitCount>

Sets the company identifier of the manufacturer of the Bluetooth controller. An 8-bit
value is set.

Note: This parameter is relevant for data frame configuration and for the packet type
LL VERSION_IND.

Parameters:
<VNumber> numeric
*RST: 0
<BitCount> integer
Range: 8 to 8
*RST: 8
Example: SOURcel :BB:BTO:ECON:PCON:VNUM #HO0O, 8

Sets the version number.

Manual operation: See "Version Number(hex)" on page 83

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:WOFFset
<WOffset>

Sets the start point of the window transmit for data event and advertising frame config-
uration with the packet type CONNECT _IND.

Command sets the values in ms. Query returns values in s.

Parameters:
<WOffset> float
Range: 0 s to depending on connection event interval
Increment: 1.25E-3 s
*RST: Os
Default unit: ms
Example: See Example"Configure event and frame configuration settings"

on page 179.

Manual operation: See "Transmit Window Offset" on page 54
See "Transmit Window Offset" on page 77

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:WSIZe <WSize>

Sets the size of the transmit window, regarding to the start point for data event and
advertising frame configuration with the packet type CONNECT _IND.

Parameters:

<WSize> float
Range: 1.25E-3 to depends on connection event interval
Increment: 1.25E-3
*RST: 1.25E-3

User Manual 1179.2054.02 — 07 246



R&S®SMM-K60/-K117/-K178 Remote control commands

Packet configuration commands - LE

Example: See Example"To configure data packets" on page 213.

Manual operation: See "Transmit Window Size" on page 77

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ATYPe <AType>
Sets the address type in the payload of Bluetooth LE LL_PERIODIC_SYNC_IND pack-

ets.
Parameters:
<AType> PUBLic | RANDom
*RST: PUBLic
Example: See Example"To configure data packets" on page 213.

Manual operation: See "Address Type" on page 88

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CECount
<CECount>

Specifies the connection event count in the CtrData field of the LL_PERI-
ODIC_SYNC_IND control data PDU.

Parameters:
<CECount> integer
Range: 0 to 65535
*RST: 0
Example: See Example"To configure data packets" on page 213.

Manual operation: See "Connection Event Count" on page 87

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ID <Id>, <BitCount>
Specifies the ID in the CtrData field of the LL_PERIODIC_SYNC_IND PDU.

Parameters:
<ld> numeric
*RST: #HAAAA
<BitCount> integer
Range: 16 to 16
*RST: 16
Example: See Example"To configure data packets" on page 213.

Manual operation: See "ID(hex)" on page 87
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:LPECounter
<LPECounter>

Specifies the lastPaEventCounter field in the CtrData field of the LL_PERI-
ODIC_SYNC_IND PDU.

Parameters:
<LPECounter> integer
Range: 0 to 65535
*RST: 0
Example: See Example"To configure data packets" on page 213.

Manual operation: See "Last Pa Event Counter" on page 88

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MCLReq
<MCLReg>

Specifies the minimum CTE length in the CtrData field of the LL_CTE_Req PDU.

Parameters:
<MCLReg> float
Range: 16E-6 to 160E-6
Increment: 8E-6
*RST: 16E-6
Example: See Example"To configure data packets" on page 213.

Manual operation: See "MinCTELenReq" on page 89
See "CTETypeReq" on page 89

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L1M:STATe
<State>

Sets the LE 1M PHY in the CtrData field of the LL_PERIODIC_SYNC_IND PDU.

Parameters:
<State> 1]ON| 0| OFF
*RST: 0
Example: See Example"To configure data packets" on page 213.

Manual operation: See "PHY" on page 88

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L2M:STATe
<State>

Sets the LE 2M PHY in the CtrData field of the LL_PERIODIC_SYNC_IND PDU.

Parameters:
<State> 1]ON| 0| OFF

*RST: 0

User Manual 1179.2054.02 — 07 248



R&S®SMM-K60/-K117/-K178 Remote control commands

Packet configuration commands - LE

Example: See Example"To configure data packets" on page 213.

Manual operation: See "PHY" on page 88

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:LCOD:STATe
<State>

Sets the LE Coded PHY in the CtrData field of the LL_PERIODIC_SYNC_IND PDU.

Parameters:
<State> 1]ON| 0| OFF
*RST: 0
Example: See Example"To configure data packets" on page 213.

Manual operation: See "PHY" on page 88

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCECounter

<SCECounter>
Parameters:
<SCECounter> integer
Range: 0 to 65535
*RST: 0
Example: See Example"To configure data packets" on page 213.

Manual operation: See "Sync Connection Event Counter" on page 89

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SID <Sid>,
<BitCount>

Specifies the SID in the CtrData field of the LL_PERIODIC_SYNC _IND.

Parameters:
<Sid> numeric
*RST: #HO
<BitCount> integer
Range: 4 to 4
*RST: 4
Example: See Example"To configure data packets" on page 213.

Manual operation: See "SID(hex)" on page 88
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Cs payload configuration

Example: To configure CS control PDUs

// EE o
// Configure settings of an LE uncoded PHY test packet.

// R IR E E dE S I S I I b b E h b h b h b b b h b b b bk b b b b b h h h b b b I E h b b b b b b b b b b b b E h b b b b b b b b b b b b b b b i
// Set for a data channel test packet in the LE uncoded PHY.
:SOURcel:BB:BTOoth:CTYPe CS

:SOURcel:BB:BTOoth:UPTYpe CCRQ

// Sets for an LL_CS_CAPABILITIES REQ control PDU.

:SOURcel :BB:BTOoth:PFORmat L2M

VAR EEEEEE R LA AR EEEE AR AR R R

// Configure and check LL CS CONFIG REQ PDU settings.

// R IR E E kb S E I b b b h b b b b b h b b b b b bk b b b b b h b b b b b b E h b b b b b b b b b b b b E b b b b b b b b b b b b b b b b
:SOURcel:BB:BTOoth:CS:CDATa:CID 1

// The Config ID is one.

:SOURcel:BB:BTOoth:CS:CMRepetition 1

// Sets one cycle of the ChM field for non-Mode-0 steps within the CS procedure.
:SOURcel:BB:BTOoth:CS:CDATa:MMODe MODE1

// The main mode is Mode-1.

:SOURcel:BB:BTOoth:CS:CDATa:MMRepetition O

// The main mode repetition bit is zero.

:SOURcel:BB:BTOoth:CS:CDATa:MMISteps 2

// The minimum number of main mode steps is two.
:SOURcel:BB:BTOoth:CS:CDATa:MMASteps 2

// The maximum number of main mode steps is two.

// Enable the companion signal.

:SOURcel:BB:BTOoth:CS:CDATa:MZSTeps 1

// There is one Mode-0 step.

:SOURcel:BB:BTOoth:CS:CDATA:CSIGnal 1

:SOURcel :BB:BTOoth:CS:CDATA:RFU 0

// KKK KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR AR AR KA KA KKK

// Configure and check LL _CS CAPABILITIES REQ PDU settings.
] R Rk ko K Kk ok ok K K KKk ok K K Kk ok o K KKKk ok o K KKk ok ok K K Kk ok ok ok K Kk ok ok ok o K Kk ok ok ok K K Kk ok ok o K K Kk ok ok K
:SOURcel:BB:BTOoth:CS:CDATA:CSPCapability?

// Response: "LE2M"

// The PHY is LE 2M.

:SOURcel:BB:BTOoth:CS:CDATa:MAPath 1
:SOURcel:BB:BTOoth:CS:CDATa:MPSupported 1
:SOURcel:BB:BTOoth:CS:CDATa:MTYPe?

// Response: "MODE3"

// The mode type is Mode-3.
:SOURcel:BB:BTOoth:CS:CDATa:NANT?

// Response: "1"

// The number of antenna elements is 1.
:SOURcel:BB:BTOoth:CS:CDATa:NCONfig?

// Response: "1"
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// There is one unique Cs configuration. You can have up to four independent
// Cs configurations.

:SOURcel:BB:BTOoth:CS:CDATa:NFAE 1

// The transmitting LE device only supports an FAE of zero.
:SOURcel:BB:BTOoth:CS:CDATa:SPEStimate?

// Response: "QO"

// The device does not support PCT estimates from a sounding sequence.
:S0URcel:BB:BTOoth:CS:CDATa:TSW TSW_1

// The duration of the antenna switch period is one microsecond.

// Configure timing capabilities.
:SOURcel:BB:BTOoth:CS:CDATa:BPOSition0:TIPO:CAPabitility 1

// Enables the T IPl capability for bit position 0. The T IP1 time is 10 microseconds.
:SOURcel:BB:BTOoth:CS:CDATa:BPOSitionl :TIPO:CAPabitility?

// Response: "QO"

// The T IP1l capability for bit position 1 is disabled.
:SOURcel:BB:BTOoth:CS:CDATa:BPOSition0:TIPT:CAPabitility 1

// Enables the T IP2 capability for bit position 0. The T IP2 time is 10 microseconds.
:SOURcel:BB:BTOoth:CS:CDATa:BPOSitionl :TIPT:CAPabitility?

// Response: "QO"

// The T IP2 capability for bit position 1 is disabled.
:SOURcel:BB:BTOoth:CS:CDATa:BPOSition0:TFCAPabitility 1

// Enables the T FCS capability for bit position 0. The T FCS time is 15 microseconds.
:SOURcel:BB:BTOoth:CS:CDATa:BPOSitionl:TFCAPabitility?

// Response: "0"

// The T _FCS capability for bit position 1 is disabled.
:SOURcel:BB:BTOoth:CS:CDATa:BPOSition0:TPCAPabitility 1

// Enables the T PM capability for bit position 0. The T PM time is 10 microseconds.
:SOURcel :BB:BTOoth:CS:CDATa:BPOSitionl :TPCAPabitility?

// Response: "QO"

// The T PM capability for bit position 1 is disabled.

// R Ik Sk kb kb b b b bk b b b b b b bk bk bk b b b b b b b b b bk bk bk b b b bk b kb b b kb b b bk kb i

// Configure and check LL_CS_TERMINATE IND PDU settings.

VAR AR EEEEE R AR EEEE AR AR R R

:SOURcel :BB:BTOoth:CS:CDATa:ECODe #HFF, 8

// Sets the error code "FF" in hexadecimal representation.

// R IR dE I S I I E b E h b b E h h b b b b h bk b b b b b h h dh b b b E E h b b b b b b b b b b b b b b b b b b b b b b b b b b b b b i

// Configure and check LL CS_IND PDU settings.

// KKK KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR A AN AR KA KA KKK

:SOURcel:BB:BTOoth:CS:CDATa:EOFFset 500

// Sets an event offset of 500 microseconds.

VAR EEEEEE R LA AR EEEE AR AR R e R R

// Configure and check LL CS REQ PDU settings.

// R IR E I b I S b E E h b IE E S b E E b b b h b dh b b b b b b b E h b b b b E E h b b b b h b b b b b h b b b b b b b b b b b b b b b b i

:SOURcel:BB:BTOoth:CS:CDATa:MPLength 2.5

// The maximum procedure length is 2.5 milliseconds.
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Commands:

[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:BPOSition<ch0>]: TFCapability........c.cceeeerreeennnens 253
[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:BPOSition<ch0>]:TIPO:CAPability..................cc.... 253
[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:BPOSition<ch0>]:TIPT:CAPability............ccvuueeeeeens 253
[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:BPOSition<ch0>]:TPCapability..............cceerreerenn.. 254
[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:CHANNel<chO>]:CFAE......cc.ccii i 254
[:SOURce<hw>]:BB:BTOOth:CS:CDATA:ACH ...ttt e e e 254
[:SOURce<hw>]:BB:BTO0th:CS:CDATA:CECOUNL......uiiiiiieiii e e et e e e 255
[:SOURce<hw>]:BB:BTOO0th:CS:CDATA:CCID:STATE ceutueeeieeieiie e eereeta e e e eeeeie e e eeen s 255
[:SOURce<hw>]:BB:BTOOth:CS:CDATA:CID.....uuururuuuiieieieieeeeeeeeeeeeeeeeeeeeeeeeeeresssrasnnannnnnnns 255
[:SOURce<hw>]:BB:BTOOth:CS:CDATA:CSATNICEC. ... eeeieerieeeeeeeeiieeeeeeeeeiieeeeeeeenteeeeeeens 255
[:SOURce<hw>]:BB:BTOOth:CS:CDATA:CSIGNAL.....cceeiieeriieeeeeeeitieeeeeeeetee e e eeeeree e e e eeenans 256
[:SOURce<hw>]:BB:BTOOth:CS:CDATA:ECODE......cciiiiieeieee et e e 256
[:SOURce<hw>]:BB:BTO0th:CS:CDATa:EOFFSEt.....cceieiiie e 256
[:SOURce<hw>]:BB:BTO0th:CS:CDATA:MAPALN. ... 256
[:SOURce<hw>]:BB:BTOOth:CS:CDATA:MMASEEPS. ...ueiieieeiiieeeeeeiiie e e e ettt e e eeeei e eees 257
[:SOURce<hw>]:BB:BTOOth:CS:CDATA:MMISEEPS.....ccceieriieeeeeeiiiieeeeeeeiiieeeeeeeenieeeeeeeeenes 257
[:SOURce<hw>]:BB:BTOOth:CS:CDATA:MMODE.......ccvvueieeeiiiriiieeeeeeeerieeeeeeernteeeeeseeranaanns 257
[:SOURce<hw>]:BB:BTO0th:CS:CDATa:MMREPELItION. ....vuuieeieiiiieeeeeeeeeieeeeeeeeeeree e e eeeeann 257
[:SOURce<hw>]:BB:BTOo0th:CS:CDATa:MPLENGth. .....coeiiiieee e 258
[:SOURce<hw>]:BB:BTO0th:CS:CDATA:MPSUPPOMET. ......eeeeeereeereeeereseeseseeseseeseseeseseeseneen 258
[:SOURce<hw>]:BB:BTOOth:CS:CDATAIMTYPE?.....iiiieieeeeeeeeeeeeeee e e 258
[:SOURce<hw>]:BB:BTOO0th:CS:CDATAIMZSTEPS.....cceeeeeieeeeeereeeerrerererisinsaaeaeseseeeeaaaaees 258
[:SOURCce<hw>]:BB:BTOOth:CS:CDATA:NANT .....ccittiieieeeieetiee e e e eeentee e e e e eeraee e e e e eenraneeeaees 259
[:SOURce<hw>]:BB:BTO0th:CS:CDATa:NCONIFIG....ccceeeieeeeeieieieeeeeeeeeee e e 259
[:SOURce<hw>]:BB:BTOOth:CS:CDATa:NFAE......c. i 259
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:NRSCapability........cccuuieeiiiiiiiieiieee e, 260
[:SOURce<hw>]:BB:BTOo0th:CS:CDATa:NSCapability........c.cveuiieeiiiieiieiiieee e 260
[:SOURce<hw>]:BB:BTO0Oth:CS:CDATA:OMAX......uuuuruuuuaaaaaiaeeeeeeeeeeaaeaeeereeeeeeeenaenennnnnnnnns 260
[:SOURce<hw>]:BB:BTO0th:CS:CDATA:OMIN......cevrrrrrririiiiiiieieieeeeeeeeeeeeeeeeeeeeeeesesseranannne 260
[:SOURce<hw>]:BB:BTOOth:CS:CDATA:PCOUNL......uuieieeiiiiiieeeeeeetieeeeeeeeeteeeeeeeennaeeeeeeees 261
[:SOURce<hw>]:BB:BTOOth:CS:CDATA:PDELLA....ccuuueiieeiiiiiieeeeeeeeiee e eeeeettceeeeeeeerie e eeeeees 261
[:SOURce<hw>]:BB:BTOOth:CS:CDATa:PHY ... 261
[:SOURce<hw>]:BB:BTO0th:CS:CDATa:PINTEIrVALl......ccuiieieee e 262
[:SOURce<hw>]:BB:BTOo0th:CS:CDATa:PPANIENNA. .....ccuiiiiieieeeeeei e 262
[:SOURce<hw>]:BB:BTO0th:CS:CDATa:RAONIY......cccereieeeeeieieiiiiniiieessaeeeee e e e e eeaaaeaaeeeees 262
[:SOURce<hw>]:BB:BTO0th:CS:CDATa:RCAPaDIlity.........ceeeeiiiriieieeeeeeiice e ee e, 262
[:SOURCce<hw>]:BB:BTOOth:CS:CDATA:RFU......uceiiiiiiiiiiieeeeeeecee et 263
[:SOURCce<hw>]:BB:BTOOth:CS:CDATA:RTYPE.....ccceeeiriieieeeietrieeeeeeeeree e eeeeeearae e e e e eeerannns 263
[:SOURce<hw>]:BB:BTOOth:CS:CDATA:TFCS.. ..ttt eaes 263
[:SOURce<hw>]:BB:BTOO0th:CS:CDATA:TIONE......ceuieiiieiee et 264
[:SOURce<hw>]:BB:BTOOth:CS:CDATA: TITWO....ceeeeeeeeeeeeeeeeeeeeeeeeeeeeeere e e e e 264
[:SOURce<hw>]:BB:BTOOth:CS:CDATA: TPM...ccuuiiiuueuunuaaaaaeieeeeeeeeeaeeeeeeeeeeeeeeeeenennnnnnnnnnnnns 264
[:SOURCce<hw>]:BB:BTOOth:CS:CDATA:TSW....ciittiiieeeeeeriieeeeeeeeteeeeeeeetnteeeeesestaneeeeeeenes 264
[:SOURce<hw>]:BB:BTOO0th:CS:CDATA:RRSEQUENCE. .....uuuieeeeerriiieeeeeeeeieeeeeeeetnreeeeeeeeranns 265
[:SOURce<hw>]:BB:BTO0th:CS:CDATa:RSOUNING.....cevrrrrrrrrinriiiiaiaieeeeeeeeeeeeereeeeeeeeeeeeens 265
[:SOURce<hw>]:BB:BTO0th:CS:CDATa:SINTErVal....c.ccuiiiieee e 265
[:SOURce<hw>]:BB:BTOo0th:CS:CDATa:SLENGth......conie e 266
[:SOURce<hw>]:BB:BTO0th:CS:CDATa:SNUMDET.......uucaaeieieeeeeeeeeaeeeeeeieeeeeeeeeaeeeeeennnennaanas 266
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[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SPEStiMate.......coeuiiiiieieiiee e 266
[:SOURce<hw>]:BB:BTOO0th:CS:CDATA:SMODAE........uiiiuieeiei ettt 267
[:SOURce<hw>]:BB:BTOo0th:CS:CDATa:CSPCapability?.........cceerrrrermrmrniiaaaaaaeae e e e eeeeeeenn 267

[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:BPOSition<ch0>]: TFCapability
<TfcsCapability>

Enables the T_FCS capability including the T_FCS time per bit position.

Suffix:
BPOSition<ch0> 0to9
Bit position (optional suffix)

Parameters:
<TfcsCapability> 1]ON| 0| OFF
*RST: 0
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "T_FCS_Capability Table" on page 118

[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:BPOSition<ch0>]:TIPO:CAPability
<TIOCapability>

Enables the T_IP1 capability including the T_IP1 time per bit position.

See also [ : SOURce<hw>] :BB:BTOoth:CS[:SEVent<ch0>] :MZERo: TIPO
on page 197.

Suffix:
BPOSition<ch0> Oto7
Bit position (optional suffix)

Parameters:
<TIOCapability> 1]ON| 0| OFF
*RST: 0
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "T_|P1_Capability Table" on page 117

[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:BPOSition<ch0>]: TIPT:CAPability
<TITCapability>

Enables the T_IP2 capability including the T_IP2 time per bit position.

Suffix:
BPOSition<ch0> Oto7
Bit position (optional suffix)

Parameters:
<TITCapability> 1|ON |0 | OFF

*RST: 0
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Example: See Example"To configure CS control PDUs" on page 250.
Manual operation: See "T_IP2_Capability Table" on page 118

[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:BPOSition<ch0>]:TPCapability
<TpmCapability>

Enables the T_PM capability including the T_PM time per bit position.

Suffix:
BPOSition<ch0> Oto2
Bit position (optional suffix)

Parameters:
<TpmCapability> 1|ON |0 | OFF
*RST: 0
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "T_PM_Capability Table" on page 119

[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:CHANnel<ch0>]:CFAE <ChFae>

Sets the value of the fractional frequency offset actuation error (FAE) value per chan-

nel.
Suffix:
CHANnRel<chO> 0to 71
Channel number (optional suffix)
Parameters:
<ChFae> integer
Range: -128 to 127
*RST: 0
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Channel FAE Table" on page 129

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:ACI <ACI>

Sets the antenna configuration index (ACI) field. The value has a length of 1 octet or 0
to 7 in decimal representation.

Parameters:

<ACI> ACIO | ACI1 | ACI2 | ACI3 | ACI4 | ACI5 | ACI6 | ACI7
*RST: ACIO

Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "ACI" on page 125
See "ACI" on page 127
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[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CECount <ConnEventCount>
Sets the 16-bit connEventCount field bits in hexadecimal representation.

Parameters:
<ConnEventCount> integer

Range: 0 to 65535
*RST: 0

Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "connEventCount" on page 123
See "connEventCount" on page 127

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CCID:STATe <State>
Enables the CS configuration ID. Set this ID with the following command:

[ :SOURce<hw>] :BB:BTOoth:CS:CDATa:CID on page 255

Parameters:
<State> 1]ON|0|OFF
*RST: 0
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "State" on page 119

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CID <Configld>

Sets the 6-bit Config_ID field that is the CS configuration ID. Settable ID values are 2
bits in decimal representation. All other values are for future use.

Parameters:
<Configld> integer
Range: 0to3
*RST: 1
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Config ID" on page 119

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CSAThreec <CsaThreec>

Enables the channel selection algorithm #3c.

Parameters:
<CsaThreec> 1|ON |0 | OFF
*RST: 0
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Channel Selection Algorithm #3c" on page 116
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[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CSIGnal <CompanionSignal>
Enables the companion signal.

See also "Companion Signal" on page 110.

Parameters:
<CompanionSignal> 1| ON |0 | OFF
*RST: 0
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Companion_Signal" on page 116

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:ECODe <ECode>, <BitCount>

Sets an 8-bit error code. For an LL_CS_TERMINATE_IND packet, informs the remote
device about the termination of the connection.

Parameters:
<ECode> numeric
*RST: #HO00
<BitCount> integer
Range: 8 to 8
*RST: 8
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Error Code(hex)" on page 128

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:EOFFset <EventOffset>

Sets the time value of the Offset field. The value has a length of three octets or 9 bits.

Parameters:
<EventOffset> integer
Range: 500 to 4e6
*RST: 500
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Offset" on page 127

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MAPath <MaxAntPath>

Sets the maximum Num_Ant paths.

Parameters:
<MaxAntPath> integer
Range: 1t 4
*RST: 1
Example: See Example"To configure CS control PDUs" on page 250.
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Manual operation: See "Max_Ant Path" on page 115

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MMASteps <MMMaxSteps>

Sets the maximum number of main mode steps.

Parameters:
<MMMaxSteps> integer
Range: 2 to 255
*RST: 2
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Main_Mode Max_Steps" on page 120

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MMISteps <MMMinSteps>

Sets the minimum number of main mode steps.

Parameters:
<MMMinSteps> integer
Range: 2 to 255
*RST: 2
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Main_Mode_Min_Steps" on page 120

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MMODe <MainMode>
Sets the main mode of the CS LL Control PDU.

For an overview on available submodes per main mode, see Table 5-8.

Parameters:

<MainMode> MODE1 | MODEZ2 | MODE3
For a description, see [ : SOURce<hw>] :BB:BTOoth:CS[:
SEVent<ch0>] :MMODe on page 195.
*RST: MODE1

Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Main_Mode" on page 120

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MMRepetition <MMRepetition>

Sets the main mode repetition.

Parameters:

<MMRepetition> integer
Range: 0to3
*RST: 0
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Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Main_Mode_Repetition" on page 120

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MPLength <MPLength>

Sets the time value of the Max_Procedure_Len field. The value has a length of two
octets or 6 bits.

Parameters:
<MPLength> float
Range: 2.5 to 40959375
Increment: 0.001
*RST: 25
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Max_ Procedure Len" on page 124

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MPSupported <MPSupported>
Sets the bits of the Max_Procedures_Supported field.

Parameters:
<MPSupported> integer
Range: 0to 4
*RST: 1
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Max_Procedures_Supported” on page 117

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MTYPe?
Queries the CS LL control packet mode type that is Mode-3.

Return values:

<ModeType> MODE3

*RST: MODE3
Example: See Example"To configure CS control PDUs" on page 250.
Usage: Query only

Manual operation: See "Mode_Types" on page 114

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MZSTeps <Mode0Steps>

Sets the number of Mode-0 steps.
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Parameters:
<ModeOSteps> integer
Range: 1to3
*RST: 1
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Mode 0 Steps" on page 120

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:NANT <NumAnt>

Sets the bits of the Num_Ant field. This field indicates the number of antenna elements
of the channel sounding device.

Parameters:
<NumAnt> integer
Range: 1to 4
*RST: 1
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Num_Ant" on page 115

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:NCONfig <NumConfig>

Sets the Num_Configs field that relates to the number of independent CS configura-

tions.
Parameters:
<NumConfig> integer
Range: 1to4
*RST: 1
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Num_Configs" on page 117

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:NFAE <NoFae>

Sets the No_FAE bit. This bit indicates if the transmitting LE device supports a frac-
tional frequency offset actuation error (FAE) or not.

Parameters:
<NoFae> 1]ON| 0| OFF

1|ON
The transmitting LE device only supports an FAE of zero.

0|OFF
The transmitting LE device supports FAE values as listed in an
FAE table.

*RST: 0
Example: See Example"To configure CS control PDUs" on page 250.
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Manual operation: See "No_FAE" on page 116

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:NRSCapability <NRSCapability>
Sets the NADM random sequence capability.

Parameters:
<NRSCapability> NONADM | NADM

NONADM
NADM disabled

NADM
NADM enabled

*RST: NONADM
Example: See Example"To configure CS control PDUs" on page 250.
Manual operation: See "NADM_Random_Sequence Capability" on page 115

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:NSCapability <NSCapability>
Sets the NADM sounding sequence capability.

Parameters:
<NSCapability> NONADM | NADM

NONADM
NADM disabled

NADM
NADM enabled

*RST: NONADM
Example: See Example"To configure CS control PDUs" on page 250.
Manual operation: See "NADM_Sounding_Capability" on page 115

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:OMAX <OffsetMax>

Sets the time value of the Offset_Max field. The value has a length of 3 octets or 9 bits.

Parameters:
<OffsetMax> integer
Range: 500 to 16777215
*RST: 500
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Offset_Max" on page 124

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:OMIN <OffsetMin>

Sets the time value of the Offset_Min field. The value has a length of 3 octets or 9 bits.
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Parameters:
<OffsetMin> integer
Range: 500 to 4e6
*RST: 500
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Offset Min" on page 123

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:PCOunt <ProcCount>

Sets the bits in the Procedure_Count field. The value has a length of 2 octets.

Parameters:
<ProcCount> integer
Range: 1 to 65535
*RST: 1
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Procedure_Count" on page 125

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:PDELta <PwrDelta>

Sets the bits in the Pwr_Delta field. The value has a length of 1 octets or 3 bits.

Parameters:
<PwrDelta> integer
Range: 0 to 255
*RST: 0
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Pwr_Delta" on page 126
See "Pwr_Delta" on page 128

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:PHY?
Queries the PHY field value.

This value indicates the TX PHY of the remote device to which the Pwr_Delta field in
this PDU applies.

Return values:

<Phy> L1M | L2M | LCOD | L2M2B
For a description, see [ : SOURce<hw>] :BB:BTOoth: PFORmat
on page 175.
*RST: L1M
Example: See Example"To configure CS control PDUs" on page 250.
Usage: Query only
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Manual operation: See "PHY" on page 120
See "PHY" on page 125

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:PINTerval <Procinterval>

Sets the procedure interval in the Procedure_Interval field. The value has a length of
two octets or 6 bits.

Parameters:
<Proclinterval> integer
Range: 0 to 65535
*RST: 0
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Procedure_Interval" on page 125

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:PPANtenna <PPAntenna>

Sets the bits in the Preferred_Peer_Ant field. The value has a length of one octet or 3
bits.

The table Table 5-11 lists all possible values and their meaning.

Parameters:
<PPAntenna> ANTO | ANT1 | ANT2 | ANT3
*RST: ANTO
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Preferred_Peer_Ant" on page 125

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RAONIly <RttAaOnly>

Queries or sets the time values of the RTT_AA_Only_N field.

Setting the value depends on the bits of the RTT_Capability field via the command:
:SOURcel :BB:BTOoth:CS:CDATa:RCAPability

See also the table Table 5-9 for an overview.

Parameters:
<RttAaOnly> AR150 | AR10 | ARO
*RST: AR150
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "RTT_AA_ Only" on page 114

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RCAPability <RttCapability>
Sets the bits in the RTT_Capability field.
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These bits determine the time values for the RTT_AA_Only_N field, the RTT_Sound-
ing_ N field and the RTT_Random_Sequence_N field.

Parameters:
<RttCapability> CAPO | CAP1 | CAP2
See the table Table 5-9 for an overview.
*RST: CAPO
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "RTT_Capability" on page 114

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RFU <RFU>
Sets the bits that are reserved for future use (RFU).

The number of RFU bits can vary depending on the CS_Control_Data PDU.

Parameters:
<RFU> integer
Range: 0to3
*RST: 0
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "RFU" on page 117

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RTYPe <RttType>

Sets the RTT type determined by the 4-bit RTT_Type field. This field indicates the
round trip time (RTT) variant within the CS procedure.

Parameters:

RttType RAAOT | R32SS | R96SS | R32RS | R64RS | R96RS | R128RS
For a description, see the table Table 5-10.
*RST: RAAOT

Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "RTT_Type" on page 121

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:TFCS <TFcs>

Sets the frequency change period (T_FCS) between consecutive CS steps. The period
ranges from 15 ps to 150 ps.

Parameters:

<TFcs> TFCS_15| TFCS_20 | TFCS_30 | TFCS_40| TFCS_50 |
TFCS_60| TFCS_80 | TFCS_100 | TFCS_120 | TFCS_150
TFCS_x, x represents values in microseconds.
*RST: TFCS_150

Example: See Example"To configure CS control PDUs" on page 250.
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Manual operation: See "T_FCS" on page 122

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:TIONe <TipOne>

Sets the time "T_IP1" in microseconds.

Parameters:

<TipOne> TIP1_10 | TIP1_20 | TIP1_30 | TIP1_40 | TIP1_50| TIP1_60 |
TIP1_80 | TIP1_145
TP1_x, x represents values in microseconds.
*RST: TIP1_145

Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "T_IP1" on page 122

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:TITWo <TipTwo>

Sets the time "T_IP2" in microseconds.

Parameters:

<TipTwo> TIP2_10 | TIP2_20 | TIP2_30 | TIP2_40 | TIP2_50 | TIP2_60 |
TIP2_80 | TIP2_145
TIP2_x, x represents values in microseconds.
*RST: TIP2_145

Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "T_IP2" on page 122

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:TPM <TPM>

Sets the time "T_PM" in microseconds.

Parameters:
<TPM> TPM_10 | TPM_20 | TPM_40 | TPM_652
TPM_x, x represents values in microseconds.
*RST: TPM_40
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "T_PM" on page 122

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:TSW <Tsw>
Sets the T_SW field values that relate to the duration of the antenna switch period.

The local controller uses this period when switching antennas during active transmis-
sions.
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Parameters:

<Tsw> TSW 0| TSW_1|TSW_2 | TSW_4 | TSW_10
Duration of the antenna switch period is 0, 1, 2, 4 or 10 micro-
seconds.
*RST: n.a. (no preset. default: TSW_0)

Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "T_SW" on page 117

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RRSequence <RRSequence>

Queries or sets the time values of the RTT_Random_Sequence_N field.

Setting the value depends on the bits of the RTT_Capability field via the command:
:SOURcel :BB:BTOoth:CS:CDATa:RCAPability

See also the table Table 5-9 for an overview.

Parameters:
<RRSequence> AR150 | AR10 | ARO
*RST: AR150
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "RTT_Random_Sequence N" on page 115

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RSOunding <RSOunding>

Queries or sets the time values of the RTT_Sounding_N field.

Setting the value depends on the bits of the RTT_Capability field via the command:
:SOURcel:BB:BTOoth:CS:CDATa:RCAPability

See also the table Table 5-9 for an overview.

Parameters:
<RSOunding> AR150 | AR10 | ARO
*RST: AR150
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "RTT_Sounding_N" on page 115

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SINTerval <Sublnterval>
Sets or queries the subevent interval.

Setting requires BB: BTOoth:CS:SNUMber 2 or higher. Query is for
BB:BTOoth:CS:SNUMber 1.

See [:SOURce<hw>] :BB:BTOoth:CS:CDATa: SNUMber on page 266.
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Parameters:
<Sublnterval> integer
Range: 0 to 2.7e11
*RST: 0
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Subevent_Interval" on page 124
See "Subevent_Interval" on page 127

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SLENgth <SubLength>

Sets the subevent length in the Subevent_Len field. The value has a length of three
octets or 9 bits.

Parameters:
<SubLength> integer
Range: 1250 to 4e6
*RST: 1250
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Subevent Len" on page 125
See "Subevent_Len" on page 127

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SNUMber <SubNumber>

Sets the number of subevents per event.

Parameters:
<SubNumber> integer
Range: 1 to 32
*RST: 1
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Subevent Per Event" on page 124
See "Subevents_Per_Event" on page 127

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SPEStimate <SPEstimate>

Sets the Sounding_PCT_Estimate bit. This bit indicates if the device supports phase
correction term (PCT) estimates from a sounding sequence or not.

Parameters:

<SPEstimate> 1| ON |0 | OFF
1|ON
The Sounding_PCT_Estimate bit is 1. The device supports PCT
estimates from a sounding sequence.
0|OFF
The Sounding_PCT_Estimate bit is 0. The device does not sup-
port PCT estimates from a sounding sequence.
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*RST: 0
Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Sounding PCT_Estimate" on page 116

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SMODe <SubMode>

Sets the submode of the main mode.

Parameters:

<SubMode> MODE1 | MODE2 | MODE3 | NONE
See the table Table 5-8 for an overview on available submodes
per main mode.
*RST: NONE

Example: See Example"To configure CS control PDUs" on page 250.

Manual operation: See "Sub_Mode" on page 120

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CSPCapability?
Queries the value of the CS_SYNC_PHY_Capability field that is the LE 2M PHY.

Return values:

<SyncPhy> LE2M

*RST: LE2M
Example: See Example"To configure CS control PDUs" on page 250.
Usage: Query only

Manual operation: See "CS _SYNC_ PHY_Capability" on page 115

Test packet configuration commands - LE

Example: To configure test packets

// R Rk dE h kb b b b h b b b b b b b b b b b b b b b bk b b b b b h b b b b b b b b b b b b b b b b b b b b b b b b b b b b b b b b b b b b i
// Configure settings of an LE uncoded PHY test packet.

// KA KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR AR AN KA KA KKK
// Set for a data channel test packet in the LE uncoded PHY.
SOURcel:BB:BTOoth:CTYPe DATA

SOURcel:BB:BTOoth:UPTYpe TPAC

SOURcel:BB:BTOoth:PFORmat L1M

// Configure packet interval and header settings.
SOURcel:BB:BTOoth:DTTest:TPConfiguration:TPINterval 12.5
// Sets a test packet interval of 12.5 ms.
SOURcel:BB:BTOoth:ECONfiguration:PCONfiguration:CPResent 0O
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SOURcel:BB:BTOoth:ECONfiguration:PCONfiguration:SWORd SW

// Fixed sync word value of 0x94826ESE.

// Alternatively, set a user-defined sync word.
SOURcel:BB:BTOoth:ECONfiguration:PCONfiguration:SWORdA UPAT
SOURcel:BB:BTOoth:ECONfiguration:PCONfiguration:USER FFFFFFFFF
// Sync word is OxFFFFFFFFF.

// Configure payload settings.
SOURcel:BB:BTOoth:DTTest:TPConfiguration:UPSource PAT3
// Sets a fixed pattern 11111111 as payload.
SOURcel:BB:BTOoth:DTTest:TPConfiguration:UPLength 255
// Sets a payload length of 255 bytes.

// KKK KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR AR AR AKX KKK

// Also, configure LE coded PHY test packet settings.

// R I I b I b I b I SR I b I b e S I I b I b b I b I b b I b I R e b b E I R I b b b I b I b b b b b I b b b b I b b S b I 2
SOURcel:BB:BTOoth:PFORmat LCOD
SOURcel:BB:BTOoth:ECONfiguration:PCONfiguration:SPBit TWO

// Sets 2 symbols per bit for forward erroc correction coding.

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SPBit..............euuueeiiiieierennnn. 268
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SYNCwOrd............cccevvuereeens 268
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:USERpatt...............evuvuunnnnnnn. 269
[:SOURce<hw>]:BB:BTOoth:DTTest: TPConfiguration: TPINterval..........cccceeveevvucinreereennnnnnnn. 269
[:SOURce<hw>]:BB:BTOoth:DTTest: TPConfiguration:UPLength..............cccoeerrriemeierenennnnnne 270
[:SOURce<hw>]:BB:BTOoth:DTTest: TPConfiguration:UPSoUrce............cccevereverenrnrnnnnnnnnnnn 270

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SPBit <SPB>

Specifies a coding for LE coded packets. The specification for Bluetooth wireless tech-
nology defines two values S for forward error correction: S = 2 symbol/bitand S = 8

symbol/bit.
Parameters:
<SPB> TWO | EIGHt
*RST: TWO
Example: See Example"To configure test packets" on page 267.
Options: R&S SMM-K117

Manual operation: See "Symbols per a Bit" on page 130

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SYNCword
<syncWord>

Sets the 32-bit Sync Word in the packet header field in hexadecimal representation.

Parameters:
<syncWord> SW | UPAT

SW
Fixed value of 0x94826ES8E.
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UPAT

User-defined pattern allowing 8-digit hexadecimal input via the
following command:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:
PCONfiguration:USERpatt on page 269

*RST: SW
Example: See Example"To configure test packets" on page 267.

Manual operation: See "Sync Word" on page 131

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:USERpatt
<userPatt>, <BitCount>

Sets a user-defined pattern of the 32-bit Sync Word.
Using this Sync Word requires the following setting:

SOURcel:BB:BTOoth:ECONfiguration:PCONfiguration:SYNCword UPAT

Parameters:
<userPatt> numeric
*RST: #HO
<BitCount> integer
Range: 1 to 32
*RST: 1
Example: See Example"To configure test packets" on page 267.

Manual operation: See "User Pattern(hex)" on page 131

[:SOURce<hw>]:BB:BTOoth:DTTest:TPConfiguration:TPINterval <TplInterval>

Sets the time interval between two consecutive test packets, regarding the starting
points.

Command sets the values in ms. Query returns values in s.

Parameters:
<Tplnterval> float
Range: 0.625E-3 s to 27.5E-3 s - depends on packet char-
acteristics
Increment: 0.625E-3 s
*RST: 0.625E-3 s
Default unit: ms
Example: See Example"To configure test packets" on page 267.

Manual operation: See "Packet Interval" on page 130
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[:SOURce<hw>]:BB:BTOoth:DTTest:TPConfiguration:UPLength <UpLength>

Sets the payload length.

Parameters:
<UpLength>

Example:

Manual operation:

integer
Range: 0 to 255
*RST: 37

See Example"To configure test packets" on page 267.

See "Payload Length" on page 132

[:SOURce<hw>]:BB:BTOoth:DTTest:TPConfiguration:UPSource <UpSource>

Selects the data source used for the payload test packets.

Parameters:
<UpSource>

Example:

Manual operation:

User Manual 1179.2054.02 — 07

PNO9 | PAT1 | PAT2 | PN15 | PAT3 | PAT4 | PATS | PAT6 | DLIS

PN9|PN15
Pseudo random bit sequences (PRBS) with length in bits. The
length can be 9 bits or 15 bits.

PAT1
Predefined pattern: 11110000

PAT2
Predefined pattern: 10101010

PAT3
Predefined pattern: 11111111

PAT4
Predefined pattern: 00000000

PAT5
Predefined pattern: 00001111

PAT6
Predefined pattern: 01010101

DLISt

Binary data from data lists as a data source. Set the data list file
via the following command:

[ :SOURce<hw>] :BB:BTOoth:ECONfiguration:
PCONfiguration:DATA:DSELection on page 230

*RST: PNO09
See Example"To configure test packets" on page 267.

See "Payload Type" on page 131
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Channel configuration commands - BR/EDR

8.8 Channel configuration commands - BR/IEDR

[:SOURCe<hW>]:BB:BTOOtN:PTYPE.....cuiiiuiuuaaaaaeie e e e e e e e e eeeeeeeeeeeeeeeeeeeeneneee e e e e e e e e eeeeas 271
[:SOURce<hw>]:BB:BTOOth:SLENGN.....ccveriiiiiiiiei e e e e e e s e e e e e e e s s s saenrrren e e e e e e e e e e 271
[:SOURCce<hw>]:BB:BTOOth:STIMING...cceieeeieeeeeeeieieeeeeeeieieeenininusseseseeeseeeaeaaaaeeeeeseeesennens 271

[:SOURce<hw>]:BB:BTOoth:PTYPe <PType>

The available packets depend on the selected transport mode. All packet types as
defined in the Bluetooth specifications are supported.

Parameters:

<PType> ID | NULL | POLL | FHS | DM1 | DH1 | DM3 | DH3 | DM5 | DH5 |
AUX1 | ADH1 | ADH3 | ADH5 | AEDH1 | AEDH3 | AEDHS5 |
HV1 | HV2 |HV3 | DV | EV3 | EV4 | EV5 | EEV3 | EEV5 |
EEEV3 | EEEV5
*RST: DHA1

Example: BB:BTO:PTYP NULL

Sets a null packet.

Manual operation: See "Packet Type" on page 134

[:SOURce<hw>]:BB:BTOoth:SLENgth <SLength>

Sets the sequence length of the Bluetooth signal in number of frames. This signal is
calculated in advance and output in the arbitrary waveform generator.

Parameters:
<SLength> integer
Range: depends on the number of states in dirty transmitter
test to dynamic
*RST: 1
Example: BB:BTO:SLEN 10

sets the sequence length to 10 frames.

Manual operation: See "Sequence Length" on page 134

[:SOURce<hw>]:BB:BTOoth:STIMing <SlotTiming>

Selects the Rx slot timing mode.

Parameters:

<SlotTiming> TX | LOOPback
*RST: X

Example: BB:BTO:PTYP DH3

sets the packet type.
BB:BTO:STIM LOOP

selects loopback test mode.
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Packet configuration commands - BR/EDR

Manual operation: See "Slot Timing" on page 134

Packet configuration commands - BR/EDR

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:ACKNowledgement............c.ccvueeeeeeerevrnneennens 272
[:SOURce<hw>]:BB:BTOo0th:PCONfiguration:BDALAD.........cceererrerrrreininniiircnieeeeeeeeeeaaaaens 273
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:BDANGP........cuueiireieiieiieieerieiceeeeeeeeeiineaeeeees 273
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:BDAUAP........cuueeieeiiiiiiieieereeiceeeeeeeeeieneeeeeens 273
[:SOURce<hw>]:BB:BTO0th:PCONfiguration:CODEVICE........ceeerrrmrmrnnuaaaaaeeeeeeeeeaaaaaaeeeeeees 274
[:SOURce<hw>]:BB:BTO0th:PCONFiguration:DATA.........evvurmrerniiiieieiereeeeeeeeeeeseeeereeeeeeesenns 274
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:DPATEM.....uuuueeieieieeeeeeeeeeeeeeeereeeeeneens 274
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:DSELECtON........ccvveeieeereriiceeeeeeeeriannn. 275
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:VDPALern.........cccoeeieiiiiiiieiiieeeeeeeee 275
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:VDSEIlection..........cccccciiiuiiiiiiiiiiiniiians 276
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DLENGth..........uuumuuaaiaaaieee e ee e 276
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DSFPacKet............cceerrrrrrrrmrmrnnniaiainaneeeeeeenns 276
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DWHIteNiNg........cceeeereeeeeeeeeieieeeeeeeeeeeievinieeenes 277
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:EIRPacketfollows.............ccceevevevreereeenrnrnnnnnnns 277
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:HFCONtrol.........cevvueieeiiiiiiieeeeeeeeeicee e 277
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:LFSWOrd.............cceuurueieirimriniieneeeeeeiieeeeeeeeens 278
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:LTADAIrESS.......cceevruueeeeererinieeeeeeeenneeeeeeeennns 278
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:PFCONtrol..........ccceeeeeeieieieieeeeeeeeeieeiieee 279
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:PLENGth..........ccceveriieeeriieieeeeeeeeeeeeieeen 279
[:SOURce<hw>]:BB:BTO0th:PCONFigUration:SLAP........ccuuuieeieeieeeiiie et e et eeeenes 279
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:SNSValUe...........ccvvueeereeriririieeeeeeeiieeeeeeeeennns 280
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:SRMOdE..........ceeeeeeeeeeieieeeeeeereeenininiee e 280
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:VDATa. .......ccuieiieiaae ettt 281

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:ACKNowledgement
<Acknowledgement>

Sets the ARQN bit of the packet header..

Parameters:
<Acknowledgement> NAK | ACK
NAK
Request to retransmit the previous payload.

ACK
Previous payload has been received successfully.

*RST: ACK

Example: BB:BTO:PTYP DH1

selects the packet type DH1.
BB:BTO:PCON:DSFP PED

enable packet editor under data source for packet
BB:BTO:PCON:ACKN ACK

sets positive acknowledgement

Manual operation: See "Acknowledgment" on page 138
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[:SOURce<hw>]:BB:BTOoth:PCONfiguration:BDALap <BdalLap>, <BitCount>

Sets the lower address part of Bluetooth Device Address. The length of LAP is 24 bits
or 6 hexadecimal figures.

Parameters:
<Bdalap> numeric
Range: #H000000 to #HFFFFFF
*RST: 80
<BitCount> integer
Range: 8 to 24
*RST: 24
Example: BB:BTO:PCON:BDAL #H000000,24

Sets the lower address part.

Manual operation: See "Bluetooth Device Address (BD_ADDR)" on page 137

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:BDANap <BdaNap>, <BitCount>

Enters the non-significant address part of Bluetooth Device Address. The length of
NAP is 16 bits or 4 hexadecimal figures.

Parameters:
<BdaNap> numeric
Range: #H0000 to #HFFFF
*RST: ABCD
<BitCount> integer
Range: 16 to 16
*RST: 16
Example: BB:BTO:PCON:BDAN #H0000,16

Sets the non-significant address part.

Manual operation: See "Bluetooth Device Address (BD_ADDR)" on page 137

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:BDAUap <BdaUap>, <BitCount>

Enters the upper address part of Bluetooth Device Address. The length of UAP is 8 bits
or 2 hexadecimal figures.

Parameters:

<BdaUap> numeric
Range: #HOO to #HFF
Increment: 1
*RST: 48

<BitCount> integer

Range: 8 to 8
*RST: 8
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Example: BB:BTO:PCON:BDAN #HO0O0, 8
Sets the non-significant address part.

Manual operation: See "Bluetooth Device Address (BD_ADDR)" on page 137

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:CODevice <CoDevice>, <BitCount>

A parameter received during the device discovery procedure, indicates the type of
device and which types of service that are supported.

Parameters:
<CoDevice> numeric
Range: #HO000000 to #HFFFFFF
*RST: #HO
<BitCount> integer
Range: 24 to 24
*RST: 24
Example: BB:BTO:PTYP FHS

Sets the packet type.
BB:BTO:PCON:DSFP PED

Enables the packet editor under data source for the packet.
BB:BTO:PCON:COD #H020104,24
Sets the class of device.

Manual operation: See "Class of Device" on page 140

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA <Data>

Selects the data source used for the payload.

Parameters:

<Data> ALLO | ALL1 | PATTern | PNO9 | PN11 | PN15 | PN16 | PN20 |
PN21 | PN23 | DLISt
*RST: PNO09

Example: BB:BTO:PTYP FHS

sets the packet type
BB:BTO:PCON:DSFP PED

enable packet editor under data source for packet
BB:BTO:PCON:DATA ALLI

sets the data type.

Manual operation: See "Data Source" on page 138

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:DPATtern <DPattern>,
<BitCount>

Selects the data for a pattern.
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Parameters:
<DPattern>

<BitCount>

Example:

Manual operation:

Packet configuration commands - BR/EDR

numeric

*RST: #HO

integer

Range: 1 to 64

*RST: 1
BB:BTO:PCON:DATA PATT
Sets the data type.

BB:BTO:PCON:DATA:DPAT #B010101, 6
Selects the data for a pattern with the length of 6 bits.

See "Data Source" on page 138

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:DSELection <DSelection>

The command selects data list file.

Parameters:
<DSelection>

Example:

Manual operation:

string
Increment: 1

BB:BTO:PCON:DATA DLIS

selects the data type.
BB:BTO:PCON:DSEL bluetooth 1

selects the file for the data.

See "Data Source" on page 138

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:VDPAttern <VdPattern>,

<BitCount>

Sets the bit pattern for the voice data.

Parameters:
<VdPattern>

<BitCount>

Example:

Manual operation:
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numeric

*RST: #HO
integer

Range: 1 to 64
*RST: 1

BB:BTO:PCON:DATA: PATT

Selects the data type.

BB:BTO:PCON:DATA:VDPA #B010101,6

Selects the bit pattern for the voice data with the length of 24
bits.

See "Data Source (Voice Field)" on page 140
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[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:VDSElection <VdSelection>

Selects the data list for voice data.

Parameters:
<VdSelection>

Example:

Manual operation:

string

BB:BTO:PCON:VDAT DLIS

selects the data type.
BB:BTO:PCON:VDSE bluetooth 1

selects the file for the data.

See "Data Source (Voice Field)" on page 140

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DLENgth <DLength>

Sets the payload data length in bytes.

Parameters:
<DLength>

Example:

Manual operation:

integer
Range: 0 to depends on packet type

Increment: 1
*RST: depends on packet type

BB:BTO:PTYP DHI

sets the packet type.
BB:BTO:PCON:DSFP PED

enable packet editor under data source for packet
BB:BTO:PCON:DLEN 25

sets the data length.
See "Data Length" on page 139

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DSFPacket <DsfPacket>

Selects the data source for the selected packet type.

Parameters:
<DsfPacket>

Example:

Manual operation:
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PEDit | ADATa

PED

Enables the "Packet Editor". All packet fields can be configured
individually.

ADAT

Fills the generated packets with the selected data source. Useful
if predefined data contents are loaded with a data list file or the
data contents of the packet are not of interest.

*RST: PEDit

BB:BTO:PCON:DSFP PED
enables packet editor under data source for packet.

See "Data Source for Packet" on page 136
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[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DWHitening <DWhitening>
Activates the "Data Whitening".

Parameters:
<DWhitening> 1]ON| 0| OFF

*RST: 0
Example: BB:BTO:PCON:DWH ON

activates data whitening.

Manual operation: See "Data Whitening" on page 136

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:EIRPacketfollows <EirPacketFollow>

Indicates that an extended inquiry response packet can follow.

Parameters:
<EirPacketFollow> YES |NO
YES
Indicates that EIR packet follows.
NO
Indicates that EIR packet does not follow.
*RST: NO
Example: BB:BTO:PCON:PTYP FHS

sets the packet type.
BB:BTO:PCON:DSFP PED

enables the packet editor under data source for the packet
BB:BTO:PCON:EIRP YES

the EIR packet follows.

Manual operation: See "EIR packet follows" on page 139

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:HFControl <HfControl>

The command sets the FLOW bit in the header. This bit indicates start or stop of trans-
mission of packets over the ACL logical transport.

Parameters:
<HfControl> GO | STOP

GO
Allows the other devices to transmit new data.

STOP
Stops the other devices from transmitting data temporarily.

*RST: GO
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Example: BB:BTO:PCON:PTYP DH1
sets the packet type.
BB:BTO:PCON:DSFP PED

enable packet editor under data source for packet.
BB:BTO:PCON:HFC GO
allows the other devices to transmit new data.

Manual operation: See "Flow Control" on page 137

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:LFSWord <LapForSW>, <BitCount>

Sets the lower address part (LAP) of the sync word for FHS packets. The length of
LAP is 24 bits or 6 hexadecimal figures.

Parameters:
<LapForSW> numeric
Range: #H000000 to #HFFFFFF
*RST: #H000080
<BitCount> integer
Range: 8 to 24
*RST: 24
Example: BB:BTO:PCON:LFSW #H000080,24

Sets the lower address part.

Manual operation: See "LAP for Sync Word" on page 136

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:LTADdress <LtAddress>

The command enters the logical transport address for the header. Each Peripheral
active in a piconet is assigned a primary logical transport address (LT_ADDR). The all-
zero LT_ADDR is reserved for broadcast messages.

Parameters:

<LtAddress> integer
Range: 0Oto7
Increment: 1
*RST: 0

Example: BB:BTO:PCON:PTYP DH1

sets the packet type.

BB:BTO:PCON:DSFP PED

enable packet editor under data source for packet
BB:BTO:PCON:LTAD 0

sets the logical transport address equal zero.

Manual operation: See "Logical Transport Address" on page 137
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[:SOURce<hw>]:BB:BTOoth:PCONfiguration:PFControl <PfControl>
The command sets the FLOW bit in the payload (flow control per logical link).

Parameters:
<PfControl> GO | STOP
GO
Indicates the start of transmission of ACL packets after a new
connection has been established.
STOP
Indicates the stop of transmission of ACL packets before an
additional amount of payload data is sent.
*RST: GO
Example: BB:BTO:PCON:PTYP DH1

sets the packet type.
BB:BTO:PCON:DSFP PED

enable packet editor under data source for packet
BB:BTO:PCON:PFC GO

allows the flow per logical link.

Manual operation: See "Flow Control" on page 139

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:PLENgth <PLength>
Sets the packet length in symbols.

Parameters:
<PLength> integer
Range: 1 to depends on packet type
Increment: 1
*RST: depends on packet type
Example: BB:BTO:PCON:DSFP ADAT

fills the all data under data source for packet.
BB:BTO:PCON:PLEN 1

sets the packet length.

Manual operation: See "Packet Length" on page 142

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:SLAP <State>

Activates synchronization of the lower address part (LAP) of the sync word and Blue-
tooth device address.

Parameters:
<State> 1|ON |0 | OFF

*RST: 1
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Example:

Manual operation:

Packet configuration commands - BR/EDR

BB:BTO:PCON:SLAP 0

deactivates LAP synchronization.
BB:BTO:PCON:LFSW #H000080,24

sets LAP of the sync word separately.

See "Synchronize LAP with BD_ADDR" on page 136

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:SNSValue <SnSvalue>

Sets the start value of the header SEQN bit. The SEQN bit is present in the header to
filter out retransmissions in the destination. The signal generator is altering this bit
automatically on consecutive frames, if a sequence length of at least 2 frames is set.

Parameters:
<SnSvalue>

Example:

Manual operation:

integer

Range: 0 to 1

*RST: 1
BB:BTO:PCON:PTYP DH1

sets the packet type.
BB:BTO:PCON:DSFP PED

enables packet editor under data source for packet.
BB:BTO:PCON:SNSV ONE

sets the SEQN bit of the first CRC data packet at the start of a
connection.

See "SEQN Start Value" on page 138

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:SRMode <SrMode>

The command indicates the interval between two consecutive page scan windows,
determines the behavior of the paging device.

Parameters:
<SrMode>

Example:
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RO | R1]|R2

RO

The scan interval is equal to the scan window T w page scan
(continuous nscan) and maximal 1.28s.

R1
The scan interval is maximal 1.28s.

R2
The scan interval is maximal 2.56s.

*RST: RO

BB:BTO:PCON:PTYP FHS

sets the packet type.
BB:BTO:PCON:DSFP PED

enables packet editor under data source for packet.
BB:BTO:PCON:SRM RO

sets the scan repetition mode.
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Filter/clipping commands

Manual operation: See "Scan Repetition Mode" on page 140

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:VDATa <VData>

Selects the data source for the voice field.

Parameters:

<VData> ALLO | ALL1 | PATTern | PNO9 | PN11 | PN15 | PN16 | PN20 |
PN21 | PN23 | DLISt
*RST: PNO09

Example: BB:BTO:PCON:VDAT ALLI

sets the voice data type.

Manual operation: See "Data Source (Voice Field)" on page 140

Filter/clipping commands

[:SOURce<hw>]:BB:BTOOth:CLIPPING:LEVEL......ciiiieeeeiie et 281
[:SOURce<hw>]:BB:BTOO0th:CLIPPING:MODE.......ccccitieieeeeeeeeeieeeeeeeeeeeeeeeeeene e 282
[:SOURCce<hw>]:BB:BTOOth:CLIPPING:STATE. ...ceeeeeeriieieeeeetiieeeeeeeerie s e e e eeetaaeeeeseestaaeaaeens 282
[:SOURCe<hw>]:BB:BTOOth:FILTErFILTEIS?. .. cceeiveteieeeeeetiieeeeeeeeetee e e e e eernteeeeeeeebaeeeeeeenes 282
[:SOURce<hw>]:BB:BTOOth:FILTErTYPE....cu it 283
[:SOURce<hw>]:BB:BTOoOth:FILTer:ILENGth. ..o 283
[:SOURce<hw>]:BB:BTOoth:FILTer:ILENgth:AUTO[:STATE]. .. ccuuieeeieieeeeee et 284
[:SOURce<hw>]:BB:BTOOth:FILTErOSAMPIING. .. .uuuuaaaaaaeeeeeeeeeaeeeeeeeeeeeeeeeeeeaeeeneneeeee s 284
[:SOURce<hw>]:BB:BTOoth:FILTer:OSAMPplIiNg:AUTO[:STATE]. ..ceeuureernieeeen e e eeeneeee 284
[:SOURCce<hw>]:BB:BTOOth:FILTENMINDEX......ccvvrueeeeeieeiniieeeeeeeerieeeeeerernaeeeeeeesnnnseeeeeesnns 284
[:SOURCe<hw>]:BB:BTOOth:FILTERMTYPE....ccutuieieeiieeiiieeeeeeeree e eeeeeebe e e e e e eaabe e e e e eebaa s 285
[:SOURce<hw>]:BB:BTOoth:MSETtings:FDEViation..........c.coeuiiiiiiiiieiee e 285
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:APCO25..........ccovieeiieiieieeeeeieee e e 285
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:COSINE.......ccceevreueeeeeeeeicie e e eeeieieeeeeeeeennn 285
[:SOURce<hw>]:BB:BTOoth:FILTer:PARamMEter:FGAUSS........cceveeeeeeeeeeeeeeeninreiaenaaa e e 286
[:SOURce<hw>]:BB:BTOo0th:FILTer:PARAmMEter:GAUSS. ........cvvrreririicieieieieeeeeeeeeeeeeeeereeeens 286
[:SOURce<hw>]:BB:BTOoth:FILTer:PARaMEter:LPASS.......ccoeiiiiiiieeeeeeeeieee et eeeaaa 286
[:SOURce<hw>]:BB:BTOoth:FILTer:PARAMEtEr:PGAUSS. .....c.uueeeeeeiiiiiieeeeeeerieeeeeeeeeiiaeeeens 287
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:RCOSINE.........cevvueeeeeeieeriieeeeeeeeeeeeeeeeeeeannn 287
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:SPHAaSe.........cccoeeviieieiieiceeeiice e 287
[:SOURce<hw>]:BB:BTO0th:SRATE:VARIAtION. ....uuuueiieeiiiiie e eeeeiece e eeeaaa 288

[:SOURce<hw>]:BB:BTOoth:CLIPping:LEVel <Level>
Sets the limit for level clipping.

This value indicates at what point the signal is clipped. It is specified as a percentage,
relative to the highest level. 100% indicates that clipping does not take place.
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Parameters:
<Level>

Example:

Manual operation:

Filter/clipping commands

integer

Range: 1 to 100
Increment: 1

*RST: 100
Default unit: PCT

SOURcel:BB:BTO:CLIP:LEV 80

Sets the limit for level clipping to 80% of the maximum level.
SOURcel :BB:BTO:CLIP:STAT ON

Activates level clipping.

See "Clipping Level" on page 148

[:SOURce<hw>]:BB:BTOoth:CLIPping:MODE <Mode>

The command sets the method for level clipping.

Parameters:
<Mode>

Example:

Manual operation:

VECTor | SCALar

VECTor
The reference level is the amplitude | i+jq |.

SCALar
The reference level is the absolute maximum of the | and Q val-
ues.

*RST: VECTor

SOURcel:BB:BTO:CLIP:MODE VECT
Sets the amplitude as reference level.

See "Clipping Mode" on page 149

[:SOURce<hw>]:BB:BTOoth:CLIPping:STATe <State>

Activates level clipping.

The value is defined with the command BB: BTO:CLIPping:LEVel, the mode of cal-
culation with the command BB:BTO:CLIPping:MODE.

Parameters:
<State>

Example:

Manual operation:

1] ON |0 | OFF
*RST: OFF

SOURcel :BB:BTO:CLIP:STAT ON
Activates level clipping.

See "Filter/Clipping" on page 37
See "State" on page 148

[:SOURce<hw>]:BB:BTOoth:FILTer:FILTers?

Queries all configured baseband filters.
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These filters are the common GFSK baseband filter and, for some EDR packets, a
DPSK filter. See also Table 7-1.

Return values:
<filters> string

Example: SOURcel:BB:BTO:FILT:FILT?
// Response: "GFSK, Root Raised Cosine (RRC)"
GFSK is a common baseband filter. Root raised cosine (RRC) is
the /4 DQPSK filter.
SOURcel :BB:BTO: TMOde?
// Response: "ESCO"
SOURcel :BB:BTO:PTYPe?
// Response: "EEV3"
SOURcel:BB:BTO:PTYPe EV3
SOURcel :BB:BTO:FILT:FILT?
// Response: "GEFSK"
GFSK is the only filter.

Usage: Query only
Manual operation:  See "Filter/Clipping" on page 37

[:SOURce<hw>]:BB:BTOoth:FILTer:TYPE <Type>

Selects the filters used for /4 DQPSK and 8DPSK modulations. This opens a selec-
tion window containing all the filters available to the instrument.

Parameters:

<Type> RCOSine | COSine | GAUSs | LGAuss | CONE | COF705 |
COEQualizer | COFequalizer | C2K3x | APCO25 | SPHase |
RECTangle | PGAuss | LPASs | DIRac | ENPShape |
EWPShape
*RST: RCOSine

Example: SOURcel:BB:BTO:FILT:TYPE RCOS

Sets the filter type RCOSine.

Manual operation: See "Filter" on page 146

[:SOURce<hw>]:BB:BTOoth:FILTer:ILENgth <ILength>

Sets the impulse length (the number of filter taps).

Parameters:

<ILength> integer
Range: 1 to depends on oversampling
*RST: 32

Example: SOURcel:BB:BTO:FILT:ILEN 10

Sets the number of filter tabs to 10.

Manual operation: See "Impulse Length" on page 145
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[:SOURce<hw>]:BB:BTOoth:FILTer:ILENgth:AUTO[:STATe] <State>
Activates the impulse length state.

If activated, the most sensible parameter values are selected. The value depends on
the coherence check.

Parameters:
<State> 1]ON| 0| OFF
*RST: 1
Example: SOURcel:BB:BTO:FILT:ILEN:AUTO ON

Selects the most sensible parameters automatically.

Manual operation: See "Impulse Length" on page 145

[:SOURce<hw>]:BB:BTOoth:FILTer:0SAMpling <OSampling>

Sets the upsampling factor.

Parameters:
<OSampling> integer
Range: 1 to 32
*RST: 10
Example: SOURcel:BB:BTO:FILT:0SAM 10

Sets the upsampling factor to 10.

Manual operation: See "Oversampling” on page 145

[:SOURce<hw>]:BB:BTOoth:FILTer:OSAMpling:AUTO[:STATe] <State>

Activates the upsampling factor state. If activated, the most sensible parameter values
are selected. The value depends on the coherence check. If deactivated, the values
can be changed manually.

Parameters:
<State> 1|ON |0 | OFF
*RST: 1
Example: SOURcel:BB:BTO:FILT:0SAM:AUTO ON

The most sensible parameters are selected automatically.

Manual operation: See "Oversampling" on page 145

[:SOURce<hw>]:BB:BTOoth:FILTer:MINDex <MIndex>
Queries the modulation index resulting from the entered frequency deviation value.

Parameters:
<MIndex> string
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Example: SOURcel :BB:BTO:FILT:MIND?
Queries the modulation index
// Response: "0.5"

Manual operation: See "Modulation Index" on page 147

[:SOURce<hw>]:BB:BTOoth:FILTer:MTYPe <MType>

Queries the modulation type used for the current packet selection.

Parameters:
<MType> string
Example: SOURcel :BB:BTO:FILT:MTYP?

Queries the modulation type

Manual operation: See "Modulation Type" on page 147

[:SOURce<hw>]:BB:BTOoth:MSETtings:FDEViation <FDeviation>

Sets the frequency deviation.

Parameters:
<FDeviation> float
Range: Depends on Bluetooth mode
Increment: 0.1
*RST: depends on Bluetooth mode
Example: SOURcel:BB:BTO:MSET:FDEV 160

Sets a frequency deviation of 160 kHz.

Manual operation: See "Frequency Deviation" on page 147

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:APCO25 <Apco25>
Sets the roll-off factor for filter type APCO25.

Parameters:
<Apco25> float
Range: 0.05 to 0.99
Increment: 0.01
*RST: 0.2
Example: SOURcel:BB:BTO:FILT:PAR:APCO25 0.2

Sets the roll-off factor to 0.2 for filter type APCO25.

Manual operation: See "B*T" on page 144
See "Roll Off Factor/B*T" on page 146

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:COSine <Cosine>

Sets the roll-off factor for the Cosine filter type.
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Parameters:
<Cosine> float
Range: 0to1
Increment: 0.01
*RST: 0.1
Example: SOURcel :BB:BTO:FILT:PAR:COS 0.35

Sets the roll-off factor to 0.35 for filter type Cosine.

Manual operation: See "B*T" on page 144
See "Roll Off Factor/B*T" on page 146

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:FGAuss <FGauss>
Sets the B x T for the Gauss filter type.

Parameters:
<FGauss> float
Range: 0.15 to 2.5
Increment: 0.01
*RST: 0.5
Example: SOURcel:BB:BTO:FILT:PAR:FGA 0.5

Sets B x T to 0.5 for the Gauss filter type for the GFSK section
of the packet.

Manual operation: See "B*T" on page 144
See "Roll Off Factor/B*T" on page 146

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:GAUSs <Gauss>
Sets the B x T for the Gauss filter type.

Parameters:
<Gauss> float
Range: 0.15 to 2.5
Increment: 0.01
*RST: 0.5
Example: SOURcel:BB:BTO:FILT:PAR:GAUS 0.5
Sets B x T to 0.5 for the Gauss filter type for /4 DQPSK or
8DPSK sections.

Manual operation: See "B*T" on page 144
See "Roll Off Factor/B*T" on page 146

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:LPASs <LPass>
Sets the cut off frequency factor for a lowpass filter (ACP Opt.).
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Parameters:
<LPass> float
Range: 0.05 to 2
Increment: 0.01
*RST: 0.5
Example: SOURcel:BB:BTO:FILT:PAR:LPAS 1

Sets the cut off frequency factor for a lowpass filter.

Manual operation: See "B*T" on page 144
See "Roll Off Factor/B*T" on page 146
See "Cut Off Frequency Factor" on page 146

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:PGAuss <PGauss>
Sets the B x T for the Pure Gauss filter type.

Parameters:
<PGauss> float
Range: 0.15 to 2.5
Increment: 0.01
*RST: 0.5
Example: SOURcel:BB:BTO:FILT:PAR:PGA 0.5

Sets B x T to 0.5 for the Pure Gauss filter type.

Manual operation: See "B*T" on page 144
See "Roll Off Factor/B*T" on page 146

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:RCOSine <RCosine>

Sets the roll-off factor for the Root Cosine filter type.

Parameters:
<RCosine> float
Range: 0 to 1
Increment: 0.01
*RST: 0.4
Example: SOURcel:BB:BTO:FILT:PAR:RCOS 0.22

Sets the roll-off factor to 0.22 for filter type Root Cosine.

Manual operation: See "B*T" on page 144
See "Roll Off Factor/B*T" on page 146

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:SPHase <SPhase>
Sets the BXT for the split phase filter type.
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Parameters:
<SPhase> float
Range: 0.15 to 2.5
Increment: 0.01
*RST: 2
Example: SOURcel:BB:BTO:FILT:PAR:SPH 0.5

Sets B x T to 0.5 for the Split Phase filter type.

Manual operation: See "B*T" on page 144
See "Roll Off Factor/B*T" on page 146

[:SOURce<hw>]:BB:BTOoth:SRATe:VARiation <Variation>

Sets the symbol rate.

Parameters:
<Variation> float
Range: 4E2 to 15E6
Increment: 1E-3
*RST: 1E6
Example: BB:BTO:SRAT:VAR 1

sets the symbol rate variation to 1 MHz.

Manual operation: See "Symbol Rate Variation" on page 148

Power ramping commands

[:SOURce<hw>]:BB:BTO0th:PRAMPING:FOFFSEt.......uuuiiaiaaeieie e 288
[:SOURce<hw>]:BB:BTO0th:PRAMPING:RFUNCHON. ....cciiieieeeeiee e 289
[:SOURce<hw>]:BB:BTO0th:PRAMPING:ROFFSEt.....ccciiiiiiiieieeieeeicie et 289
[:SOURce<hw>]:BB:BTOOth:PRAMPING:RTIME.......cevtuieieeiiiitieieeeeeeteeeeeeeeetee e e e eerae e 289

[:SOURce<hw>]:BB:BTOoth:PRAMping:FOFFset <FOffset>

Sets the offset of the falling edge of a burst. The offset is specified by the selected
number of symbols.

Negative values shift the falling edge to earlier positions, which results in a correspond-
ing number of skipped symbols at the end of the burst.

Positive values shift the falling edge to later positions, which results in a corresponding
number of added 0 padding symbols following the burst.

Parameters:

<FOffset> integer
Range: -32 to 32
Increment: 1
*RST: 0
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Example: BB:BTO:PRAM: FOFF 8
Adds eight symbols at the end of the burst.

Manual operation: See "Fall Offset" on page 150

[:SOURce<hw>]:BB:BTOoth:PRAMping:RFUNction <RFunction>

The command selects the form of the transmitted power, i.e. the shape of the rising
and falling edges during power ramp control.

Parameters:
<RFunction> LINear | COSine

*RST: COSine
Example: BB:BTO:PRAM:RFUN LIN

sets linear shape for the rising and falling edges during power
ramp control.

Manual operation: See "Ramp Function" on page 150

[:SOURce<hw>]:BB:BTOoth:PRAMping:ROFFset <ROffset>

Sets the offset of the rising edge of a burst. The offset is specified by the selected num-
ber of symbols.

Negative values shift the rising edge to earlier positions, which results in a correspond-
ing number of added 0 padding symbols before the burst.

Positive values shift the rising edge to later positions, which results in a corresponding
number of skipped symbols at the beginning of the burst.

Parameters:
<ROffset> integer
Range: -32 to 32
Increment: 1
*RST: -2
Example: BB:BTO:PRAM:ROFF 8

Skips eight symbols at the beginning of the burst.

Manual operation: See "Rise Offset" on page 150

[:SOURce<hw>]:BB:BTOoth:PRAMping:RTIMe <RTime>

Sets the ramp time, which extends the burst by a corresponding number of 0 padding
symbols at the beginning and the end of a burst. During this period of time, power
ramping is based on the specified ramp function.

Parameters:

<RTime> integer
Range: 1 to 32
Increment: 1
*RST: 2
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Example: BB:BTO:PRAM:TIME 2
Extends the burst by 2 symbols at the beginning and end of the
burst.

Manual operation: See "Ramp Time" on page 150

8.12 Trigger commands

Example: To configure an external trigger

// B

// Configure trigger in armed retrigger mode, set source, enable

// synchronization to external trigger, set external

// inhibit and delay.

// KKK KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR A A AR AR AR AR KRR R KKK
SOURcel:BB:BTOoth:TRIGger:SEQuence ARET
SOURcel:BB:BTOoth:TRIGger:SOURce EGT1
SOURcel:BB:BTOoth:TRIGger:EXTernal : SYNChronize:OUTPut 1

SOURcel :BB:BTOoth:TRIGger:EXTernal :INHibit 100
SOURcel:BB:BTOoth:TRIGger:EXTernal :DELay 10

Example: To configure an internal trigger

// R Rk kg ko kb b b b b b b b b b kb b b b h b b bk b b b b b b b gk b b b b b gk b b b b bk dh b b b b bk b b b bk i

// Configure trigger in single mode.

// Set source to internal, specify signal duration

// unit and duration.

// R R R R R R R R R R R R R R R R R R R
SOURcel:BB:BTOoth:TRIGger:SEQuence SING
SOURcel:BB:BTOoth:TRIGger:SOURce INT

SOURcel:BB:BTOoth:TRIGger:SLUNit SEQ

SOURcel:BB:BTOoth:TRIGger:SLUNit FRAMe
SOURcel:BB:BTOoth:TRIGger:SLENgth 2

// R Rk dh ko kb b b kb b b b b bk kb h b b bk b b b b b b b kb b b kb b b b b b bk dh b b b b b b b b b b bk

// Alternatively configure trigger in armed retrigger mode.
// Set source to internal. Enable Bluetooth signal, start

// the trigger - signal generation starts.

// Stop signal generation and wait for a trigger

// event to restart signal generation.

// Query the current trigger signal generation status.

// ER R R R R R R R R R R R R R R R R
SOURcel:BB:BTOoth:TRIGger:SEQuence ARETrigger
SOURcel:BB:BTOoth:TRIGger:SOURce INT
SOURcel:BB:BTOoth:STATe 1

SOURcel:BB:BTOoth:TRIGger:EXEcute

User Manual 1179.2054.02 — 07 290



R&S®SMM-K60/-K117/-K178 Remote control commands

Trigger commands

[:SOURce<hw>]:BB:BTOOth[: TRIGGEr:SEQUENCE.......cieeeieeiureeeeeeieiiiieeeeeeeniaeeeeeenannaeaaees 291
[:SOURce<hw>]:BB:BTOO0th:TRIGGErSOURCE. ....uiiuieieii et 291
[:SOURce<hw>]:BB:BTOOth: TRIGGErNRMODE.........ccceeeeeeiieieieiiiinieeeeae e e e e e e eeaaaaaaeaeeeees 292
[:SOURce<hw>]:BB:BTO0th: TRIGQErTIME:DATE.......ccceeeieeeeieinrnnnaaaae e eeeeeeeeaaeaeeeeeeeeeees 292
[:SOURce<hw>]:BB:BTOOth:TRIGGEr:TIME:TIME.......ccvuieieeieeiiiiieeeeeeerieee e e e eeane e e e e ee s 292
[:SOURce<hw>]:BB:BTOOth: TRIGQEr:TIME[:STATE]...cevuueieeeeeerriieieeeeeeteeeeeeeeraneeeeeeesrannnnns 293
[:SOURce<hw>]:BB:BTOo0th:TRIGGer:SLENGth......cuiiiiieeee e 293
[:SOURce<hw>]:BB:BTOOth:TRIGGErSLUNIL. .....uiitiiieiieie e 294
[:SOURce<hw>]:BB:BTO0th: TRIGGerARM:EXECULE.....ccieeeeiercieeeeeeieice e ee e e 294
[:SOURce<hw>]:BB:BTOOth: TRIGGENEXECULE.....cceeeeeeeeeeeeeeeeeeeeeeeeeeee e e e e e e e 294
[:SOURce<hw>]:BB:BTOoth: TRIGger[:EXTernal]:SYNChronize:OUTPUL.......c.cccvvveeeeeeeeennnn. 294
[:SOURce<hw>]:BB:BTOoth:TRIGger[:EXTernal]:DELaY........ccccevurueieeieeiiiieeeeeeeeeieeeeeeeeanns 295
[:SOURce<hw>]:BB:BTO0th: TRIGGEr[:EXTErNal]:INHIDIt.....vveeeeeeeeeeeeeeeeereseeeseseseeeeeseeeeens 295

[:SOURce<hw>]:BB:BTOoth[: TRIGger]:SEQuence <Sequence>
Selects the trigger mode:

® AUTO = auto

® RETRigger = retrigger

® AAUTo = armed auto

® ARETrigger = armed retrigger

® SINGle =single

Parameters:
<Sequence> AUTO | RETRigger | AAUTo | ARETrigger | SINGle
*RST: AUTO
Example: See Example"To configure an internal trigger" on page 290.

Manual operation: See "Mode" on page 152

[:SOURce<hw>]:BB:BTOoth:TRIGger:SOURce <Source>
Selects the trigger signal source and determines the way the triggering is executed.
Provided are the following trigger sources:
® TINTernal: Internal manual triggering of the instrument
® External trigger signal via one of the local or global connectors:
— EGT1|EGT2: External global trigger
— EGC1|EGC2: External global clock

® For secondary instruments (SCONfiguration:MULTiinstrument:MODE SEC),
triggering via the external baseband synchronization signal of the primary instru-
ment:
SOURcel:BB:ARB:TRIGger:SOURce BBSY

® OBASeband|BEXTernal |EXTernal: Setting only
Provided only for backward compatibility with other Rohde & Schwarz signal gener-

ators. The R&S SMM100A accepts these values and maps them automatically as
follows:
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OBASeband = INTA, BEXTernal = EGT2, EXTernal = EGT1

Parameters:
<Source> INTernal|EGT1|EGT2|EGC1|EGC2|EXTernal|BBSY
*RST: INTernal
Example: See Example"To configure an external trigger" on page 290.
Example: See Example"To configure an internal trigger" on page 290.

Manual operation: See "Source" on page 154

[:SOURce<hw>]:BB:BTOoth:TRIGger:RMODe <RMode>

Queries signal generation status for all trigger modes with Bluetooth modulation on.

Parameters:
<RMode> RUN | STOP
*RST: STOP
Example: See Example"To configure an internal trigger" on page 290.

Manual operation: See "Running/Stopped" on page 153

[:SOURce<hw>]:BB:BTOoth:TRIGger:TIME:DATE <Year>, <Month>, <Day>

Sets the date for a time-based trigger signal. For trigger modes single or armed auto,
you can activate triggering at this date via the following command:

SOURce<hw>:BB:<DigStd>:TRIGger:TIME: STATe

<DigsStd> is the mnemonic for the digital standard, for example, ARB. Time-based trig-
gering behaves analogously for all digital standards that support this feature.

Parameters:
<Year> integer
Range: 1980 to 9999
<Month> integer
Range: 1 to 12
<Day> Range: 1 to 31
Increment: 1
Example: See example "Configure a time-based trigger signal" in the sub-

chapter "Trigger Commands" of the chapter "SOURce:BB:ARB
subsystem" in the R&S SMM100A user manual.

Manual operation: See "Trigger Time" on page 153

[:SOURce<hw>]:BB:BTOoth:TRIGger:TIME:TIME <Time>

Sets the time for a time-based trigger signal. For trigger modes single or armed auto,
you can activate triggering at this time via the following command:
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SOURce<hw>:BB:<DigStd>:TRIGger:TIME: STATe

<Digstd> is the mnemonic for the digital standard, for example, ARB. Time-based trig-
gering behaves analogously for all digital standards that support this feature.

Parameters:
<Time> string
Example: See example "Configure a time-based trigger signal" in the sub-

chapter "Trigger Commands" of the chapter "SOURce:BB:ARB
subsystem" in the R&S SMM100A user manual.

Manual operation: See "Trigger Time" on page 153

[:SOURce<hw>]:BB:BTOoth:TRIGger:TIME[:STATe] <Hour>, <Minute>, <Second>

Activates time-based triggering with a fixed time reference. If activated, the
R&S SMM100A triggers signal generation when its operating system time matches a
specified time.

Specify the trigger date and trigger time with the following commands:
SOURce<hw>:BB:<DigStd>:TRIGger:TIME:DATE
SOURce<hw>:BB:<DigStd>:TRIGger:TIME: TIME

<Digstd> is the mnemonic for the digital standard, for example, ARB. Time-based trig-
gering behaves analogously for all digital standards that support this feature.

Parameters:
<Hour> integer
Range: 0 to 23
<Minute> integer
Range: 0 to 59
<Second> integer
Range: 0 to 59
Example: See example "Configure a time-based trigger signal" in the sub-

chapter "Trigger Commands" of the chapter "SOURce:BB:ARB
subsystem" in the R&S SMM100A user manual.

Manual operation: See "Time Based Trigger" on page 153

[:SOURce<hw>]:BB:BTOoth:TRIGger:SLENgth <SLength>

Defines the length of the signal sequence that is output in the SING1e trigger mode.

Parameters:
<SLength> integer
Range: 1 to 7000
*RST: 1
Example: See Example"To configure an internal trigger" on page 290.

User Manual 1179.2054.02 — 07 293



R&S®SMM-K60/-K117/-K178 Remote control commands

Trigger commands

Manual operation: See "Signal Duration" on page 152

[:SOURce<hw>]:BB:BTOoth:TRIGger:SLUNit <SIUnit>
Defines the unit for the entry of the signal sequence length.

Parameters:
<SlUnit> FRAMe | SEQuence | EVENt

FRAMe
A single frame is generated after a trigger event.

SEQuence
A single sequence is generated after a trigger event.

*RST: SEQuence
Example: See Example"To configure an internal trigger" on page 290.

Manual operation: See "Signal Duration Unit" on page 152

[:SOURce<hw>]:BB:BTOoth:TRIGger:ARM:EXECute

Stops signal generation; a subsequent trigger event restarts signal generation.
Example: See Example"To configure an internal trigger" on page 290.
Usage: Event

Manual operation: See "Arm" on page 153

[:SOURce<hw>]:BB:BTOoth:TRIGger:EXECute

Executes a trigger.

Example: See Example"To configure an internal trigger" on page 290.
Usage: Event

Manual operation: See "Execute Trigger" on page 153

[:SOURce<hw>]:BB:BTOoth:TRIGger[:EXTernal]:SYNChronize:OUTPut <Output>

Enables signal output synchronous to the trigger event.

Parameters:
<Output> 1]ON| 0| OFF
*RST: 1
Example: See Example"To configure an external trigger" on page 290.

Manual operation: See "Sync. Output to Ext. Trigger/Sync. Output to Trigger"
on page 154
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[:SOURce<hw>]:BB:BTOoth:TRIGger[:EXTernal]:DELay <Delay>
Sets the trigger delay.

Parameters:
<Delay> float

Range: 0 to 2147483647
Increment: 0.01
*RST: 0

Example: See Example"To configure an external trigger" on page 290.

Manual operation: See "External Delay/Trigger Delay" on page 155

[:SOURce<hw>]:BB:BTOoth: TRIGger[:EXTernal]:INHibit <Inhibit>

Specifies the number of samples by which a restart is to be inhibited following an exter-
nal trigger event.

Parameters:
<Inhibit> integer
Range: 0 to 21.47*symbRate
*RST: 0
Example: See Example"To configure an external trigger" on page 290.

Manual operation: See "External Inhibit/Trigger Inhibit" on page 155

8.13 Marker commands

Example: To configure a marker signal

// o o o
// Configure marker mode: set a marker at ARB sequence start.

// LRSS SRS S SRR SRS SRS SRS EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE S
SOURcel:BB:BTOoth:TRIGger :OUTPutl:MODE RESTart

// SOURcel:BB:BTOoth:TRIGger:OUTPutl:MODE STARt

// SOURcel:BB:BTOoth:TRIGger:0UTPutl:MODE ACTive

// KKK AR KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR A AKX KKK

// Alternatively configure pulse marker. Set pulse

// divider and frequency

// KA A KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR AR A KA KA KK
SOURcel:BB:BTOoth:TRIGger:0UTPutl:MODE PULSe
SOURcel:BB:BTOoth:TRIGger:OUTPutl:PULSe:DIVider 2
SOURcel:BB:BTOoth:TRIGger:OUTPutl:PULSe:FREQuency?

// 500000

// ER R R E kb E b b b b b E h h b E b h b b E h b b E b b SE E E b b b b b b b b b b b b b b b b b b b b b b b E b b b b b b b b b

// Alternatively configure bit pattern marker. Specify pattern.
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// KKK AR A AR A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A KA A A AR A AR A AR AR KN KKK

SOURcel:BB:BTOoth:TRIGger:O0UTPutl :MODE PATTern
SOURcel :BB:BTOoth:TRIGger:OUTPutl:PATTern #H2,2

// KKK KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR AR AR AR RA KK

// Alternatively configure on/off ratio marker. Set on/off time.

A
SOURcel:BB:BTOoth:TRIGger:OUTPutl:MODE RAT

SOURcel :BB:BTOoth:TRIGger:OUTPutl:ONTime 40000
SOURcel:BB:BTOoth:TRIGger:OUTPutl:OFFTime 20000

Example: To configure marker delay
// KKK KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR A AR A AR KRR KKK
// Enable fixed marker delay. Query the limit for minimum and maximum

// marker delay. Set delay for the marker signal output.

// KKK KA A AR A A A A A A A AR A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR AR AR XA AR KA KK

SOURcel:BB:BTOoth:TRIGger:OUTPutl:DELay 1600

[:SOURce<hw>]:BB:BTOoth: TRIGger:OUTPut<ch>:DELay.......ccceriuiiiiiiiiiiiiiieeeeeeeeee 296
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:FESHift.........cccooviiiiiiiiiiiiiiieeee 296
[:SOURce<hw>]:BB:BTOoth: TRIGger:OUTPut<ch>:MODE.............ccccevrrerrrrerrinininnnaaannn 297
[:SOURce<hw>]:BB:BTOo0th: TRIGger:OUTPUt<Ch>:ONTIME.......uuuuuaaaraiereeeeeeeeeeeeeerereeeennns 298
[:SOURce<hw>]:BB:BTOo0th: TRIGger:OUTPUt<Ch>:OFFTIME......ccuururrurmniiiiiaieieeeeeeaaaeaeen 298
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPUt<Ch>:PATTEIM........uceieeeeerrniieeeeeeenieeeeeeeernnns 298
[:SOURce<hw>]:BB:BTOoth: TRIGger:OUTPUt<Ch>:PINDEX.......cccuiiiuiiiniiiiiieiieeieeeceeeee 298
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PULSe:DIVider........c.cccoeuiiiiiiiniiinnaann. 298
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PULSe:FREQueNncy?.............ccccevveeeens 299
[:SOURce<hw>]:BB:BTOoth: TRIGger:OUTPut<ch>:RESHIift........c.ccceueimummuiiiiiiiineeeeeeeeeenn. 299

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:DELay <Delay>

Defines the delay between the signal on the marker outputs and the start of the sig-

nals.
Parameters:
<Delay> float
Range: 0 to 16777215
Increment: 1
*RST: 0
Example: See Example"To configure marker delay” on page 296.

Manual operation: See "Delay" on page 158

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:FESHift <Shift>

Shifts the falling edge of the marker the specified number of samples.

Negative values result in a shift back of the marker edge.
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Parameters:
<Shift>

Example:

Example:

Manual operation:

Marker commands

float

Range: dynamic to dynamic
Increment: 1E-6

*RST: 0

SOURcel:BB:BTO:TRIG:OUTP1:FESH 10
Shifts the falling edge of marker 1 by 75 samples.

See also Example"To configure a marker signal” on page 295.

See "Mode" on page 156

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:MODE <Mode>

Defines the signal for the selected marker output.

Parameters:
<Mode>

Example:

User Manual 1179.2054.02 — 07

RESTart | STARt | ACTive | PULSe | PATTern | RATio | IACTive

RESTart
A marker signal is generated at the start of each signal
sequence.

STARt
A marker signal is generated at the start of each event/frame.

ACTive

The marker masks the active part of the event/frame. At the start
of each burst, the marker signal changes to high. It changes
back to low after the end of each burst.

PULSe

A regular marker signal is generated. The clock frequency is
defined by entering a divider. The frequency is derived by divid-
ing the symbol rate by the divider. The input box for divider
opens when "Pulse" is selected, and the resulting pulse fre-
quency is displayed below.

PATTern

A marker signal that is defined by a bit pattern is generated. The
pattern has a maximum length of 32 bits and is defined in an
input field which opens when pattern is selected.

RATio

A regular marker signal corresponding to the "Time Off" / "Time
On" specifications in the commands
SOURcel:BB:BTO:TRIGger:QUTPut:OFFTime and
SOURcel :BB:BTO:TRIGger:OUTPut :ONTime is generated.
IACTive

The marker masks the inactive part of the event/frame. At the
start of each burst, the marker signal changes to low. It changes
back to high after the end of each burst.

*RST: RESTart

See Example"To configure a marker signal” on page 295.
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Marker commands

Manual operation: See "Mode" on page 156

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:ONTime <OnTime>
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:0OFFTime <OffTime>

Sets the duration of the ON and OFF periods.

Parameters:
<OffTime> integer
Range: 1 to 16777215
*RST: 1
Example: See Example"To configure a marker signal” on page 295.

Manual operation: See "Mode" on page 156

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PATTern <Pattern>, <BitCount>

Selects the data for a pattern.

Parameters:
<Pattern> numeric
*RST: #H2
<BitCount> integer
Range: 1 to 64
*RST: 2
Example: See Example"To configure a marker signal” on page 295.

Manual operation: See "Mode" on page 156

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PINDex <PIndex>

For Bluetooth LE data packets higher than one, sets the packet index. The index corre-
sponds to the transmitted Tx event during the connection interval.

Parameters:
<PIndex> integer
Range: 1 to depends on "No. Of Tx Packets/Event"
parameter
*RST: 1

Manual operation: See "Mode" on page 156

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PULSe:DIVider <Divider>

Sets the divider for the clock frequency.
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Parameters:
<Divider>

Example:

Manual operation:

Clock commands

integer
Range: 2 to 1024
*RST: 2

See Example"To configure a marker signal” on page 295.

See "Mode" on page 156

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PULSe:FREQuency?

Queries the marker pulse frequency.

Return values:
<Frequency>

Example:
Usage:

Manual operation:

float

Range: 2 to 1024
Increment: 1E-3
*RST: 2

See Example"To configure a marker signal" on page 295.
Query only
See "Mode" on page 156

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:RESHift <Shift>

Shifts the rising edge of the marker the specified number of samples.

Negative values result in a shift back of the marker edge.

Parameters:
<Shift>

Example:

Example:

Manual operation:

float

Range: dynamic to dynamic
Increment: 1E-6

*RST: 0

SOURcel:BB:BTO:TRIG:OUTPut2:RESH -20
Shifts back the rising edge of marker 2 by 20 samples.

See also Example"To configure a marker signal" on page 295.

See "Mode" on page 156

8.14 Clock commands

This section lists the remote control commands to configure the clock.
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Clock commands

Example: To configure clock settings

VAR EEEEEE SRR LA A EEEE SRR EEEE e E Rt

// Select internal clock.

// ER R R E h h E b b b S I E I h b h b b E E b E E b b E E E b b b b b b dh b b b b b h 3h b b b E b 3E b b b b b h b b b b b b b 3

SOURcel:BB:BTOoth:CLOCk:SOURce INTernal

// KKK KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR A A AR AR KRR XA KKK

// Alternatively select external clock. Set its mode.

VAR EEEEEE SRR LA AR EEEE SRR EEEE AR R R Rt

SOURcel:BB:BTOoth:CLOCk:MODe SAMP

[:SOURce<hw>]:BB:BTOOth:CLOCK:SOURCE.......cceeeeeeeeeeeeeeeeeeeeeeeenieievesean s e s e e e e aaaaaas 300

[:SOURce<hw>]:BB:BTOoth:CLOCk:SOURce <Source>

Selects the clock source:
® TINTernal: Internal clock reference
® TFICLock: External local clock

® EXTernal = ELCLock: Setting only
Provided for backward compatibility with other Rohde & Schwarz signal generators

Parameters:
<Source> INTernal
*RST: INTernal
Example: See Example"To configure clock settings" on page 300.

Manual operation: See "Clock Source" on page 159
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Glossary: Specifications

Symbols
[1]: Bluetooth SIG: Bluetooth Core Specification, version 5.4
https://www.bluetooth.com/specifications/specs/

[2]: Bluetooth SIG: Channel Sounding, revision CR_PR
https://www.bluetooth.com/specifications/specs/
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List of commands

[:SOURCe<hw>]:BB:BTOOth:BCROIE.........ouiiiiiiiiieieeeeie ettt 174
[:SOURCe<hW>]:BB:BTOOth:BCTEXE?.....c.eiiiiiieiieeiiee ettt 162
[:SOURCe<hw>]:BB:BTOOth:BIMODE.........c.ueeiiiiie ettt et e e et e e et e e e eaaa e e e eanaeeanes
[:SOURCe<hw>]:BB:BTOOth:CCRC:ISTATE. .....cuiiiiitieieeiteetiest ettt ettt ettt ettt sbe et et entenneeneens
[:SOURce<hw>]:BB:BTOOth:CLIPPINGILEVEL. ..ot
[:SOURce<hw>]:BB:BTOOth: CLIPPING:MODE ..ottt
[:SOURce<hw>]:BB:BTOOth: CLIPPING:STATE. ... .ottt
[:SOURce<hw>]:BB:BTOOth:CLOCK:SOURCE. ........ciiiiiiiiiiiii ittt
[:SOURCce<hw>]:BB:BTOOth:CS:CDATA:ACH.......eee ittt et e et e e e e e eanaeeanes
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CCID:STATe...
[:SOURce<hw>]:BB:BTOOth:CS:CDATA:CECOUNL......c.uiiiiiiiiii ittt
[:SOURce<hw>]:BB:BTOOth:CS:CDATA:CID.......ccuiieicieiieetee ettt e e e ear e e enaee s
[:SOURce<hw>]:BB:BTOOth:CS:CDATA:CSATRIEEC. ... .cueiiiieieieeieeee sttt
[:SOURce<hw>]:BB:BTOO0th:CS:CDATA:CSIGNAL......cccuiiiiiiiiiiiit e
[:SOURce<hw>]:BB:BTO0th:CS:CDATa:CSPCapability?.........c.ccouiiiiaiiiiiieiie et 267
[:SOURce<hw>]:BB:BTOOth:CS:CDATA:ECODE.........ceiiiiiiieiiieiieite ettt
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:EOFFset..
[:SOURce<hw>]:BB:BTO0th:CS:CDATA:MAPALN.........oeiieeiieeeee e
[:SOURce<hw>]:BB:BTOOth:CS:CDATA:IMMASEEPS. .....ccueiiiiuiiiiaiieie ettt 257
[:SOURce<hw>]:BB:BTOOth:CS:CDATAIMMISIEPS. .....ceiuiiiiiiiiiieiie ettt 257
[:SOURce<hw>]:BB:BTOO0th:CS:CDATA:MMODE...........cccueiieetiee it ce ettt et eare e e earae e e eaaeaeeaes 257
[:SOURce<hw>]:BB:BTO0th:CS:CDATa:MMREPEHHION. ..ot 257
[:SOURce<hw>]:BB:BTO0th:CS:CDATa:MPLENGN.....c.eiiiiiiiii e
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MPSupported

[:SOURce<hw>]:BB:BTO0th:CS:CDATA:NCONIIG. ......eeiiiiiiiieieiiiesieeiieie s 259
[:SOURce<hw>]:BB:BTOOth:CS:CDATAINFAE ... ...ttt 259
[:SOURce<hw>]:BB:BTO0th:CS:CDATa:NRSCapability...........ccccuiiiiiiiiiieeiieeie e 260
[:SOURce<hw>]:BB:BTO0th:CS:CDATa:NSCapa@bility.........c.eerueiieieriiiierieeese e 260
[:SOURce<hw>]:BB:BTOOth:CS:CDATAIOMAX.......uiiiiiiiiiaite ittt
[:SOURce<hw>]:BB:BTOOth:CS:CDATA:OMIN.......cccuiiiiitiii ettt e et eare e e sarae e e ereeaeeaes
[:SOURce<hw>]:BB:BTOOth:CS:CDATA:PCOUNL.......ceiiiiiieiiieieiteeie sttt
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:PDELta....

[:SOURce<hw>]:BB:BTO0Oth:CS:CDATA:PINTEIVAL .......ceiiiiiiiiiiieiesieee e
[:SOURce<hw>]:BB:BTOO0th:CS:CDATa:PPANIENNA. .......eiiiiiiiiiie e
[:SOURce<hw>]:BB:BTOOth:CS:CDATAIRAONIY.......ciiiiiitiiiii ettt
[:SOURce<hw>]:BB:BTO0th:CS:CDATa:RCAPADIlitY.......cceeriiiiieiiieeieee e
[:SOURce<hw>]:BB:BTOOth:CS:CDATAIRFU.....cc.eiiiiiiiiiiieiie et
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RRSequence
[:SOURce<hw>]:BB:BTO0th:CS:CDATa:RSOUNGING. ....ceuveteimieiieiieiie ettt
[:SOURce<hw>]:BB:BTOOth:CS:CDATAIRTYPE.......iiiiiiiiiiie it
[:SOURce<hw>]:BB:BTOO0th:CS:CDATA:SINTEIVAL......cc.eeiieitiie et
[:SOURce<hw>]:BB:BTO0th:CS:CDATa:SLENGh.......coiiiiiiiiiiee e
[:SOURce<hw>]:BB:BTOOth:CS:CDATA:SIMODAE.........cciiiiiiiiiieiie ettt
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[:SOURce<hw>]:BB:BTOO0th:CS:CDATA:SNUMDET.........ccoiiieictiie ettt
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SPEStimate....

[:SOURce<hw>]:BB:BTOOth:CS:CDATA:TFCS.......ooiiiiiiiiie ittt
[:SOURce<hw>]:BB:BTOOth:CS:CDATA: TIONE.........oeeiiuiiieetiie ettt et e e e e aea e e
[:SOURce<hw>]:BB:BTOOth:CS:CDATA:TITWO. ....ceiiiiiiiieitie ettt ettt ettt eeeeeneeaneaeas
[:SOURce<hw>]:BB:BTOOth:CS:CDATA:TPM......ciiiiiiiiiiiii ittt et
[:SOURCce<hw>]:BB:BTOOth:CS:CDATA:TSW......oeiiiiieeiiiie ettt e et e et e e eaa e e s eaneeeannes
[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:BPOSition<ch0>]:TFCapability.............cccceriiiiiiiiiiiiiii e 253
[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:BPOSition<ch0>]: TIPO:CAPability..........ccccervvirriiriiiieiieeieee 253
[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:BPOSition<ch0>]: TIPT:CAPability..........cccceriiieiiiiiiiiiiieieee 253
[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:BPOSition<ch0>]:TPCapability.............cccerviriiiiiiiiiiiieeiiee 254
[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:CHANNEI<ChO>]:CFAE. ..ot 254
[:SOURCce<hw>]:BB:BTOOth:CS:CFCHM?.......uiiiiiiee ettt a e eare e e ena e e e ennee s 208
[:SOURce<hw>]:BB:BTOOth:CS:CINC.... ...ttt ettt e et eaee e e eneeenbeesneeanns 207
[:SOURCe<hw>]:BB:BTOOth:CS:CINP.......ciiiiiiieiiieiee ettt 207
[:SOURCce<hw>]:BB:BTOOth:CS:CINTEIVAL......c.ueeiiiiie ettt a et e e e e e eanaeeenes 190
[:SOURCce<hw>]:BB:BTOOth:CSiCIVC.... ..ottt ettt ettt et et e e eneeenneeenee s 206
[:SOURCe<hW>]:BB:BTOOth:CS:CIVP.....c.iiiiiiiiie ettt 206
[:SOURce<hw>]:BB:BTOO0th:CS:CMREPELItION. ......c.eviiiiiiiecciie ettt 209

[:SOURce<hw>]:BB:BTOoth:CS:CPVP
[:SOURce<hw>]:BB:BTOoth:CS:CSEL
[:SOURCe<hw>]:BB:BTOOth:CS:ICSPVC......ciiiii ettt ettt e et e e e e s e e e e aaaeeas 208
[:SOURce<hw>]:BB:BTOoth:CS:CTABIle[:CHANNel<ch0>]:CALLOWEd. .........coiiiiiiiiiieiie e 205
[:SOURce<hw>]:BB:BTOoth:CS:CTABIe[:CHANnNel<ch0>]:CFReqUENCY?..........coouiiiiiiiiiiiciiec e 204
[:SOURce<hw>]:BB:BTOoth:CS:CTABIe[:CHANNEI<ChO>]:CINDEX?........eveeiiiieeeieee et 205
[:SOURce<hw>]:BB:BTOoth:CS:CTABIe[:CHANNEI<ChO>]:CTYPE?. ..ottt 205
[:SOURce<hw>]:BB:BTOoth:CS:CTCJump
[:SOURCce<hw>]:BB:BTOOth:CS:CTCSRAPE........cciiiiieeiiiie ettt et e et e e e e e eaneeeenes
[:SOURce<hw>]:BB:BTOOth:CS:EINTEIVAL......cc.eiiiiiiiiiii ettt ettt
[:SOURCce<hw>]:BB:BTOOth:CS:EOFFSEL........coiiiiiiiiieiie et
[:SOURCce<hw>]:BB:BTOOth:CS:ROLE.........coiiiiiieiiii ettt et e et e e e e s enneeeanes
[:SOURce<hw>]:BB:BTOOth:CS:SINTEIVAL......ccueiiiiiiiiii ettt
[:SOURce<hw>]:BB:BTOOth:CS:SLENGIN.......ciiiiiiiiitie e e
[:SOURCce<hw>]:BB:BTOOth:CS:SNUMDET..........cciiiiiieiiiee ettt et e et e e ese e e e eanaeeanes
[:SOURce<hw>]:BB:BTOOth:CS:SSCHEAUING........coiuiiiiieiiieiie ittt
[:SOURce<hw>]:BB:BTO0th:CS[:SEVent<ChO>]:DATA. ... ..ottt
[:SOURce<hw>]:BB:BTO0th:CS[:SEVent<ChO>]:DLISt..........ccoiiieiiiie e
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MMASteps...
[:SOURce<hw>]:BB:BTO0th:CS[:SEVent<ChO>]:MMISTEPS. ......coouiiiiiiiiiieeiie et

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<chO>]:MMODE..........coeeiiiriieiiii e

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MMREPELitioN...........cueeiiiiiiiiieiieiie e 197
[:SOURce<hw>]:BB:BTO0th:CS[:SEVent<ChO>]:MMSTEPS?......cciiiiiieriiiiiieieeeiee et 197
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<chO>]:MONE:TIPO.........ccooiiiiiie et 197
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<chO>]:MTHREE:INAP?..........ooiiiiiiiii it 198
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTHRee:TIPT....
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<chO>]:MTHREE:TPM..........ccooiieiiiie et

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<chO>]:MTHREE: TSW?.......oiiiiiiiiiii e 198
[:SOURce<hw>]:BB:BTOo0th:CS[:SEVent<chO>]1:MTWO:INAP?. ...ttt 198
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<chO>]:MTWO:TIPT.......ooiiiiie et 199
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<chO>]:MTWO:TPM......cccoiiiiiiiiiie et 198
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[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<chO>]:MTWO:TSW?.....ccoiieiiee et 198
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MZERo:TIPO..
[:SOURce<hw>]:BB:BTO0th:CS[:SEVent<ChO>]:MZSTEPS.......cciiiiiiiiiiiiieiie ettt
[:SOURce<hw>]:BB:BTOo0th:CS[:SEVent<ChO>]:NOSTEP.....cccuiieiriieeciiie ettt
[:SOURce<hw>]:BB:BTO0th:CS[:SEVent<ChO>]:PATTEIN.......coiiiiiiiiii ettt
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:SEQLeNGth.........ccoiiiiiiiiiiiceee e
[:SOURce<hw>]:BB:BTOo0th:CS[:SEVent<chO>]:SMODAE............cccceeiiiiieeiiiie ettt
[:SOURce<hw>]:BB:BTO0th:CS[:SEVent<chO>]:SMSTEP?.......oiiiiiiieiie ettt 197
[:SOURce<hw>]:BB:BTO0th:CS[:SEVent<chO>]:SSPaCE?.........coiiiiiiiiiieiieee s 194
[:SOURce<hw>]:BB:BTO0th:CS[:SEVENt<ChO>]:STYPE........ooiiiiiieiciiie e 199
[:SOURce<hw>]:BB:BTO0th:CS[:SEVent<chO>]:TFCS.......cociiieie e 194
[:SOURce<hw>]:BB:BTOo0th:CS[:SEVent<chO>]:UPAYI0ad.........cociiiiiiiiiiiieie e 199
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:UPPattern.... ..200
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<chO0>][:STEP<st0>]:CAADAIESS.........coeiuiaiiiaiieiieaiieeie e 202
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<chO>][:STEP<StO>]:CINDEX........ccccuiririiriiiiieiieeiee e 202
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<chO>][:STEP<st0>]:CSIGNal...........cccevvvreiiiiecciiee e 203
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:CTEXtension...........c.ccceivieiiiiiiniieieee 204
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<chO>][:STEP<StO>]:MTYPE?.....ociiiieieeiee e 201
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:SCONtent............cccoereiiiieiiiie e 202
[:SOURce<hw>]:BB:BTOoth:CTYPe...

[:SOURCe<hW>]:BB:BTOOtN:DCY CIE.....cciuiiiiiiiiieiee ettt
[:SOURce<hw>]:BB:BTOOth:DTTeSt:DT TSIAtE.....cciuiieeiiiie ettt 167
[:SOURce<hw>]:BB:BTOo0th:DTTest:FDDEVIAtION. ... ....ccuiiiiiiiiiiiieiie et 167
[:SOURce<hw>]:BB:BTOOth:DTTESt:IFDRALE. ........ciiiiiiiiiiii i

[:SOURce<hw>]:BB:BTOoth:DTTest:MIMode
[:SOURce<hw>]:BB:BTOoth:DTTest:NPPSet
[:SOURce<hw>]:BB:BTOoth:DTTest:SPHase

[:SOURce<hw>]:BB:BTOO0th:DTTest:STDEfaUIL..........ccccueieeiiiieciiie e 169
[:SOURce<hw>]:BB:BTOOth:DTTESETABLE. .....coiiiiiii ettt et e e 169
[:SOURce<hw>]:BB:BTOoth:DTTest: TABLe:LONG:SET<ch>:CFOFfSet........ccccciimiiiiiiiiiiiecieeec e 170
[:SOURce<hw>]:BB:BTOoth:DTTest: TABLE:LONG:SET<Ch>:MINDEX........ccceecririreiriieeiiiieeciiee e 170
[:SOURce<hw>]:BB:BTOoth:DTTest: TABLE:LONG:SET<Ch>:STATE......cccciiiiiiieiiiaiee e 171
[:SOURce<hw>]:BB:BTOoth:DTTest: TABLe:LONG:SET<Ch>:STERIOI........ccccuiiiiiiiiiiiciieeeeeee 171
[:SOURce<hw>]:BB:BTOoth:DTTest: TABLe:SHORt:SET<ch>:CFOFfSEt........c..cccoviiiiiiiieeciiie e 172
[:SOURce<hw>]:BB:BTOoth:DTTest: TABLe:SHORt:SET<Ch>:STATE.......coiiiiiiiiiieiie e 172
[:SOURce<hw>]:BB:BTOoth:DTTest: TABLe:SHORt:SET<Ch>:STERFIOF.........ccciiiiiiiiiiiiiiieceeeec e 173
[:SOURce<hw>]:BB:BTOoth:DTTest: TPConfiguration: TPINterval.............c.cccoooiiiiiiiiiiieie e 269

[:SOURce<hw>]:BB:BTOoth:DTTest: TPConfiguration:UPLength
[:SOURce<hw>]:BB:BTOoth:DTTest: TPConfiguration:UPSource

[:SOURCce<hw>]:BB:BTOOth:DURGLON. .......ccuueiiiiiie ettt ettt e s e e e aaaeens
[:SOURce<hw>]:BB:BTOoth:ECONfig:PCONfig:ANTGaIN<ChO>........cccoiiiiiiiiiii e
[:SOURce<hw>]:BB:BTOoth:ECONfig:PCONFfig:ANTNUMDET.........coiiiiiiiiiiiii e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:ACTable:CHANNEI<ChO>:STATE........cccecvuiiriiiiieiiieieeieee 181
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:ADINtErval............ccooiiiiiiiiiiiie et 182

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:AEDelay
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:AEINterval

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:APINTErVaL...........cceiiiiiiriiiiieeieee e 183
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:DCTable:CHANnNel<chO0>:STATe.........cccceiiiiiiieiiiciec e 181
[:SOURce<hw>]:BB:BTOo0th:ECONfiguration:LCMOGE............coiiiiiieiiieiiie ittt 183
[:SOURce<hw>]:BB:BTO0th:ECONTFiGUration:LTKEY.........ccueruruiiuiiiiiieieieeae sttt 184
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AADDIESS............cooutriieiieiiieiiieiie e 217
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD:APATIEM..........cocuiiiieiiiiie e 223
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD:ASELection............cccceivveiiiiieenncnne 223
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACASSIgNed...........ccceeiiiiiiiiiieiiiieeaieeees 224
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACID..........c.ccouiriirniiiiieiie e 224
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ADID.............ccouiiiiiiiieiiiiiiieeeeseeeee e 224
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONFiguration:ALAP...........cciriiiiiiiieeeeeseeeseeeie 225
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ALENGth............cooiiiiiiiiiiiiiiieeee 225
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AMODAE..............ccceriuiiiiiiiiiiieiieeie e 226
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ANU@P........cccceeiiiiiiiiiiiiiiiee e 226
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AOFFSet............coviiiiiiiiiiiiiiiccec e 227

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AOUNits
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:APHY ..........ccoiiiiiiiiiie e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ASID..........ccccceriiriiiiiiiiiieniee e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ATYPe.........ccccoiiiiiiiiiiiieiieieee e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CACCUracy..........cccceerueeriiuieeeniiieeieae e 228
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CECount
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CID............cccouiriiiiiiiiiiiie e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration: CINStant
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CINTerval
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ClIValue.............cccccoouiiiiiiiiiiieiiieiic e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CPReseNt.............cccoeiiiiiiiiiiie e 218
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CSELection............ccccevuiiniiiiiiniiieenee 218
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTIMe...........ceoriiiiiiiiiiiiiiie e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTREq.........ceeiiiieiiiiiiiiiie i
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTYPe....
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA.........ccciiiiiiiiieiieeie e

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA:DPATIEIN........coooeiiiiiieiiie e 230
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA:DSELection...........cccccevcviiniiiiiinncnnns 230
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DCMTable:CHANnel<ch0>:STATe.............. 181

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DLENGth.............cccooiiiiiiiiiiieieeeen
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DWHitening............cccccceeriiiiieniinicniccee
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ECODAE..............ccovuieiiiiiiiiieiiienie e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ECOUNtEr............ccceiiiiiiiiiiiie e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EDIVersifier.............cccooiriiiiiiniiiecneen,
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHEader:STATE..........ccccooiiiieiiieiie e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:AADDress:STATe
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:ADINfo:STATe.........ccceervircviennnnne
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:APTR:STATE........cccccceerirrieennnnnn
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:CINFO:STATe..........cccvveiiiereennen.
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:SINFO:STATe........cccceeieerrirninene
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags: TADDress:STATe
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags: TPOWer:STATe..........ccceeeiueenne
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit<ch0>:STATe...
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:FSLength............cccooiiiiiiiiiiiie
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:HLENGth.............ccccoiiiiiiiiee
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ICASSIgned............ccccevvuirmiiriiiinniiieeneee
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ICID.............ccceiiiiiiiiiiiiieeiiese e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ID............cccoeiiiiiiiiieiiie e
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ILAP............ccceiiiiiiiiiiiiiieie e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:INUap
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:LCTIimeouUt...........c.cerviiiiiiiiiiiiiie e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:LPECOUNtEr...........ccceeiiiiiiiiiieiieciec e,
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MCLREq..........ccccueriiiiiiiiiiiiiieeeee e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MIVector..............ccouviviiiiiiiieiiicic e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MNINterval..............ccccooiiiiiiiiiniiiiienee.
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MROCHtets...........cccoieiriiiiiiiie e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MRTIMe. .........cccervuiriiiiiiiiiciiceee e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MSKD............cccceeiiiiiiiiiiiiiieiiiesie e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTOCtets...........cccoeeiiiiiiiiiieeie e,
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:LTM:STATe........ccoeiviiiiiiriiiees
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:L2M:STATe......
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:LCOD:STATe
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTTime..........ccceruiiiiiiiiiinieiiece e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MUCHanNels.............ccccceeiiiiiiiniiiienens
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MXINterval............ccccceiiiiiiiiiniiiiieciieeee
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NCINterval............cccccooiiriiiiiiniiniiciee,
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NLCTimeout.............ccceeiuiiiiiiiiiniiiieeiiene
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NSLatency
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NSValue.............cccoeoeiiiiiiiiiiiiiiiiieeceen
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NWOFfset............ccceeiiiiiiiiiiiiiiic e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NWSize............ccoooiiiiiiiiiiiie e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:OADJUSL.............cociiiiiriiiiiieiiceie e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:OF FSet<ch0>:STATe.........cccoeeiiiiiiiiiieennnn
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet<chO>:VALUE...........cccceeriieiiinnann
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PAINterval
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L1M:STATE........cceiiiiiiieiiiiiiiieeiee
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L2M:STATE........cccocvioeriiieneiieieceenn
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:LCOD:STATe........cccceieerriiiieiricnieens
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L1M:STATE.......cccceeiiiiiiiiiiiieiiee
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L2M:STATE........ccovvrierereiicieeeee
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:LCOD:STATE........cccoeiviireirriiirenns
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PPERIOdICity.............cccceriiiiiiiiiiiiiiieeiee
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RATYPE.......ccciuiiiiiiiiiiiiieaiiiee e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RCECOUNt...........cccceeiviiiiiiiiieniieiic e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ROPCOdE............cceeriiiiiiiiiiiieiieieesee e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:L1M:STATe
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:L2M:STATe
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYS:LCOD:STATE........cccecvueerirriiainenns
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RVECHOT...........ccccciiiiiiiiiiieiiiie e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCACCUraCY.........ccceerrveeruiriieeiieeeeneeeee
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCASSIgNed............cccceoiuiiiiiiiiiiiiiiieiieens
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCECoOUNtEr............ccoceiiiiiiiiiiieiiie e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCID....
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SID...........c.ccceiiiiiiiiiiiiiieiieiieee e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SIVecCtor............cocciiiiiiiiiiiieieeeeee e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SLAP...........ccceriiiiiiiiiiiieeece e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SLATENCY.........cccceeiiiiiiiiiiiiieiieeee e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SNU@P........ccccceeiiiiiriiiiiiiiie e
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SOUNItS............cccceeriiiiiiiniiiiienie e 244
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SPBit
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SPOFfSet..........cccccoviiiiiiiiiiiieiiecece 244
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SSKD............ccccoiiriiiiiiiiiieiie e 237
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SSValue.............ccccooeiiiiiiiiniiie e 218
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:LTM:STATe........ccoevviiiiiriiiiienns 238
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:L2M:STATe........cccceivveiiiiiiiaieenns 238
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:LCOD:STATE.........cccererrvenerrenne 238
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SVNUMDET............cccoeiiiiiiiiiiieiieciece 244
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SYNCWOrd............ccccciiiiiiiiiiiiiiiieiieiieesene 268
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration: TATYPE........ccoiueieiiiieeiiiieeiiiee e 241
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TLAP............ccouiriiirieeiieiie e 225
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TNU@p...........cccoeiriieiiiiiiiiieiiieiie e 226
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration: TPHYS:L1M:STATE........ccovriiniiiiiiiieeenn 242
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration: TPHYS:L2M:STATE.......c.covviiriiinriiieeieee 242
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration: TPHYs:LCOD:STATE.........cceevverrriieeiaann 242
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPOWeT............cccciiiiiiiiiiieiiie e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:USERpatt............cccccoeeriiiniiiiiiiiiceeee
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:UTYPe..........ccceiiiiiiiiiiiiiiiieeiieeee e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:VNUMber...
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:WOFFSet............ccccoviiiiiiiiiiiiinieneeseee
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:WSIZe............ccccoviiiiiiiiiiiiiieiie e
[:SOURce<hw>]:BB:BTOo0th:ECONIfiguration:PNUMDET...........ccoiiiiiiiiiiieeeiee e
[:SOURce<hw>]:BB:BTO0th:ECONfigUration:SDCI?.......cc.ciiuiiiiiiiieiiieiiee et 187
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:SINTEIVaAL...........cccuiiiiiiiiiiiiiiii et
[:SOURce<hw>]:BB:BTO0th:ECONfiguration:SWINAOW...........ccoiiiriiiiiieiieieie e
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:WOINfo?....
[:SOURce<hw>]:BB:BTOo0th:ECONfiguration:WSINFO?.........coiiiiiiiiieiie et 189
[:SOURCce<hw>]:BB:BTOOth:FILTEIFILTEIS?. ... ettt ettt 282
[:SOURce<hw>]:BB:BTOOth:FILTErILENGLN.......ooiiiiiiiiii e 283
[:SOURce<hw>]:BB:BTOoth:FILTer:ILENgth:AUTO[:STATE].....c.uetiiieiiieeiieiie ettt 284
[:SOURce<hw>]:BB:BTOOth:FILTEIMINDEX......ccviruiiuiiiieiieite ettt ettt 284
[:SOURCce<hw>]:BB:BTOOth:FILTERMTYPE. ...ttt s 285
[:SOURce<hw>]:BB:BTOOth:FILTENOSAMPIING.....cciiiiiieitiiaiie ittt 284
[:SOURce<hw>]:BB:BTOoth:FILTer:OSAMPIING:AUTO[:STATE]......ccuiiiiierieeieeieesie et 284
[:SOURce<hw>]:BB:BTOoth:FILTer:PARamMeter:APCO25........c...oooiiiiiiiiiecee et 285

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:COSine
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:FGAuss

[:SOURce<hw>]:BB:BTOoth:FILTer:PARAMELEr:GAUSS........ccviiiiiiiieiie et

[:SOURce<hw>]:BB:BTOoth:FILTer:PARAMEtEr:LPASS.........ocooiiieeee et

[:SOURce<hw>]:BB:BTOoth:FILTer:PARAMELErPGAUSS. ... ...coiiiiiiiiiiee ettt 287
[:SOURce<hw>]:BB:BTOoth:FILTer:PARamMeter:RCOSINE. ......ccciiiiiiiiiiiecieeeiec e 287
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:SPHASE............cccceeiiuiie e 287
[:SOURCce<hw>]:BB:BTOOth:FILTEITYPE. ..ottt 283
[:SOURce<hw>]:BB:BTOOth:MFORMAL..........iiitiiiiiiiii ittt 178
[:SOURce<hw>]:BB:BTO0th:MSETtiNGS:FDEVIAtioN..........ccoiiiiiiiieiiieiie e 285
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:ACKNowledgement..............ccooriiiiiiiiiiiiiee e 272
[:SOURce<hw>]:BB:BTOo0th:PCONfiguration:BDALAP..........cocuiiiiiiiieiiiiiieie e 273
[:SOURce<hw>]:BB:BTOo0th:PCONfiguration:BDANEP. ........cccuiiiiiiiiiaiieeitie ittt 273
[:SOURce<hw>]:BB:BTO0th:PCONfiguration:BDAUGP. .........coeeriiiuiiiiiieiieiteeeeie e 273
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[:SOURce<hw>]:BB:BTOo0th:PCONfiguration:CODEVICE. ..........coiuiiiieiiiiiieiiie ettt 274
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:DPATIEM......cc.uiiiiiiiieiie et 274
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:DSELECHON. ........cceiiiiiiiiiiiie e 275
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:VDPALEIN.........ccoviiiiiiiiee e 275
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:VDSEIECHON. ........cccoeeiiiiiiiiiieiieeeeee e 276
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DLENGh...........ccoouiiiiiiiiiiie e 276
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DSFPaCKet............cccoriiiiriiiiiicieee e 276
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DWHItENING..........cooiiiiiiiiiiiieec e 277
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:EIRPacketfollows..............cccoiiiiiiiiiiiiiiiiiciic e 277
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:HFCONLrol............ccoiiiiiiiiiiieiiieeeee e
[:SOURce<hw>]:BB:BTOo0th:PCONfiguration:LFSWOrd...........cccoiiiiiiiiiiiiiceeeee e
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:LTADdress
[:SOURce<hw>]:BB:BTOo0th:PCONIfiguration:PFCONIOL..........cccuiiiiiiieiieeee e
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:PLENGIh.........cociiiiiiiii e
[:SOURce<hw>]:BB:BTO0th:PCONFigUration:SLAP...........oiiiiiiiiiie it
[:SOURce<hw>]:BB:BTOo0th:PCONIfiguration:SNSValUe...........ccooiuiiiiiiiiiiiie e
[:SOURce<hw>]:BB:BTOo0th:PCONfiguration:SRMOAE...........c.coriiiiiiiiiiiiiii e
[:SOURce<hw>]:BB:BTO0th:PCONFfiGUration:VDATA. .......c.ceiiiiiiiiiiieiie ettt

[:SOURce<hw>]:BB:BTOoth:PFORmat

[:SOURce<hw>]:BB:BTOoth:PRAMping:FOFFset
[:SOURce<hw>]:BB:BTO0th:PRAMPING:RFUNCHON. .......cciiiiiiiiiiiieiie e
[:SOURce<hw>]:BB:BTO0th:PRAMPING:ROFFSEL......ccuiiitiiiiiiiii e
[:SOURce<hw>]:BB:BTOOth:PRAMPING:RTIME.......coiiiiiiiiiieiiee s
[:SOURCe<hw>]:BB:BTOOth:PRESEL.........cueeiiiieiiiee ettt et e e et e e e e e e enneeeanes
[:SOURCE<hW>]:BB:BTOOth:PTYPE. ... ..ottt ettt ettt e et ae e e
[:SOURce<hw>]:BB:BTOoth:SETTing:CATalog...
[:SOURce<hw>]:BB:BTOOth:SETTING:DELELE........ooiiiiiiieiii e
[:SOURce<hw>]:BB:BTOOth:SETTING:LOAD.......ooiiiiiii ittt e e e
[:SOURce<hw>]:BB:BTOOth:SETTING:STORE.......cciiiiiiiiiiiiie it
[:SOURce<hw>]:BB:BTOOth:SLENGh. ......eiiiiiiiiii e
[:SOURce<hw>]:BB:BTOOth:SRATE:VARIGLON. ........ooiiiiiiiiiii ettt
[:SOURCE<hW>]:BB:BTOOtN:STATE. ...ttt ettt b e s
[:SOURCe<hW>]:BB:BTOOth:STIMING. .....cetiiiiitiiieeiie ettt ettt anee s
[:SOURCce<hw>]:BB:BTOOth: TIMODAE.........cciiiiiiiaiiieiiie ettt ettt ettt e et e e see e st e eseeeebeeaneeeeneeenneaaseean
[:SOURce<hw>]:BB:BTOo0th: TRIGGErARM:EXECULE.......ccueiiiiiiiiiiicie e
[:SOURce<hw>]:BB:BTOOth: TRIGENREXECULE.......cueiiiiiiiiiiieiie e
[:SOURce<hw>]:BB:BTOoth: TRIGger:OUTPut<ch>:DELay....
[:SOURce<hw>]:BB:BTOoth: TRIGger:OUTPut<ch>:FESHIft...........cccooiiiiiiiii e
[:SOURce<hw>]:BB:BTOoth: TRIGger:OUTPUt<Ch>:MODE............ccccoiiiiiiiiiie et
[:SOURce<hw>]:BB:BTOoth: TRIGger:OUTPUt<Ch>:OFFTIME........ccccoiiiiiieiiieiie et
[:SOURce<hw>]:BB:BTOo0th: TRIGger:OUTPUt<Ch>:ONTIME........cceeiiiiiiiriiiiie e
[:SOURce<hw>]:BB:BTOoth: TRIGer:OUTPUt<Ch>:PATTEIN.....cc.ciiiiiiiiiiieiie e
[:SOURce<hw>]:BB:BTOoth: TRIGer:OUTPUL<Ch>:PINDEX........cciiuiiiiiiaiieiiiieiie et
[:SOURce<hw>]:BB:BTOoth: TRIGger:OUTPut<ch>:PULSe:DIVider
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[:SOURce<hw>]:BB:BTOOth: TRIGEIRSOURCE........ccuiiiiiiiiieiie ettt
[:SOURce<hw>]:BB:BTOoth: TRIGger: TIME:DATE....

[:SOURce<hw>]:BB:BTOOth: TRIGGErTIME:TIME........coiiiiiiiiiiiieee s
[:SOURce<hw>]:BB:BTOOth: TRIGGErTIME[:STATE]. ....ccueiiiitiniieitie ettt
[:SOURce<hw>]:BB:BTOoth: TRIGger[:EXTernal]l:DELaY...........cccciiiiiiiiiieiie et 295
[:SOURce<hw>]:BB:BTOoth: TRIGger[:EXTernal]:INHIbIt.............ccoooiiiiii e 295
[:SOURce<hw>]:BB:BTOoth: TRIGger[:EXTernal]:SYNChronize:OUTPUL............ccooiiiiiiiiiiiiiiieiie e 294
[:SOURce<hw>]:BB:BTOOth:UNIT:TIME.........ooiiiiiiiiiiiii ettt et e e e e s 165
[:SOURCE<hW>]:BB:BTOOth:UPTYPE. . ..ottt et 176
[:SOURCce<hw>]:BB:BTOOth:USLENGLN.......coiuiiiiiiiiiii e 178
[:SOURce<hw>]:BB:BTOOth:VERSION?.........eiiiiiiiieiie ettt ne e e s 165
[:SOURce<hw>]:BB:BTOOth:WAVEfOrM:ICREGLE.........cueiiiiiiiiiiieiie e

[:SOURce<hw>]:BB:BTOoth[: TRIGger]:SEQuence....
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